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About the Release Notes
The Release Notes are a comprehensive user guide for the latest release of the Salesforce application and the AppExchange.
Unlike a traditional release notes document that includes only a simple list of enhancements and known bugs, the Salesforce
Release Notes give you everything you need to get and up and running with the new features and functionality in the latest
release.

What's Included in the Release Notes

For every new piece of major functionality, the Release Notes provide:

• A brief, high-level description of the functionality
• Implementation tips to help you get started with setup and administration
• Best practice tips to help you maximize the benefit of the functionality
• Complete end-to-end instructions on how to set up and use the functionality

Beyond the major new features, the Additional Enhancements sections include a list and brief description of every other
enhancement or functionality change included in the latest release—everything from new merge fields you can use in formulas
to improved icons for greater usability to additional fields that are available in standard reports.

Let the Release Notes be your guide to success with the latest release from salesforce.com!
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SALESFORCE CRM

Salesforce PRM
Salesforce PRM allows you to leverage the power of Salesforce to extend the benefits of a CRM system to your indirect sales
channels through a simple and easy-to-use portal. Many new features have been added to Salesforce PRM in Winter '07,
including:

• Custom objects are now available in the partner portal
• Activity-based collaboration with partners
• Configurable list views for partners
• Configurable email templates
• Partner statistics
• Password reset self-service for partners
• Ability for channel managers to log in as a partner user

Implementation Tips

To use PRM, follow these steps:

1. Contact customer support to purchase partner licenses.
2. Install the PRM Portal app.
3. Configure Salesforce for PRM.
4. Define your partner users and channel managers.
5. Customize PRM portals.

Best Practices

• Create a public group for channel managers. You can use this group for filtering and controlling access to documents. For
more information, see "Creating and Editing Groups" in the Salesforce online help.

• Create a lead queue for channel managers. You can use this queue for lead assignment rules. For more information, see
"Setting Up Queues" in the Salesforce online help.

• Use the All Partner Users group for filtering and controlling access to documents. For more granular control, you can also
create a group for each partner organization. For more information, see Creating and Editing Groups.

• Create a lead queue for each partner organization and add all the partner users from that organization to the queue. You
can create a queue that includes all of the partner users in a particular role. This allows you to assign leads to a partner
organization rather than a specific partner user. For more information, see Setting Up Queues.

• Create a queue for all partner users. This allows you to make a lead available to any partner user. If you create a queue with
channel manager roles and subordinates, the partner users under that channel manager cannot see the queue, but non-partner
users can see and use the queue.

• Use notes and attachments on leads and opportunities so partners can add notes about the lead or opportunity.
• Create custom list views for partner users. These custom lists can be added to partner user page layouts or as statistics for

the home page sidebar.

Note:  If your organization uses divisions to segment data, avoid including the Division field in filter criteria in
list views intended for partner users. Filter criteria based on divisions are ignored in the partner portal.
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About Salesforce PRM

About Partner Relationship Management

Partner relationship management (PRM) allows companies that sell through indirect sales channels to maximize the return
on their channel investments and increase channel revenues. With partner relationship management, organizations can manage,
track, and forecast their channel business alongside their direct sales business. It also helps partners sell more effectively, close
more business, and achieve greater profits.

Empowering your partners with your Salesforce data can help you sell more without spending more. However, you want to
control the information your partners can access, and you want your partners to work within an application that uses your
company's branding. You can accomplish this by granting your partners access to a Salesforce PRM portal.

A PRM portal allows partner users to log in to Salesforce through a separate website than your non-partner users. PRM portal
users can only see the data that you have made available to them. Furthermore, PRM portal users can only manipulate data
if you give them the appropriate user permissions.

The following Salesforce features are key to partner relationship management:

Partner accounts
Partner accounts are accounts that a channel manager uses to manage partner organizations, partner users,
and activities.

Partner users
Partner users are Salesforce users with limited capabilities. They are associated with a particular partner
account, have limited access to your organization's data, and log in via a PRM portal.

Channel managers
Channel managers are the internal users that manage your partners.

PRM portals
PRM portals allow partner users to log in to Salesforce through a web portal rather than through
salesforce.com. You can customize the web portal to show your branding, and you can configure it to
meet your functional and security needs. You can also have multiple portals to meet your different
requirements for working with partners.

To use PRM, follow these steps:

1. Contact customer support to purchase partner licenses.
2. Install the PRM Portal app.
3. Configure Salesforce for PRM.
4. Define your partner users and channel managers.
5. Customize PRM portals.

Caution:  Make sure your organization has not enabled the Disallow HTML documents and attachments
setting available at Setup ➤ Security Controls ➤ HTML Documents and Attachments Settings.This setting blocks
users from uploading any HTML file to the Documents tab or as an attachment to a record.

Installing the PRM App

User Permissions Needed

"Download AppExchange Packages"To install apps:
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To install the Salesforce PRM app:

1. Go to the AppExchange by clicking Setup ➤ Exchange ➤ Installed Apps.
2. Click Visit the AppExchange to go to the AppExchange website.
3. Browse or search the AppExchange to find the PRM Portal app.
4. Click Get It Now from the app information page.
5. Review the components. PRM is composed of the PRM custom app and the Salesforce PRM Setup custom window.

Caution:  Once it is installed, do not change the name of the PRM custom app. If you change the name of the
custom app, PRM will no longer function properly.

6. Click Next.
7. Choose the Select security settings option. This allows you to choose the usage access for all existing custom and

standard profiles in your organization.
8. Select "Full Access" as the access level for your administrator and channel manager profiles.

Note:  If you have not created profiles for channel managers, you can give them access to the PRM custom app
when you create the profiles.

9. Click Next.
10. Click Install to install all the components in the PRM app.
11. Click OK.

After installing the PRM app, follow these steps:

• Configure PRM.
• Configure channel managers and partner users.
• Create and customize one or more PRM portals.

Optionally, you may also want to create approval processes or a deal registration process.

Configuring PRM

User Permissions Needed

Customize ApplicationTo configure the PRM app:

Once you have installed the PRM app, you need to enable partner relationship management.

To enable partner relationship management:

1. Click Setup ➤ Customize ➤ Partners ➤ Settings.
2. Click Edit.
3. Select Enable Partner Relationship Management.
4. Click Save.

Note:  Partner relationship management cannot be disabled. If you no longer need the functionality, deactivate your
partner users.

After enabling partner relationship management, you need to configure how you will communicate user information with
your partners. This involves setting the email address for these communications and defining email templates for new partner
users and partner users requesting a password reset.
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To configure PRM communication templates:

1. Click Setup ➤ Partners ➤ Settings.
2. Click Edit.
3. Set the following options:

DescriptionSetting

The email address from which all email communications
will be sent, for example, "partners@acme.com." Salesforce

"From" Email Address

sends the emails automatically, but they will appear to the
partner user as if they were sent from this email address. If
a partner user responds to the email, the response will be
sent to this address.

The name that will be associated with the "From" Email
Address, for example, "Acme Partner Program."

"From" Email Name

The email template for notifying new partner users of their
account and initial password.

New User Template

The email template for notifying partners users of their
temporary password when their password is reset by a
Channel Manager or System Administrator.

New Password Template

The email template for notifying partner users of their
temporary password when they request a password reset.

Lost Password Template

4. Click Save.

Samples of these communication templates are available, and are used by default. You should create custom templates that
use your company branding and the URL to the partner portal.

About PRM User Management

There are two types of users for PRM—channel managers and partner users.

Channel managers are the internal users that manage your partners. Before enabling a PRM portal, you need to customize
your channel manager profiles so that channel managers can manage partners. For information on customizing your channel
managers, see About PRM Channel Manager User Management.

Partner users are external to your organization but sell your products or services through indirect sales channels. Your partner
users use a PRM portal to log in to Salesforce. Once logged in, they can access whatever information you make available to
them. You must take steps to protect your organization’s confidential or internal information. For information on customizing
your partner users, see About PRM Partner User Management.

Enabling Lead Conversion for Partner Users

User Permissions Needed

"Manage Users"To create, edit, or delete profiles:

"Customize Application"To configure the PRM app:
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You may choose to allow your partner users to convert leads. Lead conversion by partners is very similar to the standard lead
conversion process your other users follow.

To allow partner users to convert leads:

1. Ensure that the following permissions are enabled on the partner profile:

• "Convert Leads"
• "Edit" on leads
• "Edit" on accounts
• "Edit" on contacts
• "Create" on contacts
• "Create" on accounts
• "Create" on tasks

For more information on setting user permissions on profiles, see "User Permissions on Profiles" in the Salesforce online
help.

2. Ensure that partner users have Read Only access to the Global Portal Settings folder on the Documents tab. The Global
Portal Settings folder is automatically created when you install PRM.

3. Create Lead Status values that work with your channel business processes.
4. Click Setup ➤ Exchange ➤ Installed Apps.
5. Click Configure next to the Salesforce PRM app. A new window opens to display the PRM Portals setup page.
6. Select the name of the portal you want to configure.
7. In the Available Tabs section, click Edit next to the Leads tab.
8. Select Automatic Lead Conversion.
9. To map standard lead fields to custom opportunity fields, select Standard Field Mapping, then map each standard

field to the appropriate custom field.

Tip:  Because partner users do not have access to contacts, mapping standard lead fields to custom opportunity
fields allows you to share information with the partner user that they normally would not see.

10. Click Save.

To convert a lead, a partner user will change the status of the lead to a converted lead status, such as "Converted."

How Lead Conversion Works in PRM Portals

Lead conversion in the PRM portal works slightly different than it does in Salesforce, primarily because partner users do not
have access to accounts and contacts. Instead, in the PRM portal, the lead conversion process attempts to match the lead
Email Address with the Email Address of contacts with the following results:

• If one contact is found with a matching email address, and the contact has an associated account, the conversion process
uses the existing contact and account to create a new opportunity that is associated with that account.

• If one contact is found with a matching email address, and the contact does not have an associated account, a new contact,
account, and opportunity are created.

• If there is more than one contact that has a matching email address:

• If only one of the contacts is owned by the partner user, and there is an account associated with the contact, a new
opportunity is created that is associated with that account.

• If only one of the contacts is owned by the partner user, and there is no account associated with the contact, a new
contact, account, and opportunity are created.
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• If more than one contact with a matching email address is owned by the partner user, the first contact found is used.
If there is an account associated with that contact, a new opportunity is created that is associated with that account. If
there is no account associated with the contact, a new account, contact, and opportunity are created.

• If none of the matching contacts are owned by the partner user, then the first contact found is used. If there is an
account associated with that contact, a new opportunity is created that is associated with that account. If there is no
account associated with the contact, a new account, contact, and opportunity are created.

• If no email matches are found, a new contact, account, and opportunity are created.

Note:  Assignment rules cannot be triggered by actions in the PRM portal.

Managing PRM Portals

User Permissions Needed

"Customize Application"To create, edit, and delete PRM portals:

When partner relationship management is enabled, a default PRM portal is automatically created. You can customize this
portal to fit your needs, or you can create new portals as needed. Having multiple portals allows you to have a custom portal
for each type of partner you have. For example, you may have partners in different geographies, or you may have different
partner levels based on the amount of sales they have generated. Each type of partner can be associated with a unique PRM
portal that you have customized for them.

Note:  Do not create a portal for every partner account. Organize your partners together into logical groups.

To customize PRM portals:

1. Click Setup ➤ Exchange ➤ Installed Apps.
2. Click Configure next to the Salesforce PRM app. A new window opens to display the PRM Portals setup page.

From the PRM Portals setup page, you can perform any of the following actions.

• To create a new PRM portal, click New. See "Defining a PRM Portal" in the Salesforce online help.
• To assign partner users to a portal, click Portal Assignment. See Assigning Partner Users to a PRM Portal.
• To reset the default portal, click Reset Default Portal. Resetting the default portal removes any customizations you have

made to your default portal.
• To view and customize the settings for an existing portal, select the portal name. See Configuring a PRM Portal.
• To edit the details of an existing portal, click Edit next to a portal name. In addition to being able to set the portal name,

you can also configure what objects to include in search, the partner account owner title, change the logout URL, and
manage the look and feel of the portal. See Configuring a PRM Portal.

• To preview an existing partner portal, click Preview.

A new window opens with a preview of your portal.

• To delete a portal, click Del. A warning dialog prompts you to confirm the deletion. Any users assigned to a deleted portal
are reassigned to the default portal. None of the associated documents are deleted. You cannot delete the default portal.
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Creating Partner Accounts

User Permissions Needed

"Read" on accountsTo view accounts:

"Create" on accountsTo create accounts:

"Manage Partners"To enable a partner account:

Partner accounts are business accounts that a channel manager uses to manage partner organizations, partner users, and
activities. Each company with which you partner should be added to Salesforce as a business account. Channel managers are
associated with partner accounts by account ownership. A channel manager who owns a partner account can access all the
information and manage all the activities of the partner account. This allows the channel manager to easily keep up-to-date
on partner activities.

Note:  If your organization has person accounts, they cannot be used as partner accounts. Only business accounts can
be used as partner accounts.

To create a partner account:

1. Create a new business account. See Creating Accounts.
2. Then, click Enable As Partner.
3. A confirmation dialog will open. Select Yes, I want to enable this account as a partner account..
4. Click Confirm.

Once you have a partner account created, you can add partner users to the account as contact records. Partner users are Salesforce
users with limited capabilities focused on managing leads. Partner users log in to Salesforce through the PRM portal.

Note:  Partner accounts cannot be deleted.

Salesforce Console
Available in: Professional, Enterprise, Unlimited, and Developer Editions

With Winter '07 comes the Salesforce console—a highly optimized AJAX desktop that can dramatically speed up support,
sales, and telemarketing functions in your organization. Increase business efficiency for users by setting up the console to
consolidate all related data in Salesforce on one screen, without any plug-ins or client software. Information displayed in the
console gives users greater insight into the data they work with because they can see exactly how it is related.

Implementation Tips

• Custom s-controls work in the console just as they work in Salesforce.
• You cannot report on the use of the console in your organization.
• You can add up to five related lists to mini page layouts.
• Search results cannot be configured to display in the console's list view frame.
• Enterprise, Unlimited, and Developer Edition users with the "Customize Application" permission can assign a console

layout to a profile via the profile detail page by clicking the Edit link in the Console Settings section.
• You cannot change the position of where the console's list view, detail view, and mini view display on a screen.
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• There is no console API to access.

Best Practices

• Do not set up a console for occasional Salesforce users. Users who view Salesforce at least three hours a day benefit most
from the console.

• Customize mini page layouts for those objects that are needed for specific business functions. For example, customize the
account and contact mini page layouts if you plan on using the console for customer support purposes.

• Add custom objects to console layouts so that users have the option to display list views of custom object data in the console.
• Inform users to occasionally click the Refresh button in the list view so that the list view reloads with any record updates

that have occurred since they began viewing the list.
• Administrators can customize many different console layouts to display a variety of objects in the console's list view, and

then assign those console layouts to different user profiles to satisfy the business needs of different users.
• Administrators should set the Console tab visibility setting on user profiles to Default On so users have no difficulty finding

the console.
• Administrators should add the Console tab to custom apps so that users can access the console from specific apps. For

more information, see "Managing Custom Apps" in the Salesforce online help.

About the Salesforce Console

What is the Console?

The console is a tab that combines a list view and related records into one screen with different frames so that users have all
the information they need when interacting with Salesforce. By using the console, users can quickly find, view, and edit records
such as cases, accounts, and contacts with fewer clicks and without switching back and forth between screens. Administrators
choose the information displayed in the console to accommodate your varied and evolving business needs.

Before setting up or using the console, see "Console Concepts" in the Salesforce online help for a description of console
terminology.

Console Concepts

Review the following terminology used to describe the components of the Console tab:

Frames
Separate sections of the console which each display a different record, list view, or other page.

List View
The console's top frame which is a list view of records based on specific criteria. The list views you can
select to display in the Console tab are the same list views defined on the tabs of other objects. You cannot
create a list view within the console.

Detail View
The console's center frame which is the detail page view of any record selected from any of the console’s
other frames. The detail view displays the same page layouts defined for the object’s detail pages. When
a record is displayed in the detail view, it is highlighted in the list view.

Mini View
The console's right frame which displays the records associated with the record displayed in the detail
view. The fields displayed in the mini view are defined in the mini page layouts by an administrator. The
mini view does not display if the record in the detail view does not have any records associated with it.
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Sidebar
The console's left frame which displays recent items, the Recycle Bin, and other components, just like
the sidebar displayed on every Salesforce page.To show or hide the sidebar in the console, click the border
of the left frame.

Related Objects
Records chosen by an administrator to display in the mini view when records of a particular type are shown
in the detail view. For example, when a case is in the detail view, an administrator can choose to display
an associated account, contact, or asset in the mini view.

Mini Page Layouts
A subset of the items in a record's existing page layout that administrators choose to display in the mini
view. Mini page layouts inherit record type and profile associations, related lists, fields, and field access
settings from the page layout.

Console Layout
Objects chosen by an administrator to display in the list view frame of the console. For example, if an
administrator adds cases to a console layout, then users whose profiles are assigned to that console layout
can see list views of cases in the console's list view frame.

Setting Up the Console

User Permissions Needed

"Customize Application"To set up the console:

You can quickly set up the Console tab so that users have all the information they need on one screen when working with
Salesforce. To set up the console:

1. Create console layouts to define what objects are available to users in the console's list view frame.
2. Choose the related objects to show in the mini view.
3. Define mini page layouts to customize the fields and related lists of the objects that display in the console's mini view.
4. Assign profiles to a console layout to provide users access to specific objects in the console's list view.
5. Add the Console tab to custom apps so that users can access the console from specific apps.

Creating Console Layouts

User Permissions Needed

"Customize Application"To create console layouts:

To create a new console layout:

1. Click Setup ➤ Customize ➤ Console ➤ Console Layouts.
2. Click New and optionally choose an existing layout to clone.
3. Enter a name for the new layout.
4. Click Save.
5. Click Edit in the Selected List Views section.
6. To add or remove objects to the layout, select an object, and click the Add or Remove arrow.

To change the order of the objects as they will appear in the console's list view frame, select an object in the Selected List
box, and click the Up or Down arrow.
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A user can only view objects in the console's list view frame if those objects are added to the console layout to which their
profile is assigned.

7. Click Save.

Choosing Related Objects for Page Layouts

User Permissions Needed

"Customize Application"To set up the console:

While you can choose which related objects appear in the mini view of the console, you can only choose objects with a lookup
relationship on the primary object. For example, from the cases object, you can choose account and contact because cases have
account and contact lookup fields. To choose related objects:

1. Click Setup ➤ Customize and choose a standard object, or click Setup ➤ Build ➤ Custom Objects and choose a custom
object.

The standard or custom object you choose in this step represents the record in the detail view of the console, and the related
objects in the mini view will be records associated with it.

2. Select Page Layouts, and choose a page layout name.
3. Click Related Objects.
4. Select which records associated with the record in the detail view will be displayed in the mini view. You can only select

objects if they are defined as lookup relationships and those lookup fields are included on the page layout.

You can change the order of how related objects display in the mini view by clicking the up and down arrows.

5. Click Save.
6. Next, define mini page layouts to specify what fields and related lists to show for the related objects in the mini view.

Tip: The fewer related objects you add to the console's mini view, the easier it is for users to read the information
displayed. The console can also process data faster when fewer related objects are added to the mini view.

Note: You cannot choose related objects for the Close Case Layout or the Log a Case Page and View Cases Page
layouts on the Self-Service Portal.

Defining Mini Page Layouts

User Permissions Needed

"Customize Application"To set up the console:

You can define mini page layouts for the records that appear in the mini view of the console. A mini page layout contains a
subset of the items in an existing page layout. Mini page layouts inherit record type and profile associations, related lists, fields,
and field access settings from their associated page layout. The visible fields and related lists of the mini page layout can be
further customized, but the other items inherited from the associated page layout cannot be changed on the mini page layout
itself.

The event mini page layout is used for the event detail overlay, not the console.

To define a mini page layout:
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1. Click Setup ➤ Customize and choose a standard object, or click Setup ➤ Build ➤ Custom Objects and choose a custom
object.

2. Select Page Layouts, and choose a page layout name.
3. Click Mini Page Layout.
4. Select which fields and related lists will be displayed for this type of record in the mini view. For each related list you select,

choose which fields to display in that related list.

• You can select all of the available fields and up to five related lists to display in the console; however, it is recommended
that you only select a few so that users do not have to scroll to find information.

• Selected fields and related lists display in the console even when they do not contain content.
• Fields marked Always Displayed on page layouts are automatically included on the mini page layout and cannot be

removed unless they are removed from the page layout.
• Field properties on the page layout determine field properties on the mini page layout. For example, if a field is read-only

on the page layout, that same field will be read-only on the mini page layout. To change the field properties of fields
on the mini page layout, you must change the field properties of fields on the page layout. Note that the console respects
field-level security in organizations where it is available.

• To add or remove fields, select a field name, and click the Add or Remove arrow. To change the order of the fields,
select a field name in the Selected list box, and click the Up or Down arrow. Click Save when finished.

• The order of related lists on the page layout determines the order of related lists on the mini page layout. To change
the order of related lists on the mini page layout, you must change the order of related lists on the page layout, then
select the mini page layout and click Save.

5. Click Save.

Note: You cannot define mini page layouts for the Close Case Layout or the Log a Case Page and View Cases Page
layouts on the Self-Service Portal.

Assigning Console Layouts

User Permissions Needed

"Customize Application"To assign console layouts:

After you create console layouts, assign which console layouts users see. A user’s profile determines which console layout he
or she sees.

To assign console layouts:

1. Click Setup ➤ Customize ➤ Console ➤ Console Layouts.
2. Click Console Layout Assignment.
3. Select a console layout to assign to a profile via the drop-down list.
4. Select the Console tab visibility settings for a profile via the drop-down list. You can only select Console tab visibility

settings for profiles assigned to a console layout.

The following settings apply to tab visibility.

DescriptionSetting

Show the tab by default for users with this profile. Individual
users can override this setting for their login; see

Default On

"Customizing Your Display" in the Salesforce online help.
The Home page is always set to Default On.
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DescriptionSetting

Hide the tab by default for users with this profile. Individual
users can override this setting.

Default Off

Hide the tab and do not allow individual users to override
this setting in their personal customization. Making a tab

Tab Hidden

hidden does not hide the records for that tab; to prevent a
user from ever seeing records of that type, remove the "Read"
permission on that type of data.

5. Click Save.

Note:  Enterprise, Unlimited, and Developer Edition users with the "Customize Application" permission can assign
a console layout to a profile via the profile detail page by clicking the Edit link in the Console Settings section.

Displaying the Console

You can start using the Console tab after your administrator has set it up as described in "Setting Up the Console" in the
Salesforce online help.

To display the console, click the Console tab. To exit the console, select any tab.

No data displays in the console if the selected list view does not contain any records.

Note: You can only access the Console tab if your administrator has assigned your user profile to a console layout and
set your Console tab visibility setting to either Default On or Tab Hidden. If your Console tab visibility setting is set
to Tab Hidden, then you can customize your display to see the Console tab. For more information, see "Customizing
Your Display" in the Salesforce online help.

Navigating within the Console

What you click in the Console tab determines the frame a record displays in.

In the detail view, clicking:

• Buttons or links on the record displays the record in the detail view.
• Email this page ( ) displays a link to the record in an email.
• Link to this page ( ) displays the record and the URL of the record in a new browser window.
• Printable View ( ) displays a printable view of the record in a popup window.
• Customize Page ( ) allows you to customize the display of related lists in the detail view of the

record. For more information, see "Customizing Your Display" in the Salesforce online help.
• Help for this page ( ) displays an online help page for the record.

In the mini view, clicking:

• Links displays the record in the detail view. Associated records display in the mini view.
• View displays the entire record in the detail view.
• Edit displays a mini edit page in the mini view.

To edit a field not displayed on the mini edit page, click View to display the entire record in the detail
view, and then click Edit from the detail view.
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• Show more below a related list displays more of the records included in the related list in the mini
view. Show more displays an additional five records every time you click it, up to a maximum of 100.

Note: The mini view does not display if the record in the detail view does not have any records
associated with it.

In the list view, clicking:

• A link displays the record in the detail view.
• Refresh reloads the list view with any updates that have occurred to the records since you began

viewing the list.
• A column heading sorts that column in ascending order. Click the heading a second time to sort in

descending order.
• A letter at the bottom of the list view filters your list view records by the letter.
• fewer or more at the bottom of the list view displays a shorter or longer list.
• Previous Page or Next Page at the bottom of the list view displays the previous or next page of items

on the list.
• See "Using the Console List View" in the Salesforce online help for more information.

In the sidebar, clicking:

• The border of the left frame opens the sidebar in the console. Click the border of the left frame a
second time to hide the sidebar.

• A record under Recent Items displays the record in the detail view.
• Calendar displays the calendar in the detail view.
• Recycle Bin displays the Recycle Bin in the detail view.

Tip:  Clicking the back or forward buttons on your browser cycles you through pages in the console. You will not
immediately exit the console by clicking them.

Note:  Not all pages open within the console. For example, clicking Printable View, Check Spelling, Help for this
Page, lookup icons, email addresses, and custom links set to open in a new browser window all open outside of the
console in a new browser window or popup.

Using the Console List View

The console’s list view allows you to quickly perform actions within Salesforce without leaving the console.

Display list views
From the drop-down list in the top left of the list view frame, select an object, and then select a list view
of the object to display in the console’s list view frame. You cannot create a list view within the console.
Click Refresh to reload the list view with any updates that have occurred to the records since you began
viewing the list.The refresh button automatically changes colors to notify you when updates have occurred
to records in the list view.
Records italicize in the list view when you edit them in the detail view. This is to show you which records
you have edited in the list view.

Search
Enter keywords in the search box above the list view and click Go! to perform an advanced search across
all searchable records you can access in your organization. Terms in an advanced search are treated as
separate words rather than a phrase and may be found in different indexed fields within a record. So,
searching for Pat Powers in advanced search will find a contact named “Pat P Powers” as well as a contact
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named “Pat Smith” with an email address of “smith@powers.com.” Search results display in the detail
view.

Create records
From the New drop-down list, select any object to create a new record. New record pages display in the
detail view.

View recent items
From the Recent Items drop-down list, you can choose to display any of the 10 records you most recently
viewed. Recent items display in the detail view.

Perform mass actions
Select the checkbox next to items in the list view, and from the Mass Action drop-down list, choose the
action you want to perform on all the selected records.

Note: No data displays in the console if the selected list view does not contain any records.

Enhanced Activity Management and Popup Reminders
Available in: All Editions

Managing your calendar is now faster and easier than ever. With the latest enhancements, you can see personalized popup
reminders, share event and task records with your fellow team members, hover your mouse over calendar items to open
interactive overlays, and more.

Popup Reminders on Tasks and Events
You can now add popup reminders to tasks and events. Reminders notify you of an upcoming task or
event. Reminders display in a small browser popup window when you are logged in to Salesforce, and,
depending on your settings, will play a reminder sound. The reminder window includes details about the
activity, including the start time, the name of the activity, what the activity is related to, and, for events,
the location of the event. Click Setup ➤ My Personal Information ➤ Reminders to customize your
default reminder settings. You can override your default reminder settings when you are editing an activity.

Calender User Interface Enhancements
The single and multi-user calendar views now present information in an easier to read, graphical format.
Plus, if you mouse-over an event on any of the calendar views, you can see the event details overlay, a
small window that displays additional information about the event. Event detail overlays are configured
using the event mini page layout, and respect page layout, record type, and profile settings. On the event
detail overlay, you can edit, delete, or check your availability for the event.

Activities Sharing Model (Unlimited, Enterprise, and Professional Editions only)
There is a new Controlled by Parent organization-wide default you can set as the default access level for
activities. When selected, the Controlled by Parent default level allows users to perform an action (such
as view, edit, transfer, and delete) on an activity based on whether he or she can perform that same action
on the records associated with the activity. For example, if a task is associated with the Acme account and
the John Smith contact, then a user can only edit that task if he or she can also edit the Acme account
and the John Smith record.
To edit your organization-wide access level for activities, click Setup ➤ Security Controls ➤ Sharing
Settings ➤ Edit and select Controlled by Parent from the Default Activity Access drop-down
list. Then, click save.
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Custom Links for Tasks and Events
You can now add custom links for tasks and events. Navigate to Setup ➤ Customize ➤ Activities ➤

Task Buttons and Links or Setup ➤ Customize ➤ Activities ➤ Event Buttons and Links to set up
custom links for your tasks and events.

Events Security
With Winter '07, you must have at least read access to the contacts and leads you invite to a group event.
You must have at least "Add Events" access on a resource to invite it to a group event. Previously, users
were able to invite contacts, leads, and resources to a group event even if they had no sharing access to
the invitee. Note that existing invitees on group events will remain unaffected, whether or not the group
event organizer has sharing access to them.

Client Management
In Winter '07, Client management streamlines the entry and maintenance of contacts who are not associated with corporate
entities, while leveraging all of the robust customer relationship management capabilities that Salesforce offers. It is a complete
end-to-end solution for everything from client acquisition to client loyalty.

Client management is made possible through person accounts, which are an exciting major enhancement to the Salesforce data
model. Person accounts represent the individual clients with whom you do business. If your company operates on a
business-to-consumer (B2C) model, person accounts are a simple yet powerful way to manage the entire life cycle of each
customer relationship.

In essence, a person account is an account to which a person account record type (a new class of account record types) has been
assigned. Such record types seamlessly fuse the rich functionality of contacts onto the account—enabling the sending of emails,
participation in campaigns, conversion from leads, and much more.

Note: Person accounts are available as part of a limited release program. Contact salesforce.com for more information.

Implementation Tips

Person accounts are not yet generally available. For information on participating in the ongoing limited release program, please
contact your salesforce.com representative.

Follow the steps below to get started with person accounts. Please note that the order of the following steps is only a
recommendation; the steps after Step 1 are optional based on your organization's unique configuration and also can be performed
at any time.

1. Enable person accounts:

a. As a prerequisite, create at least one record type for accounts.
b. Person accounts are available upon request for Enterprise, Unlimited, and Developer Edition organizations as part of

a limited release program. After you have completed the prerequisite above, contact salesforce.com to make the request.
c. Please note that enabling person accounts is permanent and cannot be reverted. If you are an existing customer, we

recommend creating a Salesforce Sandbox to preview how person accounts will affect your organization.

2. Customize the names of tabs and field labels:

a. Rename the Accounts tab name, the business account field label, and the person account field label to meet
your business requirements.

b. Rename the Contacts tab name and the business contact field label to meet your business requirements.
c. Rename the Partners related list to "Related Accounts," "Relationships," or a similar term that reflects how your person

accounts relate to each other.

3. Customize person account page layouts:
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Go to Setup ➤ Customize ➤ Accounts ➤ Person Accounts ➤ Page Layouts.a.
b. As desired, add contact fields and related lists to the page layout.

4. Customize person account record types. When person accounts are enabled, a default person account record type is
automatically created. You can modify this default person account record type, and you can also add additional person
account record types.

5. Assign person account record types to profiles.
6. Add the person account icon to search results and lookup dialogs—the icon corresponds to the Is Person Account

field. The icon visually differentiates person accounts from business accounts in account lists and from business contacts
in contact lists. If your organization works exclusively with person accounts, then adding the icon is not necessary.

7. Similarly, add the person account icon and other person account fields as columns in public list views:

• On the Accounts tab.
• On the Contacts tab.
• For Mass Email.
• For Mass Stay-in-Touch requests.

In addition, configure the search criteria of public list views so person accounts are included or excluded appropriately.

Note that individual users will need to update their personal list views as well.

8. Customize public reports and customize public dashboards to include person account information.

Note that individual users will need to update their personal reports and dashboards as well.

9. Add the Is Person Account field to rules, such as:

• Workflow rules.
• Assignment rules.
• Escalation rules.
• Field validation rules.
• Territory assignment rules.

10. Customize partner roles for person accounts—for example, add "Spouse," "Neighbor," "Attorney," and "Accountant."
11. Customize leads:

Note: Leads with a blank Company field are converted to person accounts. The default person account record type
for your profile is applied to the new person account. Similarly, leads with a value in the Company field are converted
to business accounts. The default business account record type for your profile is applied to the new business
account.

• Create lead record types for person accounts.
• Create lead page layouts for business accounts and person accounts. Page layouts for leads that will become business

accounts must contain and require the Company field. Page layouts for leads that will becomeperson accounts must not
contain the Company field.

12. Convert existing account-contact pairs to person accounts:

a. Create one-to-one relationships between account and contact records.
b. As much as reasonably possible, edit the accounts so they contain all desired field values.
c. Using Apex API 8.0, update the record types of the desired accounts to convert them to person accounts. We recommend

running a test conversion in your Salesforce Sandbox.

13. Update integrations—for more information on the Apex API, visit the Apex Developer Network.
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Best Practices

• If your organization exclusively uses person accounts (meaning you never use business accounts, which have a Contacts
related list), consider giving the Accounts and Contacts tabs the same name. However, to differentiate the tabs, append a
character such as a period (.) or asterisk (*) to the Contacts tab name. For example, the Accounts tab becomes Clients and
the Contacts tab becomes Clients*.

• Alternatively, modify user profiles to prevent the Contacts tab from displaying: change the visibility setting for the Contacts
tab to "Default Off" or "Hidden."

• Consider renaming the standard field Account Site and repurposing it as a unique identifier for person accounts. For
example, you could rename the field "Client Number" and use it to store a number that a uniquely identifies each person.
By default this field displays in many list views and other areas throughout Salesforce, and can help differentiate people
who have similar names.

About Client Management Using Person Accounts

What is an Account?

Accounts are your organization's customers, competitors, and partners. Each account stores information such as name, address,
and phone numbers. For each account, you can store related information such as opportunities, activities, cases, partners,
contracts, and notes.

The Accounts tab displays a home page that lets you quickly create and locate all types of accounts. You can also sort and filter
your accounts using standard and custom list views. In addition, this tab lets you view and edit detailed information on each
account to which you have access.

If your organization has been enabled with person accounts, you have two different kinds of accounts: business accounts and
person accounts. Business accounts represent the other companies with which your organization does business. For business
accounts, the individuals who work at those companies are represented by contacts. Person accounts represent the individual
consumers with whom your company does business, such as a financial services client, an online shopper, or a vacation traveler.
Depending on your organization's business model, you may use business accounts, person accounts, or both. See "What is a
Person Account?" in the Salesforce online help for more information.

If your organization has been enabled with PRM, you can create partner accounts. Partner accounts are business accounts that
a channel manager uses to manage partner organizations, partner users, and activities.

Note:  In the online help and other Salesforce documentation, the word "account" by itself always refers to both
business accounts and person accounts. The terms "business account" and "person account" are used when there are
differences between the two kinds of accounts.

What is a Person Account?

Note: Person accounts are not enabled by default in Salesforce. To request person accounts, contact salesforce.com.

A person account is an individual consumer with whom you do business, such as a financial services client, an online shopper,
or a vacation traveler. Person accounts are applicable to organizations that operate on a business-to-consumer model as opposed
to a business-to-business model.

In a business-to-business model, there is a natural differentiation between the other businesses with whom you work and the
people associated with those businesses. In Salesforce, that translates to accounts and contacts having different fields, features,
and tabs. In a business-to-consumer model, because you are providing products or services to people rather than companies
or organizations, the distinction between accounts and contacts does not exist. Consequently, person accounts in Salesforce

22

   
Salesforce CRM Client Management



have a combination of fields from both accounts and contacts, and can be used as contacts in most situations that involve
contacts. For example, business accounts do not have standard fields for email address and job title, but person accounts do.
Also, person accounts can be associated with campaigns just like contacts, but business accounts cannot. For details on the
contact-specific functionality that applies to person accounts, see "Person Account Behaviors" in the Salesforce online help.

The ability for person accounts to act like contacts is made possible by applying an account record type which has special
properties. The default name of this record type is "Person Account." Your administrator may have changed the name of this
record type, and also may have created more account record types that have the same special properties. For more information
on record types, see "Managing Record Types" in the Salesforce online help and "Changing the Record Type Field" in the
Salesforce online help.

Note:  In the online help and other Salesforce documentation, the word "account" by itself always refers to both
business accounts and person accounts. The terms "business account" and "person account" are used when there are
differences between the two kinds of accounts.

Person Account Behaviors

Note: Person accounts are not enabled by default in Salesforce. To request person accounts, contact salesforce.com.

Person accounts are accounts that can also be used as contacts in many situations. The following table summarizes the key
areas in which person accounts differ from business accounts or have unique considerations:

Person Account BehaviorSalesforce Functionality

Person accounts are accounts that support contact fields and
capabilities.

Accounts

Person accounts can only be merged with other person
accounts. See "Merging Duplicate Accounts" in the Salesforce
online help.

Account Merge

On the accounts home page, the fields in the Quick Create
area are based on whether the default account record type set

Account Quick Create

on your profile is a person account record type or a business
account record type.

Person accounts can be associated with activities using either
the Name or Related To fields.

Like contacts, person accounts can be invited to group events.

Activities

Like contacts, person accounts can be added to campaigns and
have a Campaign History related list.

Campaigns

On cases, person accounts can be entered in the Account
Name field, the Contact Name field, or both.

Cases

In most situations, you can use person accounts as if they were
contacts. You can include them in all contact list views except
the Recent Contacts list on the contacts home page.

Unlike business accounts, person accounts do not have a
Contacts related list. However, you can use the Partners related
list to track relationships between different person accounts.

Contacts
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Person Account BehaviorSalesforce Functionality

Like contacts, you can add person accounts to the Contact
Roles related list on cases, contracts, and opportunities.

Contact Roles

Custom objects with relationships to either accounts or
contacts can be added as related lists on person accounts.

Custom Objects

Person accounts are not currently supported in Offline Edition,
Outlook Edition, Lotus Notes Edition, and Intellisync for
salesforce.com.

Desktop Integration

Like contacts, you can send individual emails and mass emails
to person accounts.

Email

A predetermined combination of standard account and contact
fields is available on person account page layouts. In addition,

Fields

all custom account and contact fields are available. See "Person
Account Fields" in the Salesforce online help.

Note that some business account fields are not supported for
person accounts, such as Parent Account and View
Hierarchy. Also, the Reports To field on contacts is not
supported for person accounts.

You can rename person account field labels so alternate terms
display in Salesforce.

Person accounts have unique import wizards at Setup ➤

Import ➤ Import My Person Accounts and Setup ➤ Data
Import Wizards

Management ➤ Import Person Accounts. See "What Is
Imported for Person Accounts?" in the Salesforce online help

Person accounts have an icon with a person ( ), while business
accounts have a folder icon ( ). The person account icon can

Icons

be added to search results, list views, and lookup dialogs using
the criteria "Is Person Account equals True."

Leads with a blank Company field are converted to person
accounts. The default person account record type for your

Leads

profile is applied to the new person account. Similarly, leads
with a value in the Company field are converted to business
accounts. The default business account record type for your
profile is applied to the new business account. See "Converting
Leads" in the Salesforce online help and "Assigning Record
Types to Profiles" in the Salesforce online help.

Person accounts appear in both account and contact list views.
Add the Is Person Account icon to list views to visually

List Views

differentiate person accounts from other records, and to include
or exclude person accounts in a list.

Person accounts have unique page layouts that can have
account fields, contact fields, account custom links, account

Page Layouts

related lists, and contact related lists. Person accounts page
layouts do not support the Reports To and Parent
Account fields.

24

   
Salesforce CRM Client Management



Person Account BehaviorSalesforce Functionality

You can use the Partners related list to relate person accounts
to each other. We recommend that you rename the Partners

Partners

related list to "Related Accounts," "Relationships," or a similar
term that reflects how your person accounts are connected.

Administrators can configure multiple record types for person
accounts. A person account can only be changed to another
person account record type.

Record Types

Administrators can customize the names of tabs and fields
related to person accounts, such as:

Renamed Tabs and Standard Fields

• The Accounts tab name, the business account field
label, and the person account field label.

• The Contacts tab name and the business contact field
label.

Person accounts only appear in account search results.
Administrators can add the Is Person Account icon to

Search

account search layouts in order to differentiate person accounts
from business accounts.

Like contacts, person accounts can be enabled as users for your
Self-Service portal.

Self-Service Portal

Like contacts, you can send individual and mass Stay-in-Touch
requests to person accounts.

Stay-in-Touch Requests

Creating or editing a person account triggers account workflow
rules. See "Managing Workflow" in the Salesforce online help.

Workflow Rules

Person Account Fields

Here is a description of the standard fields (in alphabetical order) that make up a person account. Some of these fields may
not be visible or editable depending on your page layout and field-level security settings. Fields with "(Contact field)" in the
description are contact fields that are supported for person accounts but not business accounts.

Note that this list does not include any custom fields that your administrator may have created. Both account and contact
custom fields are available for person accounts.

DescriptionField

The default currency for all currency amount fields in the
account. Amounts display in the account currency and are also

Account Currency

converted to the user’s personal currency. Available only for
organizations that use multiple currencies.

Division to which the account belongs. Records related to the
account, such as contacts and opportunities, automatically

Account Division

inherit the account’s division. Available only in organizations
that use divisions to segment their data.

The name of the individual. In person accounts, the account
name cannot be edited directly. Instead, Salesforce derives it

Account Name
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DescriptionField

by combining the First Name and Last Name fields in the
appropriate order per the user's language setting.

The name of the account translated into the local language.Account Name (Local)

Tracking or reference number for account. Up to 40 characters
are allowed in this field.

Account Number

Assigned owner of account. Not available in Personal Edition.Account Owner

Name of the field that determines what picklist values are
available for the record. Available in Enterprise, Unlimited,
and Developer Editions.

Account Record Type

Name of the account’s location, for example, Headquarters or
London. Up to 80 characters are allowed in this field.

Account Site

Amount of annual reported revenue.Annual Revenue

Name of assistant. Up to 40 characters are allowed in this
field. (Contact field)

Assistant

Assistant’s phone number. Up to 40 characters are allowed in
this field. (Contact field)

Asst. Phone

Street address used for billing. Up to 255 characters are allowed
in this field.

Billing Street

City portion of billing address. Up to 40 characters are allowed
in this field.

Billing City

State or province portion of billing address. Up to 20 characters
are allowed in this field.

Billing State/Province

Zip or postal code portion of billing address. Up to 20
characters are allowed in this field.

Billing Zip/Postal Code

Country portion of billing address. Up to 40 characters are
allowed in this field.

Billing Country

Birthday. You can enter a date, or click the calendar icon to
choose a date. You can add the current date by clicking the
date link next to the field. (Contact field)

Birthdate

User who created the account, including creation date and
time. (Read only)

Created By

Associated business or organizational unit. Up to 80 characters
are allowed in this field. (Contact field)

Department

Description of account. Up to 32 KB of data are allowed in
this field. Only the first 255 characters display in reports.

Description

Indicates if the person does not want to be contacted via
telephone. (Contact field)

Do Not Call

Email address. Must be a valid email address in the form:
jsmith@acme.com. Up to 80 characters are allowed in this
field. (Contact field)

Email
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DescriptionField

The person's email address will not be included in mass emails.
(Contact field)

Email Opt Out

Number of people employed by the account.Employees

When checked, shields the account from being evaluated when
account assignment rules are run, preventing it from being

Exclude from territory assignment rules

automatically assigned to territories. Also, if the account is
already assigned to territories as a result of assignment rules,
checking this box removes the account from those territories.
This checkbox only affects rule-based account assignments
and has no effect on manual account assignments. See "What
is Territory Management?" in the Salesforce online help.

Fax number. Up to 40 characters are allowed in this field.Fax

Indicates if the person has requested not to be included in
broadcast faxes. (Contact field)

Fax Opt Out

The first or given name of the individual. Up to 40 characters
are allowed in this field. (Contact field)

First Name

Miller Heiman Gold Sheet for the account. Displays only for
Miller Heiman partner organizations.

Gold Sheet

Person’s home phone number. Up to 40 characters are allowed
in this field. (Contact field)

Home Phone

Primary business of account. Entry is selected from a picklist
of available values, which are set by an administrator. Each
picklist value can have up to 40 characters.

Industry

The surname or family name of the individual. Up to 80
characters are allowed in this field. (Contact field)

Last Name

The date that the most recent Stay-in-Touch request was sent.
(Contact field)

Last Stay-in-Touch Request Date

The date that the most recent Stay-in-Touch request was
returned and merged. (Contact field)

Last Stay-in-Touch Save Date

Record source, for example, Advertisement, Partner, or Web.
Entry is selected from a picklist of available values, which are

Lead Source

set by an administrator. Each picklist value can have up to 40
characters. (Contact field)

Street mailing address. Up to 255 characters are allowed in
this field. (Contact field)

Mailing Street

City portion of mailing address. Up to 40 characters are
allowed in this field. (Contact field)

Mailing City

State or province portion of mailing address. Up to 20
characters are allowed in this field. (Contact field)

Mailing State/Province

Zip or postal code portion of mailing address. Up to 20
characters are allowed in this field. (Contact field)

Mailing Zip/Postal Code
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DescriptionField

Country portion of mailing address. Up to 40 characters are
allowed in this field. (Contact field)

Mailing Country

Cellular or mobile phone number. Up to 40 characters are
allowed in this field. (Contact field)

Mobile

User who last changed the account fields, including
modification date and time.This does not track changes made
to any of the related list items on the account. (Read only)

Modified By

Street address portion of additional address. Up to 255
characters are allowed in this field. (Contact field)

Other Street

City portion of additional address. Up to 40 characters are
allowed in this field. (Contact field)

Other City

State or province portion of additional address. Up to 20
characters are allowed in this field. (Contact field)

Other State/Province

Zip or postal code portion of additional address. Up to 20
characters are allowed in this field. (Contact field)

Other Zip/Postal Code

Country portion of additional address. Up to 40 characters
are allowed in this field. (Contact field)

Other Country

Additional phone number listing. Up to 40 characters are
allowed in this field. (Contact field)

Other Phone

Ownership of company, for example, public or private. Entry
is selected from a picklist of available values, which are set by

Ownership

an administrator. Each picklist value can have up to 40
characters.

Primary phone number of account. Up to 40 characters are
allowed in this field.

Phone

Categorization of how you rate this account, for example, Hot,
Cold. Entry is selected from a picklist of available values, which

Rating

are set by an administrator. Each picklist value can have up to
40 characters.

When checked, causes account assignment rules to run when
the account is edited and saved. When customizing the page

Run territory assignment rules on save

layout for accounts, an administrator can control whether this
checkbox displays and whether it is checked by default. See
"What is Territory Management?" in the Salesforce online
help.

Title for addressing the person, for example, Mr., Ms., Dr.,
or Prof. Entry is selected from a picklist of available values,

Salutation

which are set by an administrator. Each picklist value can have
up to 40 characters. (Contact field)

Primary mailing or shipping street address of account. Up to
255 characters are allowed in this field.

Shipping Street

City portion of primary mailing or shipping address. Up to
40 characters are allowed in this field.

Shipping City
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DescriptionField

State or province portion of primary mailing or shipping
address. Up to 20 characters are allowed in this field.

Shipping State/Province

Zip or postal code portion of primary mailing or shipping
address. Up to 20 characters are allowed in this field.

Shipping Zip/Postal Code

Country portion of primary mailing or shipping address. Up
to 40 characters are allowed in this field.

Shipping Country

Standard Industrial Classification code of the account’s main
business categorization, for example, 57340 for Electronics.
Up to 10 characters are allowed in this field.

SIC Code

The territories to which the account has been assigned. See
"What is Territory Management?" in the Salesforce online
help.

Territories

Listing of company’s exchange and stock symbol, for example,
NASDAQ: ACME. Up to 20 characters are allowed in this
field.

Ticker Symbol

Person's position within his or her organization. Up to 80
characters are allowed in this field. (Contact field)

Title

Type of account, for example, Customer, Competitor, or
Partner. Entry is selected from a picklist of available values,

Type

which are set by an administrator. Each picklist value can have
up to 40 characters.

Listing of custom links for accounts as set up by your
administrator.

Custom Links

URL of account’s website, for example, www.acme.com. Up
to 255 characters are allowed in this field; only the first 50 are
displayed.

Website

Enhanced Territory Management
With Winter '07, territory management allows sales managers to oversee complex sales organizations more easily and efficiently.
Whether your territories are aligned by region, industry, channel, product line, or other criteria, multilevel territory hierarchies
and automated rule-based account assignment enable accurate visibility, forecasting, and reporting for every layer in your
territory structure.

Implementation Tips

An implementation guide for territory management is available. Please see Deploying Territory Management.

Best Practices

Define territory list views
Account and opportunity list views can be restricted by "My Territories" or "My Territory Teams." "My
Territories" means records associated with territories to which you belong. "My Territory Teams" means
records associated with either territories to which you belong or territories below you in the territory
hierarchy.
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Configure reports with territories

• Territory fields are available in account reports, activity reports that include accounts, opportunity
reports, and user reports.

• Account reports support the following new options:

• The Territories filter can be set to "All," "Multiple Territories," or "Missing Territory."
• In the View filter, "My territory team's accounts" shows accounts that belong to your territories

and your territories' descendants.

• Opportunity reports support the following new options:

• The Territories filter can be set to "All" or "Missing Territory."
• The Hierarchy filter can be set to "Role" or "Territory."
• In the Relationship to Opportunity filter, "My team's opportunities" shows your

opportunities and opportunities owned by all of your subordinates in the role hierarchy. If your
organization uses territory management, the effect of this option depends on the value of the
Hierarchy filter. If you select "Role," you see your opportunities and opportunities owned by all
of your subordinates in the role hierarchy. If you select "Territory," you see opportunities that are
associated with your territories and your territories' descendants.

About Territory Management

What is Territory Management?

Territory management is an account sharing system that grants access to accounts based on the characteristics of the accounts.
It enables your company to structure your Salesforce data and users the same way you structure your sales territories. Particularly
if your organization has a private sharing model, you may need to grant users access to accounts based on criteria such as zip
code, industry, revenue, or a custom field that is relevant to your business. You may also need to generate forecasts for these
diverse categories of accounts.Territory management solves these business needs and provides a powerful solution for structuring
your users, accounts, and their associated opportunities and cases.

Note:  Account ownership and its effect on record sharing remains valid and unchanged when territory management
is in use.

Key benefits of territory management include:

• The ability to use account criteria to expand a private sharing model.
• Support for complex and frequently changed sales organization structures.
• Support for transferring users between territories, with the option to retain opportunities.
• Multiple forecasts per user, based on territory membership.
• Territory-based sales reports.

Note: Territory management only affects accounts and the standard objects that have a master-detail relationship to
accounts. For example, opportunities are included in territory management but leads and activities are not.

What is a Territory?

A territory is a flexible collection of accounts and users where the users have at least read access to the accounts, regardless of
who owns the account. By configuring territory settings, users in a territory can be granted read, read/write, or owner-like
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access (that is, the ability to view, edit, transfer, and delete records) to the accounts in that territory. Both accounts and users
can exist in multiple territories. You can manually add accounts to territories, or you can define account assignment rules that
assign accounts to territories for you.

Not only can you control access to accounts for users in each territory, you can also control users' access to the opportunities
and cases associated with the accounts in the territory, regardless of who owns the records. For more information, see "Territory
Fields" in the Salesforce online help.

What is a Territory Hierarchy?

Territories exist in a hierarchy which you can set up with as many nested levels as you wish. For example, you could create a
top-level territory named "Worldwide Sales" that has the child territories "North America," "Europe/Middle East," "Latin
America," "Africa," and "Asia/Australia." "North America" might have the child territories "Canada" and "United States."
"United States" might have the child territories "Western," "Central," "Southern", and "Eastern." Finally, "Western" might
have the child territories "California," "Oregon," "Washington," "Nevada," "Arizona," and "Utah." To see a graphic of an
example territory hierarchy, click here.

Note that territory hierarchies do not have to be focused on geography; they can be defined however you like. For more
information, see "Building Your Territory Hierarchy" in the Salesforce online help.

How Do Territories Affect Forecasting?

When you enable territory management for your organization, your forecast data is derived from the opportunities that are
associated with the accounts in your territories. Users will have a different forecast for each territory to which they are assigned.
For example, if you are assigned to both "California" and "Arizona," you will have one forecast for the opportunities you have
in "California," and another forecast for the opportunities you have in "Arizona." See "Viewing Customizable Forecasts" in
the Salesforce online help.

Enabling Territory Management

User Permissions Needed

"Manage Territories"To enable territory management:

Territory management is not enabled by default in Salesforce. To request territory management for your organization, contact
salesforce.com.

You must meet the following prerequisites before enabling territory management:

• Your organization must be using customizable forecasting in order to enable territory management. If you do not know
whether you have customizable forecasting, see "Do I Have Customizable Forecasting?" in the Salesforce online help.

• Follow the steps in the Deploying Territory Management Guide to prepare your organization for territory management.

After you have completed the prerequisites, you will be ready to turn on territory management for your organization:

1. In Salesforce, go to Setup ➤ Manage Territories ➤ Settings.
2. Optionally, change the organization-wide territory management settings that are configurable from the Territory Settings

page. See. "Configuring Territory Management Settings" in the Salesforce online help.
3. There are two different options for enabling territory management, which depend on your preference to retain or purge

preexisting forecast data. Click either Enable Territory Management or Enable Territory Management from Scratch.
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What the Enable Territory Management Button Does
When you click this button, your organization's current forecast hierarchy and forecast data are
automatically copied to the territory hierarchy as follows:

• The name of your organization is set as the top of the territory hierarchy.
• For each role in the forecast hierarchy, a corresponding territory is created in the new territory

hierarchy.
• Active Salesforce users are added to territories based on their roles.
• Opportunities are assigned to the opportunity owner's territory.
• Accounts are not assigned anywhere in the territory hierarchy.
• Until you add or edit territories, your forecasts will work the same as they did before you enabled

territory management.

What the Enable Territory Management from Scratch Button Does
When you click this button, the following occurs:

• All preexisting forecast data is deleted.
• An empty territory hierarchy is created.

This button is only recommended when you are setting up a brand new organization in Salesforce
that does not have an existing forecast hierarchy.

Caution: Irreversible data loss can result from clicking Enable Territory Management from
Scratch.

4. Configure territory-related fields, page layouts, and user permissions:

• Click Setup ➤ Customize ➤ Accounts:

• Click Fields to set the field-level security of the Territories and Exclude from territory assignment
rules fields.

• Click Page Layouts to add those fields to account page layouts. Also, for each account page layout, you can set
whether users can choose to run account assignment rules when they save accounts, and whether account assignment
rules should run by default whenever accounts are saved.

• Click Setup ➤ Customize ➤ Opportunities:

• Click Fields to set the field-level security of the Territory field.
• Click Page Layouts to add the field to opportunity page layouts.

• Click Setup ➤ Manage Users ➤ Profiles to grant the "Manage Territories" permission to users who will be
administrators of the territory hierarchy. Profiles that had the "Customize Application" permission before you enabled
territory management are automatically given the "Manage Territories" permission.

5. To begin working with your new territory hierarchy, click Setup ➤ Manage Territories ➤ Hierarchy. See "Building Your
Territory Hierarchy" in the Salesforce online help.

Managing Territories

User Permissions Needed

"Manage Territories"

OR

To manage territories:
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User Permissions Needed

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working below
your position in the territory hierarchy.

Managing your organization's territories involves the following tasks:

• Organize territories into hierarchies that represent your organization's forecasting requirements and how users work in
your organization. See "Building Your Territory Hierarchy" in the Salesforce online help.

• Configure organization-wide settings for territory management. See "Configuring Territory Management Settings" in the
Salesforce online help.

• Create new territories and edit existing territories. See "Creating Territories" in the Salesforce online help and "Displaying
and Editing Territories" in the Salesforce online help.

• Assign users to territories. See "Managing Users in Territories" in the Salesforce online help.
• Define account assignment rules that evaluate accounts and assign them to territories. See "Managing Account Assignment

Rules" in the Salesforce online help.
• Select accounts from lists and manually assign them to territories. See "Manually Assigning Accounts to Territories" in

the Salesforce online help.

Building Your Territory Hierarchy

User Permissions Needed

"View Setup and Configuration"To view territories:

"Manage Territories"

OR

To edit territories:

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working below
your position in the territory hierarchy.

Note:  If you clicked the Enable Territory Management button to enable territory management, your existing forecast
hierarchy was used as the basis of the territory hierarchy. For more information, see "Enabling Territory Management"
in the Salesforce online help.

To work with your organization's territory hierarchy, click Setup ➤ Manage Territories ➤ Hierarchy. The following terms
are used when referring to territories in the hierarchy:

Parent Territory
A territory that is located immediately above another territory in the hierarchy. A territory has exactly
one parent territory in the hierarchy, except for the top-level territory which does not have a parent.

Child Territory
A territory that is immediately below another territory in the hierarchy. A parent territory can have an
unlimited number of child territories.

Sibling Territory
Child territories that share the same parent territory.

Choose an option from the drop-down list to change how the territory hierarchy is displayed:
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• Show in tree view - See a visual representation of the parent-child relationships between your territories. Click Expand
All  to see all territories, or click Collapse All to see only top-level territories. To expand an individual node, click the plus
(+) icon. To collapse an individual node, click the minus (-) icon.

• Show in sorted list view - See a territory list that you can sort alphabetically by territory name, parent territory (Reports
to), or description.

• Show in list view - See a list of territories and their children, grouped alphabetically by the name of the top-level territory.
The columns are not sortable.

Each view provides links so you can create, edit, or delete territories. For more information, see:

• "Creating Territories" in the Salesforce online help
• "Displaying and Editing Territories" in the Salesforce online help
• "Deleting Territories" in the Salesforce online help

Configuring Territory Management Settings

User Permissions Needed

"Manage Territories"To configure territory settings:

You can set default account, opportunity, and case access levels for new territories, as well as whether forecast managers can
administer the territories located below them in the territory hierarchy.

1. Go to Setup ➤ Manage Territories ➤ Settings.
2. Choose default access levels for accounts, opportunities, and cases.These are the access levels that will be selected by default

when a new territory is created. See "Territory Fields" in the Salesforce online help for descriptions of these fields.

Note: These settings are not retroactive and do not affect territories that already exist.

When creating or editing an individual territory, you can override these default access levels. See "Creating
Territories" in the Salesforce online help.

3. Optionally, check Forecast managers can manage territories. When this box is checked, forecast managers
can administer subordinate territories: they can manage users, manually add accounts, and manage account assignment
rules for territories that are below their immediate territory, . Also, they can add child territories to both their immediate
territory and lower territories. To learn more about forecast managers, see "Assigning Forecast Managers in Your Forecast
Hierarchy" in the Salesforce online help.

Creating Territories

User Permissions Needed

"Manage Territories"

OR

To create territories:

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working below
your position in the territory hierarchy.

You can create up to 500 territories for your organization. To create a new territory:

34

   
Salesforce CRM Enhanced Territory Management



1. Click Setup ➤ Manage Territories ➤ Hierarchy ➤ Add Territory. You can also click Add Territory from the Child
Territories related list of a territory detail page.

2. Define the new territory by entering or changing fields. See "Territory Fields" in the Salesforce online help for a description
of each field.

There are two required standard fields for territories: Territory Name  and Parent Territory. Territories can also
have custom fields. For more information, see "Creating Custom Territory Fields" in the Salesforce online help.

3. Click Save to finish or Save & New to create more territories.

Displaying and Editing Territories

User Permissions Needed

"View Setup and Configuration"To view territories:

"Manage Territories"

OR

To edit territories:

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working below
your position in the territory hierarchy.

From the territory detail page, you can view and modify different aspects of the territory, including related territories, assigned
users, and included accounts.

Displaying Territories

1. Click Setup ➤ Manage Territories ➤ Hierarchy.
2. Select the name of the territory you want to view.

Viewing Related Territories

The Hierarchy list at the top of the territory detail page shows how this territory is related to the top-level territory in the
territory hierarchy. To see the names of other territories who share the same parent territory as this one, refer to the Siblings
list immediately below. In either list, you can click a territory name to view that territory.The territory detail page also includes
a Child Territories related list; see "Working with Territory Related Lists" in the Salesforce online help.

Editing Territories

To update an existing territory, click Edit, and then change the fields you want to modify. For more information, see "Territory
Fields" in the Salesforce online help and "Creating Custom Territory Fields" in the Salesforce online help.

If an edit to a territory affects a very large amount of data, you will be sent a confirmation email when the operation has
completed.

Cloning Territories

Click Clone to create a new territory with the same standard and custom field values as the current territory. The cloned
territory will have the same parent territory as the original territory. However, assigned users, account assignment rules, and
manually assigned accounts are not cloned.
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Viewing Accounts Assigned to a Territory

Click View Accounts to see a list of the accounts that have been assigned to this territory and territories below it in the territory
hierarchy. The list includes both manually assigned accounts and accounts that were assigned via rules.

Working with Territory Related Lists

Each territory detail page has the following related lists:

• Assigned Users - Lists the users in the territory. See "Managing Users in Territories" in the Salesforce online help.
• Inherited Account Assignment Rules - Lists the account assignment rules for this territory that are defined in a parent

territory. See "Managing Account Assignment Rules" in the Salesforce online help.
• Account Assignment Rules Defined in This Territory - Lists the account assignment rules for this territory. See "Managing

Account Assignment Rules" in the Salesforce online help.
• Manually Assigned Accounts - Lists the accounts that have been manually added to this territory. See "Manually Assigning

Accounts to Territories" in the Salesforce online help.
• Child Territories - Lists the territories located immediately below this territory in the territory hierarchy. Click Add

Territory to create a new child territory for this territory. Click a child territory name to view that territory's detail page.

Note: If enabled by your administrator, related list hover links display at the top of each detail page. Mouse-over a
related list hover link to display the corresponding related list in an interactive overlay that allows you to quickly view
and manage the related list items. You can also click a related list hover link to jump down to the content of the related
list without having to scroll down the page.

Managing Users in Territories

User Permissions Needed

"Manage Territories"

AND

To assign users to territories:

"Manage Users"

A territory can have an unlimited number of users, and a user can be assigned to an unlimited number of territories.

In the context of a specific territory, users have both an Active status and an Active in Territory status:

Active
An active user is able to log in to Salesforce.
Deactivated users, such as employees who are no longer with your company, are disabled from logging
in to Salesforce.  Deactivated users continue to own opportunities and appear in forecasts and territories.
When users are deactivated, their opportunity forecast overrides, adjusted total overrides, and manager's
choice overrides on subordinates' forecasts are frozen. However, the manager of a deactivated user can
apply manager's choice overrides to that user's forecasts. Rollup amounts will be kept current. If a
deactivated user is later reactivated, the user can resume normal work as before.
A user's active status is set by modifying his or her personal information at Setup ➤ Manage Users ➤
Users.

Active in Territory
Users with Active in Territory checked on the territory detail page have open opportunities, closed
opportunities, or no opportunities at all in that territory. Users with Active in Territory deselected
have been transferred out of or removed from the territory, but retain ownership of opportunities in the
old territory.
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To view the territories to which you belong, view the Territories related list on your personal information page accessible via
Setup ➤ My Personal Information ➤ Personal Information. Administrators can view this related list for any user via Setup
➤ Manage Users ➤ Users.

Adding Users to Territories

To add users to a territory:

1. From a territory detail page, click Add Users.
2. Choose a view from the drop-down list, or click Create New View to build a new custom view. See "Creating Custom

List Views" in the Salesforce online help.
3. Select and deselect checkboxes in the Action column to move users between the Available and Selected areas. Also, you

can:

• Click a letter to view users who correspond to that letter.
• Click All to display all users who match the criteria of the current view.
• Click select shown to move all users that are shown on the current list page to the Selected area below.
• Click deselect shown or deselect all to move users from the Selected area to the Available area.

Note:  Users already assigned to the territory will not appear in the Available users list even if they meet the list
view criteria.

4. When the Selected area includes all users that you want to assign to the territory, click Assign.

Removing Users from Territories

You can remove a user from a territory and choose who will receive his or her open opportunities:

1. In the Assigned Users related list on the territory detail page, click Remove next to the user's name.
2. Click the New Owner lookup icon ( ) to select a recipient for any open opportunities the user may have.
3. Alternatively, leave the New Owner field blank. One of the following results will occur:

• If the parent territory has a forecast manager, then that forecast manager takes ownership of the user's open opportunities.
Also, the forecast manager is assigned to the territory with Active in Territory unchecked.

• If the parent territory does not have a forecast manager, then the user remains in the territory with Active in
Territory unchecked.

4. Click Save.

If very large amounts of data are affected, you will be sent a confirmation email when the operation has completed.

Transferring Users Between Territories

The user transfer wizard allows you to move a user from one territory to another, choose which open opportunities the user
will continue to own, and designate a recipient for open opportunities the user leaves behind.

To transfer a user to another territory:

1. In the Assigned Users related list on the territory detail page, click Transfer next to the user's name.
2. Click Select next to the territory to which you are transferring the user. If necessary, expand or collapse nodes in the

territory hierarchy to display the desired destination territory.
3. Click the New Owner lookup icon ( ) to select the user who will take ownership of the open opportunities that the

transferred user does not keep. Click Next to proceed.
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If you skip this step and choose not to select a recipient, the forecast manager of the parent territory of the user's former
territory automatically receives the open opportunities that the user does not keep. If there is no forecast manager in the
parent territory of the user's former territory, then the user being moved retains ownership of his or her opportunities.

4. Choose a list view of the user's open opportunities.
5. Click Select and Deselect to move opportunities between the Available and Selected areas. Also, you can:

• Click a letter to view opportunities that correspond to that letter.
• Click All to display all opportunities that match the criteria of the current view.
• Click select shown to move all opportunities that are shown on the current list page to the Selected area below.
• Click deselect shown or deselect all to move opportunities from the Selected area to the Available area.

6. When the Selected area shows the opportunities that you want the user to retain after the transfer, click Transfer.

If very large amounts of data are affected, you will be sent a confirmation email when the operation has completed.

Note:

If you transfer the forecast manager out of a territory, that territory will no longer have a forecast and any opportunity
overrides for that territory that were created by forecast managers above it in the territory hierarchy will be deleted.
See "Overriding Customizable Forecasts" in the Salesforce online help.

Managing Account Assignment Rules

User Permissions Needed

"Manage Territories"

OR

To manage account assignment rules:

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working below
your position in the territory hierarchy.

About Account Assignment Rules

You can create account assignment rules that automatically move accounts into territories based on any standard or custom
account field, such as zip code, state, industry, revenue, or number of employees. Each rule consists of multiple rows of criteria
that specify exactly how the accounts are assigned.

Account assignment rules are governed by the following:

• A territory can have inherited account assignment rules, meaning that the rules were created somewhere higher in the
territory hierarchy and consequently also impact the given territory.

• A territory can have locally defined account assignment rules, meaning that the rule was created at the given territory.
• If a territory does not have any inherited or locally-defined account assignment rules, then it will only contain accounts

that were manually added. See "Manually Assigning Accounts to Territories" in the Salesforce online help.
• If an account matches both inherited and locally-defined account assignment rules for a territory, then the account will be

assigned to the territory and also evaluated for its child territories.
• If an account matches a territory's inherited account assignment rules but not the territory's locally-defined rules, then the

account will not be assigned to the territory, but will be evaluated for its child territories.
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Working with Account Assignment Rules

Click Run Rules on the territory detail page to evaluate the active inherited and locally-defined rules shown on the page
against all existing accounts in your organization. When you click Run Rules, an icon displays next to the button to indicate
that rules are being processed. The icon also displays for all subordinate territories. An email confirmation is sent when
processing is complete.

Note: To protect data quality, you are not allowed to modify a territory while the processing icon ( ) displays.

Click Manage Rules on the territory detail page to access the Manage Account Assignment Rules page, where you can create,
edit, preview, and run account assignment rules:

• Click New to create a new rule, or Edit to edit an existing rule. See "Creating and Editing Account Assignment Rules"
in the Salesforce online help.

• Use the Active checkbox to set a locally-defined rule as active or inactive.

Active account assignment rules automatically evaluate accounts and assign them to territories when:

• An account is created using the Salesforce user interface, the Apex API, or a client such as Offline Edition.
• An account is imported using an import wizard.
• An account is created by the conversion of a lead.
• An account is edited and saved in the Salesforce user interface, provided the Run territory management rules

on save checkbox on the account is visible and selected.
• An account is edited and saved via the Apex API.
• Run Rules is clicked on a territory detail page, provided the Exclude from territory assignment rules

checkbox on the account is deselected.
• Save & Run Rules is clicked on the manage account assignment rules page for a territory, provided the Exclude

from territory assignment rules checkbox on the account is deselected.
• Duplicate accounts are merged; see "Merging Duplicate Accounts" in the Salesforce online help.

• Click a rule name to see the details of that rule, including its active status and criteria. From a rule detail page you can edit,
delete, or clone a rule.

• Click Preview to see the accounts that would be assigned to this territory and its child territories if the rules currently
marked active were run. See "Previewing Account Assignments" in the Salesforce online help.

• Click Save to save the current active status of locally-defined rules.
• Click Save & Run Rules to save the current active status of locally-defined rules and evaluate the inherited and

locally-defined rules shown on the page against all existing accounts in your organization.

Note:  Running account assignment rules affects accounts in the Recycle Bin.

Manually Assigning Accounts to Territories

User Permissions Needed

"Manage Territories" and "Edit" on accounts

OR

To manually add accounts to territories:

You are a forecast manager, Forecast managers can
manage territories is selected, you are working below
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User Permissions Needed

your position in the territory hierarchy, and you have "Edit"
on accounts.

As an alternative to creating and running account assignment rules, you can add accounts to territories manually:

1. On the territory detail page, click Add Accounts on the Manually Assigned Accounts related list.
2. Choose a view from the drop-down list, or click Create New View to build a new custom view. See "Creating Custom

List Views" in the Salesforce online help.
3. Click Select and Deselect to move accounts between the Available and Selected areas. Also, you can:

• Click a letter to view accounts that correspond to that letter.
• Click All to display all accounts that match the criteria of the current view.
• Click select shown to move all accounts that are shown on the current list page to the Selected area below.
• Click deselect shown or deselect all to move accounts from the Selected area to the Available area.

4. When the accounts in the Selected area includes all accounts that you want to manually add to the territory, click Assign.

Note:  Manually adding accounts and running account assignment rules are completely independent. A manually
added account remains in a territory until it is manually removed. There is nothing to prevent assignment rules also
adding the account to the territory.

Territory Management FAQ

What kinds of records have territories?

Accounts, opportunities, and users have territory fields. Accounts and users can be associated with multiple territories. An
opportunity can be associated with only one territory.

Are the territory hierarchy and the role hierarchy different?

Yes. The territory hierarchy and the role hierarchy are independent. See the following comparison:

Role HierarchyTerritory Hierarchy

Is available by defaultIs available by contacting salesforce.com

Has no impact on forecasting when territory management is
enabled

Determines forecasts

Supports assigning a user to only one roleSupports assigning a user to multiple territories

Affects all other reportsAffects account and opportunity reports

Grants access to records based on ownership. Users receive
whatever access is most permissive across both hierarchies.

Grants access to records regardless of ownership. Users receive
whatever access is most permissive across both hierarchies.
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How do manually assigned accounts differ from those assigned by account assignment rules?

Manually assigned accounts are not evaluated when account assignment rules are run. After they have been manually assigned
to a territory, they remain there until they are manually removed from the territory. For more information, see "Manually
Assigning Accounts to Territories" in the Salesforce online help.

When do account assignment rules evaluate accounts?

Active account assignment rules automatically evaluate accounts and assign them to territories when:

• An account is created using the Salesforce user interface, the Apex API, or a client such as Offline Edition.
• An account is imported using an import wizard.
• An account is created by the conversion of a lead.
• An account is edited and saved in the Salesforce user interface, provided the Run territory management rules on

save checkbox on the account is visible and selected.
• An account is edited and saved via the Apex API.
• Run Rules is clicked on a territory detail page, provided the Exclude from territory assignment rules checkbox

on the account is deselected.
• Save & Run Rules is clicked on the manage account assignment rules page for a territory, provided the Exclude from

territory assignment rules checkbox on the account is deselected.
• Duplicate accounts are merged; see "Merging Duplicate Accounts" in the Salesforce online help.

How are opportunities assigned to territories?

Opportunities are automatically assigned to territories based on the following actions:

• Creating a new opportunity

Opportunities that you create are automatically assigned a territory when you meet both of the following conditions:

• You belong to or have edit privileges on the same territory as the account on the opportunity.
• You have no other territories in common with that account.

For example, if you are in the territories Berkeley and San Francisco and the account is in the territories Portland, San
Francisco, and Seattle, the opportunity will be assigned to the San Francisco territory.

• Running account assignment rules

When account assignment rules are run, opportunities are automatically assigned to the same territory as the account when:

• An opportunity does not have a territory and its account is added to a territory.
• An account moves from one territory to another. However, if an account assignment rule prohibits opportunities from

moving outside a given part of the territory hierarchy, the opportunities do not move and no longer belong to any
territories.

Opportunities are not automatically assigned to the same territory as the account when:

• An account is removed from a territory and not reassigned to a new territory in the same operation. The account's
opportunities from the original territory no longer belong to any territories.

• An account is reassigned to multiple territories in one operation.The account's opportunities from the original territory
no longer belong to any territories, unless the Confine Opportunity Assignment checkbox is checked. For more
information, see "How does opportunity confinement work?" in the Salesforce online help.

Note:  If the opportunity owner is not part of the new territory, he or she is added as an inactive member of the
territory.

41

   
Salesforce CRM Enhanced Territory Management



The following actions do not change an opportunity's territory:

• Manually assigning the opportunity's account to a territory
• Changing which account is associated with the opportunity
• Changing the account's territory as a result of account assignment rules if the opportunity and its account are in different

territories
• Transferring the opportunity to a new owner. For additional consequences of this, see "Must I be assigned to the same

territories as the opportunities I own?" in the Salesforce online help.

Must I be assigned to the same territories as the opportunities I own?

When an open opportunity is assigned to you and you do not belong to that opportunity's territory, you are assigned to the
territory with Active in Territory unchecked in the Assigned Users related list of the territory. For more information,
see "Managing Users in Territories" in the Salesforce online help.

Are opportunities transferred to different users when account assignment rules are run?

When account assignment rules cause an opportunity to be reassigned to a territory to which you already belong, you
automatically become the owner of that opportunity when you meet any of the following criteria:

• You are the only member of the territory.
• You are the only forecast manager in the territory.
• You are the only territory member enabled for forecasting.

If none of these criteria are met, the original opportunity owner is added to the territory as an inactive member.

How does opportunity confinement work?

If the Confine Opportunity Assignment checkbox is selected for a territory, the territory's opportunities remain in the
territory or its child territories when you run account assignment rules. The following exceptions apply:

• If an opportunity's account moves to only one of the territory's children, then the opportunity follows the account and is
reassigned to the account's new territory. This includes when an account moves to multiple territories and only one of the
new territories is a child of the original territory.

• If an opportunity's account moves to more than one of the territory's children, then the opportunity's territory field is set
to blank.

• If an opportunity's account moves completely out of the territory and its children, then the opportunity's territory field is
set to blank.

What happens when I undelete an account or opportunity that was assigned to a territory?

Undeleting an account or opportunity restores the territory assignment, but does not trigger the evaluation of account assignment
rules. If account assignment rules changed while the record was in the Recycle Bin, the restored record may have territories
that are not consistent with the new rules.

Analytic Mash-Ups
Winter '07 delivers exciting new capabilities for your Salesforce reports and dashboards. Now you can integrate third-party
systems into dashboards, allow users to move from one dashboard to a location other than the dashboard's source report, and
grant users read-only access to reports.
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About Analytic Mash-Ups

You can now insert any application component within a Salesforce dashboard to deliver specific data visualizations in a single
view. With Winter '07, anything that can be displayed in a custom s-control—HTML, Flash, Java, and content from other
websites—can be displayed as a visually stunning dashboard component on the Dashboards tab. Potential uses for analytic
mash-ups include integrating the following into Salesforce dashboards:

• Web analytics from Omniture and WebTrends
• Profitability analysis from Business Objects
• Supply chain analysis from Crystal Reports
• Complex visualizations of Salesforce data using Crystal Xcelsius

Implementation Tips

• You cannot create analytic mash-ups that access other dashboard components. However, analytic mash-ups using Flash
can share data via Flash variables.

• Always add <NOSCRIPT> to custom s-controls where JavaScript is used to generate content for dashboards. This allows
users to view dashboards from clients that do not support JavaScript.

Best Practices

• Build custom s-controls so that users can add them to dashboard components.
• Make sure users tasked with building custom s-controls on dashboards have the "Customize Application" permission to

create s-controls and the "Manage Dashboards" permission to add s-controls to dashboard components.
• Preview mash-ups on dashboard components before they are added to the Dashboards tab to make sure they are useful to

users.

Creating Analytic Mash-Ups

To create an analytic mash-up:

1. Create or edit a custom s-control that would be suitable as a dashboard component. For more information on creating or
editing custom s-controls, see "Defining Custom S-Controls." in the Salesforce online help

2. Create or edit a dashboard. To edit a dashboard, view the dashboard and click Edit. To create a dashboard, see "Creating
and Editing Dashboard Properties" in the Salesforce online help.

3. Click the Add Component link at the top of any column to add a component to that column.
4. Choose Custom S-Control as the Component Type.
5. Select the predefined custom s-control and set its display height.
6. Click Save.

Drill Through to URLs

You can now embed any URL in a dashboard. This allows dashboard creators to select whether users drill down to the
dashboard component's source report or to another dashboard, report, record detail page, or another system that uses a Web
interface.This can be particularly useful for presenting a high-level overview on a dashboard, and then linking to more detailed
information stored elsewhere.

Implementation Tips

• Adding URLs to other systems works well if your organization includes Single Sign-On (SSO) integration. For more
information on SSO integration, see the Salesforce online help.

• Embedding a URL on a dashboard component only works for chart type dashboard components.
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Best Practices

• Validate URLs before adding them to dashboards.
• Do not use merge fields in a drill through URL because merge fields are not supported with this feature.

Adding a Drill Through URL

To add a drill through URL to a dashboard component:

1. Create or edit a dashboard. To edit a dashboard, view the dashboard and click Edit. To create a dashboard, see "Creating
and Editing Dashboard Properties" in the Salesforce online help.

2. Click the Add Component link at the top of any column to add a component to that column.
3. If you have chosen a chart type for the component, select Other URL from the Drill Down to: drop-down list and

enter the URL in the Drill Down URL field.
4. Click Save.

Read-Only Reports User

With Winter '07 you can modify custom profiles to allow users to see reports that are only set up for them by administrators.
This allows administrators to restrict specific users from customizing reports or reporting on certain types of data. Report
designers can use filter criteria to choose the data read-only reports users see, and they can specify whether dates automatically
adjust so that reports are always current and maintenance free.

Implementation Tips

• Deselect the “Create and Customize Reports” permission on the profile of users who should only have read-only access to
reports.

• Create a new report folder in which to save reports for users who can only read reports. The reports in this folder should
have the most common role hierarchy drill down criteria set.

• Prepare to create a variety of reports to cover unforeseen reporting needs for read-only report users.

Best Practices

• Clone the existing profiles of users who should only have read-only access to reports, and then deselect the "Create and
Customize Reports" permission from the new profiles.

• Assign profiles with the deselected "Create and Customize Reports" permission to users who have no business need to
create reports.

Modifying Profiles for Read-Only Report Users

To modify a custom profile so that its users have read-only access to reports:

1. Click Setup ➤ Manage Users ➤ Profiles and select the name of the profile.
2. Click Edit.
3. Deselect the "Create and Customize Reports" permission.
4. Verify that the "Run Reports" permission is selected.
5. Click Save.
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Desktop Solution Administration
Are you running the most recent version of your favorite Salesforce client? In Winter '07, Salesforce answers that question for
you—when you log in, an alert displays on the Home tab when an update is available. In addition, a new page in the Personal
Setup area lists available clients and their version numbers.

Furthermore, administrators can now set access policies per profile to control which clients are available and how they can be
upgraded.

Implementation Tips

The ability to customize client access settings per profile is available in Enterprise and Unlimited Editions for Office Edition,
Offline Edition, Outlook Edition, and Lotus Notes Edition. It is also available in Developer Edition for Offline Edition only.
For each profile, the default client access setting is "On, updates w/o alerts." Edit your organization's profiles to customize
their client access settings.

Best Practices

For best results, use Microsoft Internet Explorer with ActiveX controls enabled. To see your ActiveX settings, open Internet
Explorer and go to Tools ➤ Internet Options... ➤ Security ➤ Custom Level... ➤ ActiveX controls and plug-ins.

About Desktop Solution Administration

Viewing Client Update Alerts

User Permissions Needed

"On, updates w/alerts"

OR

To view client update alerts:

"On, must update w/alerts"

on your profile

Under the following conditions, an alert banner automatically appears across the Home tab when new versions of clients such
as Outlook Edition and Offline Edition are available:

• Your administrator has given you access to see the Home tab alerts. See "Setting User Permissions for Desktop Clients"
in the Salesforce online help.

• In the past, you have successfully logged in from the client with your Salesforce username and password.

Click the alert banner to proceed to the Check for Updates page. Note that you can navigate to the Check for Updates page
at any time to see which client versions are installed on your computer.

Note: Offline Edition is the only client available with Developer Edition.
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Checking for Desktop Client Updates

Desktop clients such as Outlook Edition and Offline Edition integrate Salesforce with your PC. Follow these steps to see
which desktop client versions are installed on your computer and download available updates:

Note: We recommend that you use the Internet Explorer web browser with ActiveX controls enabled. If prompted,
accept the ActiveX control published by salesforce.com.This allows a registry scan that determines which client versions
are installed. With other browsers, update recommendations are based on a user’s login history—which is less precise.

1. Navigate to Setup ➤ Desktop Integration ➤ Check for Updates.
2. From the table, review the names and version numbers of available desktop clients.
3. If you are using Internet Explorer with ActiveX controls enabled, click Install Now to install a client.
4. If you are using another browser such as Mozilla Firefox, click Download Now to save the installer file to your computer.

Then double-click the saved file to run the installer program.

Your administrator controls which desktop clients you are allowed to install. See "Setting User Permissions for Desktop
Clients" in the Salesforce online help. Note that Offline Edition is the only client available with Developer Edition.

Setting User Permissions for Desktop Clients

User Permissions Needed

"Manage Users"To set user permissions for desktop clients:

Outlook Edition, Offline Edition, Office Edition, and Lotus Notes Edition are desktop clients that integrate Salesforce with
your PC. As an administrator, you can control which desktop clients your users can access as well as whether users are
automatically notified when updates are available.

In Enterprise, Unlimited, and Developer Editions, use the following procedure to set your users' desktop client permissions.
Note that Offline Edition is the only client available with Developer Edition. In Personal, Team, and Professional Editions,
all users have the system default "On, updates w/o alerts" for all clients.

1. In Salesforce, navigate to Setup ➤ Manage Users ➤ Profiles.
2. Click Edit next to a profile name.
3. Go to the Desktop Integration Clients section at the bottom of the page.
4. For each desktop client, choose one of the following options:

MeaningOption

The respective client download page at Setup ➤ Desktop
Integration is hidden. Also, users cannot log in from the
client.

Off (access denied)

The respective client download page at Setup ➤ Desktop
Integration is hidden. Users can log in from the client but
are not allowed to upgrade it from their current version.

On, no updates

Users can download, log in from, and upgrade the client,
but do not see alerts when a new version is made available.

On, updates w/o alerts

Users can download, log in from, and upgrade the client.
They will see update alerts, which they can choose to follow
or ignore.

On, updates w/alerts
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MeaningOption

Users can download, log in from, and upgrade the client.
When a new version is available, they will see an update

On, must update w/alerts

alert. They will not be able to log in from the client until
they have upgraded it.

Note:  If users in your organization have an Outlook Edition version earlier than 2.0 (such as version 115), and
their profile setting is "Off (access denied)" or "On, must update w/alerts," the error Invalid Salesforce API
request may occur when they attempt to log in to Outlook Edition. Users with Outlook Edition 2.0 or later will
see an appropriate descriptive message.

5. Click Save.

If a user is allowed to see alerts, under the condition that he or she has logged in to Salesforce from the client in the past, an
alert banner will automatically appear across the Home tab when a new version is available. Clicking the banner opens the
Check for Updates page, where users can download and run installer files. Note that the Check for Updates page is always
available from the Desktop Integration menu in setup, regardless of whether an alert has occurred.

Note: We recommend that you use the Internet Explorer web browser with ActiveX controls enabled. If prompted,
accept the ActiveX control published by salesforce.com.This allows a registry scan that determines which client versions
are installed. With other browsers, update recommendations are based on a user’s login history—which is less precise.

Lotus Notes Edition
Lotus Notes Edition is a powerful new desktop client that integrates Salesforce with Lotus Notes, allowing you to easily create
and update Salesforce records from your familiar Lotus Notes interface.

Implementation Tips

• For information on how IT departments can centrally roll out Lotus Notes Edition to an existing user base, see Deploying
Lotus Notes Edition System-Wide on page 49 below.

• To view solutions for common installation issues, search for the keyword "lotus" in the Help & Training window.

Best Practices

• Consider disabling context-sensitive menu commands to improve system performance. This reduces the number of
round-trips to the server. See Setting Lotus Notes Edition Options on page 57 below.

• Control how users can access and upgrade Lotus Notes Edition by customizing their profiles. See "Setting User Permissions
for Desktop Clients" in the Salesforce online help below.

About Lotus Notes Edition

What is Lotus Notes Edition?

Lotus Notes Edition is a plug-in for IBM® Lotus Notes® that allows you to conveniently interact with Salesforce from your
Lotus Notes user interface. Lotus Notes Edition adds new commands to the Actions and right-click menus in your Lotus
Notes user interface.

Lotus Notes Edition offers the following features:
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• Synchronize your Lotus Notes contacts, events, and tasks with Salesforce (see "Synchronizing Your Contacts and Activities
with Lotus Notes Edition" in the Salesforce online help).

• Upload Lotus Notes emails and their attachments to Salesforce (see "Adding a New Lotus Notes Outbound Email to
Salesforce" in the Salesforce online help and "Adding a Lotus Notes Sent or Received Email to Salesforce" in the Salesforce
online help).

• Associate Lotus Notes emails with accounts, assets, campaigns, cases, contacts, contracts, leads, and opportunities (see
"Associating Lotus Notes Emails with Salesforce Records" in the Salesforce online help).

• Associate events and tasks in Lotus Notes with accounts, assets, campaigns, cases, contacts, contracts, leads, opportunities,
and custom objects your administrator has set as "deployed" (see "Associating Lotus Notes Events and Tasks with Salesforce
Records" in the Salesforce online help).

• Associate contacts in Lotus Notes with related accounts and contacts (see "Associating Lotus Notes Contacts with Salesforce
Records" in the Salesforce online help).

• Create a case directly from a Lotus Notes email (see "Creating Cases from Lotus Notes Emails" in the Salesforce online
help).

• Quickly create a new Salesforce account, contact, or lead from Lotus Notes (see "Quickly Creating Salesforce Records
from Lotus Notes" in the Salesforce online help).

• From Lotus Notes, open Salesforce records in a browser (see "Opening Salesforce Records from Lotus Notes" in the
Salesforce online help).

Note:  If your administrator has renamed any Salesforce standard tab names, the tab names you see in Lotus Notes
Edition will be different from those mentioned in these help topics.

Person accounts are not supported in Lotus Notes Edition. For more information, see "What is a Person Account?"
in the Salesforce online help.

Installing Lotus Notes Edition

To download and install Lotus Notes Edition:

1. Back up your Lotus Notes databases. Contact your IT department for its preferred backup procedures.
2. Back up your Salesforce data. We recommend you run reports of your contacts and activities and then export them to

Excel. Alternatively, you can ask your Salesforce administrator to back up your organization’s data using weekly export;
see "Exporting Backup Data" in the Salesforce online help.

3. Within Salesforce, click Setup ➤ Desktop Integration ➤ Lotus Notes Edition.

In Enterprise and Unlimited Editions, your administrator may have prohibited access to the download page. For more
information, see "Setting User Permissions for Desktop Clients" in the Salesforce online help.

Also, if "person accounts" in the Salesforce online help have been enabled for your organization, Lotus Notes Edition will
not be available.

4. Click Install Now.
5. Click Yes when prompted to install Lotus Notes Edition.
6. Follow the prompts in the setup wizard to complete the installation.
7. Start Lotus Notes. A welcome wizard will introduce you to features and options. To change your Lotus Notes Edition

options later, see "Setting Lotus Notes Edition Options" in the Salesforce online help.

Note:  Lotus Notes Edition requires Salesforce to install components that edit the registry on your computer. If your
organization imposes security that prevents you from editing the registry, log in as the administrator of your machine
before installing these components or contact your IT department for assistance.

The Lotus Notes Edition download page also includes a link to download an MSI file so administrators can centrally
deploy Lotus Notes Edition to their organizations. See "Deploying Lotus Notes Edition System-Wide" in the Salesforce
online help for more information.
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Lotus Notes Edition System Requirements

The system requirements for Lotus Notes Edition are:

• Microsoft Windows 2000 or Windows XP Professional
• IBM Lotus Notes 6.0 or 6.5

Caution:  If your organization uses a custom Lotus Notes design template (.ntf ) with modified fields, Lotus Notes
Edition may not function as expected.

Lotus Notes Edition relies on the presence of certain fields in the default Lotus Notes mail template. For example,
the Send and Add command will not work if the following fields are not available:

• EnterSendTo
• EnterCopyTo
• EnterBlindCopyTo

Note:  Lotus Notes Edition is available in all languages supported by Salesforce. However, your Lotus Notes Edition
language is determined by your Windows language setting rather than your Salesforce language.

Deploying Lotus Notes Edition System-Wide

As an administrator, you can centrally deploy Lotus Notes Edition to your users:

1. Back up your users' Lotus Notes databases.
2. Make sure you have a recent backup of your organization’s Salesforce data. If your organization does not already receive

weekly export files, contact salesforce.com to request them.
3. On your computer, exit Lotus Notes.
4. In Salesforce, go to the Lotus Notes Edition download page at Setup ➤ Desktop Integration ➤ Lotus Notes Edition.
5. Save the MSI file to your computer. You will use this file when you roll out Lotus Notes Edition to your users.

The following publicly available resources may be helpful if you need more information about deploying MSI files:

• The Wikipedia encyclopedia entry for Windows Installer.
• The Definitive Guide to Windows Installer Technology for System Administrators, by Darwin Sanoy and Jeremy

Moskowitz. Published by Realtimepublishers.

Please note that the availability and accuracy of these resources cannot be guaranteed by salesforce.com.

6. Install Lotus Notes Edition on your computer.
7. See "Modifying Registry Entries" in the Salesforce online help and "Restricting Data Movement" in the Salesforce online

help to learn how to control what users can and cannot do with Lotus Notes Edition.

Modifying Registry Entries

To customize the default behavior of Lotus Notes Edition for your users, follow this procedure:

1. Open your Lotus Notes Edition dictionary file at C:\Program Files\Lotus\Notes\L_Dictionary.xml (or wherever
Lotus Notes program files exist on your computer). Note that this dictionary file takes precedence over the file with the
same name at C:\Documents and Settings\<user name>\ Application Data\salesforce.com\SM.

2. If necessary, change the OverrideOptions attribute to "true".
3. Using this tip sheet for reference, add entries to the <OverrideOptions> section. For example, to hide the salesforce.com

splash page which ordinarily displays when Lotus Notes starts, add the line <PutRegistry name="DisplaySplash"
type="string" value="false" />.
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The valid options for type are "string" and "dword". A string can have a maximum of 256 characters. A dword can be an
integer no greater than 0x7FFF.

4. Save your modified dictionary file.
5. Optionally, follow the steps in "Restricting Data Movement" in the Salesforce online help to make additional dictionary

file changes.
6. Using a tool such as Microsoft Systems Management Server (SMS), distribute the XML file to your users in the following

directory: C:\Program Files\Lotus\Notes (or wherever Lotus Notes program files exist on their computers).
7. For your users, Lotus Notes Edition will operate according to the options you specified.

Restricting Data Movement

Lotus Notes Edition allows users to synchronize their contacts, events, and tasks between Salesforce and Lotus Notes. As an
administrator, you can enforce data quality by controlling how data can move during synchronizations. Follow these steps:

1. Start a Lotus Notes client where Lotus Notes Edition has been installed.
2. In Lotus Notes, go to Actions ➤ Salesforce Options.
3. In the Contacts, Events, and Tasks tabs, set the following fields as desired:

• Synchronize Data with Salesforce - Select this checkbox to allow users to synchronize that type of record. If
you deselect it, all Lotus Notes Edition features related to synchronization will be hidden from your users.

• Data Movement - Can be Synchronize with Salesforce, Import from Salesforce, Export to
Salesforce, Import with Overwrites, or Export with Overwrites. For descriptions of these options, see
"Contacts, Events, and Tasks Options for Synchronization" in the Salesforce online help.

• Click Advanced ➤ Conflict and choose one of the following radio buttons: Ignore all conflicts, Notify me
when conflicts occur, Salesforce always wins, or Lotus Notes always wins. For descriptions of these
options, see "Advanced Contacts, Events, and Tasks Options for Synchronization" in the Salesforce online help.

4. Click the User Permissions tab. For reference, the Synchronization Settings area summarizes the settings you made in the
previous step.

5. In the User Permissions area, select or deselect the following checkboxes:

• User can modify which objects are synchronized

• User can modify field mappings - For more information, see "Mapping Custom Fields for Lotus Notes Edition
Synchronization" in the Salesforce online help.

• User can modify conflict resolution options - For more information, see "Resolving Data Conflicts
During Lotus Notes Edition Synchronization" in the Salesforce online help.

• User can modify the direction of synchronizations

• User can use quick create - For more information, see "Quickly Creating Salesforce Records from Lotus Notes"
in the Salesforce online help.

6. As needed, enter custom view names in the Custom view names box. For example, you can specify a view for a particular
language, or specify a nonstandard folder or view where you would like Lotus Notes Edition commands to be enabled.
Use semicolons to separate multiple names.

7. As needed, enter custom class names in the Custom template classes box. Use semicolons to separate multiple values.

In Lotus Notes, template class names are displayed in the dialog at File ➤ Database ➤ Properties - see the Inheritance
section on the fourth tab from the left.

8. Optionally, click Restore to revert the settings to their default values.
9. Click the Show File button to open the settings file L_Dictionary.xml. If necessary, change the OverrideOptions

attribute to "true". Save and close the file.
10. If you have not already prohibited user access to program files, do so now. At a minimum, deny write access to C:\Program

Files\salesforce.com.
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11. Using a tool such as Microsoft Systems Management Server (SMS), distribute the XML file to your users in the following
directory: C:\Program Files\Lotus\Notes (or wherever Lotus Notes program files exist on their computers).

12. When they start Lotus Notes Edition, users will only be able to perform the operations that you have enabled and will not
have access to the User Permissions tab.

Tip:  For best results, we recommend the following settings:

Recommended SettingType of Record

Import from SalesforceContacts

Synchronize with SalesforceEvents

Synchronize with SalesforceTasks

Synchronizing Your Contacts and Activities with Lotus Notes Edition

With Lotus Notes Edition, you can synchronize your contacts, events, and tasks between Salesforce and Lotus Notes.

Note:  If you want to synchronize contacts owned by other users, set your sync profile before synchronizing; see "Setting
Your Sync Profile" in the Salesforce online help.

Your administrator may have customized Lotus Notes Edition to disallow certain operations such as synchronizing
contacts or uploading attachments. If your administrator has prohibited a particular operation, all related commands
will be disabled in your user interface.

You currently cannot synchronize activity reminders between Salesforce and Lotus Notes.

1. In Lotus Notes, select one or more contacts or tasks that you want to synchronize with Salesforce. Make sure that a check
mark appears next to each selected item. For events, open the calendar entry.

2. Right-click and choose Mark for Sync to specify that the item will by synchronized. Alternatively, choose Mark for Sync
from the Actions menu.

3. Right-click and choose Sync to start a synchronization operation. Alternatively, choose Sync from the Actions menu.

Your first synchronization may take several minutes, because your data is comparison-checked in order to prevent duplicates.

4. If records will be added to Lotus Notes or Salesforce as a result of the synchronization, you will see a dialog box that
summarizes these changes and asks you to confirm them. If you decide not to accept them, click Cancel.

5. If necessary, you will be prompted to resolve any data conflicts. See "Resolving Data Conflicts During Lotus Notes Edition
Synchronization" in the Salesforce online help.

6. When the synchronization process completes, click OK.

To specify that you no longer want to synchronize an item, select one or more items and click Unmark for Sync in the right-click
or Actions menus.

Tip:  Lotus Notes Edition contains various synchronization options you can customize, including scheduling
synchronization, specifying the synchronization direction, determining how conflicts should be handled by default,
and specifying the field mappings for synchronization. See "Setting Lotus Notes Edition Options" in the Salesforce
online help.
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Resolving Data Conflicts During Lotus Notes Edition Synchronization

During synchronization, the conflict resolution tool allows you to choose which information to save if a record has been
modified at more than one location. For example, if you changed a contact’s phone number in Lotus Notes and then changed
that contact’s address in Salesforce, you will need to identify which values are the most recent and correct.

1. View which records and fields have data conflicts.

In the conflict resolution window, the left side of the window displays a list of the records that have data conflicts. The
right side of the window displays the fields that have conflicting data for the record selected in the left side. Use the
drop-down list in the left pane to choose how you want records displayed, in a tree or list view. Use the drop-down list in
the right pane to switch between a list of all fields or only those that have conflicting data.

2. Choose the record in the left pane that you want to resolve.
3. To specify the information that should be saved, either select the appropriate radio button, Your Values or Salesforce

Values, or click the pencil icon and type directly into the Your Values column.

Note:  Checkbox fields show a check mark or are blank for unchecked.

Some values are read only in the conflict resolution window. For read-only values, you can only select which value
to save; you cannot directly edit the field.

4. Repeat these steps for each record listed in the left pane. When you have selected a value to resolve the conflict, the status
of the record in the left pane displays a green check.

5. Click Submit when you have finished making selections for all records in conflict.

Finding Contacts and Leads in the Lotus Notes Edition Salesforce Address Book

With Lotus Notes Edition, you can use the Salesforce Address Book to find contacts and leads and add them as recipients of
outbound emails.

1. In Lotus Notes, click the mail icon to open your email database.
2. Click New Memo.
3. Choose Salesforce Address Book from either the right-click or Actions menus.
4. In the search box, enter all or part of the Email, First Name, Last Name, Phone, lead Company, custom email or phone

number field, or any other field accessible in sidebar search for contacts and leads. For a complete list, see "Search Fields"
in the Salesforce online help.

For example, enter mi or mike or meyers or mike meyers to find Mike Meyers.

5. Click Search to find the matching contacts and leads.
6. Select names from the search results.
7. Click the To, Cc, or Bcc button to add the names as recipients of the email.
8. Click OK to finish.

Adding a New Lotus Notes Outbound Email to Salesforce

Lotus Notes Edition enables you to send emails from IBM® Lotus Notes® and quickly log them as tasks in Salesforce.

1. In Lotus Notes, click the mail icon to open your email database.
2. Click New Memo.
3. If desired, use the Salesforce Address Book to add contacts and leads as recipients of the email. See "Finding Contacts and

Leads in the Lotus Notes Edition Salesforce Address Book" in the Salesforce online help.
4. Compose your email.
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5. Choose Send and Add from either the right-click or Actions menus. Alternatively, choose Send File and Add to also file
the sent email in a Lotus Notes folder of your choice.

The Add to Salesforce dialog window opens.

6. Associate the email with accounts, assets, campaigns, cases, contacts, contracts, leads, and opportunities. See "Associating
Lotus Notes Emails with Salesforce Records" in the Salesforce online help.

7. To create a new account, contact, or lead from the Add to Salesforce dialog, see "Quickly Creating Salesforce Records
from Lotus Notes" in the Salesforce online help.

8. In the Attachments tab, add email attachments or other files on your computer as attachments on the contact, lead, or
other record you chose earlier.

9. In the Message tab, edit the body of the email as desired. This only affects the task in Salesforce, not the stored email in
Lotus Notes.

10. Click the Add to Salesforce button in the dialog.
11. If you chose Send File and Add, select the Lotus Notes folder where you want to save the sent email.
12. The email is added as a task in the Activity History related list of the associated records. Lotus Notes Edition automatically

sets the Type value of the task to Email.

In the confirmation dialog, click OK to return to your email database.

If enabled, the new task will automatically open in a browser window. Note that the window may open behind the other
windows on your desktop.

Note:  If you have multiple IMAP or POP3 email accounts and you select your non-default email account for sending
and adding new emails to Salesforce, Lotus Notes Edition does not use the non-default account you have selected. It
always uses your default IMAP or POP3 email account when you click the Add to Salesforce button.

Your administrator may have customized Lotus Notes Edition to disallow certain operations such as synchronizing
contacts or uploading attachments. If your administrator has prohibited a particular operation, all related commands
will be disabled in your user interface.

Adding a Lotus Notes Sent or Received Email to Salesforce

You can use Lotus Notes Edition to upload emails that you have sent or received in Lotus Notes as tasks in Salesforce.

1. In your Lotus Notes mail view, select an email by adding a check mark next to it. Alternatively, open the email.
2. Choose Add Email from either the right-click or Actions menus.

The Add to Salesforce dialog window opens.

3. Associate the email with accounts, assets, campaigns, cases, contacts, contracts, leads, and opportunities. See "Associating
Lotus Notes Emails with Salesforce Records" in the Salesforce online help.

4. To create a new account, contact, or lead from the Add to Salesforce dialog, see "Quickly Creating Salesforce Records
from Lotus Notes" in the Salesforce online help.

5. In the Attachments tab, add email attachments or other files on your computer as attachments on the contact, lead, or
other record you chose earlier.

6. In the Message tab, edit the body of the email as desired. This only affects the task in Salesforce, not the stored email in
Lotus Notes.

7. Click the Add to Salesforce button in the dialog.
8. The email is added as a task in the Activity History related list of the associated records. Lotus Notes Edition automatically

sets the Type value of the task to Email.

In the confirmation dialog, click OK to return to your email database.

If enabled, the new task will automatically open in a browser window. Note that the window may open behind the other
windows on your desktop.
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Note:

Your administrator may have customized Lotus Notes Edition to disallow certain operations such as synchronizing
contacts or uploading attachments. If your administrator has prohibited a particular operation, all related commands
will be disabled in your user interface.

Associating Lotus Notes Emails with Salesforce Records

User Permissions Needed

"Read" on each type of recordTo associate Lotus Notes items with Salesforce records:

You can associate Lotus Notes emails with accounts, assets, campaigns, cases, contacts, contracts, leads, and opportunities.

1. Compose a new outbound email or select a sent or received email, and then open the Add to Salesforce dialog window.
2. In the Names tab of the dialog:

a. Click the lookup icon to select an assignee for the new task.
b. Choose a status for the task.
c. Optionally, edit the task subject, which is automatically populated with the subject from the email.
d. Lotus Notes Edition automatically matches the recipient and sender fields of the email with the Email field of existing

contacts and leads. If no matches are found or if you want to choose a different record, enter a search term and click
Go!. See the tip below for help on performing searches.

e. Select your chosen contact or lead to highlight it.

3. If you are associating the email with a contact, continue to the Related To tab:

a. Choose an object from the Search Options box.
b. Enter a search term and click Go!. See the tip below for help on performing searches.
c. Select your chosen record to highlight it. This record does not need to have a relationship to the contact you chose on

the Names tab.

4. Continue adding the email to Salesforce. See "Adding a New Lotus Notes Outbound Email to Salesforce" in the Salesforce
online help and "Adding a Lotus Notes Sent or Received Email to Salesforce" in the Salesforce online help.

Tip: When searching for Salesforce records in the Names and Related To tabs, be aware of the following:

• You can perform searches for any field supported in Salesforce sidebar search. See "Search Fields" in the Salesforce
online help for a complete list.

• You can use Boolean operators such as AND and OR in your search terms.
• Within the search results, click the View link to open that record.

Note:

Your administrator may have customized Lotus Notes Edition to disallow certain operations such as synchronizing
contacts or uploading attachments. If your administrator has prohibited a particular operation, all related commands
will be disabled in your user interface.
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Associating Lotus Notes Events and Tasks with Salesforce Records

User Permissions Needed

"Read" on each type of recordTo associate Lotus Notes items with Salesforce records:

In Lotus Notes, you can associate events on your calendar and tasks on your to-do list with accounts, assets, campaigns, cases,
contacts, contracts, leads, opportunities, and custom objects your administrator has set as "deployed". Note that for events and
tasks, you can only associate the custom objects for which your administrator has checked Allow Activities.

1. In Lotus Notes, open the individual event or task. Alternatively, select the item so there is a check mark next to it.
2. Choose Associate from either the right-click or Actions menus.

A dialog window opens.

3. In the first line of the Associations box:

a. Choose Contacts or Leads from the drop-down list.
b. Click the lookup icon to search for and select the desired person.

4. If you chose Contacts in the first line, then you can proceed to the second line in the Associations box:

a. Choose an object from the drop-down list.
b. Click the lookup icon to search for and select the desired record.

5. Optionally, click View to open a selected record in a new browser window.
6. Click OK to save your work.

Note:

Your administrator may have customized Lotus Notes Edition to disallow certain operations such as synchronizing
contacts or uploading attachments. If your administrator has prohibited a particular operation, all related commands
will be disabled in your user interface.

Associating Lotus Notes Contacts with Salesforce Records

User Permissions Needed

"Read" on each type of recordTo associate Lotus Notes items with Salesforce records:

In Lotus Notes, you can specify an account to which a contact is related as well as the name of the contact's reporting manager.

1. In Lotus Notes, open a contact. Alternatively, select the contact so there is a check mark next to it.
2. Choose Associate from either the right-click or Actions menus.

A dialog window opens.

3. In the Contacts line, click the lookup icon to search for and select the contact's manager. Lotus Notes Edition will add
the manager's name to the Reports To field on the contact.

4. In the Accounts line, click the lookup icon to search for and select a related account.
5. Optionally, click View to open a selected record in a new browser window.
6. Click OK to save your work.

55

   
Salesforce CRM Lotus Notes Edition



Note:

Your administrator may have customized Lotus Notes Edition to disallow certain operations such as synchronizing
contacts or uploading attachments. If your administrator has prohibited a particular operation, all related commands
will be disabled in your user interface.

Creating Cases from Lotus Notes Emails

For emails that you have sent or received in Lotus Notes, you can create a case in Salesforce using the contents of the email.

1. In your Lotus Notes mail view, select an email by adding a check mark next to it. Alternatively, open the email.
2. Choose Add Case from either the right-click or Actions menus.

The Add to Salesforce dialog window opens.

3. In the Names tab of the dialog:

a. Click the lookup icon to select an owner for the new case.
b. Choose a status for the case.
c. Optionally, edit the case subject, which is automatically populated with the subject from the email.
d. Lotus Notes Edition automatically matches the recipient and sender fields of the email with the Email field of existing

contacts. If no matches are found or to choose a different contact, enter a search term and click Go!.

Note the following:

• You can perform searches for any field supported in Salesforce sidebar search. See "Search Fields" in the Salesforce
online help for a complete list.

• You can use Boolean operators such as AND and OR in your search terms.
• Within the search results, click the View link to open that record.

e. Select your chosen contact to highlight it.

4. To create a new contact from the Add to Salesforce dialog, see "Quickly Creating Salesforce Records from Lotus Notes"
in the Salesforce online help.

5. In the Attachments tab, add email attachments or other files on your computer as attachments on the new case.
6. In the Message tab, edit the body of the email as desired. This only affects the case description in Salesforce, not the stored

email in Lotus Notes.
7. Click the Add to Salesforce button in the dialog.
8. If enabled, the new case will automatically open in a browser window. Note that the window may open behind the other

windows on your desktop.

Note:

Your administrator may have customized Lotus Notes Edition to disallow certain operations such as synchronizing
contacts or uploading attachments. If your administrator has prohibited a particular operation, all related commands
will be disabled in your user interface.

Quickly Creating Salesforce Records from Lotus Notes

User Permissions Needed

"Create" on accountsTo create accounts from Lotus Notes:

"Create" on contactsTo create contacts from Lotus Notes:
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User Permissions Needed

"Create" on leadsTo create leads from Lotus Notes:

In the Add to Salesforce and Associate Item dialogs, the Quick Create links allow you to rapidly add new accounts, contacts,
or leads.

1. In the Quick Create area, click Account, Contact, or Lead. The links vary depending on your current context.
2. In the popup dialog, fill in the fields to add a new record. Fields marked with an asterisk (*) are required.
3. Click Save.

The new record is immediately created and displays in the Matching Records box.

4. Optionally, click View to open the record in a new browser window.

Tip: To close the popup without saving, press the Esc key.

Note:

Your administrator may have customized Lotus Notes Edition to disallow certain operations such as synchronizing
contacts or uploading attachments. If your administrator has prohibited a particular operation, all related commands
will be disabled in your user interface.

Opening Salesforce Records from Lotus Notes

When viewing a contact, task, or nonrecurring calendar event in Lotus Notes, you can open that record's detail page in
Salesforce:

1. In Lotus Notes, open an individual contact, task, or nonrecurring calendar event. Alternatively, select the item so there is
a check mark next to it.

Note that recurring events cannot be opened in Salesforce from Lotus Notes.

2. Choose View in Salesforce from either the right-click or Actions menus.
3. The Salesforce record opens in a browser window. Note that the window may open behind the other windows on your

desktop.

Setting Lotus Notes Edition Options

To customize your Lotus Notes Edition options:

1. In IBM® Lotus Notes®, select Actions ➤ Salesforce Options.
2. Select each tab in the dialog to customize the Lotus Notes Edition options. See "Lotus Notes Edition Options" in the

Salesforce online help for descriptions of each option.
3. Click OK to save your settings.

Lotus Notes Edition Options

Click each tab of the Lotus Notes Edition Options dialog to customize the settings described here.

Note:  Some of these options may not be available if your IT administrators have deployed Lotus Notes Edition with
a custom configuration.
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General options
User Settings

DescriptionOption

Your Salesforce username.Username

Your Salesforce password.Password

The URL of the Apex API server for Lotus Notes
Edition to access your Salesforce data. Read only.

Server

Click the Verify button to confirm that your username and password are correct.
General Preferences

DescriptionOption

Enable or disable the Lotus Notes Edition window
that briefly displays when Lotus Notes starts.

Display splash screen on Lotus Notes

startup

Enable or disable synchronization when your Lotus
Notes location is set to "Island (Disconnected)." If

Enable synchronization in Island mode

enabled, Lotus Notes Edition synchronizes with
the local database on your computer instead of the
database on your organization's Lotus Domino
server. Also, Lotus Notes Edition assumes that you
are connected to the Internet in order to synchronize
with Salesforce.

Display a notification dialog when Lotus Notes
Edition synchronization completes.

Display 'Sync completed' dialog

Visual Preferences

DescriptionOption

Enable or disable the context-sensitive display of
commands in the Actions and right-click menus

Enable context-sensitive menus

based on your current Lotus Notes operation. If
disabled, all menu commands always display.

Synchronization Preferences

DescriptionOption

Remove your synchronization history. Your next
synchronization will take place as if you had never

Delete history and synchronize from

scratch

before synchronized any records. When you select
this option, Lotus Notes Edition removes the
synchronized icons from all items that were
previously synchronized.

Enable automatic scheduled synchronizations every
1-8 hours.

Synchronize on schedule every XX hours
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In the General tab of the Lotus Notes Edition Options dialog, click Help to open Lotus Notes Edition
online help. Click About to view your Lotus Notes Edition version number.

Contacts, Events, and Tasks Options for Synchronization
In the Contacts, Events, and Tasks tabs of the dialog, set these options to determine how your contacts,
events, and tasks will be synchronized. You can set different options for each type of record.

DescriptionOption

Enable or disable synchronization between Lotus
Notes and Salesforce.

Synchronize Data with Salesforce

Determine how data is treated during
synchronization. Your choices are:

Data Movement

• Synchronize with Salesforce - During
synchronizations, records modified in Lotus
Notes will be reflected in Salesforce, and vice
versa. This is the default option and is
recommended for most users.

• Import from Salesforce - During its first
synchronization, a record in Salesforce will
create or update a record in Lotus Notes. If that
record is ever modified in Lotus Notes, it will
be skipped in future synchronizations. If the
record is only modified in Salesforce, future
synchronizations will cause the corresponding
record in Lotus Notes to be updated. However,
deleting a synchronized record in Salesforce will
not cause its Lotus Notes counterpart to be
deleted.

• Export to Salesforce - During its first
synchronization, a record in Lotus Notes will
create or update a record in Salesforce. If that
record is ever modified in Salesforce, it will be
skipped in future synchronizations. If the record
is only modified in Lotus Notes, future
synchronizations will cause the corresponding
record in Salesforce to be updated. However,
deleting a synchronized record in Lotus Notes
will not cause its Salesforce counterpart to be
deleted.

• Import with Overwrites - During its first
synchronization, a record in Salesforce will
create or update a record in Lotus Notes. At
future synchronizations, any changes made in
Salesforce will be reflected in Lotus Notes,
regardless of whether the Lotus Notes version
of the record had been changed in the
meantime. However, deleting a synchronized
record in Salesforce will not cause its Lotus
Notes counterpart to be deleted.

• Export with Overwrites - During its first
synchronization, a record in Lotus Notes will
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DescriptionOption

create or update a record in Salesforce. At future
synchronizations, any changes made in Lotus
Notes will be reflected in Salesforce, regardless
of whether the Salesforce version of the record
had been changed in the meantime. However,
deleting a synchronized record in Lotus Notes
will not cause its Salesforce counterpart to be
deleted.

Read-only. The Lotus Notes folders where Lotus
Notes Edition will look for items to synchronize.

Folder Settings

The items themselves must be marked for
synchronization or they will not be synchronized.
See "Synchronizing Your Contacts and Activities
with Lotus Notes Edition" in the Salesforce online
help for information on marking items for
synchronization.

Advanced Contacts, Events, and Tasks Options for Synchronization
Click the Advanced button in the Contacts, Events, and Tasks tabs of the dialog to customize additional
synchronization options. You can set different options for each type of record.

DescriptionOption

Enable or disable confirmation when records will
be deleted as a result of synchronization. This

Confirmation tab - Confirm record

deletions

option is enabled by default so you will be asked to
confirm any record deletions during
synchronization.

Enable or disable confirmation when records will
be updated as a result of synchronization. This

Confirmation tab - Confirm record

changes and additions

option is enabled by default so you will be asked to
confirm any record updates during synchronization.

In the Conflict tab, select an option to determine
how Lotus Notes Edition handles conflicts between

Conflict tab

Salesforce data and Lotus Notes data during
synchronization.

• Ignore all conflicts - Records with conflicts are
not synchronized.

• Notify me when conflicts occur - Lotus Notes
Edition notifies you of any conflicts so you can
manually resolve them. This is the default
option. See "Resolving Data Conflicts During
Lotus Notes Edition Synchronization" in the
Salesforce online help.

• Salesforce always wins - The value in the
Salesforce record is always accepted when a
conflict occurs.
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DescriptionOption

• Lotus Notes always wins - The value in Lotus
Notes is always accepted when a conflict occurs.

Determines time frame for synchronized tasks and
events. This option is in the Options tab of the
advanced settings for tasks and events.

The choices for events are:

Options tab - Synchronization Scope

• Today and future events - Only events with a
date of today or greater that are marked for
synchronization will be synchronized.

• All events - All events, including past events,
that are marked for synchronization will be
synchronized.

The choices for tasks are:

• Open and recently closed tasks - Only open
tasks and tasks completed within the last seven
days that are marked for synchronization will
be synchronized.

• Import Salesforce tasks of type Email -
Only available if Open and recently closed
tasks is selected. When this checkbox is
deselected, tasks that have a Type value of
"Email" are not imported into Lotus Notes
during synchronization, provided the
field-level security settings of the Type
picklist make the picklist visible for your
profile. The tasks affected by this option
include, but are not limited to, emails that
you have used Lotus Notes Edition to add
to Salesforce as completed tasks. Note that
the Type picklist must also be included on
your task page layout if you want the picklist
to be visible when viewing task records in
Salesforce.

• All tasks - All tasks, regardless of status, that
are marked for synchronization will be
synchronized.

Shows you how Salesforce fields are mapped to
Lotus Notes fields for synchronization. To

Field Maps tab

customize the field mapping, see "Mapping Custom
Fields for Lotus Notes Edition Synchronization"
in the Salesforce online help.

Email options
Related To Settings
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DescriptionOption

Select the types of records to show by default when
associating an email with a related record. Use

Display by Default

Ctrl+click or Shift+click to select multiple types of
records.

Search Settings

DescriptionOption

The number of Salesforce records to show in the
search results when associating items or finding

Maximum number of search results

names in the Address Book.The maximum number
allowed is 200.

When adding an email to Salesforce, automatically
run a search for matching contacts or leads.

Automatically perform search for adding

email

Email Options

DescriptionOption

Enable or disable the dialog that displays when a
message is successfully added to Salesforce.

Display email added successfully dialog

Automatically display the new task in a browser
window after adding an email message to Salesforce.

Show item after adding email

Case Options

DescriptionOption

Automatically display the new case in a browser
window after creating a case from an email message.

Show item after creating case

Browser Options

DescriptionOption

When opening Salesforce records from Lotus Notes,
always open a new browser window rather than
reusing an existing browser window.

Always use new web browser

Log File options
The Log File tab of the Lotus Notes Editions Options dialog shows the location of the Lotus Notes
Edition log file. This location cannot be changed.
Click View to open the log file in a text editor. Click Send to send the log file to salesforce.com Customer
Support for troubleshooting.
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User Permissions options
The User Permissions tab of the Lotus Notes Edition Options dialog contains settings that an IT
administrator can edit and save when deploying a customized configuration of Lotus Notes Edition to a
group of end users. If your IT administrator has customized Lotus Notes Edition for your organization,
this tab will not be available. See "Deploying Lotus Notes Edition System-Wide" in the Salesforce online
help for more information.

Mapping Custom Fields for Lotus Notes Edition Synchronization

In the Actions ➤ Salesforce Options dialog box, you can view and customize the field mappings used for Lotus Notes Edition
synchronization.

To map custom Salesforce fields to standard or custom Lotus Notes fields for synchronization:

1. From the Contacts, Events, or Tasks tabs, click Advanced ➤ Field Maps ➤ New Mapping. Each type of item has a
different field mapping.

2. Choose a field from the Salesforce Field drop-down list. This drop-down list displays the names of all Salesforce
fields that have not yet been mapped.

Caution:  If you map custom fields that are universally required, make sure the universally required fields have a
default value so that Outlook Edition users will not encounter errors. Furthermore, avoid mapping custom fields
that require validation by Salesforce in order to be created. For example, if you map a custom field whose values
must be unique, a value that you manually add in Outlook may result in a uniqueness error during synchronization.
For details about custom field attributes, see "Custom Field Attributes" in the Salesforce online help.

3. Choose a field from the Lotus Notes Field drop-down list. This drop-down list displays the names of the standard
Lotus Notes fields for that kind of record.

Note:  Custom Lotus Notes fields do not display in this list. To map a Salesforce field to a custom Lotus Notes
field, you must create the field within the field mapping dialog. Simply type the name of the new field into the
box. The custom Lotus Notes field name must be a single word (no spaces) with only letters and numbers.

4. With very few exceptions, accept the default Conversion field value, "Use salesforce.com type."

Note: The following are the only circumstances in which you should change the Conversion field from its default
value:

• If you are mapping a field that represents either a date or a date and time combination, then choose "date" or
"datetime," respectively.

• If you are mapping a field that represents the urgency of a task, then choose "Priority."
• If you are mapping a field that represents the status of a task, then choose "Status."
• If you are mapping a field that represents how other users see this time in your calendar, then choose

"BusyStatus."

If you change the default value of the Conversion field, the value will display in the Type column when you view
your saved mappings.

5. Leave the Matching score and Nonmatching score fields at 50. If you modify these fields, it may cause duplicate records
to be created. Modifying these fields is an advanced customization and we recommend that you leave the default values.

6. Click OK to save the new mapping.

To change the mapping for a specific field, select it from the list and click Edit Mapping. To delete the mapping for a field,
select it from the list and click Delete Mapping.
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Call Center Edition

Available in: Team, Professional, Enterprise, Unlimited and Developer Editions

Call Center Edition seamlessly integrates Salesforce with third-party computer-telephony integration (CTI) systems. After
a lightweight CTI adapter program has been installed on a Salesforce user's machine, the user can use the features of a CTI
system through the Salesforce SoftPhone, a customizable call control tool that appears in the sidebar of every Salesforce page.

The SoftPhone allows Salesforce users to:

• Make calls by dialing a number in the SoftPhone, choosing a number in an online directory, or clicking a phone number
in any contact, lead, activity, or account

• Receive calls
• Quickly view all Salesforce records that are related to the call, such as contacts, cases, or accounts
• Transfer calls
• Initiate conference calls
• Put callers on hold
• Attach records to calls
• Generate automatic call logs

Administrators can configure Call Center Edition by:

• Modifying SoftPhone layouts and assigning them to selected user profiles
• Adding phone numbers to call center directories

Developers can use Salesforce Call Center Edition code libraries to:

• Customize the functionality of existing CTI adapters
• Build new CTI adapters for phone systems that are not yet supported

Implementation Tips

• Call Center Edition is available as a limited release. Contact salesforce.com to learn how your organization can begin using
it.

• Call Center Edition is best suited for call centers that:

• Include fewer than 500 call center agents
• Receive or initiate fewer than 250,000 calls per day
• Do not operate 24x7

• Any machine that uses Call Center Edition must have a CTI adapter installed. A CTI adapter is a light-weight software
program that acts as an intermediary between a third-party CTI system, salesforce.com, and a Salesforce user. Because a
CTI adapter communicates directly with an individual CTI system, an organization must use a different CTI adapter for
each type of CTI system that is in use. You can download CTI adapters for a variety of CTI systems from the AppExchange.

• Call Center Edition does not support Internet Explorer 7 or Firefox. Use Internet Explorer 6 instead.

Best Practices

• Create directory numbers for conference rooms and queues that are accessible to a particular call center.
• Ensure that internal call SoftPhone layouts contain the User object.
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• Design your call center's interactive voice response scripts so that they attach data to calls in the format prescribed in the
Call Center Edition Developer's Guide.

• See the Call Center Edition Developer's Guide for information on customizing Call Center Edition beyond the scope of
what is currently offered on the AppExchange.

About Call Center Edition

Call Center Edition System Requirements

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

Call Center Edition requires the installation of a light-weight computer-telephony integration (CTI) adapter on every Salesforce
user's machine. The minimum system requirements for this adapter are:

• Internet Explorer 6.0
• Windows XP
• 256 MB of RAM (512 MB recommended)
• 20 MB disk space minimum
• P2 500Mhz processor or above

Setting Up Call Center Edition

User Permissions Needed

"Manage Call Centers"To manage call centers, call center users, call center directories,
and SoftPhone layouts:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

Before Salesforce users can access Call Center Edition features, an administrator must perform the following tasks:

1. Install a CTI adapter on every call center user machine. Call Center Edition features are not available on machines that
do not have an adapter installed.

2. Define a new call center record for every computer-telephony integration (CTI) system in use at your organization.
3. Assign Salesforce users to the appropriate call center. A Call Center Edition user must be associated with a call center to

view the SoftPhone user interface.
4. Optionally, configure call center phone directories with additional directory numbers and updated phone number search

layouts.
5. Optionally, customize SoftPhone layouts for different user profiles, so that the SoftPhone of a salesperson might show

related leads, accounts, and opportunities, while the SoftPhone of a support rep might show related cases and solutions.
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Deploying Adapters to Call Center Machines

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

Any machine that uses Call Center Edition must have a CTI adapter installed. A CTI adapter is a light-weight software
program that controls the appearance and behavior of a Salesforce SoftPhone. The adapter acts as an intermediary between a
third-party CTI system, Salesforce, and a Call Center Edition user. It must be installed on any machine that needs access to
Call Center Edition functionality.

Because a CTI adapter communicates directly with an individual CTI system, an organization must use a different CTI adapter
for each type of CTI system that is in use. For example, if an organization wants to integrate one call center that runs Cisco
IPCC Enterprise™ and one call center that runs Cisco IPCC Express™, the organization must have two CTI adapters available.
A call center user's machine only requires the SoftPhone CTI adapter for the call center to which it connects.

To download a SoftPhone CTI adapter from salesforce.com, visit the AppExchange.The adapter installation package includes
both the adapter setup files and a call center definition file that can be used in conjunction with the adapter.

To install a CTI adapter on a single machine, run the CTI adapter's Setup.exe application as a Windows administrator
user.

To deploy a CTI adapter to all the machines in a call center at once, use the .msi file that is packaged with the installer and
your preferred Software Management System.

Once a CTI adapter is installed, you can perform the following operations:

• Start the CTI adapter application by clicking Start ➤ Programs ➤ salesforce.com ➤ <Your CTI System Name> Adapter.
You can verify that the CTI adapter is running by looking for the  icon in the system tray of the computer.

• Stop the CTI adapter application by right-clicking the  system tray icon and choosing Exit.
• Modify CTI adapter log settings by right-clicking the  system tray icon and choosing Logging.... In the CTI Log

Settings dialog:

• Select the types of messages that you want to log. Keep log levels at Low - Errors unless you are troubleshooting an
issue with your adapter.

• Specify the location for the two log files that the CTI adapter generates. For more information on these files, see the
Call Center Edition Developer's Guide.

Creating a Call Center

User Permissions Needed

"Manage Call Centers"To create a call center by importing or cloning:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

A call center in Call Center Edition corresponds to a single computer-telephony integration (CTI) system already in place at
your organization. Salesforce users must be assigned to a call center record before they can use any Call Center Edition features.

There are two ways to create a call center record in Salesforce:

• Import a call center definition file into Salesforce. Use this method to create your first call center for a CTI adapter that
was just installed.
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• Clone an existing call center definition. Use this method to create additional call centers for a particular CTI adapter. For
example, if you already have a call center record for a Cisco IPCC Enterprise™ call center based in one location, you can
clone that record for a Cisco IPCC Enterprise call center based in another location.

To view a list of call centers that have already been created, click Setup ➤ Customize ➤ Call Center Edition ➤ Call Centers.

Call Center Definition Files

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

A call center definition file specifies a set of fields and values that are used to define a call center in Salesforce for a particular
CTI adapter. Salesforce uses call center definition files in order to support the integration of Call Center Edition with multiple
CTI system vendors.

By default, any CTI adapter installation package includes a default call center definition file that works specifically with that
adapter. This XML file is located in the adapter installation directory and is named after the CTI system that it supports. For
example, the Cisco IPCC Enterprise™ adapter's default call center definition file is named CiscoIPCCEnterprise7x.xml.

The first instance of a call center for a particular CTI adapter must be defined by importing the adapter's call center definition
file into Salesforce. Subsequent call centers can be created by cloning the original call center that was created with the import.

If your organization modifies an adapter or builds a new one, you must customize the adapter's call center definition file so
that it includes any additional call center information that is required. For example, if you are building a CTI adapter for a
system that supports a backup server, your call center definition file should include fields for the backup server's IP address
and port number. CTI adapters for systems that do not make use of a backup server do not need those fields in their associated
call center definition files.

Note:  Once a call center definition file has been imported into Salesforce, the set of fields that were specified in the
file cannot be modified. The values assigned to those fields, however, can be changed within Salesforce.

See the following topics for information about creating and importing a call center definition file:

• To create a call center definition file for a custom CTI adapter, see "Creating a Call Center Definition File" in the Salesforce
online help.

• To view a sample call center definition file, see "Sample Call Center Definition File" in the Salesforce online help.
• To import a call center definition file into Salesforce, see "Importing a Call Center Definition File" in the Salesforce online

help

Importing a Call Center Definition File

User Permissions Needed

"Manage Call Centers"To import call center definition files:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

To create your first call center for a CTI adapter that was just installed, you can import the adapter's default call center definition
file into Salesforce:

1. Click Setup ➤ Customize ➤ Call Center Edition ➤ Call Centers.
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2. Click Import.
3. Next to the Call Center Definition File field, click Browse to navigate to the default call center definition file in

your CTI adapter installation directory. This XML file is named after the type of CTI system that the adapter supports.
For example, the Cisco™ IPCC Enterprise adapter's default call center definition file is named
CiscoIPCCEnterprise7x.xml. Click Open to enter the path in the Call Center Definition File field.

4. Click Import to import the file and return to the All Call Centers page. The new call center record is listed with the other
call centers in your organization.

Note:  If you receive the error "A call center with this internal name already exists," a call center definition file for
this CTI adapter has already been imported into Salesforce. To create additional call center records for this CTI
adapter, clone the adapter's existing call center, or modify the call center definition file to include a different value
for reqInternalName.

5. Click Edit next to the name of the new call center to modify the call center's settings .

To create additional call centers for a particular CTI adapter, see "Cloning a Call Center" in the Salesforce online help.

To define a new call center definition file for a CTI adapter that was customized specifically for your organization, see "Creating
a Call Center Definition File" in the Salesforce online help.

Creating a Call Center Definition File

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

If you have built a custom CTI adapter you must write a call center definition file to support it. Use a text or XML editor to
define an XML file according to the guidelines outlined in the following topics:

• Call Center Definition XML Format
• Required Call Center Elements and Attributes
• Specifying Values for <item> Elements
• "Sample Call Center Definition File" in the Salesforce online help

Call Center Definition XML Format

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

A call center definition file consists of three XML elements: callCenter, section, and item. The following list provides
details about the properties and attributes of each element:

callCenter
This element represents a definition for a single call center phone system. At least one <callCenter>
element must be included in every call center definition file. A <callCenter> element consists of one
or more <section> elements.

section
This element represents a grouping of related data fields, such as server information or dialing prefixes.
When a call center is edited in Salesforce, fields are organized by the section to which they are assigned.
A <section> element belongs to a single <callCenter> element, and consists of one or more <item>
elements.
Attributes:
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DescriptionRequired?TypeName

The order in which the section should appear when
the call center is edited in Salesforce. For example, a

RequiredPositive IntegersortOrder

section with sortOrder="1" comes just before a
section with sortOrder="2".

The values for sortOrder must be non-negative
integers, and no numbers can be skipped within a
single call center definition. For example, if there are
three section elements in a call center definition file,
one <section> element must have sortOrder="0",
one <section> element must have sortOrder="1",
and one <section> element must have
sortOrder="2".

The internal name of the section as defined in the
Salesforce database. You can use this value to refer to
the section when writing custom adapter code.

Names must be composed of only alphanumeric
characters with no white space or other punctuation.
They are limited to 40 characters each.

RequiredStringname

Names beginning with "req" are reserved for
requiredSalesforce sections only (see "Required Call
Center Elements and Attributes" in the Salesforce
online help). Other reserved words that cannot be
used for the name attribute include “label”,
“sortOrder”, “internalNameLabel”, and
“displayNameLabel”.

The name of the section when viewed in Salesforce.
Labels can be composed of any string of UTF-8
characters. They are limited to 1000 characters each.

OptionalStringlabel

item
This element represents a single field in a call center definition, such as the IP address of a primary server
or the dialing prefix for international calls. When call centers are edited in Salesforce, each <item> element
is listed under the section to which it belongs. You can have multiple <item> elements in a <section>
element.
Attributes:

DescriptionRequired?TypeName

The order in which the item should appear when the
call center is edited in Salesforce. For example, an item

RequiredPositive IntegersortOrder

with sortOrder="1" comes just before an item with
sortOrder="2".

The values for sortOrder must be non-negative
integers, and no numbers can be skipped within a
single call center definition. For example, if there are
three item elements in a call center definition file, one
<item> element must have sortOrder="0", one
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DescriptionRequired?TypeName

<item> element must have sortOrder="1", and
one <item> element must have sortOrder="2".

The internal name of the item as defined in the
Salesforce database. You can use this value to refer to
the item when writing custom adapter code.

Names must be composed of only alphanumeric
characters with no white space or other punctuation.
They are limited to 40 characters each.

RequiredStringname

Names beginning with "req" are reserved for
requiredSalesforce sections only (see "Required Call
Center Elements and Attributes" in the Salesforce
online help). Other reserved words that cannot be
used for the name attribute include “label”,
“sortOrder”, “internalNameLabel”, and
“displayNameLabel”.

The name of the item when viewed in Salesforce.
Labels can be composed of any string of UTF-8
characters. They are limited to 1000 characters each.

OptionalStringlabel

Required Call Center Elements and Attributes

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

Certain <section> and <item> elements are required in every call center definition file and must be included according to
the following rules:

• There must be one <section> that includes <item> elements with the following names:

Description<item> Name

Represents the unique identifier for the call center in the database. It must have
a sortOrder value of "0", and its value must be specified in the call center

reqInternalName

definition (see "Specifying Values for <item> Elements" in the Salesforce online
help). A value for "reqInternalName" must be composed of no more than 40
alphanumeric characters with no white space or other punctuation. It must start
with an alphabetic character and must be unique from the "reqInternalName"
of all other call centers defined in your organization.

Represents the name of the call center as displayed in Salesforce. It must have
a sortOrder value of "1". A value for "reqDisplayName" has a maximum length
of 1000 UTF-8 characters.

reqDisplayName

Represents a description of the call center. A value for "reqDescription" has a
maximum length of 1000 UTF-8 characters.

reqDescription

Represents the Program ID (progId) of the CTI adapter that should be used
for this call center. This value is specified in the default call center definition

reqProgId
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Description<item> Name

file that comes bundled with every CTI adapter installer, or in the base COM
class of a custom CTI adapter.

You can add additional <item> elements to this section if needed.

• There must be one <section> that includes <item> elements with the following names:

Description<item> Name

Represents the dialing prefix for calls outside the call centerreqOutsidePrefix

Represents the dialing prefix for long distance callsreqLongDistancePrefix

Represents the dialing prefix for international callsreqInternationalPrefix

The value for each of these <item> elements, if specified, must contain only digits (0-9).

Specifying Values for <item> Elements

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

With the exception of the "reqInternalName" <item>, whose value must always be specified in a call center definition file,
you can specify <item> values either in the call center definition file or in Salesforce once the definition file has been imported.

To specify a value for an <item> element in a cell center definition file, place the value between the opening and closing tags
of the <item>. For example:

<item sortOrder="0" name="reqInternalName" label="Call Center Internal 
Label">MyCallCenter</item>

sets the value of the "reqInternalName" <item> to "MyCallCenter". Note that any <item> value other than the value for
"reqInternalName" can be edited in Salesforce after the call center definition is imported.

Sample Call Center Definition File

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

The following XML code makes up a sample call center definition file. For more information on the XML format of a call
center definition file, see "Creating a Call Center Definition File" in the Salesforce online help.

<!-- 
     All sections and items whose name value begins with "req" are 
     required in a valid call center definition file. The sortOrder 
     and label attributes can be changed for all required sections 
     and items except reqGeneralInfo, reqInternalName, and 
     reqDisplayName, in which only the label attribute can be altered.

   Note that the value for the reqInternalName item is limited to
     40 alphanumeric characters and must start with an alphabetic
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     character. reqInternalName must be unique for all call centers 
     that you define.
-->

<callCenter>

<section sortOrder="0" name="reqGeneralInfo" label="General Info">     
   <item sortOrder="0" name="reqInternalName" 
         label="Internal Name">callCenter001</item>     
   <item sortOrder="1" name="reqDisplayName" 
         label="Display Name">My Call Center</item>     
   <item sortOrder="2" name="reqDescription" 
         label="Description">Located in San Francisco, CA</item>
 <item sortOrder="3" name="reqProgId" 
         label="CTI Connector ProgId">MyAdapter.MyAdapter.1</item>  
</section>   

<section sortOrder="1" name="ServerInfo" label="CTI Server Info">
   <item sortOrder="0" name="HostA" 
         label="Host A">Host A</item>
   <item sortOrder="1" name="PortA" 
         label="Port A">Port A</item>
   <item sortOrder="2" name="HostB" 
         label="Host B">Host B</item>
   <item sortOrder="3" name="PortB" 
         label="Port B">Port B</item>
   <item sortOrder="4" name="PeripheralID" 
         label="Peripheral ID">1000</item>
</section>

<section sortOrder="2" name="reqDialingOptions" label="Dialing Options"> 
   <item sortOrder="0" name="reqOutsidePrefix" 
         label="Outside Prefix">1</item>
   <item sortOrder="1" name="reqLongDistPrefix" 
         label="Long Distance Prefix">9</item>
   <item sortOrder="2" name="reqInternationalPrefix" 
         label="International Prefix">01</item>
</section> 

</callCenter>

Cloning a Call Center

User Permissions Needed

"Manage Call Centers"To view and clone a call center:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

To create more than one call center for a particular CTI adapter, you can clone an existing one. For example, if you already
have a call center record for a Cisco IPCC Enterprise™ call center based in one location, you can clone that record for a Cisco
IPCC Enterprise call center based in another location.

To clone a call center:

1. Click Setup ➤ Customize ➤ Call Center Edition ➤ Call Centers.
2. Click the name of the call center that you want to clone.
3. Click Clone. This action opens a new call center for editing with the same fields and values as the original call center.

Only the Internal Name field is left intentionally blank to allow you to provide a new name. This name is limited to 40
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alphanumeric characters and must start with an alphabetic character. Internal Name must be unique for every call center
defined in your organization. For more information, see "Call Center Fields" in the Salesforce online help.

4. Make any additional changes to the new call center as necessary.
5. Click Save to save the new call center, or click Cancel to return to the All Call Centers page without saving the cloned

call center.

Displaying and Editing a Call Center

User Permissions Needed

"Manage Call Centers"To view or edit a call center:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

A call center in Call Center Edition corresponds to a single computer-telephony integration (CTI) system already in place at
your organization. Salesforce users must be assigned to a call center record before they can use any Call Center Edition features.

To view call center details:

1. Click Setup ➤ Customize ➤ Call Center Edition ➤ Call Centers.
2. Click the name of the call center that you want to view.

From the Call Center Detail page you can:

• Click Edit to modify the properties of the call center.
• Click Delete to erase the call center record from Salesforce. When you delete a call center, all associated directory numbers

are also deleted. Any users associated with the call center must be reassigned to another call center to continue using Call
Center Edition features.

• Click Clone to create a duplicate copy of the call center with the same fields and values as the current call center.
• Click Manage Call Center Users to designate Salesforce users as members of this call center.

Call Center Fields

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

All call centers include the following required fields, though additional fields may be available depending on the content of
the call center definition file that was used to create the call center:

DescriptionField

Represents the unique identifier for the call center in the database. Internal Name must be
composed of no more than 40 alphanumeric characters with no white space or other

Internal Name

punctuation. It must start with an alphabetic character and must be unique from the Internal
Name of all other call centers defined in your organization. Once a value for Internal Name
has been saved for a call center, it cannot be changed.

Represents the name of the call center as displayed in Salesforce. It must have a sortOrder
value of "1". Display Name has a maximum length of 1000 UTF-8 characters.

Display Name
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DescriptionField

Represents a description of the call center. Description has a maximum length of 1000
UTF-8 characters.

Description

Represents the Program ID (progId) of the CTI adapter that should be used for this call
center. This value is specified in the default call center definition file that comes bundled with
every CTI adapter installer, or in the base COM class of a custom CTI adapter.

CTI Connector ProgId

Represents the dialing prefix for calls outside the call centerOutside Prefix

Represents the dialing prefix for long distance callsLong Distance Prefix

Represents the dialing prefix for international callsInternational Prefix

Managing Call Center Users

User Permissions Needed

"Manage Call Centers"To add or remove users from a call center:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

A Salesforce user cannot view Call Center Edition features unless an administrator has assigned the user to a call center. See
the following for instructions:

• Adding a User to a Call Center
• Removing a User from a Call Center

Every call center user has access to a set of personal SoftPhone settings that specify:

• Whether the user should be automatically logged into his or her SoftPhone when he or she logs into Salesforce
• How a record should be displayed when it is the only one that matches an incoming call

To change the default personal SoftPhone settings for all new call center users, use the Apex API. For information, see the
Apex API guide available at http://www.appexchange.com.

Adding a User to a Call Center

User Permissions Needed

"Manage Call Centers"To add users to a call center:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

To add a user to a call center in Call Center Edition:

1. Click Setup ➤ Customize ➤ Call Center Edition ➤ Call Centers.
2. Click the name of the call center to which you want to assign the Salesforce user.
3. In the Call Center Users related list, click Manage Call Center Users.
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4. Click Add More Users.
5. Specify search criteria to find the Salesforce users who should be assigned to the call center. For more information, see

"Entering Filter Criteria" in the Salesforce online help.
6. Click Find to display the list of Salesforce users that meet your search criteria. All users who already belong to a call center

are excluded from search results because a user can only be assigned to one call center at a time.
7. Select the checkbox next to each user who should be assigned to the call center and click Add to Call Center.

Alternatively, you can change a particular user's call center in the User Edit page:

1. Click Setup ➤ Manage Users ➤ Users.
2. Click Edit next to the name of the user.
3. Modify the Call Center field as appropriate. You can change the user's call center by clicking  and choosing a new

call center, or you can remove the user from his or her current call center by deleting the call center name from the field.

Removing a User from a Call Center

User Permissions Needed

"Manage Call Centers"To remove users from a call center:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

To remove a user from a call center in Call Center Edition:

1. Click Setup ➤ Customize ➤ Call Center Edition ➤ Call Centers.
2. Click the name of the call center from which you want to remove the Salesforce user.
3. In the Call Center Users related list, click Manage Call Center Users.
4. Click Remove next to the name of the user that you want to remove from the call center.

To remove multiple users at once, select the Action checkbox next to each user you want to remove and click Remove
Users.

Alternatively, you can change a particular user's call center in the User Edit page:

1. Click Setup ➤ Manage Users ➤ Users.
2. Click Edit next to the name of the user.
3. Modify the Call Center field as appropriate. You can change the user's call center by clicking  and choosing a new

call center, or you can remove the user from his or her current call center by deleting the call center name from the field.

Customizing a Call Center Directory

User Permissions Needed

"Manage Call Centers"To manage call center directories:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.
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Every call center in Call Center Edition includes a call center directory that allows users to search for phone numbers throughout
your organization. You can customize call center directories by:

• Adding additional directory numbers, either to a single call center or to all defined call centers in your organization
• Updating phone number search layouts

Adding a Number to a Call Center Directory

User Permissions Needed

"Manage Call Centers"To view, add, edit, or delete an additional directory number:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

To customize call center directories by adding additional directory numbers, either to a single call center or to all defined call
centers in your organization:

1. Click Setup ➤ Customize ➤ Call Center Edition ➤ Directory Numbers. From this page, you can:

• Click Edit to edit an existing additional directory number.
• Click Del to delete an existing additional directory number.
• Click the name of an existing additional directory number to view its details in the Additional Directory Number Detail

page. From this page you can click Edit to edit the number, click Delete to delete it, or click Clone to quickly create
a new additional directory number with the same information as the existing number.

2. Click New to define a new additional directory number.
3. In the Name field, enter a label that identifies the additional directory number.
4. In the Phone field, enter the phone number, including any international country codes. Dialing prefixes, such as 9 or 1,

do not need to be included.
5. In the Call Center field, select the call center directory to which you want to add the new directory number. To add

the number to every call center directory in your organization, choose -- Global --.
6. In the Description field, optionally enter text that provides further information about the additional directory number.
7. Click Save to save the number and return to the All Additional Directory Numbers page. Alternatively, click Save & New

to save the number and create another.

Tip:  If you have a large number of directory numbers to define, use the Salesforce Data Loader to create them in one
step.

Customizing SoftPhone Layouts

User Permissions Needed

"Manage Call Centers"To view, create, edit, or delete a SoftPhone layout:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.
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A SoftPhone is a customizable call control tool that appears in the sidebar of every Salesforce page if a user is assigned to a
call center and is working on a machine on which a CTI adapter has been installed. Similar to page layouts, you can design
custom SoftPhone layouts and assign them to Call Center Edition users based on their user profile. See the following for
information:

• Designing a Custom SoftPhone Layout
• Assigning a SoftPhone Layout to a User Profile

Designing a Custom SoftPhone Layout

User Permissions Needed

"Manage Call Centers"To view, create, edit, or delete a SoftPhone layout:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

In a SoftPhone layout you can control the call-related fields that are displayed and the Salesforce objects that are searched for
an incoming call. To design a custom SoftPhone layout:

1. Click Setup ➤ Customize ➤ Call Center Edition ➤ SoftPhone Layouts.
2. Click New to create a new SoftPhone layout definition, or click Edit next to the name of an existing layout definition to

view or modify it.
3. In the Name field, enter a label that uniquely identifies your SoftPhone layout definition.
4. In the Select Call Type picklist, choose the type of call for which the currently-displayed SoftPhone layout should be

used. Every SoftPhone layout definition allows you to specify different layouts for inbound, outbound, and internal calls.
These three layouts are grouped together in a single SoftPhone layout definition.

5. In the Display these call-related fields section, click Edit to add, remove, or change the order of fields in the
currently-displayed SoftPhone layout:

• To add a field to the SoftPhone layout, select it in the Available list and click Add.
• To remove a field from the SoftPhone layout, select it in the Selections list and click Remove.
• To change the order of a field in the SoftPhone layout, select it in the Selections list and click Up or Down.

Any changes that you make are automatically updated in the SoftPhone layout preview image on the right side of the page.
To hide the Available and Selections lists, click Collapse.

Note:  Phone-related fields that you select in a SoftPhone layout will only appear in a user's SoftPhone if a valid
value for that field is available. For example, if you add a Caller ID field to the layout of an outbound call, Caller
ID will not appear.

6. In the Display these Salesforce Objects section, click Add/Remove Objects to add, remove, or change the order
of links to call-related objects.

7. Below the list of selected objects, click Edit next to each If single <Object> found, display row to specify the
fields that should be displayed in the SoftPhone layout if a single record for that object is the only record found. You can
add, remove, or change the order of fields.

8. Configure SoftPhone layouts for any remaining call types in the Select Call Type picklist.
9. Click Save.
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Assigning a SoftPhone Layout to a User Profile

User Permissions Needed

"Manage Call Centers"To assign a SoftPhone layout to a user profile:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

Once you have defined one or more custom SoftPhone layouts, you can assign them to user profiles:

1. Click Setup ➤ Customize ➤ Call Center Edition ➤ SoftPhone Layouts.
2. Click Layout Assignment.
3. For each user profile that appears in the page, select the SoftPhone layout that the profile should use. Profiles are only

listed in this page if they include users that are currently assigned to a call center, or if they have already been assigned a
custom SoftPhone layout.

4. Click Save.

Note:  Call center users will see their newly assigned SoftPhone layout the next time they log into Salesforce.

Using the SoftPhone

User Permissions Needed

Member of a call centerTo view and use the SoftPhone:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

The Call Center Edition SoftPhone appears in the left side bar of yourSalesforce window. You can use it to perform the
following functions:

• Log in to your call center
• Modify your call center state to show whether you are ready to receive a new call
• Dial a phone number by using the built-in SoftPhone, or by clicking the  icon next to any phone number associated

with a contact, lead, activity, or account
• Look up a phone number in your custom call-center directory
• Answer a phone call from another call center user or an external number
• Put a caller on hold
• Initiate a conference call with another call center user or an external number
• Transfer a phone call to another call center user or an external number
• Add comments to or associate Salesforce records with an automatic call log to quickly record information related to a call
• Edit personal Call Center Edition settings to customize the behavior of your SoftPhone

Note: The sidebar cannot be collapsed if you are a Call Center Edition user.
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Note:  Some Call Center Edition features that are described in this help system may not be available with your
SoftPhone because of customizations that have been made for your organization. See your administrator for details.

Logging In to the SoftPhone

User Permissions Needed

Member of a call centerTo log in to Call Center Edition:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

Call Center Edition requires you to first log in to Salesforce and then to log in separately to your organization's phone system.
The phone system login is located in the sidebar and only appears if you are:

• Assigned to a call center in Salesforce
• Using a machine on which an appropriate CTI adapter is installed. (You can quickly verify that an adapter is installed by

looking for the  icon in the system tray of your computer. The system tray is located next to the clock in the lower-right
corner of your monitor.)

If a phone system login does not appear, contact your administrator.

Depending on the phone system that your organization uses, the login prompts you to enter your user ID, password, and other
credentials. Once you have entered these values, click Log In to complete the connection to your phone system.

To automatically log in to your phone system without having to click the Log In button:

1. Click Setup ➤ Call Center Settings ➤ My SoftPhone Settings.
2. Select Automatically log in to your call center when logging into Salesforce. Once you have logged

in to your phone system once, Salesforce remembers your login information and automatically makes a connection to your
phone system whenever you log in to Salesforce.

Note:  If you explicitly log out of the phone system at any time while you are logged in to Salesforce, automatic log
in is turned off for the remainder of your Salesforce session. To reenable automatic log in, log out of Salesforce and
then log back in.

After logging in to a phone system, your call center state is automatically set to Not Ready for Calls. If you want to receive
calls, you must change your call center state to Ready for Calls.

Changing Your Call Center State

User Permissions Needed

Member of a call centerTo change your call center state:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.
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While logged in to Call Center Edition, there may be times when you do not want to receive calls on your SoftPhone, or when
you need to step away from your desk. To avoid receiving calls when you do not want them, you can set your call center state

next to the  icon in the SoftPhone. Possible values for call center state include:

DescriptionCall Center State

You are not currently on a call, and you are prepared to receive
the next direct or queued call.

Ready for Calls

You are not currently on a call, and you are not prepared to
receive the next queued call.

In this state you can still receive calls that are dialed directly
to your extension.

Not Ready for Calls

You are currently connected to a caller and cannot receive
either a direct or a queued call.

On a Call

You are currently on a call, and you wish to go directly to the
Not Ready for Calls state when the call is complete.

Wrap-Up

You want to log out from your call center phone system and
remain logged in to Salesforce. After selecting this option,

Log Out

Call Center Edition automatically closes the connection to
your call center and displays the SoftPhone login screen.

When you first log in to Call Center Edition, your call center state is automatically set to Not Ready for Calls. You must
choose Ready for Calls from the drop-down list before you can receive any calls.

Note:  Some Call Center Edition features that are described in this help system may not be available with your
SoftPhone because of customizations that have been made for your organization. See your administrator for details.

Making a Call Using the SoftPhone

User Permissions Needed

Member of a call centerTo make a call:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

In Call Center Edition there are three ways to make a call:

• Making a Call by Dialing a Number Manually
• Making a Call Using the Call Center Directory
• Making a Call Using Click-to-Dial

While on a call, you can also make a call on a second phone line by clicking New Line. The new line allows you to enter a
new phone number while remaining connected to your original caller. Once you click Dial, your original call is placed on hold,
and your new call begins.
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Note:  If you make a call while your call center state is set to Ready for Calls, your state moves directly to Not Ready,
and you must enter Not Ready reason codes if this is enabled for your call center.

To end a call that you just dialed, click End Call.

Note:  Some phone systems do not allow you to end a call from a SoftPhone before it is answered. In these cases, an
End Call button is not displayed, and you must use your physical phone set to terminate the call.

If a number you dial is busy, a message appears and you have the option to dial again or cancel the call.

Note:  Some Call Center Edition features that are described in this help system may not be available with your
SoftPhone because of customizations that have been made for your organization. See your administrator for details.

Making a Call by Dialing a Number Manually

User Permissions Needed

Member of a call centerTo make a call:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

To make a call in Call Center Edition by manually dialing a number:

1. In the SoftPhone, click the name of the open line that you want to use. This action opens the dial pad for that line.
2. Enter the phone number that you want to dial by clicking the number buttons on the dial pad, or by typing numbers on

your keyboard.
3. Click Dial or press the Enter key on your keyboard.

Note:  Some Call Center Edition features that are described in this help system may not be available with your
SoftPhone because of customizations that have been made for your organization. See your administrator for details.

Making a Call Using the Call Center Directory

User Permissions Needed

Member of a call centerTo make a call:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

To make a call in Call Center Edition using the call center directory:

1. In the SoftPhone, click the name of the open line that you want to use. This action opens the dial pad for that line.
2. Click  next to the dial pad to open your call center directory.
3. Use the directory to locate the number that you want to dial.
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4. When you have found the number, click the name associated with the number to automatically enter the number into the
dial pad.

5. Click Dial or press the Enter key on your keyboard.

Note:  Some Call Center Edition features that are described in this help system may not be available with your
SoftPhone because of customizations that have been made for your organization. See your administrator for details.

Making a Call Using Click-to-Dial

User Permissions Needed

Member of a call centerTo make a call:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

To make a call directly from the phone field of a contact, lead, activity, or account using Call Center Edition:

1. Locate the number that you want to dial in a contact, lead, activity, or account.
2. Click the  button to the right of the number. The number is automatically dialed in the first open SoftPhone line.

Note:

• A number that has already been clicked cannot be clicked again for five seconds.
• The  button does not appear next to fax numbers.

Note:  Some Call Center Edition features that are described in this help system may not be available with your
SoftPhone because of customizations that have been made for your organization. See your administrator for details.

Using the Call Center Directory

User Permissions Needed

Member of a call centerTo use a call center directory:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

Every call center has an associated call center directory that includes the name and number of every user that belongs to that
call center, as well as other phone numbers that are related to records in your system.

To use your call center directory:

1. In the SoftPhone, click the name of the open line that you want to use. This action opens the dial pad for that line. Click
 next to the dial pad to open your call center directory.

2. Search the call center directory for a phone number:

a. In the Pick an object drop-down, choose the type of record that you want to search. Any object with a phone number
field is included in this list.

82

   
Salesforce CRM Call Center Edition



b. In the Search text box, type all or part of the name for which you are searching. For a list of the fields that are searched
for a particular object, see "Lookup Dialog Search Fields" in the Salesforce online help.

c. Click Go to view a list of only those records that include your search text.

3. When you find the phone number that you want, click its associated record name to automatically enter the number into
the SoftPhone.

4. Click Dial to make the call.

Answering a Call Using the SoftPhone

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

User Permissions Needed

Member of a call centerTo answer calls with a SoftPhone:

When logged in to a SoftPhone, you can receive a call when:

• The call originates from a queue and your call center state is set to Ready for Calls
• The call is dialed directly to your extension and you are not already on a call

You can tell that you have an incoming call if you see a flashing red button and the words "Incoming Call," "Incoming Transfer,"
or "Incoming Conference" next to the name of a telephone line in your SoftPhone.

Details about the call, if any, are displayed just above the Answer button, and typically include the phone number of the caller
and the number that the caller dialed to reach you. When the caller's phone number can be matched with a number in an
existing Salesforce record, a link to that record is also displayed. Likewise, if your call center prompts callers to enter an account
number or other data before being connected with a representative, your SoftPhone searches for records that contain that
information and automatically displays links to matching results.

To answer an incoming call, you can:

• Click Answer in the SoftPhone.
• Use your physical telephone set to pick up the call.

When you answer a call, the Call Duration clock starts ticking, and your call center state is automatically set to Busy. If
you do not answer the call, the system forwards it to another user and your call center state is automatically set to Not Ready
for Calls.

Once you have answered a call, you can:

• Log comments and associate Salesforce records with the call
• Put the caller on hold
• Transfer the call to another call center user
• Conference another call center user into the call
• End the call

Note:  If your SoftPhone supports multiple lines and you have a call established on one telephone line when you answer
a call on a second line, the first call will automatically be put on hold.

Note:  Some Call Center Edition features that are described in this help system may not be available with your
SoftPhone because of customizations that have been made for your organization. See your administrator for details.
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Putting a Caller on Hold Using the SoftPhone

User Permissions Needed

Member of a call centerTo put a caller on hold:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

Call Center Edition allows you to put any caller on hold so that the caller cannot hear you speaking. To put a caller on hold,
click Hold in the SoftPhone line that is currently active. The Hold Time clock that shows how long the caller has been
waiting automatically starts, and the line light icon ( ) begins to blink yellow.

To resume the call, click Retrieve from Hold. If you want to end the call without retrieving the caller from hold, click End
Call.

Note:

• Callers are automatically put on hold whenever you initiate a call transfer, dial a number on a second line, or initiate
a conference call.

• If you click Hold while on a conference, your line becomes mute but other conference participants can still speak
to one another.

Note:  Some Call Center Edition features that are described in this help system may not be available with your
SoftPhone because of customizations that have been made for your organization. See your administrator for details.

Making a Conference Call Using the SoftPhone

User Permissions Needed

Member of a call centerTo initiate a conference call:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

To initiate a conference call with another call center user or an outside phone number:

1. While on a call, click Conference in the SoftPhone line that is currently active. Your caller is automatically put on hold
and a new dial pad becomes active.

2. Use the dial pad, your keyboard, or the phone directory to enter the phone number of the person who you want to include
in the conference.

3. Click Initiate Conference. Your first caller remains on hold while you are on the call with the destination number. If a
number you dial is busy, a message appears and you have the option to dial again or cancel the call.

4. Once you have connected with the second caller and are ready to start the conference, click Complete Conference. The
second caller joins the first on your original telephone line and all three of you can speak freely to one another. If you no
longer want to conference the call after dialing the second number, click Cancel Conference to hang up on the second
caller and return to your original caller.
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Note:

• If you click Hold while on a conference, your line becomes mute but other conference participants can still speak
to one another.

• Some phone systems limit the number of callers who can be conferenced on a single line. See your administrator
for details.

Transferring a Call Using the SoftPhone

User Permissions Needed

Member of a call centerTo transfer a call:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

To transfer a call to another call center user or to an external phone number:

1. Attach any relevant Salesforce records to the call that you want to transfer. For example, if you created a case for the call,
save it, and make sure that it is selected in one of the Related To fields of the current call log. By doing this, the user to
whom you are transferring the call will have access to the case in his or her SoftPhone.

2. Click Transfer in the SoftPhone line that you want to transfer. You remain on the line with your first caller and a new
dial pad becomes active.

3. Use the dial pad, your keyboard, or the call center directory to enter the phone number of the person to whom the call
should be transferred.

4. Click Initiate Transfer. Your first caller is automatically put on hold while you are on the call with the destination number.
If a number you dial is busy, a message appears and you have the option to dial again or cancel the call.

5. When you are ready to transfer your first caller to the destination number, click Complete Transfer. If you no longer want
to transfer the call, click Cancel Transfer.

Once you complete a transfer, your line is immediately freed and you return to the "Ready for Calls" state.

Creating Call Logs in the SoftPhone

User Permissions Needed

Member of a call centerTo create a call log:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

Every external call that you make or receive with a SoftPhone automatically generates a call log activity record. You can view
these call logs in the Activity History related list of any Salesforce record that is associated with the call or by running a report.
Automatically generated call log records include values for:

• The call center user who received or initiated the call
• The phone number of the contact who called or who was called by the call center user
• The date on which the call took place
• The duration of the call, in seconds
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• Whether the call was inbound or outbound
• The call center system’s unique identifier for the call

You can associate up to two records and add comments to a call log while the call is underway. To do so:

1. Associate up to two the records with the call log:

• When you view or create a contact, lead, or person account, a Name drop-down list appears in the call log. Use this list
to select a single contact, lead, or person account record to associate with the call.

• When you view or create any other type of Salesforce record, a Related to drop-down list appears in the call log.
Use this list to select a single record of any other type to associate with the call.

Note:  Custom object records can only be associated with a call log if the custom object tracks activities. See
"Defining Custom Objects" in the Salesforce online help.

By default, the most recently viewed records are selected in the Name and Related to lists unless you manually choose
a different record. The records that you choose in these lists will include the call log in their Activity History related lists
once the call ends. These records are also displayed with the call if it is transferred to or conferenced with another Call
Center Edition user.

2. In the Comments field, add information about what happened during the call.

After the call ends, the call log is automatically saved as a completed task. You can quickly access the saved call logs for calls
that were just completed by expanding the Last X Calls section of the SoftPhone. Up to three of your last calls are displayed
in this list with your most recent call displayed first:

• To view a saved call log, click Call.
• To view a record that was associated with a call log, click the name of the record.

To view a list of all calls that you've made or received in the past day, click My Calls Today. This link opens the My Calls
Today report in the Reports tab.

Note:  Some Call Center Edition features that are described in this help system may not be available with your
SoftPhone because of customizations that have been made for your organization. See your administrator for details.

Wrapping Up a Call Using the SoftPhone

User Permissions Needed

Member of a call centerTo end a call:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

When you are ready to end a call:

1. Update the associated call log. For example, if you created a case or viewed a contact while you were on the call, verify that
they are selected in one of the Related To fields of the log, and use the Comments text box to enter any notes about the
call.

Note:  Call logs are not created for internal calls.
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2. Click End Call in the active SoftPhone line or use your physical phone set to hang up. This terminates the call and frees
the line..

3. If wrap up codes are not enabled, your call center state is set back to Ready for Calls and the log for your call is automatically
saved.

4. If wrap up codes are enabled, your call center state is set to Wrap Up and a set of reason codes are displayed in the SoftPhone.
While in this state you cannot receive any incoming calls.

a. Select the reason code that best represents the outcome of the call.
b. Optionally make any additional modifications to your call log.
c. Click Done. Your call center state returns to Ready for Calls, and the log for your call is automatically saved.

All saved call logs are placed in the Last N Calls section of the SoftPhone for quick reference. You can review details of these
call logs by clicking any of the associated links:

• The Subject link (for example, "Call 6/01/2006 12:34 PM") opens the call log details page.
• Either of the Related To links opens the detail page for the specified Salesforce record.

Note:  Some Call Center Edition features that are described in this help system may not be available with your
SoftPhone because of customizations that have been made for your organization. See your administrator for details.

Editing Personal SoftPhone Settings

User Permissions Needed

Member of a call centerTo edit personal SoftPhone settings:

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

You can control personal SoftPhone settings within Salesforce. To change your settings, click Setup ➤ Call Center Settings
➤ My SoftPhone Settings.

The following settings are available:

DescriptionSetting

Select this option if you want Salesforce to use saved login
information to automatically log you in to your SoftPhone.

Automatically log in to your call center when

logging into Salesforce

Choose one of the following options to specify how a record
should be displayed when it is the only one that matches an
incoming call:

If only one record found on incoming call

• Always open the record automatically. This
option displays the record in the main Salesforce window,
overwriting whatever was there before. All unsaved changes
from your previous record are lost.

• Never open the record automatically. This
option does not display the matching record. To view it
you must click on the record's link in the SoftPhone.
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Call Center Edition Reports

User Permissions Needed

"Run Reports"

AND

To run reports:

"Read" on the records included in report

Note: Call Center Edition is available as part of a limited release program. Contact salesforce.com for more information.

The reports in this folder help you analyze the Call Center Edition phone calls that were handled by you and your team.

• The My Team's Calls This Week gives you information about the calls that were handled by the call center users on your
team during the past week, including associated records and the result of each call.

• The My Calls Today report gives you information about the calls that you initiated or received during the past day, including
associated records and the result of each call.

• The My Calls This Week report gives you information about the calls that you initiated or received during the past week,
including associated records and the result of each call.

Multilingual Solutions
Available in: Professional, Enterprise, Unlimited, and Developer Editions

With Winter '07, you can use multilingual solutions to easily manage your organization's library of solutions in multiple
languages. Multilingual solutions helps users effortlessly create and edit solutions in different languages. Users can also report
on which solutions have been translated and which solutions are out of date and need to be translated. Once solutions are
translated into any of the languages supported by Salesforce, your internal users and customers can find solutions in their
preferred language, or all supported languages, via the Solutions tab, Self-Service portal, and public knowledge base.

Implementation Tips

• Run solution reports to locate any existing solutions that are already translated and will need to be converted to translated
solutions after you enable multilingual solutions.

• Translate your solution categories before enabling multilingual solutions and then associate solutions with each other. This
will help you associate solutions with the correct categories.

• Translate solution categories so that they display in the language of each user on the Solutions tab and in the preferred
language of each customer on the Self-Service portal as specified in the customer's Self-Service user information settings.

• After you enable multilingual solutions, associate any existing translated solutions with the appropriate master solutions.
You can do this manually using the Master Solution lookup field, or you can export a report of existing translated
solutions and then import those solutions to associate them with a master solution. For each translated solution you import,
include the 15 to 18 character Solution ID field of its master solution in a master solution column on your import file.
To view the Solution ID field for master solutions, run the Translated Solution report.

• Customize solution page layouts to include the Master Solution Title field, Master Solution Details field,
Out-of-Date field, and the Translated Solutions related list.

• Make solution edit pages easier for users to translate multilingual solutions by setting the Detail Information section to
two columns and placing the Master Solution Title and Master Solution Details fields alongside each other.
Underneath those fields, place the Solution Title and Solution Details fields alongside each other so that users
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can effortlessly compare the master and translated solutions. Note that the Master Solution Title and Master
Solution Details fields display only on the translated solution edit page.

• Set the field-level security settings of the Master Solution lookup field to editable for profiles with the "Create" and
"Edit" permissions on solutions. When the Master Solution lookup field is editable, users can associate translated
solutions with master solutions. Field-level security is available in Enterprise, Unlimited, and Developer Editions only.

Best Practices

• Enable multilingual solution search for your Self-Service portal so that customers can automatically view solution search
results in their preferred language as specified in their Self-Service user information settings. Customers can also choose
to view solution search results in a specific language or all supported languages via a language drop-down list. By default,
the Login Page of your Self-Service portal displays in your organization's language.

• Enable multilingual solution search for your public knowledge base so that customers can choose to view solution search
results in a specific language or all supported languages via a language drop-down list. By default, the public knowledge
base displays in your organization's language.

• Track translated solutions marked Out of Date by running the Translated Solutions report.
• Create a custom list view on the Solutions tab so users can see which translated solutions may need translating. Simply

enter the following search criteria in the list view: "Out of Date equals True".
• Use the solutions import wizard to import master and translated solutions and associate them with each other.
• Add a long text area custom field to solutions called Translation Comments and include it on solution page layouts so

that users can add any comments regarding the translation of the solution. Users should include a date with their comments
so that other users can see when each comment was added.

About Multilingual Solutions

What are Multilingual Solutions?

The multilingual solutions feature helps you translate solutions and solution categories into the languages supported by
Salesforce so that customers and support reps can find answers to inquiries in the language with which they are most comfortable.

Multilingual solutions can lower support costs by:

• Improving customer satisfaction by answering inquiries in the languages preferred by customers
• Deflecting unnecessary incoming calls by providing solutions in languages that are the most useful for customers
• Managing inquiries in multiple languages from one location, anytime and anywhere

Review the following key terms for multilingual solutions:

Master Solution
A solution created in any language supported by Salesforce. A master solution can have zero or more
translations associated with it; it cannot be linked to another master solution.

Translated Solution
A solution translated into another language supported by Salesforce and associated with exactly one master
solution. A translated solution cannot have the same language as its master solution or any other translated
solutions associated with that master solution. A translated solution cannot have other translated solutions
associated with it. Translated solutions are represented by the  icon on solution detail pages, solution
edit pages, solution list views, and solution search results.

You can work with multilingual solutions from the following:
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Solutions Tab
When creating a new solution, users can choose a language in which to write the solution from the
Language picklist field. Once the solution is saved, it becomes a master solution. Users can then create
a translated solution by clicking New on the Translated Solutions related list of the master solution detail
page. When a master solution is modified, users can adjust the statuses of its translated solutions to indicate
that they may need translating. For more information, see "Setting Multilingual Solution Statuses" in the
Salesforce online help.

Cases Tab
When users search for relevant solutions on a case by entering keywords in the Solutions related list and
clicking Find Solution, search results include solutions in all languages that have matching keywords.
Alternatively, if suggested solutions is enabled for cases, users can click View Suggested Solutions to find
relevant solutions in multiple languages if they share common words with the case. For more information,
see "Solving Cases" in the Salesforce online help.

Self-Service Portal
If multilingual solution search is enabled for your Self-Service portal, customers automatically view solution
search results in their preferred language as specified in their Self-Service user information settings.
Customers can also choose to view solution search results in a specific language or all supported languages
via a language drop-down list. By default, the Login Page of your Self-Service portal displays in your
organization's language.

Public Knowledge Base
If multilingual solution search is enabled for your public knowledge base, customers can choose to view
solution search results in a specific language or all supported languages via a language drop-down list. By
default, the public knowledge base displays in your organization's language.

Solution Categories
Users with the "Manage Translation" permission can translate solution categories so that they display in
the language of each user on the Solutions tab and in the preferred language of each customer on the
Self-Service portal as specified in the customer's Self-Service user information settings. Solution categories
are not translated for the public knowledge base.
To translate solution categories, see "Entering Translated Terms" in the Salesforce online help.

Reports
You can track translated solutions marked Out of Date by choosing the Translated Solutions report.
Running this report also lists the title and details of translated solutions. You can also create a custom
report for multilingual solutions using the Master and Translated Solutions report type. For more
information, see "Support Reports" in the Salesforce online help.

List Views
You can see which translated solutions are marked Out of Date and may need translating by creating
a custom list view on the Solutions tab and entering the following search criteria: "Out of Date equals
True".

Import
The solutions import wizard includes options to import master and translated solutions and associate
them with each other. For more information, see "What Is Imported for Solutions?" in the Salesforce
online help.

To learn more about enabling multilingual solutions, see "Enabling Multilingual Solutions" in the Salesforce online help.

90

   
Salesforce CRM Multilingual Solutions



Enabling Multilingual Solutions

User Permissions Needed

"Customize Application"To enable multilingual solutions:

You can turn on multilingual solutions so users have the ability to translate solutions into multiple languages.

Preparing for Multilingual Solutions

Before you enable multilingual solutions:

• Run solution reports to locate any existing solutions that are already translated and will need to be converted to translated
solutions after you enable multilingual solutions.

When multilingual solutions is enabled for the first time, all existing solutions automatically become master solutions. You
can create translated solutions from master solutions by associating a master solution without any translated solutions with
a master solution of a different language via the Master Solution lookup field.

• Translate any existing solution categories.

Translated solutions inherit the solution categories of their master solution. We recommend that you translate your solution
categories before enabling multilingual solutions and then associate solutions with each other. This will help you associate
solutions with the correct categories. For more information on translating solution categories, see "Entering Translated
Terms" in the Salesforce online help.

Enabling Multilingual Solutions

To enable multilingual solutions:

1. Click Setup ➤ Customize ➤ Solutions ➤ Solution Settings.
2. Click Edit.
3. Select Enable Multilingual Solutions.

Optionally, select Enable Multilingual Solution Search in Self-Service Portal and Enable
Multilingual Solution Search for Public Knowledge Base to allow customers to view solution search results
in a specific language or all supported languages via a language drop-down list. For more information, see "Customizing
Solution Settings" in the Salesforce online help.

4. Click Save.
5. Customize solution page layouts to include the Master Solution Title field, Master Solution Details field,

Out-of-Date field, and the Translated Solutions related list. The Language picklist and Master Solution lookup
fields are automatically added to solution page layouts when you enable multilingual solutions.

Tip: You can make solution edit pages easier for users to translate multilingual solutions by setting the Detail
Information section to two columns and placing the Master Solution Title and Master Solution Details
fields alongside each other. Underneath those fields, place the Solution Title and Solution Details fields
alongside each other so that users can effortlessly compare the master and translated solutions. Note that the
Master Solution Title and Master Solution Details fields display only on the translated solution edit
page.

6. Set the field-level security settings of the Master Solution lookup field to editable for profiles with the "Create" and
"Edit" permissions on solutions.

When the Master Solution lookup field is editable, users can associate translated solutions with master solutions.

Field-level security is available in Enterprise, Unlimited, and Developer Editions only.
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7. As a best practice, add a long text area custom field to solutions called Translation Comments and include it on solution
page layouts so that users can add any comments regarding the translation of the solution. Users should include a date with
their comments so that other users can see when each comment was added.

Note: You can deselect the Enable Multilingual Solutions checkbox at any time, but deselecting it removes
all associations between master and translated solutions and automatically disables the Enable Multilingual
Solution Search in Self Service Portal and Enable Multilingual Solution Search for Public
Knowledge Base settings. If you select the Enable Multilingual Solutions checkbox again, the associations
between master and translated solutions are restored.

Rolling Out Multilingual Solutions

After enabling multilingual solutions:

• Associate any existing translated solutions with the appropriate master solutions.

You can do this manually using the Master Solution lookup field, or you can export a report of existing translated
solutions and then import those solutions to associate them with a master solution. For each translated solution you import,
include the 15 to 18 character Solution ID field of its master solution in a master solution column on your import file.
To view the Solution ID field for master solutions, run the Translated Solution report. To learn more about importing
solutions, see "What Is Imported for Solutions?" in the Salesforce online help. If you import solutions by mistake, you can
use mass delete to remove them from your organization. See "Deleting Mass Data" in the Salesforce online help.

Customizing Solution Settings

User Permissions Needed

"Customize Application"To change solution settings:

To customize solution settings:

1. Click Setup ➤ Customize ➤ Solutions ➤ Solution Settings.
2. Click Edit.
3. Select Enable solution browsing to turn on the ability to browse for and find solutions by category.

This setting enables solution browsing on the Solutions tab and when solving a case. For information on translating solution
categories into multiple languages, see "Entering Translated Terms" in the Salesforce online help.

4. Select Enable Multilingual Solutions to turn on the ability for users to translate solutions into multiple languages.
For more information, see "What are Multilingual Solutions?" in the Salesforce online help. To further customize your
organization for multilingual solutions, see "Enabling Multilingual Solutions" in the Salesforce online help.

You can deselect the Enable Multilingual Solutions checkbox at any time, but deselecting it removes all associations
between master and translated solutions and automatically disables the Enable Multilingual Solution Search
in Self Service Portal and Enable Multilingual Solution Search for Public Knowledge Base
settings. If you select the Enable Multilingual Solutions checkbox again, the associations between master and
translated solutions are restored.

5. Select Enable Multilingual Solution Search in Self-Service Portal to add a language drop-down list to
the Self-Service portal that automatically restricts search results to solutions that match the Self-Service portal user’s
language. From the language drop-down list, Self-Service portal users can choose whether to search for solutions in a
specific language or any language supported by Salesforce.

Deselecting this checkbox removes the language drop-down list from the Self-Service portal, and search results include
solutions in all languages, regardless of the Self-Service portal user's language.
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6. Select Enable Multilingual Solution Search for Public Knowledge Base to add a language drop-down
list to the public knowledge base so that public knowledge base users can choose which language to search for solutions.
From the language drop-down list, public knowledge base users can choose whether to search for solutions in a specific
language or any language supported by Salesforce.

Deselecting this checkbox removes the language drop-down list from the public knowledge base, and search results include
solutions in all languages.

7. Click Save.
8. To enable solution browsing by customers in the public knowledge base or yourSelf-Service portal, see "Enabling the

Public Knowledge Base" in the Salesforce online help and "Enabling Self-Service Features and Settings" in the Salesforce
online help.

In addition, you can customize the top-level category accessible by public knowledge base andSelf-Service users. You do
not need to modify this setting if you want customers to view all categories and all solutions that are visible in the Self-Service
portal or visible in the public knowledge base.

Setting Multilingual Solution Statuses

User Permissions Needed

"Edit" on solutionsTo change the status of translated solutions:

After you modify a master solution, you can adjust the statuses of each translated solution associated with it and notify users
to update those translations, if necessary:

1. Choose a status for the translated solution from the Status picklist. For example, Draft, Reviewed, or Duplicate. The
picklist values available for you to choose from are set by your administrator.

2. Select the Out of Date checkbox to indicate that the master solution has been updated and that the translated solution
may need translating. The translated solution will be marked Out of Date on the Translated Solution related list of the
master solution.

3. Select the Send Notification checkbox if you want the last active user who created or modified the solution to receive
an email notifying them that the master solution has been updated and that the translated solution may need translating.

The user displayed in the Notification Recipient column will receive the email. Email notices are system-generated
and cannot be modified. The email notification is in the language of the notification recipient.

4. Click Save.

Deleting Solutions

User Permissions Needed

"Delete" on solutionsTo delete unpublished solutions:

"Manage Published Solutions"To delete published solutions:

To delete a solution, click Del next to the solution on the solutions list page, or click Delete on the solutions detail page. The
Del link is displayed only for solution managers, administrators, and users with the "Manage Published Solutions" or "Delete"
permission on solutions.

When you delete a solution, all related history and attachments are also deleted. The solution is moved to the Recycle Bin.
Associated cases are not deleted with the solution, but the case associations are removed and are not restored if you later
undelete the solution.
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For organizations with multilingual solutions enabled:

• Deleting a master solution does not delete the translated solutions associated with it. Instead, each translated solution
becomes a master solution.

• Deleting a translated solution removes the association with its master solution.
• Undeleting a master or translated solution from the Recycle Bin does not restore its associations with other master or

translated solutions. You can manually restore the associations by modifying the Master Solution lookup field on the
edit page of translated solutions.

• After deleting a translated solution, you can create a new translated solution in the same language. However, you will not
be able to undelete the original translated solution from the Recycle Bin until you delete the second translated solution.

Additional Salesforce Enhancements

Account Enhancements

• The Account Name field can now contain up to 255 characters.
• The Partners related list on account detail pages can be customized to display your choice of fields.

Account Team Enhancements

• You can now define a default account team that consists of the other users with whom you regularly collaborate on accounts.
To set up your default account team, go to the new Default Account Team related list at Setup ➤ My Personal Information
➤ Personal Information.

• You can assign each account team member a role such as "project manager" or "senior support representative" to reflect
that person's role on the account.

• Depending on your sharing model, you can specify the level of access each account team member will have to the account,
the account's opportunities, and the account's cases.

• You have the option to automatically add your default account team to all of your accounts.
• Please note that account teams are not the same as sales teams, although they share the same set of available team member

roles. Account teams work together on accounts, while sales teams work together on opportunities

Case Enhancements

Case Assignment Rules
You can now add any standard case contact field to rule entry criteria on case assignment rules. Users with
the "Customize Application" permission can create or update rule entries on case assignment rules by
clicking Setup ➤ Customize ➤ Cases ➤ Assignment Rules.

Case Comment Enhancements

• You can now edit or delete comments that have been added to a case if you are an administrator or
have the "Manage All Data" permission.

• You can now send email notification of new or updated case comments to users who are not members
of your Self-Service portal. To enable this option, click Setup ➤ Customize ➤ Cases ➤ Support
Settings.

• In the Cases, Case Lifecycle, Cases with Assets, and Cases with Emails report types, the Case Comment
Information section now displays underneath the Case Information section on the Select Columns
step of the report wizard.

Case Contact Roles
You can now associate more than one contact with a case via case contact roles. Related contacts appear
in the Contact Roles related list on a case, and are associated with a role, such as First Reporter, Account
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Manager, or CIO. To email the primary contact and all contact roles on a case, click Send An Email on
the Contact Roles related list.

Case Contact Name and Account Name Fields

• Before Winter '07, when you updated a contact's account, the contact's cases automatically moved to
the new account. Now, when you update a contact's account, the contact's cases remain associated
with the original account unless you change the Account Name field on the cases.

• When you update the Contact Name field on a case, the Account Name field no longer automatically
defaults to the account associated with the contact when you save the case. However, you can change
the Account Name field during subsequent updates. If the contact is a Self-Service user, he or she
can only view cases on the Self-Service portal that are associated with the account on their contact
record.

Note:  Users who do not have permission to view or edit the Account Name field on cases
are able to do so when they change the contact on a case.

Close Case Page Layout
You can now add the Account Name field to the Close Case Layout.

Close Link on the Cases Related List
You can now close a case directly from the Cases related list by clicking the Cls link.

Email-to-Case Enhancements

Automatic Field Updates
Now, if an inbound email does not contain the email address of an existing contact, then the Web Name
field on the case is automatically updated with the name in the From field of the email, and the Web
Email field on the case is automatically updated with the address provided in the inbound email.

Email Thread Options
With Winter '07, you can to choose whether the thread ID should be included in the emails users send
from cases. The thread ID is the unique ID of each case email, such as [ref:00DxRtp.500xXFKf:ref ]. By
default, the thread ID is added to both the subject and body of case emails. To set thread ID options,
click Setup ➤ Customize ➤ Cases ➤ Email-to-Case ➤ Edit.

Forecast Enhancements

Forecast Summary Reporting on Teams and Inactive Users
Winter '07 allows you to report on forecast summary information for your entire team across any level of
the sales hierarchy. You can also retain an accurate view of forecasts and closed deals even for those sales
representatives who are no longer employed at your company by keeping inactive users enabled as forecast
users.

Forecast Category Details
Drill into the Forecast Summary amount to view the list of deals contributing to that amount and the
forecast categories to which they belong.

Quota Administration
The Apex API now allows you to mass insert or update quotas for your sales representatives
programmatically.
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Help & Training Window Enhancements

Winter '07 includes several enhancements to the Help & Training window to make it easier and faster for you to get the
assistance you need. Click the Help & Training link at the top of any page or the context-sensitive Help for this Page link
on any page to view these enhancements:

• The Home tab of the Help & Training window is redesigned to provide you with more relevant information. It includes
Featured Solutions, a link to the system status at trust.salesforce.com, feeds from the Salesforce blog, and a list of ways to
contact salesforce.com Customer Support.

• An  Email Page link is now available at the top of the window. Click the link to send a URL for the help topic or
knowledge base solution to yourself or anyone else.

• The search results in the Help & Training window now include recommended training classes relevant to your search
keywords.

• The search functionality of the Help & Training window is improved to give you more accurate and relevant results.
Consider these tips when searching for help topics, knowledge base solutions, and training classes:

• Search returns online help topics, knowledge base solutions, and recommended training classes that include all or any
of your keywords. For example, searching for synchronize Outlook may return results with just synchronize, just Outlook,
or both keywords in any order. Items that include more of your keywords are listed higher in results, and items that
contain your keywords as a phrase or near each other are also listed higher.

• Use multiple keywords to narrow your search results. For example, create lead assignment rules returns more specific
results than just assignment rules.

• Search is not case-sensitive. Mail Merge is the same as mail merge.
• Search finds variants of your keywords, for example, searching for creating finds items containing create, creation, or

creating.
• Commonly used words such as the, about, and, and not are ignored.
• Search wildcards, such as * and ?, and operators, such as AND, OR, and AND NOT, are treated like any other keyword.

For example, searching for outlook AND cases is treated exactly the same as outlook cases.

Lead Enhancements

• The lead Company field can now contain up to 255 characters.
• Users with the "Create and Customize Reports" permission can now select options from a View: drop-down list on lead

history reports to filter data by My Leads, My Teams Leads, User Owned Leads, Queue Owned Leads, and All Leads.

Opportunity and Opportunity Products Enhancements

• The Partners related list on opportunity detail pages can be customized to display your choice of fields.
• You can now add custom links for opportunity products. Navigate to Setup ➤ Customize ➤ Products ➤ Buttons and

Links to set up custom links for your opportunity products.
• You can now track discounts at the opportunity product level by referencing the List Price field on opportunity products

in formulas. Simply create a formula: Discount = ListPrice – UnitPrice to calculate the discount amount

Forecast Enhancements

• Deactivated users continue to own opportunities and appear in forecasts and territories. When users are deactivated, their
opportunity forecast overrides, adjusted total overrides, and manager's choice overrides on subordinates' forecasts are frozen.
However, the manager of a deactivated user can apply manager's choice overrides to that user's forecasts. Rollup amounts
will be kept current. If a deactivated user is later reactivated, the user can resume normal work as before.

• In the forecasting hierarchy, "forecast user" has been renamed "forecast manager."
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Reports

Winter '07 includes the following additional enhancements for reports:

• You can now save the hierarchy level when creating reports.
• The Owner field is now available in the Account Owner report lookup.
• All user fields are available for display in the user reports.
• Custom summary formulas can now contain up to 400 characters in length.
• For easier navigation, you are now redirected back to your report after saving it.
• For dashboards, the calculation row limit has been increased to 10000.
• The axis on line and horizontal bar charts now shows fewer, more readable values when the x-axis is a date or picklist value.

Solution Enhancements

Solution Attachments
When adding attachments to solutions, attachments are now restricted by your organization's upload size
limit of 5 MB. The previous limit was 1.5 MB.
For security reasons, users are now prohibited from uploading solution attachments with the following
file extensions: htm, html, htt, htx, mhtm, mhtml, shtm, shtml, acgi.

Publishing Solutions
With Winter '07, the Published checkbox on solutions has been renamed Visible in Self-Service
Portal. Also, the Visible in Public Knowledge Base checkbox is no longer dependent on this
field. You can now publish solutions to your public knowledge base without having to publish them to
your Self-Service portal.

Solution Search Enhancements
The solution search functionality now utilizes "proximity searching" technology. This means solutions
that contain your keywords as a phrase or contain keywords that are near each other are ranked higher in
the search results. This enhancement is designed to achieve more accurate and relevant search results
when searching for solutions on the Solutions tab, when solving a case, or when using suggested solutions.
In all areas of solution search, the search results include solutions that include all or any of your keywords.
For example, searching for synchronize Outlook may return results with just synchronize, just Outlook, or
both keywords in any order. Items that include more of your keywords are listed higher in results, and
items that contain your keywords as a phrase or near each other are also listed higher. In addition, Solution
Search can find variants of your search terms, for example, searching for creating finds solutions containing
create, creation, or creating.
When searching solutions for a case, links now display at the top left-hand corner of solution detail pages
to help you return to the page that lists potential solutions. The links that display are:

• Back to Suggested Solutions List if you are viewing a solution from the suggested solutions list
• Back to Solution Search Results if you are viewing a solution from the solution search results list
• Back to List: Solutions if you are viewing a solution from a solution list view

Note: These links do not display in the Self-Service portal.

Solution Subject and Description Merge Field
You can now add the content of a solution's Solution Title and Solution Detail fields to a text
email template using a single merge field. This means that a generated email with more than one solution
can display each solution title with its corresponding details.
You can use this field on the Edit Text Email Template page, accessed by clicking Setup ➤ Customize
➤ Communication Templates ➤ Email Templates, and choosing Case Fields from the Select
Field Type drop-down list, and then selecting Solution Subject and Description from the
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Select Field drop-down list. Alternatively, you can enter the following merge field value directly into
your email template text: {!Solution.Subject_and_Description}.

Field History Tracking Enhancements

• Users who can view the History related list can now only see the history data on the tracked fields that are visible to them
in their page layouts or via field-level security. For more information, see "Setting Field-Level Security" in the Salesforce
online help.
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APEX

Embedded Mash-Ups
Available in: Team, Professional, Enterprise, Unlimited, and Developer Editions

Build a composite user interface by integrating content and applications using different sources. A composite user interface
provides a seamless user experience that increases user productivity and reduces the cost of Web page development. Key
capabilities of a composite user interface include:

• Custom s-controls on record detail pages

Display custom HTML and JavaScript content, or content from an external URL "inline" with the standard Salesforce
page content.

• Custom s-controls in dashboards

Create "mashboards" by integrating third-party analytics using s-controls in dashboards

• Custom buttons and links

Add custom buttons on any list view, detail page, or related list, and promote them to the button bar to make them easy
to find. In list views or related lists, the buttons can invoke actions on selected records or add new records to the list. Among
other things, custom buttons and links allow you to display a custom user interface within the current page, minus the
header and sidebar. They also support execution of inline JavaScript which can be used with the Salesforce AJAX toolkit
to create new levels of interactivity in the user interface.

• Overrides of standard buttons

Override the behavior of standard buttons on any object to inject your own custom user interface into Salesforce. This
affects the entire organization, essentially replacing the standard action of the button with an instruction to render a specific
custom s-control. Standard buttons can also be removed from any object’s list view, detail page, or related list.

• Custom s-control developer enhancements

Use existing formula functions to do server-side calculations and evaluations before rendering your content. Leverage new
advanced functions and global variables to generate client-side JavaScript.

Locate all s-control references on the "Where is this used?" page.

Create up to 2000 s-controls depending on edition. For the number of s-controls allowed in your edition, see "App Setup
Limits" in the Salesforce online help. If you have previously created more s-controls than are allowed for your edition,
those s-controls will still be available.

In addition, you can now add custom links for opportunity products, tasks, and events.

Implementation Tips

• Custom buttons display at the top and bottom of the detail page to the right of all standard buttons.
• You can include s-controls in any field section on your page layout to display the s-control content "inline" without requiring

users to click a button or link to see it. Simply edit the page layout, choose the s-control, and drag it to any section on the
page layout.

• If your custom link references a URL, create a custom s-control that references that URL so you can include the s-control
directly on your page layout.
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• Custom buttons are not distinguished from standard buttons in any graphical way. However, you can recognize them by
their location on the right of all standard buttons.

• If the button bar gets too wide, the browser displays a horizontal scroll bar.
• The View standard button refers to all of the links in Salesforce that display the detail page for a record. Overriding the

view standard button reroutes all of these links.
• Custom buttons are available for activities under the individual setup links for tasks and events. To add a custom button

to an activity list view, first create a custom list button in tasks or events. Next, add it to your activity list view layout. To
override a button that applies to both tasks and events, click Setup ➤ Customize ➤ Activities ➤ Activity Buttons.

• Custom buttons are not available in Web-to-Lead or Web-to-Case.
• Buttons on search results, lookup dialogs, and tabs, cannot be changed. However, you can change the buttons on list view

layouts under search layouts.
• Buttons on reports cannot be changed.
• Some standard buttons can be overridden, but none can be relocated on the detail page or relabeled.
• If your organization uses person accounts, your person account records use any standard button overrides or custom buttons

and links you have made for accounts. Your person account records also use any overrides for the View Self-Service and
Enable Self-Service buttons you have made for contacts. Use the person account page layouts to edit any custom links or
detail page buttons for person account records. To customize the list view layouts for person accounts, edit the account list
view layout where you access account search layouts.

• If your organization uses the console, list buttons are available in the Mass Action drop-down list. List buttons will not
display in the mini page layouts. Overrides for the Edit and View buttons for an object do not affect the Edit and View
buttons in the mini page layouts. Pages that display due to overrides or custom buttons and links display in the console
without the header or sidebar.

• If you get an error message when overriding a button that appears in a list, try calling the s-control using the "URLFOR"
in the Salesforce online help function.

• When creating custom buttons, be mindful of any validation rules your organization has for records on that object. For
example, a custom list button that changes case status may conflict with a case validation rule. In this scenario, Salesforce
displays the error message for the validation rule when users click the custom button.

Best Practices

Use the following best practices when building s-controls:

• If you create a URL s-control, do not select Show Section Heading on Detail Page in the page layout section where you
put the s-control. This option in conjunction with collapsible sections causes some problems in certain browsers.

• Use global variables to access special merge fields for components like custom buttons, links, and s-controls. For example,
the $Request global variable allows you to access query parameters inside a snippet, s-control, or custom button.

• Use the {!$Organization.UISkin} merge field in your s-control to retrieve the User Interface Theme that the organization
has selected. The "Theme1" value for this merge field represents the Salesforce Classic theme and "Theme2" represents
the Salesforce theme. To view this merge field in an example, see "Useful S-Controls" in the Salesforce online help.

• S-controls use the {! and } characters (previously used to surround merge fields in formulas) to enclose an expression, which
can include one or more merge fields, functions, or global variables.

• When overriding an action, use the no override argument to prevent a recursion, indicated by empty frames on the
page. For example, the following s-control overrides the case close action:

<html>
<head>
<script src="/soap/ajax/8.0/connection.js">
</script>
<script>
function init()
{
var queryResult = sforce.connection.query("Select count() from CaseSolution Where CaseId
 = '{!Case.Id}'");
var size = queryResult.size;
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if (size > 0) {
//go to the standard case close page without invoking the override
window.parent.location.href = "{!URLFOR($Action.Case.CloseCase, Case.Id, 
[retURL=URLFOR($Action.Case.View, Case.Id)], true)}"
}
else
{
alert("Case must contain at least one solution before it can be closed.");
//go to the standard case detail page
this.parent.location.href = "{!URLFOR($Action.Case.View, Case.Id)}";
}
}
</script>
</head>
<body onload="init()">
<p>&nbsp;</p>
</body>
</html>

See "URLFOR" in the Salesforce online help for more information on this example.
• To insert activity merge fields, select "Event" or "Task" from the Select Field Type drop-down list.

Use the following best practices when creating custom buttons:

• Use formula functions in s-controls or custom buttons with caution. Because functions run on the server before your
HTML or JavaScript is passed to the browser, they can only evaluate information that exists at that time. Avoid using
functions like IF to evaluate conditions that only exist when the code reaches the browser, such as the value of a JavaScript
variable that is returned from your code.

• To prevent a user from performing a particular action, such as creating or editing, change the user's permissions rather
than hiding the standard button. Hiding a standard button removes it from a page layout but the link is still available and
users can navigate to the new or edit page manually.

• Use global variables to access special merge fields for components like custom buttons, links, and s-controls. For example,
the $Request global variable allows you to access query parameters inside a snippet, s-control, or custom button.

• To insert activity merge fields, select "Event" or "Task" from the Select Field Type drop-down list.

Availability

Custom buttons and links are available on:

• All custom objects
• All standard objects except documents, forecasts, price books, roles, and territories
• All standard related lists except Notes & Attachments, Attachments, HTML Email Status, Account Teams, Contact

Roles, Partners, Case Comments, Price Books, Quotas, Personal Groups, Login History, Approval History, Lead History,
and Solutions

• Custom links, but not custom buttons, are available on users and custom home pages

Setting Up a Composite User Interface

About S-Controls

Use s-controls to add your own functionality to your Salesforce organization. Whether you are integrating a hosted application
of your own or are extending your current Salesforce user interface, use s-controls to store your code or refer to code elsewhere.

S-controls are components that you set up and define in Salesforce to store your custom code. Use s-controls to create and
display your custom data forms within Salesforce using components like custom links, web tabs, or custom buttons. For
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example, you can define a custom s-control containing HTML or JavaScript and address merge fields to display a map of a
contact's address.

An s-control can contain any type of content that displays or runs in a browser. For example, the content of an s-control can
be a Java applet, an ActiveX control, an Excel file, or a custom HTML web form. S-controls have the following attributes:

DescriptionAttribute Name

The text that displays on page layouts for embedded s-controls.Label

The unique name for the s-control. It must contain alphanumeric characters only and begin
with a letter.

S-Control Name

Determines how you plan to use the s-control:

HTML
Select this option if you want to enter the content for your s-control in the Content area.

Type

URL
Select this option if you want to enter the link or URL of an external website in the Content
area.

Snippet
Snippets are s-controls that are designed to be included in other s-controls. Select this
option if you want to enter the content for your s-control snippet in the Content area.

Text that describes the s-control. This only displays to administrators.Description

Enter the content or source for your s-control. You can enter up to 1 million characters in this
field. The HTML code defines exactly how your users should view the custom s-control.

Content

• To pass specific Salesforce data, choose the data type in the Select Field Type drop-down
list and choose one of the fields listed in the Insert Field drop-down list.

• To insert an operator, choose the appropriate operator icon from the Insert Operator
drop-down list. Use the examples in "Operators and Functions" in the Salesforce online
help.

• To insert a function, double-click its name in the list, or select it and click Insert Selected
Function. To filter the list of functions, choose a category from the Functions drop-down
list. Select a function and click Help on this function to view a description and examples
of formulas using that function.

• To reference a file that you uploaded in the Filename field as part of the custom s-control,
select "Custom S-Control" from the Select Field Type drop-down list, and choose
"Custom S-Control URL" to get the merge field for it. For a Java Applet, you can also use
the {!Scontrol_JavaCodebase} merge field and the {!Scontrol_JavaArchive} merge field.

• To insert activity merge fields, select "Event" or "Task" from the Select Field Type
drop-down list.

Tip:  Internet standards require special encoding for URLs. Salesforce automatically
encodes the text from any merge field you insert into a link. Encode any additional
text in your link manually. For example, to generate the following URL:

http://www.google.com/search?q={!user.name} Steve Mark 50%

Use this content:

http://www.google.com/search?q={!user.name}+Steve+Mark+50%25
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DescriptionAttribute Name

Upload a file to display when you add this custom s-control to a custom link.The file can contain
a Java applet, Active-X control, or any other type of content you want. This option only applies
to HTML s-controls.

Filename

This option is a hint that tells Salesforce that this s-control should be cached to improve
performance, if possible. This option only applies to HTML s-controls.

Prebuild In Page

The default encoding setting is Unicode (UTF-8). Change it if you are passing information to
a URL that requires data in a different format. This option is available when you select "URL"
for the Type.

Encoding

S-Control Terminology

The following terminology is used for custom s-controls in Salesforce:

Advanced Functions
Advanced functions are formula functions designed for use in custom buttons, links, and s-controls. For
example, the INCLUDE advanced function returns the content from an s-control snippet. For more
details on advanced functions, see "Operators and Functions" in the Salesforce online help.

Global Variables
Global variables are special merge fields that you can use to reference data in your organization. For more
information, see "Understanding Global Variables in Custom S-Controls" in the Salesforce online help.

S-Controls
S-controls are components that you set up and define in Salesforce to store your custom code. Use s-controls
to create and display your custom data forms within Salesforce using components like custom links, web
tabs, or custom buttons. For example, you can define a custom s-control containing HTML or JavaScript
and address merge fields to display a map of a contact's address.

Snippet
Snippets are s-controls that are designed to be included in other s-controls. Similar to a helper method
that is used by other methods in a piece of code, a snippet allows you to maintain a single copy of HTML
or JavaScript that you can reuse in multiple s-controls.

Defining Custom S-Controls

User Permissions Needed

"Customize Application"To create, edit, and delete custom s-controls:

The custom s-control library is a place where you can store and upload content for use in many areas within Salesforce such
as: custom links, web tabs, custom buttons, and dashboards. S-controls provide a flexible, open means of extending the
Salesforce user interface, including the ability to create and display your own custom data forms.

An s-control can contain any type of content that you can display or run in a browser, for example, a Java applet, an ActiveX
control, an Excel file, or a custom HTML web form.

To define an s-control:

1. Click Setup ➤ Build ➤ Custom S-Controls.
2. Click New Custom S-Control, or click Edit to change an existing custom s-control.
3. Enter the following attributes:
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DescriptionAttribute Name

The text that displays on page layouts for embedded s-controls.Label

The unique name for the s-control. It must contain alphanumeric characters only and begin
with a letter.

S-Control Name

Determines how you plan to use the s-control:

HTML
Select this option if you want to enter the content for your s-control in the Content
area.

Type

URL
Select this option if you want to enter the link or URL of an external website in the
Content area.

Snippet
Snippets are s-controls that are designed to be included in other s-controls. Select this
option if you want to enter the content for your s-control snippet in the Content area.

Text that describes the s-control. This only displays to administrators.Description

Enter the content or source for your s-control. You can enter up to 1 million characters in
this field.The HTML code defines exactly how your users should view the custom s-control.

Content

• To pass specific Salesforce data, choose the data type in the Select Field Type
drop-down list and choose one of the fields listed in the Insert Field drop-down list.

• To insert an operator, choose the appropriate operator icon from the Insert Operator
drop-down list. Use the examples in "Operators and Functions" in the Salesforce online
help.

• To insert a function, double-click its name in the list, or select it and click Insert Selected
Function.To filter the list of functions, choose a category from the Functions drop-down
list. Select a function and click Help on this function to view a description and examples
of formulas using that function.

• To reference a file that you uploaded in the Filename field as part of the custom s-control,
select "Custom S-Control" from the Select Field Type drop-down list, and choose
"Custom S-Control URL" to get the merge field for it. For a Java Applet, you can also
use the {!Scontrol_JavaCodebase} merge field and the {!Scontrol_JavaArchive} merge
field.

• To insert activity merge fields, select "Event" or "Task" from the Select Field Type
drop-down list.

Tip:  Internet standards require special encoding for URLs. Salesforce automatically
encodes the text from any merge field you insert into a link. Encode any additional
text in your link manually. For example, to generate the following URL:

http://www.google.com/search?q={!user.name} Steve Mark 50%

Use this content:

http://www.google.com/search?q={!user.name}+Steve+Mark+50%25
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DescriptionAttribute Name

Upload a file to display when you add this custom s-control to a custom link. The file can
contain a Java applet, Active-X control, or any other type of content you want. This option
only applies to HTML s-controls.

Filename

This option is a hint that tells Salesforce that this s-control should be cached to improve
performance, if possible. This option only applies to HTML s-controls.

Prebuild In Page

The default encoding setting is Unicode (UTF-8). Change it if you are passing information
to a URL that requires data in a different format. This option is available when you select
"URL" for the Type.

Encoding

4. Optionally, click Check Syntax to validate all Salesforce merge fields and functions.
5. Click Save when you are finished. Alternatively, click Quick Save to save and continue editing.
6. Create a custom button or link to display the custom s-control to your users. See "Defining Custom Buttons and Links"

in the Salesforce online help. Alternatively, create a web tab using the custom s-control, add the s-control to a page layout,
or add the s-control to a dashboard.

Useful S-Controls

User Permissions Needed

"Customize Application"To create, edit, and delete custom s-controls:

Creating Accounts

While Salesforce provides many buttons and options for creating new accounts, you may want to add that ability to a custom
object page layout or web tab. Use the following s-control to create a link to the new account page:

<html>
<body>
{!LINKTO("Create a New Account", $Action.Account.New,
   $ObjectType.Account)}
</body>
</html>

This example uses the $Action global variable to access the new account page in Salesforce.

For more information on using this function, see "LINKTO" in the Salesforce online help.

Including Snippets

Include snippets in your custom s-controls to reuse common code. The following example references a snippet that provides
a header for a page that you created to display in a web tab. It displays the page title "My Title." Use the $SControl global
variable to call a snippet.

<html>
<body>
{! INCLUDE($SControl.Header_Snippet, 
[title = "My Title", theme = "modern"])}
</body>
</html>

For more information on using this function, see "INCLUDE" in the Salesforce online help.
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Overriding the Close Case Page

Validation rules are a useful way of validating data on a record before saving it. However, you may want to validate the data
associated with a record. Use an s-control like the one below to ensure that a case is associated with at least one solution before
users are allowed to close it:

<html>
<head>
<script src="/soap/ajax/8.0/connection.js">
</script>
<script>
function init()
{
var queryResult = sforce.connection.query("Select count() from CaseSolution Where CaseId =
 '{!Case.Id}'");
var size = queryResult.size;
if (size > 0) {
//go to the standard case close page without invoking the override
window.parent.location.href = "{!URLFOR($Action.Case.CloseCase, Case.Id, 
[retURL=URLFOR($Action.Case.View, Case.Id)], true)}"
}
else
{
alert("Case must contain at least one solution before it can be closed.");
//go to the standard case detail page
this.parent.location.href = "{!URLFOR($Action.Case.View, Case.Id)}";
}
}
</script>
</head>
<body onload="init()">
<p>&nbsp;</p>
</body>
</html>

To implement this functionality, create an s-control with the content above. Then, override the close case action using the
s-control. The s-control displays a message to users when they click Close Case on a case with no associated solutions. If the
case is associated with at least one solution, the standard close case page displays as usual. This override does not apply to
records updated using the API.

For more information on using this function, see "URLFOR" in the Salesforce online help.

Understanding Global Variables in Custom S-Controls

User Permissions Needed

"Customize Application"To create, edit, and delete custom s-controls:

S-controls allow you to use special merge fields to reference the data in your organization. Use the following global variables
when choosing a merge field type to add to your s-control:

$Action

A global merge field type to use when referencing standard
Salesforce actions such as creating new accounts, editing

Description:

accounts, and deleting accounts. Use action merge fields in
LINKTO and URLFOR functions to reference the action
selected.
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Use:
1. Select the field type: $Action.
2. Insert a merge field, such as $Action.Account.New.

The s-control below references the standard action for creating
new accounts in the $Action.Account.New merge field.
<html>
<body>

S-Control Example:

{!LINKTO("Create a New Account", 
$Action.Account.New,
   $ObjectType.Account)}
</body>
</html>

Tips:
• This global variable is only available for custom buttons,

links, and s-controls.

$ObjectType

A global merge field type to use when referencing standard
or custom objects such as accounts, cases, or opportunities.

Description:

Use object type merge fields in LINKTO,
GETRECORDIDS, and URLFOR functions to reference a
specific type of data.

Use:
1. Select the field type: $ObjectType.
2. Select an object to insert a merge field representing that

object, such as $ObjectType.Case.

The custom list button below references the cases standard
object in the $ObjectType.Case merge field.
{!REQUIRESCRIPT("/soap/ajax/8.0/connection.js")}

Custom Button Example:

var records = 
{!GETRECORDIDS($ObjectType.Case)}; 
var newRecords = []; 

if (records[0] == null) 
{ 
alert("Please select at least one row") 
} 
else 
{ 
for (var n in records) { 
var c = new sforce.SObject("Case"); 
c.id = records[n]; 
c.Status = "New"; 
newRecords.push(c); 
} 

result = 
sforce.connection.update(newRecords); 

window.location.reload(); 
}

107

   
Apex Embedded Mash-Ups



Tips:
• This global variable is only available for custom buttons,

links, and s-controls.

$Request

A global merge field to use when referencing a query parameter
by name that returns a value.

Description:

Add $Request manually to your s-control.Use:

The snippet below, named Title_Snippet, requires two input
parameters: titleTheme and titleText. You can reuse it

S-Control Example:

in many s-controls to provide page title and theme in your
HTML.

<h2 class=”{!$Request.titleTheme}.title”>
{!$Request.titleText}</h2>

The s-control below calls this snippet using the INCLUDE
function, sending it the parameters for both the title and theme
of the HTML page it creates.

<html>
<head>
</head>
<body>
{! INCLUDE($SControl.Title_Snippet, 
[titleTheme = "modern", titleText = "My 
Sample Title"]) }

... Insert your page specific content here 

...

</body>
</html>

Tips:
• This global variable is only available for custom buttons,

links, and s-controls.

$SControl

A global merge field type to use when referencing an existing
custom s-control by name. Use s-control merge fields in

Description:

LINKTO, INCLUDE, and URLFOR functions to reference
one of your custom s-controls.

Use:
1. Select the field type: $SControl.
2. Select an s-control to insert a merge field representing that

s-control, such as $Scontrol.Header_Snippet.
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The s-control below references the snippet in the
$Scontrol.Header_Snippet merge field:
<html>
<body>

S-Control Example:

{! INCLUDE($SControl.Header_Snippet, 
[title = "My Title", theme = "modern"])}
</body>
</html>

Tips:
• The drop-down list for Insert Merge Field lists all

your custom s-controls except snippets. Although snippets
are s-controls, they behave differently. For example, you
cannot reference a snippet from a URLFOR function
directly; snippets are not available when creating a custom
button or link that has a Content Source of "Custom
S-Control;" and you cannot add snippets to your page
layouts. To insert a snippet in your s-control, use the
Insert Snippet drop-down button.

• This global variable is only available for custom buttons,
links, and s-controls.

Setting Custom Buttons and Links

User Permissions Needed

"Customize Application"To create or change custom buttons and links:

Create custom buttons and links to integrate Salesforce data with external URLs, applications, your company’s intranet, or
other back-end office systems.

Custom links can link to:

• An external URL, such as www.google.com or your company’s intranet
• A custom s-control in the custom s-control library, such as a Java applet or Active-X control

Custom buttons can:

• Connect users to external applications, such as a web page that displays a map to a contact's address
• Run an s-control from the s-control library, such as an s-control that escalates a case from the case detail page
• Launch custom links

For both custom links and buttons, you can choose the display window properties that determine how the target of a link or
button is displayed to your users. Custom links and s-controls can include Salesforce fields as tokens within the URL or custom
s-control. For example, you could include an account name in a URL that searches Yahoo:
http://search.yahoo.com/bin/search?p={!Account_Name}. In addition, s-controls can include operators and
functions.
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Defining Custom Buttons and Links

User Permissions Needed

"Customize Application"To create or change custom buttons or links:

Before creating a custom button or link, determine what action you want to occur when a user clicks it. Consider s-controls
if you want the button or link to run a Java applet, HTML page, or other code.

To define custom buttons and links:

1. Select Setup ➤ Customize, select the appropriate tab or users link, and choose Buttons and Links. Custom buttons are
not available on the user object or custom home pages.

Custom buttons and links are available for activities under the individual setup links for tasks and events. However, you
can override a button that applies to both tasks and events by clicking Setup ➤ Customize ➤ Activities ➤ Activity
Buttons.

For custom objects, click Setup ➤ Build ➤ Custom Objects, and select one of the custom objects in the list.

2. Click New from the Custom Buttons and Links section.
3. Enter the following attributes:

DescriptionAttribute Name

The text that displays on user pages for the custom button or link.Label

The unique name for the button or link used when referenced from a merge field. It must
contain alphanumeric characters only and begin with a letter.

Name

Text that distinguishes the button or link from others. This displays only to administrators
when setting up buttons and links.

Description

Determines where the button or link is available on page layouts:

Detail Page Link
Select this option if you want to add the link to the Custom Links section of your page
layouts.

Display Type

Detail Page Button
Select this option if you want to add the custom button to a record's detail page. You
can only add detail page buttons to the Button Section of a page layout.

List Button
Select this option if you want to add the custom button to a list view or related list. You
can only add list buttons to the Related List Section of a page layout or the List View
layout of a search layout.

Choose the outcome of clicking the button or link.

When applicable, some settings have default values. For example, if you choose "Display in
new window," the default height of a new window is 600 pixels. To change these settings,
see "Editing Window Open Properties" in the Salesforce online help.

Behavior

Choose whether to use a URL, s-control, or JavaScript action as the content of the button
or link. To use an s-control, choose "Custom S-Control," and select the s-control from the

Content Source

drop-down list. To use a URL, select "URL," and enter the link below in the text area box
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DescriptionAttribute Name

exactly as it would appear in the address bar of a web browser. To execute JavaScript code
when the button or link is activated, select "OnClick JavaScript," and enter the code in the
text area box below.

Enter the content of the button or link for buttons and links of type URL or OnClick
JavaScript:

Content

• To pass specific Salesforce data, choose the data type in the Select Field Type
drop-down list and choose one of the fields listed in the Insert Field drop-down list.

• To insert an operator, choose the appropriate operator icon from the Insert Operator
drop-down list. Use the examples in "Operators and Functions" in the Salesforce online
help.

• To insert a function, double-click its name in the list, or select it and click Insert Selected
Function.To filter the list of functions, choose a category from the Functions drop-down
list. Select a function and click Help on this function to view a description and examples
of formulas using that function.

• To insert activity merge fields, select "Event" or "Task" from the Select Field Type
drop-down list.

Tip:  Internet standards require special encoding for URLs. Salesforce automatically
encodes the text from any merge field you insert into a link. Encode any additional
text in your link manually. For example, to generate the following URL:

http://www.google.com/search?q={!user.name} Steve Mark 50%

Use this content:

http://www.google.com/search?q={!user.name}+Steve+Mark+50%25

Encoding setting that defaults to Unicode (UTF-8). Change the default encoding setting if
the target of a link requires data in a different format.This is available if your Content Source
is URL.

Link Encoding

4. Optionally, click Check Syntax to validate all Salesforce merge fields and functions.
5. Click Save when you are finished.

Click Quick Save to save and continue editing.

Click Preview to view the URL specified.

Click Cancel to quit without saving your content.

6. "Edit the page layout" in the Salesforce online help for the appropriate tab to display the new button or link.

If you add a custom link for users, it is automatically added to the Custom Links section of the user detail page. Detail
page buttons can only be added to the Button Section of a page layout.

Note: The Link URL can be up to 3000 bytes. When data is substituted for the tokens in the URL, the link may
exceed 3000 bytes. Your browser may enforce additional limits for the maximum URL length.
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Editing Window Open Properties

User Permissions Needed

"Customize Application"To edit custom button or link properties:

Custom buttons and links can open in different types of windows. If you have selected a custom button or link to open in a
popup window, set the window properties. If you leave the window properties blank, the custom button or link will use the
default settings of the user’s browser.

To edit the window open properties:

1. Select the custom button or link by clicking Setup ➤ Customize, selecting the appropriate tab or users link, clicking
Buttons and Links, and selecting the button or link name. Custom buttons are not available on the user object.

For custom objects, click Setup ➤ Build ➤ Custom Objects, and select one of the custom objects in the list.

2. Click Window Open Properties.
3. Edit the following properties:

DescriptionWindow Property

The width (in pixels) of the popup.Width

The height (in pixels) of the popup.Height

The location on the screen where the popup should open.Window Position

Allow users to resize the popup window.Resizeable

Show the browser’s address bar which contains the URL.Show Address Bar

Show browser scrollbars for the popup.Show Scrollbars

Show the browser toolbars. Toolbars normally contain
navigation buttons like Back, Forward, and Print.

Show Toolbars

Show the browser menus. The menus typically contain
option like File and Edit.

Show Menu Bar

Show the status bar at the bottom of the browser.Show Status Bar

Note:  Some properties may not be available depending on the Behavior of the custom button or link. For example,
if you chose "Execute JavaScript," no window open properties are available.

Overriding Standard Buttons

User Permissions Needed

"Customize Application"To override standard buttons:

Salesforce gives you the power to override the action of the standard buttons provided on record detail pages.

Before you override a standard button, review the following considerations:
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• You can override a standard button to run an s-control. To learn more about creating s-controls, see "Defining Custom
S-Controls" in the Salesforce online help.

• If you override a standard button in Salesforce, that button is still available in Offline Edition or Apex Mobile, but it retains
its original behavior.

• You cannot add button overrides to an AppExchange package.
• Only some standard buttons can be overridden. For example, you cannot override the Save or Sharing buttons, but you

can override New, View, Edit, and Delete buttons.
• If a button is not available for overrides, you may still be able to hide it on the page layout.
• You can override buttons on the detail page but not the edit page of a record.
• Button overrides affect everywhere that action or behavior is available. For example, overriding the New button on an

account also overrides the account option in the Create New drop-down list in the sidebar.

To override a standard button or link:

1. Click Setup ➤ Customize, select the appropriate activity or tab link, and then click Buttons and Links.

For custom objects, click Setup ➤ Build ➤ Custom Objects, and select one of the custom objects in the list.

2. Click Override next to the button you want to override in the Standard Buttons and Links section of the page.
3. Select the s-control you want to run when users click the button.
4. Optionally, enter any comments to note the reason for making this change.
5. Click Save.

Button overrides are global throughout Salesforce because overrides control the action behind the button. For example, if
you override the New button on opportunities, your replacement action takes affect wherever that action is available:

• The Opportunities tab home page
• Any Opportunities related lists on other objects such as accounts
• The Create New drop-down list in the sidebar
• Any browser bookmarks for this Salesforce page

To reset an override:

1. Click Setup ➤ Customize, select the appropriate activity or tab link, and then click Buttons and Links.

For custom objects, click Setup ➤ Build ➤ Custom Objects, and select one of the custom objects in the list.

2. Click Reset next to the override.
3. Click OK.

Useful Custom Buttons

User Permissions Needed

"Customize Application"To create or change custom buttons or links:

International Maps

You may have customers in both the United States and United Kingdom and you want to display the appropriate type of
Google map for each account based on the country. Create the following custom link on your account detail page to display
the appropriate type of map depending on the country:

1. Define a custom link for accounts with the following attributes:

• Display Type is "Detail Page Link"
• Behavior is "Display in new window"
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• Content Source is "URL"
• Use the following sample code:

{! 
IF(Account.BillingCountry = "US", 
"http://maps.google.com/maps?q="&Account.BillingStreet&
"+"&Account.BillingCity&"+"&Account.BillingState&"+"&Account.BillingCountry, 
(IF(Account.BillingCountry = "UK", 
"http://maps.google.co.uk/maps?q="&Account.BillingStreet
&"+"&Account.BillingCity&"+"&Account.BillingCountry, 
"http://maps.google.com"))) 
}

2. Add the link to your account page layout.

For more information on using this function, see "IF" in the Salesforce online help.

Reopening Cases

Related lists are valuable because they allow users to perform an action on several records at once. Add a custom list button
to your cases related lists so that users can reopen several cases on an opportunity at once.

1. Define a custom list button for cases with the following attributes:

• Behavior is "Execute JavaScript"
• Content Source is "OnClick Java Script"
• Use the following sample code:

{!REQUIRESCRIPT("/soap/ajax/8.0/connection.js")} 

var records = {!GETRECORDIDS($ObjectType.Case)}; 
var newRecords = []; 

if (records[0] == null) 
{ 
alert("Please select at least one row") 
} 
else 
{ 
for (var n in records) { 
var c = new sforce.SObject("Case"); 
c.id = records[n]; 
c.Status = "New"; 
newRecords.push(c); 
} 

result = sforce.connection.update(newRecords); 

window.location.reload(); 
}

2. Add the custom list button to your opportunity page layouts by editing the Cases related list.

Note:  Notice the check for records[0] == null, which displays a message to users when they do not select at
least one record in the list.
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Viewing References to Salesforce Components

User Permissions Needed

"Customize Application"To create or change custom buttons or links:

"Customize Application"To create, edit, and delete custom s-controls:

You can view a list of all the areas in Salesforce that reference a component. For example, view the custom links, custom
buttons, or page layouts that reference a custom s-control. To do this, click Where is this used? from the detail page of the
component. Salesforce lists the type of component that references the component and the label for that component. Click any
item in the list to view it directly.

User Interface Customization - Renaming Standard Tabs and
Fields

Available in: Team, Professional, Enterprise, Unlimited, and Developer Editions

Integrating Salesforce with existing business processes and legacy systems is critical to any large enterprise. In the Summer
'06 release, we provided the means to rename standard tabs. Now with Winter '07, you can also rename standard fields and
other labels. Renaming standard fields ensures that standard terminology is consistent across multiple systems and avoids
creating duplicate custom fields.

Implementation Tips

• Audit all fields before renaming any standard fields.
• You can rename standard fields on accounts, activities, assets, campaigns, cases, contacts, contracts, documents, events,

leads, opportunities, partners, price books, products, solutions, and tasks.
• The renamed labels display on all user pages in Salesforce including Personal Setup. However, all pages in the Setup area

use the default, original labels.
• Some standard fields, such as Created By and Last Modified By, are purposely omitted from renaming because they

track system information.
• Outlook Edition and Offline Edition use your new names.

Best Practices

• Plan your renaming carefully so that you do not rename a standard field the same name as one of your custom fields. Begin
by auditing your usage of custom fields for duplicate fields so that you do not have fields designed to store the same
information. Next, plan a transition before you rename. For example, determine how renamed fields will impact users and
how you will broadcast the new labels.

• After renaming tabs, objects, or fields, check the following additional items that may need manual updates:

• Review all list view names. List view names continue to display the original object name until you change them manually.
• Check standard report names and descriptions for the objects you renamed. If standard report names contain the old

name, update them accordingly.
• Update the titles and descriptions of any email templates that contain the original object or field name.
• Manually change any other items you customized with the standard object or field name. For example, custom fields,

page layouts, and record types may contain the original tab or field name.
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• If you have renamed tabs, objects, or fields, you can also replace the Salesforce online help with another URL. Users
can view this URL whenever they click on any context-sensitive help link on an end-user page or within Personal Setup.
After you replace the help, the Help & Training link at the very top of every page and all Administration Setup pages
will continue to display Salesforce online help. For instructions on replacing the online help, see "Replacing Salesforce
Online Help" in the Salesforce online help.

About Renaming Standard Tabs and Fields

Renaming Tab and Field Labels

User Permissions Needed

"Customize Application"To rename tab and field labels:

"Customize Application"To reset renamed tabs:

You can change the display labels of standard tabs, objects, fields, and other related user interface labels so they better reflect
your organization's business requirements. When you rename a label, such as changing the "Accounts" label to "Companies,"
the new label appears on all user pages, in Outlook Edition, and in Offline Edition. With rare exception, all pages in the Setup
area use the default, original labels.

Developer Edition organizations automatically have renaming enabled; organizations using other Editions can contact
salesforce.com to request renaming. Before renaming tabs, objects, fields, and other related labels, review the implementation
tips for administrators.

1. Click Setup ➤ Customize ➤ Tab Names and Labels ➤ Rename Tabs and Labels.
2. Select your default language from the Select Language drop-down list at the top of the page. After you have renamed

labels in your default language, repeat this procedure for the additional languages used in your organization.
3. Click Edit next to the tab or object you want to rename. Optionally, click Reset to change the name of your renamed tab

or object to its original name.

If the tab you want to rename does not appear in the list, it might be a custom tab. To rename a custom tab, rename the
custom object you used to create it. See "Defining Custom Objects" in the Salesforce online help.

4. Enter the singular and plural forms of the new tab label. Also, select the Starts with a vowel sound checkbox for
labels that start with a vowel. This ensures that the proper article (such as "a" or "an") is used. Then click Next.

A renamed tab or object cannot use the name of another standard tab, custom object, or custom tab.

5. Enter the standard field labels and other user interface labels to be used for the selected tab or object. Be sure to enter both
a singular and plural form for each label that requires it. Also, select the Starts with a vowel sound checkbox for
labels that start with a vowel.

If your organization uses person accounts, see "Renaming Person Account Labels" in the Salesforce online help.

Note: Some standard fields, such as Created By and Last Modified By, are purposely omitted from renaming
because they track system information.

6. Click Save.
7. Repeat this procedure to translate labels into all other languages used in your organization.
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Tip:  After renaming a tab or object, rename any custom reports, dashboards, profiles, custom fields, and list views
that contain the original name. You can modify labels for custom field names, picklist values, record types, page layout
sections, solution categories, field validation error messages, custom app names, custom s-control labels, custom buttons
and links, and division names using the translation workbench. To rename a standard report, click Save As from the
report wizard and save it to a report folder designed for your new name.

Renaming Person Account Labels

Person accounts available in: Enterprise, Unlimited, and Developer Editions

If your organization uses person accounts, you can rename the following standard field labels:

DescriptionTabField

An account that is not a person account because it does not
have a record type specific to person accounts. This label is

AccountsBusiness Account

primarily used to clarify the type of accounts you are
importing.

A person account. For more information, see below.AccountsPerson Account

A contact that is associated with a business account. This label
is primarily used to clarify the type of accounts you are
importing.

ContactsBusiness Contact

When you rename the Person Account field label, the renamed label appears in Salesforce as follows:

• As a prefix to differentiate person account fields such as Birthdate and Home Phone from business account fields. For
example, Person Account: Birthdate is available as an account column in opportunity reports.

• In the name of the Is Person Account field and icon. For example, if you rename the Person Account field to
"Consumer," then Is Person Account becomes Is Consumer.

Note: The Person Account and Business Account field labels are completely independent from actual record
type names. To customize person account record types, click Setup ➤ Customize ➤ Accounts ➤ Person Accounts
➤ Record Types. To customize business account record types, click Setup ➤ Customize ➤ Accounts ➤ Record
Types.

Data Model Customization - Sharing on Custom Objects
Available in: Enterprise, Unlimited and Developer Editions

With Winter '07, you can now control sharing for custom objects in three ways:

• Set a default sharing model for each of your custom objects
• Create custom object sharing rules to automatically share records based on your requirements
• Have record owners or administrators manually share individual custom object records with anyone of their choosing
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Implementation Tips

• Custom object sharing rules are useful only if you have set the default sharing model to Private or Read Only. To make
this change, click Setup ➤ Security Controls ➤ Sharing Settings, and then click Edit in the Organization-Wide Defaults
section.

• To define sharing rules for custom objects, click Setup ➤ Security Controls ➤ Sharing Settings, and then click New in
the Sharing Rules related list for your custom object.

Best Practices

• To share all records in the system with a particular group of users or a specific role, create a sharing rule that sets the Owned
By field to the “All Internal Users” public group.

• Where possible, use “Roles and Subordinates” over “Roles” to minimize the number of sharing rules that you need to create.

About Custom Object Sharing

By default, the sharing model for custom objects is set to Public Read/Write. Administrators can change this setting by clicking
Setup ➤ Security Controls ➤ Sharing Settings, and then clicking Edit in the Organization-Wide Defaults section.

To edit sharing rules for a custom object, click Setup ➤ Security Controls ➤ Sharing Settings, and then click New in the
Sharing Rules related list for that custom object.

A record owner or administrator can extend sharing of an individual custom object record by clicking Sharing on the record's
detail page.

Data Model Customization - Queues for Custom Objects

Available in: Team, Professional, Enterprise, Unlimited and Developer Editions

With Winter '07, you can now use queues to help your organization manage the distribution of custom object records. When
a custom object record is created, assign it to a queue so that the users who belong to the queue can access it and take ownership
of it as appropriate.

Implementation Tips

• All queues, including those for cases and leads, are now created in a single location under Setup ➤ Manage Users ➤
Queues.

• You can create custom object assignment rules by setting up a workflow rule that reassigns ownership of custom object
records to a queue with a field update on the record owner field.

Best Practices

• Ease queue management by using the same queue for multiple objects. For example, you can define a single queue that
includes both leads and cases. When queue members view the contents of the queue in the Leads tab, they see only leads.
When queue members view the contents of the queue in the Cases tab, they see only cases.

• Remove terminated employees from queues to simplify queue member auditing.
• Use the Owner Alias field in list views and reports to view which records are owned by which queues.
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About Queues for Custom Objects

Setting Up Queues

User Permissions Needed

"Customize Application"

AND

To create or change queues:

"Manage Public List Views"

To set up your queues for leads, cases, or custom objects:

1. Click Setup ➤ Manage Users ➤ Queues.
2. Click New.
3. Enter a name for the queue.
4. Specify an email address to which all notification emails will be sent (for example, when a new record is put in the queue).

This can be an individual user or a distribution list set up via your organization’s email system.
5. Select Send Assignment Email to Members to individually notify all queue members and the specified Queue Email

address when new records are placed in the queue. If this checkbox is not selected, only the Queue Email address is
notified.

Note:  If a Queue Email address is not specified, individual queue members are always notified of new records,
regardless of this checkbox setting.

6. If your organization uses divisions, select the default division for the queue. This determines the division for a record when
it is assigned to the queue via assignment rules or a manual change of ownership.

Note that cases inherit the division of the contact to which they are related, or are assigned to the default global division
if no contact is specified.

7. Specify which objects can be placed in the queue. Your choices can include cases, leads, or any custom objects.
8. Specify which users, roles, public groups, territories, or partner users will be members of the queue.

Only queue members and users above them in the role hierarchy can take ownership of records in that queue, unless the
queue includes leads or cases and your organization has set the lead or case organization-wide defaults to Public
Read/Write/Transfer.

9. Click Save.

Note: When you create a queue, Salesforce automatically creates a corresponding list view. Users can access the queue
list view from the Cases, Leads, or custom object tabs.

Only queue members and users above them in the role hierarchy have access to that queue list view, unless the queue
includes leads or cases and your organization has set the lead or case organization-wide defaults to Public
Read/Write/Transfer.

Once you have defined a queue, you can set up lead or case assignment rules to automatically reassign ownership of leads and
cases to the queue. See "Managing Assignment Rules" in the Salesforce online help.
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For queues that include custom objects, you can accomplish the same thing by setting up a workflow rule that reassigns
ownership of custom object records to a queue with a field update on the record owner field. See "Managing Field Updates"
in the Salesforce online help.

Editing and Deleting Queues

User Permissions Needed

"Customize Application"

AND

To create or change queues:

"Manage Public List Views"

To edit or delete a queue:

1. Choose Setup ➤ Manage Users ➤ Queues.
2. Select the name of the queue.
3. Click Delete to remove the queue, or choose Edit to make changes.

You cannot delete a queue if it is used by an assignment rule or has any records in it.

The queue detail page lists all of the members of the queue. Click Show Members to view the Expanded Queue Membership
related list, which shows you all of the queue members plus any users who have the same access as the queue members because
they are higher in the role hierarchy.

Taking Ownership of Custom Objects in a Queue

To take ownership of custom objects in a queue, view the queue list view on the custom object tab, check the box next to one
or more records, and then click Accept.

Note: You can view and accept records only from queues of which you are a member or if you are higher in the role
hierarchy than a queue member. Administrators, and users with the "Modify All Data" permission, can view and take
records from any queue.

Data Model Customization - Smart Defaulting of Field Values
Available in: Team, Professional, Enterprise, Unlimited, and Developer Editions

With default field values, users can now spend less time entering data into Salesforce and more time working with customers.
Default values allow them to create records more quickly by auto-populating fields that usually contain the same data. Default
field values automatically insert the value of a custom field based on a formula when a new record is created. Administrators
can design default values with clicks, not code, reducing implementation time and costs. With Winter '07, you can now:

• Set default field values
• Create intelligent defaults
• Use new formula functions designed especially for default values
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Implementation Tips

• If a default value is based on the value of a merge field, Salesforce uses the value of the merge field at the time the default
value is executed. If the value of the merge field changes later, the default value is not updated.

• Users can change or remove the default field value on a record.
• Default values should not be assigned to fields that are both required and "unique" in the Salesforce online help, as uniqueness

errors may result.
• If you make an activity custom field universally required, you must also provide a default value.
• If an activity custom field is unique, you cannot provide a default value.
• Default field values are different from formula fields in the following ways: they are only executed once, at record creation;

they are not read only; and the user can change the value but cannot restore the default field value.
• Since the default value is inserted before users enter any values in the new record, you cannot use the fields on the current

record to create a default field value. For example, you cannot create a default field value on a contact that uses the first
initial and last name because those values are not available when you click New to create a contact record. However, you
can use the record type because it is selected before the record edit page displays.

• To apply a different default value for different record types, use the record type as a merge field in a CASE function within
the default field value setup.

• Fields that are not visible to the user due to field-level security are still available in the formula for a default field value.
• Offline Edition and Outlook Edition do not display default values. However, Salesforce inserts the default values when a

user syncs unless the user entered a value.
• Default field values are not available the Self-Service portal.
• Lead conversion, Web-to-Lead, and Web-to-Case do not execute default field values.

Best Practices

• Define user-specific default field values, such as office location or region, by creating custom fields on the user object.
• Create role or job specific default values using the $UserRole and $Profile merge field types.
• Use default values to provide instructional text and make the field read only on the page layout.

Setting Up Default Field Values

About Default Field Values

Use default field values to make your users more productive by reducing the number of fields they need to fill in manually.
Default field values automatically insert the value of a custom field based on a formula when a new record is created.

After you have defined default values:

1. The user chooses to create a new record.
2. Default field value is executed.
3. Salesforce displays the edit page with the default field value pre-populated.
4. The user enters the fields for the new record.
5. The user saves the new record.

The user can change the field's value but the initial default field value is only executed once, during record creation. For
example, you can set the default field value on a custom lead field to seven days after the creation date to signify when to
contact the lead again. You can change this value later, but you cannot automatically restore the value that was seven days after
the creation date.

Set up default field values for the following types of custom fields:
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• Checkbox
• Currency
• Date
• Date/Time
• Email
• Number
• Percent
• Phone
• Picklist (use the default option when setting up the picklist)
• Text
• Text Area
• URL

For a description of these types, see "Custom Field Types" in the Salesforce online help.

Defining Default Field Values

User Permissions Needed

"View Setup and Configuration"To view default field values:

"Customize Application"To define or change default field values:

To define a default field value:

1. Begin by creating a custom field; see "Adding Fields" in the Salesforce online help. You can also define a default value for
an existing custom field; see "Editing Fields" in the Salesforce online help.

2. Choose the type of field to create and click Next. For a list of the types available for default values, see "About Default
Field Values" in the Salesforce online help.

3. Enter the attributes for the field.
4. Enter a default value or define a formula to calculate the default value:

a. Click Show More... to view the formula builder.
b. To pass specific Salesforce data, choose the data type in the Select Field Type drop-down list and choose one of

the fields listed in the Insert Field drop-down list.
c. To insert an operator, choose the appropriate operator icon from the Insert Operator drop-down list. Use the

examples in "Operators and Functions" in the Salesforce online help.
d. Double-click a function to insert it in your formula. For a description of each operator and function, see "Operators

and Functions" in the Salesforce online help.
e. Click Check Syntax to check your formula for errors.

5. Click Next.
6. In Enterprise, Unlimited, and Developer Editions, set the field-level security to determine whether the field should be

visible for specific profiles, and click Next.
7. Choose the page layouts that should display the field. The field is added as the last field in the first two-column section

on the page layout. For user custom fields, the field is automatically added to the bottom of the user detail page.
8. Click Save to finish or Save & New to create more custom fields.

Note: Default values should not be assigned to fields that are both required and "unique" in the Salesforce online
help, as uniqueness errors may result.
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Useful Default Field Value Formulas

User Permissions Needed

"View Setup and Configuration"To view default field values:

"Customize Application"To define or change default field values:

Maximum Discount Rate

Your organization my apply different discount rates to opportunities based on the department of the person creating the
opportunity. Use the following example to set a default value for a custom field called Discount Rate on opportunities.

CASE(User.Department, "IT", 0.25, "Field", 0.15, 0)

In this example, the formula inserts a discount rate of 25% on any opportunity created by a user in the "IT" department or
15% on any opportunity created by someone in the "Field" department. A zero is applied if the creator does not belong to
either of these departments. This is a custom percent field on opportunities that uses the standard user field Department.

For more information on using this function, see "CASE" in the Salesforce online help.

Product Language

You may want to associate a product with its language so that your users know the type of documentation or adapter to include.
Use the following default value formula to automatically set the language of a product based on the country of the user creating
the product. In this example, the default value is "Japanese" if the user's country is "Japan" and "English" if the user's country
is "US." If neither is true, the default value "unknown" is inserted into the Product Language field.

CASE( $User.Country , "Japan", "Japanese", "US", "English","unknown")

For more information on using this function, see "CASE" in the Salesforce online help.

Tax Rate

Use this default value formula to set the tax rate of an asset based on the user's city. Create a custom percent field with the
following default value:

IF($User.City =  "Napa", 0.0750, 
 IF($User.City =  "Paso Robles", 0.0725, 
  IF($User.City =  "Sutter Creek", 0.0725, 
   IF($User.City =  "Los Olivos", 0.0750, 
    IF($User.City =  "Livermore", 0.0875, null
    )
   )
  )
 )
)

In this example, a tax rate of 8.75% is applied to an asset when the user's address is in the city of Livermore. When none of
the cities listed apply, the Tax Rate field is empty. You can also use the Tax Rate field in formulas to automatically calculate
taxable amounts and final sales prices.
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Workflow Field Updates and Outbound Messages
Available in: Enterprise, Unlimited, and Developer Editions

Workflow allows your teams to operate more efficiently using automated business processes for your standardized internal
procedures. Now, use Salesforce to automatically change the value of a field as a result of a workflow rule or approval process.
In addition, you can send a customizable XML message to any desired Web-available listener, eliminating the need to poll
for changes.

Other workflow enhancements in Winter '07 include the following:

• Your workflow rules can now include OR filters. When building a filter, click Advanced Options to specify your advanced
filter conditions, including AND, OR, and NOT conditions between filter rows.

• You can now create up to 300 total rules per object, up to a maximum of 500 rules per organization.
• Workflow rules can now trigger up to 10 workflow actions per action type. Workflow action types include alerts, tasks,

field updates, or outbound messages.
• When defining filter criteria, customize your own special value for dates by entering "NEXT <number> DAYS" or "LAST

<number> DAYS" and inserting the number of days. For example, use "NEXT 7 DAYS" to include each day in the following
week. Insert any number greater than zero without commas.

• If your workflow rules are set up to fire when a record changes, changing the owner of a record will fire the rule.
• You can now update the Owner and Record Type fields on a record as a result of a workflow rule.
• You can now use standard and custom fields from the user object when creating workflow rules.
• You can now create workflow rules for contracts, products, and products on opportunities.

Implementation Tips

Use the following implementation tips for field updates:

• Field updates may affect the information in a related list. For example, if a field such as the Amount or Close Date of
an opportunity is set to be updated, it will affect the Stage History related list on opportunities.

• Read-only fields like formula or auto-number fields are not available for field updates.
• The Language picklist field on multilingual solutions is not available for field updates.
• Field updates function independent of field-level security. Therefore, a workflow rule can update fields even though they

are hidden on the user's page layout.
• The results of a workflow field update cannot trigger other workflow rules.
• The result of a field update is unpredictable when a single workflow rule includes multiple field updates that apply different

values to the same field. Multiple field updates within a rule occur in no particular order.
• The same workflow rule does not reevaluate a record that has changed due to a workflow field update. This prevents an

infinite loop of updates.
• Field updates occur after case assignment, lead assignment, auto-response, and case escalation rules.
• Field updates occur before workflow alerts, tasks, and outbound messages.
• You can define field updates using the Amount field on opportunities but it will only apply to those opportunities that do

not have products. Adding products to an opportunity changes the Amount field to a read-only field that is automatically
calculated and not affected by that field update.

• You can define field updates for the Status field on contracts. However, the value of this field may affect the value of the
Status Category field as well.

• You can define field updates for the Stage field on opportunities, but be aware of how this field affects the Probability
and Forecast Category fields. See "Updating Opportunity Stages" in the Salesforce online help for information on
the relationship between these fields.
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• You can update long text area fields, but the option to insert A specific value restricts you to entering up to 255
characters.

• Some fields, such as Related To and Private fields on activities, are not available for field updates.
• If your organization uses multiple currencies, currency fields are updated using the record's currency. If you choose to

update a field based on a formula, any values in your formula are interpreted in the currency of the record.
• Before changing the type of a custom field, make sure that it is not the target of a field update or referenced in a field

update formula that would be invalidated by the new type.
• You cannot delete a custom field that is referenced by a field update.
• Field updates are tracked in the History related list if you have set history tracking on those fields.
• Validation rules run before assignment rules, auto-response rules, escalation rules, and workflow rules. However, updates

to records based on workflow rules do not trigger validation rules. Therefore, workflow rules can invalidate previously valid
fields.

• If a field update references a specific user, you cannot deactivate that user. For example, if your field update is designed to
change the owner of an account to Bob Smith, change the field update before deactivating Bob Smith.

• You cannot make a field universally required if it is used by a field update that sets the field to a blank value. For details,
see "About Universally Required Fields" in the Salesforce online help.

• Avoid creating a field update for contracts or orders that changes the Status field to any value other than Approved.

Use the following implementation tips for outbound messages:

• Outbound messages require a web service consumer endpoint that is accessible over the Internet. To allow communication
to this endpoint, deploy the endpoint and open at least one port of your firewall.

• Although HTTPS is used to make the outbound call, no authentication is done.
• The session ID included in an outbound message may expire.

Best Practices

• Use field updates on read-only fields to enforce business processes.
• Replace your polling integrations with outbound messages to reduce API load wherever possible.
• Avoid changing the developer name of a field if you use it in an outbound message.
• Be careful when designing field updates because they do not respect field-level security.
• Design field updates and outbound messages carefully so that they do not create infinite loops.

Setting Up Workflow Field Updates and Outbound Messages

Defining Field Updates

User Permissions Needed

"Customize Application"To define, edit, or delete field updates:

Field updates allow you to automatically change the value of a field to a value you specify. To set field updates into action,
associate them with a workflow rule or approval process.

Before you begin, review the "Field Update Considerations" in the Salesforce online help. To define field updates:

1. Click Setup ➤ Customize ➤ Workflow & Approvals ➤ Field Updates.
2. Click New Field Update.
3. Configure the field update.
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Enter a name and description for this field update.a.
b. Choose the object and the field you want to update.
c. Specify the new field value. The available options depend on the type of field you are updating. You can:

• Choose A specific value, and enter the value in the space provided.
• Choose A blank value (null) if you want Salesforce to remove any existing value and leave the field blank.

This option may not be available for several reasons such as the field is required or a checkbox.
• For record owners, choose the user to whom the record should be assigned. For case, lead, and custom object records,

you can also choose a queue for this field. Optionally, select Notify Assignee to send an email to the new record
owner.

• For checkboxes, choose True to select the checkbox and False to deselect it.
• For picklists, select a specific value from the drop-down list, or select the value above or below the current value

based on the sorting specified in the picklist definition. If you sort values alphabetically, the values above or below
may be different for users in other languages.

• Choose Use a formula to set the new value to calculate the new value based on an expression, merge
fields, or other values.

a. To pass specific Salesforce data, choose the data type in the Select Field Type drop-down list and choose
one of the fields listed in the Insert Field drop-down list.

b. To insert an operator, choose the appropriate operator icon from the Insert Operator drop-down list. Use
the examples in "Operators and Functions" in the Salesforce online help.

c. Optionally, insert a function from the Functions list. Functions are pre-built formulas that you can customize
with your input parameters. See "Operators and Functions" in the Salesforce online help for a description of
each operator and function.

d. Click Save.

Defining Outbound Messages

User Permissions Needed

"Customize Application"To define, edit, or delete outbound messages:

Outbound messages send the information you specify to an endpoint you designate. You can set up workflow rules and approval
processes to send outbound messages to an endpoint as a means of getting information to an external service.

When you associate an outbound message with a workflow rule or approval process, the outbound message sends the selected
information to the associated endpoint URL whenever the workflow rule or approval process is triggered. Once the endpoint
URL receives the message, it can take the information from the message and process it, assuming that the Web service has
been configured appropriately.

To define outbound messages:

1. Click Setup ➤ Customize ➤ Workflow & Approvals ➤ Outbound Messages.
2. Click New Outbound Message.
3. Choose the object that has the information you want included in the outbound message, and click Next.
4. Configure the outbound message.

a. Enter a name and description for this outbound message.
b. Enter an endpoint URL for the recipient of the message. Salesforce sends a SOAP message to this endpoint.
c. Select the Salesforce user to use when sending the message. The chosen user controls data visibility for the message

that is sent to the endpoint.
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d. Select Include Session ID if you want the Salesforce session ID included in the outbound message. Include the
session ID in your message if you intend to make API calls and you do not want to include a username and password.
Sending a username and password is less secure than sending a session ID.

e. Select the fields you want included in the outbound message and click Add.

5. Click Save.
6. On the outbound message detail page, click the Click for WSDL link to view the WSDL associated with this message.

The WSDL is bound to the outbound message and contains the instructions about how to reach the endpoint service and
what data is sent to it.

7. To set outbound messages into action, associate them with a workflow rule or approval process.

Note:  If you do not have these options, your organization does not have outbound messaging enabled. Contact
salesforce.com to enable outbound messaging for your organization.

Tracking Outbound Message Delivery Status

User Permissions Needed

"Customize Application"To track outbound messages:

Outbound messages send the information you specify to an endpoint you designate. You can set up workflow rules and approval
processes to send outbound messages to an endpoint as a means of getting information to an external service.

To track the status of an outbound message, click Setup ➤ Monitoring ➤ View the Outbound Message Queue. Alternatively,
click Setup ➤ Customize ➤ Workflow & Approvals ➤ Outbound Messages, and then click View Message Delivery Status.
Here you can view the status of your outbound messages including the total number of attempted deliveries. Click any workflow
or approval process action ID to view the action that triggered it.

Note:  If you do not have these options, your organization does not have outbound messaging enabled. Contact
salesforce.com to enable outbound messaging for your organization.

Approval Process Automation
Available in: Enterprise, Unlimited, and Developer Editions

Automate and enforce practically any business process within your organization: sales, service, human resources, or finance.
With minimal effort, you can build an automated approval process that increases your employees' productivity while decreasing
their workload. With approval process automation in Winter '07, you can:

• Create simple or multiple step approval processes
• Automate anything in your company by creating approval processes for standard and custom objects
• Use the new user field, Delegated Approver, for delegation of approval requests
• Build hierarchical relationship fields on users to designate managers or other users that are authorized to approve approval

requests
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Implementation Tips

• Active approval processes cannot be deleted but they can be deactivated. Before deleting an approval process, make sure
it is inactive and that no records have been submitted for approval. If any records have been submitted, delete them and
remove them from the Recycle Bin.

• After you activate an approval process, you cannot add, delete, or change the sorting of the steps for that approval process.
• Educate your users on the criteria for each approval process and what each of your approval processes does. Users cannot

tell what approval process is triggered when they click Submit for Approval.
• Records are locked while in an approval process. Only users with the "Modify All Data" permission can unlock those locked

records.
• An error message displays for the user submitting an approval request if the approval request needs to go to the user's direct

manager and there is no direct manager for that user.
• An error message displays for the user submitting an approval request if the approval process has a field update that fails

field validation rules. This could happen for a field that is not visible on the user's page layout.
• Approval processes that allow the user to select an approver manually also allow the user submitting a request to select

himself or herself as the approver.
• When the assigned approver is a queue:

• Any queue member can approve or reject an approval request that is assigned to the queue.
• When an approval request is assigned to a queue, the email notification is sent to the email address for the queue.

Depending on your queue settings, an email notification is also sent to each queue member.
• When an approval request is rejected and returned to the previous approver and the previous approver was a queue, the

approval request is assigned to the user who approved it, instead of the queue.
• The Approval History related list displays the queue name in the Assigned To column and the actual user who

approved or rejected the approval request in the Actual Approver column.
• Delegates of all queue members can approve requests when the process step is configured to allow delegated approvers.

Note:  Queues are only available on specific objects. For more information on queues, see "Managing Queues" in
the Salesforce online help.

Best Practices

• Test your approval processes in your Salesforce Sandbox before activating it in your Salesforce organization.
• Clone approval processes to create similar processes quickly.
• Any record can potentially go through multiple approval processes during its lifetime. Therefore, the entry criteria for each

approval process should be specific enough to ensure it does not go through the same process twice.
• Active approval processes are ordered. For optimum performance, sort your approval processes by the criteria a record must

have to be submitted for that approval process. For example, the approval process with the most specific criteria should be
sorted before the approval process with the least specific criteria.

• Give users the "Modify All Data" permission if they are responsible for performing mass actions on pending approval
requests.

• Delegates should periodically check the new standard report, My Delegated Approval Requests, to get a list of all approval
requests they could be responsible for approving.
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About Approval Process Automation

What Are Approval Processes?

User Permissions Needed

Various user permissions required depending on the actionTo use approvals:

Your business runs more efficiently with automated processes. For example, you may already have workflow rules that
automatically send email alerts or assign tasks based on your internal processes. Approvals take automation one step further,
allowing you to specify a sequence of steps that are required to approve a record.

An approval process is an automated process your organization can use to approve records in Salesforce. An approval process
specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records
included in the process, or just records that have certain attributes. An approval process also specifies the actions to take when
a record is approved, rejected, or first submitted for approval.

For example, your organization may have a two-step process for approving expenses: submitted expenses that are less than
$50 are automatically approved, those over $50 must be approved by a manager, and those over $5,000 must also be approved
by a Vice President. In this example, your approval process would specify the following:

• If an expense record is submitted for approval, lock the record so that users cannot edit it and change the status to
"Submitted."

• If the amount is $50 or less, automatically approve the request.
• If the amount is greater than $50, send an approval request to the direct manager.
• If the amount is greater than $5,000 and the first approval request is approved, send an approval request to the Vice

President.
• If all approval requests are approved, change the status to "Approved" and unlock the record.
• If any approval requests are rejected, change the status to "Rejected" and unlock the record.

An approval process includes the following elements:

• A name and description to distinguish it from other approval processes
• Entry criteria if you only want records with certain attributes to be included
• A designated user who can approve requests
• Settings to specify who, if anyone, can change a record once it has been submitted for approval
• Any number of steps that determine the sequence of actions to take when a record matches the criteria. Each step can have

up to 40 actions, 10 of each type: email alerts, field updates, tasks, and outbound messages.
• Up to 40 additional actions that occur when a record is initially submitted
• Up to 40 additional actions that occur when a record is approved
• Up to 40 additional actions that occur when a record is rejected

To begin designing your approval processes, see "Getting Started with Approval Processes" in the Salesforce online help.

Getting Started with Approval Processes

User Permissions Needed

"Customize Application"To create approval processes:
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An approval process is an automated process your organization can use to approve records in Salesforce. An approval process
specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records
included in the process, or just records that have certain attributes. An approval process also specifies the actions to take when
a record is approved, rejected, or first submitted for approval.

Before you begin creating an approval process, review the "Approval Process Checklist" in the Salesforce online help to prepare
for your implementation and determine what wizard to use.

To automate your organization's processes:

1. Create an approval process.
2. Add steps to your approval process.
3. Specify initial submission actions.
4. Specify final approval actions.
5. Specify final rejection actions.
6. If this is the first approval process you are creating:

• Add the Approval History related list to the appropriate page layout.The Approval History related list lets users submit
approval requests and track a record's progress through an approval process from the record detail page. See "Customizing
Page Layouts" in the Salesforce online help.

• Consider adding the Items To Approve related list to your custom home page layouts. It gives users an instant view of
the approval requests they need to approve or reject. For instructions on adding this related list to your home page
layouts, see "Designing Home Page Layouts" in the Salesforce online help.

• If you created any custom user fields for your approval process, populate these fields with the appropriate values.

Note:  Standard reports for approval requests are included in both the Administrative Reports folder and the Activities
Reports folder. See "Administrative Reports" in the Salesforce online help and "Activity Reports" in the Salesforce
online help.

Approval Process Checklist

Plan each approval process carefully to ensure a successful implementation. Review the following checklist about preparing
the appropriate information before creating your approval process.

• Prepare an approval request email template.
• Determine the approval request sender.
• Determine the assigned approver.
• Determine the delegated approver.
• Decide if your approval process needs a filter.
• Design initial submission actions.
• Decide if users can approve requests from a wireless device.
• Determine if users can edit records that are awaiting approval.
• Decide if records should be auto-approved or rejected.
• Determine how many levels your process has.
• Determine the actions when an approval request is approved or rejected.

What email template do you want to use for approval requests?
The email template you specify on an approval process is used when notifying users that an approval
request is assigned to them. Salesforce offers a default email template, which you can modify, or you can
create your own. Evaluate the default email template to see if it is appropriate for your approval process.
If not, create your own email templates to use for your approval request notifications. Include the
appropriate approval process merge fields to link directly to the approval request. For details about using
merge fields, see "About Merge Fields" in the Salesforce online help.
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Determine who should be the sender of approval requests.
The approval request notifications are automatically sent from the user who submitted the record for
approval. You have the option to assign a different return email address to these notifications. Determine
what email address to use.

Who will be responsible for approving requests?
Requests can be approved or rejected by any of the following:

• A manually chosen user or queue
• A user or queue specified by the administrator
• A user listed in a custom hierarchy field on the user detail page

Each step in your approval process can assign approval requests using any of these options.
The option to use a custom hierarchy field allows you to assign approval requests to the submitter's
manager. To do this, create a custom hierarchical relationship field on users called "Direct Manager" and
store each user's manager in that field. Custom hierarchical relationship fields prevent you from selecting
a user that directly or indirectly reports to itself.

Should approval requests be delegated to another user for approval?
An approval request can be approved by a designated delegate for the approver. However, you have the
ability to disable this option. Determine if you want to allow delegated users to approve requests. Then,
for each user, populate the Delegated Approver field on the user's detail page.

What records should be included in this process?
Determine what attributes a record must have to be included in your approval process. If necessary, create
the custom fields to store this information so that you can use it in your filter criteria. For example, if you
want to include expense records from your headquarters office only, create a custom picklist field called
Office Location that has two options: "HQ" and "Field." Then, your filter criteria for the process
would specify that records must have "HQ" in the Office Location field to be included.

What should occur when a record is first submitted for approval?
When users submit a record for approval, Salesforce automatically locks the record so that other users
cannot change it while it is awaiting approval. Decide if you want other workflow actions to occur when
a record is first submitted, such as alerts, tasks, field updates, and outbound messages. These actions
belong on your list of Initial Submission Actions.

Should users be able to approve requests from a wireless device?
Determine if you want to require users to log in to Salesforce to approve requests. Alternatively, you can
set up your approval process to allow users to approve requests remotely using a wireless browser.

Who can edit records that are awaiting approval?
Records submitted for approval are automatically locked. Users with the "Modify All Data" permission
can always unlock a record and edit it. However, you may also specify that the currently assigned approver
can edit the record as well.

Should records be automatically approved or rejected based on certain criteria?
You can set filter criteria in the first step of your process that automatically approves or rejects records.
For example, all expenses submitted with an Amount less than $15 are automatically approved.

How many people need to approve these requests?
An approval process can have several layers of approvals. Determine how many users need to approve
requests and in what order.

Should any actions take place when a request is approved or rejected?
You can set up to 40 additional actions to take place when a request is approved or rejected at each step,
up to 10 of each of the following types:
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DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status,
Priority, and Due Date of the task.

Task

Uses an email template you specify to send an email to a designated recipient.Email

Changes the value of a selected field. You can specify a value or create a formula
for the new value.

Field Update

Sends a message to an endpoint you designate. You can also specify user name
and the data you want included in the message.

Outbound Message

Additionally, you can set up to 40 additional actions to take place when a record has received all necessary
approvals or is completely rejected.

Useful Approval Processes

User Permissions Needed

"Customize Application"To create approval processes:

Use these samples of common approval processes to help you get started creating your own:

• "PTO Requests" in the Salesforce online help
• "Expense Reports" in the Salesforce online help
• "Discounting Opportunities" in the Salesforce online help
• "Job Candidates" in the Salesforce online help

PTO Requests

Most companies require employees to file a PTO (Paid Time Off ) request and have their manager approve it. Here's how to
automate a simple one-step PTO request process using Salesforce.

• If you do not yet have a custom object to track your PTO requests, create a custom object and tab called "PTO Requests."
See "Defining Custom Objects" in the Salesforce online help and "Defining Custom Tabs" in the Salesforce online help.
Add the appropriate fields for your PTO Requests such as Start Date, End Date, and Employee Name.

• Create a custom hierarchical relationship field on the user object called Direct Manager. For each user, enter the manager,
or user responsible for approving these requests, in this field. See "Creating Custom Fields" in the Salesforce online help.

• Create an email template to notify approvers that an approval request needs to be reviewed. Be sure to include one of the
approval process merge fields to take users directly to the approval page. See "Managing Email Templates" in the Salesforce
online help.

• Use the jump start wizard to create an approval process and specify the following:

• Select the PTO Request custom object.
• Select the email template you created for this approval process.
• No need to specify a filter criteria if you want each user to submit PTO requests and have them included regardless of

their attributes.
• Choose the Automatically assign an approver using a custom hierarchy field option so that the

user in the Direct Manager field is automatically assigned as the approver.
• The jump start wizard automatically chooses the record owner as the only person who can submit PTO requests.
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• Add the Approval History related list to the PTO Request object page layout. See "Customizing Page Layouts" in the
Salesforce online help.

• Consider adding the Items To Approve related list to your custom home pages. It gives users an instant view of the approval
requests they need to approve or reject. See "Designing Home Page Layouts" in the Salesforce online help for instructions
on adding this component to your home page layouts.

• If available, use your Salesforce Sandbox to test the approval process.
• Activate the approval process.

Expense Reports

If your company requires that employees file expense reports for managers to approve, automate this process in Salesforce.
Use this example to create a two-step expense report approval process for all employees in your headquarters office. It specifies
that expenses less than $50.00 are automatically approved, those $50 and over require manager approval, and those over $5,000
require additional approval from a VP.

• If you do not yet have a custom object to track your expenses, create a custom object and tab called "Expense Reports."
See "Defining Custom Objects" in the Salesforce online help and "Defining Custom Tabs" in the Salesforce online help.
Add the appropriate fields such as Amount, Description, Status, Start Date, and End Date.

• Create a custom hierarchical relationship field on the user object called Direct Manager. For each user, enter the manager,
or user responsible for approving these requests, in this field. See "Creating Custom Fields" in the Salesforce online help.

• Create an email template to notify approvers that an approval request needs to be reviewed. Be sure to include one of the
approval process merge fields to take users directly to the approval page. See "Managing Email Templates" in the Salesforce
online help.

• Create a custom field on the user object called Office Location. Assign the "HQ" value to users in the headquarters
office location.

• Create the approval process and specify the following:

• Select the Expense Report custom object.
• The filter criteria for this approval process is "Current User: Office Location equals HQ." Records must meet this

criteria before they can be submitted to this approval process.
• Choose the Direct Manager custom field as the next automated approver.
• Select the email template you created for this approval process.
• Choose the record owner or any other user who you want to be able to submit expense reports.
• Create two approval steps:

Name this step "Step 1: Direct Manager Approval"

• Use this filter criteria and specify that records not meeting this criteria are automatically
approved: "Expense: Amount greater or equal 50."

• Choose Automatically assign using the custom field selected earlier
(Direct Manager) to send the approval request to the user in the Direct Manager field
of the user submitting the request.

• If appropriate, choose The approver's delegate may also approve this request
if you want to allow the user in the Delegated Approver field to approve requests.

Name this step "Step 2: VP Approval"

• Use the filter criteria "Expense Amount greater or equal 5000."
• Choose Let user choose the approver so that the first approver can select the

appropriate VP manually.
• If appropriate, choose The approver's delegate may also approve this request

if you want to allow the user in the Delegated Approver field to approve requests.
• Choose Perform ONLY the rejection actions for this step so that the request

returns to the direct manager for changes if the VP rejects the request.
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• Consider creating the following final approval actions:

• Define a field update to automatically change the Status field to "Approved."
• Send an approval notification to the user who submitted the expense report.
• Send an outbound message to your backoffice financial system to print a reimbursement check.

• Add the Approval History related list to the Expense Report object page layout. See "Customizing Page Layouts" in the
Salesforce online help.

• Consider adding the Items To Approve related list to your custom home pages. It gives users an instant view of the approval
requests they need to approve or reject. See "Designing Home Page Layouts" in the Salesforce online help for instructions
on adding this component to your home page layouts.

• If available, use your Salesforce Sandbox to test the approval process.
• Activate the approval process.

Discounting Opportunities

Opportunities that are discounted more than 40% require a CEO approval. Use this example to create a one-step approval
process.

• Create an email template to notify approvers that an approval request needs to be reviewed. Be sure to include one of the
approval process merge fields to take users directly to the approval page. See "Managing Email Templates" in the Salesforce
online help.

• Create a custom percent field on opportunities called Discount Percent so that users can enter a percentage discount.
• Create a custom checkbox field on opportunities called Discount Approved to indicate if the CEO approved the discount.
• Create the approval process and specify the following:

• Select the Opportunity object.
• The filter criteria for this approval process is "Discount Percent greater or equal 0.04." Records must meet this

criteria before they can be submitted to this approval process.
• No need to choose a custom field as the next automated approver because you will specify later in the process that the

CEO must approve all requests.
• Select the email template you created for this approval process.
• Choose the record owner as the only user who can submit a discount request for approval.
• Create one approval step with no filter criteria because all records submitted will need to be approved or rejected. See

"Creating Approval Steps" in the Salesforce online help.
• Choose Assign to and select the name of your CEO.
• If appropriate, choose The approver's delegate may also approve this request if you want to allow the

user in the Delegated Approver field to approve requests.
• Consider creating the following final approval actions:

• Send an approval notification to the user who submitted the discount request.
• Define a field update to automatically select the opportunity Discount Approved checkbox field.

• Add the Approval History related list to the appropriate opportunity page layouts See "Customizing Page Layouts" in the
Salesforce online help.

• Consider adding the Items To Approve related list to your custom home pages. It gives users an instant view of the approval
requests they need to approve or reject. See "Designing Home Page Layouts" in the Salesforce online help for instructions
on adding this component to your home page layouts.

• If available, use your Salesforce Sandbox to test the approval process.
• Activate the approval process.
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Job Candidates

When your company interviews candidates for a position, you may have several levels of approval before you can send an offer
letter. Use this example to create a three-step approval process that requires approval from multiple levels of management.

• If you do not yet have a custom object to track candidates, create a custom object and tab called "Candidates." See "Defining
Custom Objects" in the Salesforce online help and "Defining Custom Tabs" in the Salesforce online help. Add the
appropriate fields such as Salary, Offer Extended (checkbox), and Date of Hire.

• Create a custom hierarchical relationship field on the user object called Direct Manager. For each user, enter the manager,
or user responsible for approving these requests, in this field. See "Creating Custom Fields" in the Salesforce online help.

• Create an email template to notify approvers that an approval request needs to be reviewed. Be sure to include one of the
approval process merge fields to take users directly to the approval page. See "Managing Email Templates" in the Salesforce
online help.

• Create the approval process using the following specifications:

• Select the Candidate custom object.
• No need to enter a filter criteria because you want all submitted offers to be approved.
• Choose the Direct Manager custom field as the next automated approver.
• Select the email template you created for this approval process.
• Choose the record owner or any other user that you want to be able to submit offer letters.
• Create three approval steps:

Name this step "Step 1: Direct Manager Approval"

• No filter necessary as you want all records to advance to this step.
• Choose Automatically assign using the custom field selected earlier

(Direct Manager) to send the approval request to the user in the Direct Manager field
of the user submitting the request.

• If appropriate, choose The approver's delegate may also approve this request
if you want to allow the user in the Delegated Approver field to approve requests.

Name this step "Step 2: VP Approval"

• No filter necessary as you want all records to advance to this step.
• Choose Let the user choose the approver to allow the direct manager to select the

appropriate VP to approve the request.
• If appropriate, choose The approver's delegate may also approve this request

if you want to allow the user in the Delegated Approver field to approve requests.
• Choose Perform ONLY the rejection actions for this step so that the request

returns to the direct manager for changes if the VP rejects the request.

Name this step "Step 3: CFO Approval"

• No filter necessary as you want all records to advance to this step.
• Choose Assign to and select the name of your CFO.
• If appropriate, choose The approver's delegate may also approve this request

if you want to allow the user in the Delegated Approver field to approve requests.
• Choose Perform all rejection actions for this step AND all final

rejection actions. (Final Rejection) so that offer letters rejected by your CFO
are completely rejected.

• Consider creating the following final approval actions:

• Send an approval notification to the user who submitted the offer letter request.
• Define a field update to select the Offer Extended checkbox field.
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• Consider creating the following final rejection actions:

• Send a notification to the direct manager that the offer will not be extended.

• Add the Approval History related list to the Candidates object page layout. See "Customizing Page Layouts" in the
Salesforce online help.

• Consider adding the Items To Approve related list to your custom home pages. It gives users an instant view of the approval
requests they need to approve or reject. See "Designing Home Page Layouts" in the Salesforce online help for instructions
on adding this component to your home page layouts.

• If available, use your Salesforce Sandbox to test the approval process.
• Activate the approval process.

Choosing an Approval Process Wizard

Approval processes require planning and preparation. Before you create an approval process, determine which wizard is best
for your needs.

Jump Start Wizard
The jump start wizard is useful for simple approval processes with a single step. Use the jump start wizard
if you want to create an approval process quickly by allowing Salesforce to automatically choose some
default options for you. For a list of the options the jump start wizard chooses automatically, see "Approval
Process Jump Start Default Selections" in the Salesforce online help.

To create an approval process using the jump start wizard, see "Using the Approval Process Jump Start
Wizard" in the Salesforce online help.

Standard Wizard
The standard wizard is useful for complex approval processes. Use it when you want to fine tune the steps
in your approval process. The standard wizard consists of a setup wizard that allows you to define your
process and another setup wizard that allows you to define each step in the process.

To create an approval process using the standard wizard, see "Creating Approval Processes" in the Salesforce
online help.

Creating Approval Processes

User Permissions Needed

"Customize Application"To create approval processes:

An approval process is an automated process your organization can use to approve records in Salesforce. An approval process
specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records
included in the process, or just records that have certain attributes. An approval process also specifies the actions to take when
a record is approved, rejected, or first submitted for approval.

Before you begin, determine which wizard to use. See "Choosing an Approval Process Wizard" in the Salesforce online help.
To create an approval process:

1. Launch the approval process wizard.
2. Specify name and description.
3. Specify filter criteria.
4. Specify approver field and record editability.
5. Select email notification template.
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6. Configure approval request page layout.
7. Specify initial submitters.
8. Activate the approval process.

Launch the approval process wizard

1. Click Setup ➤ Customize ➤ Workflow & Approvals ➤ Approval Processes.
2. Choose the object for the new approval process.
3. Click Create New Approval Process and choose Use Standard Setup Wizard from the drop-down button. Alternatively,

click Use Jump Start Wizard if you want to create a basic approval process with default settings. For instructions on using
the jump start wizard, see "Using the Approval Process Jump Start Wizard" in the Salesforce online help.

Specify name and description

1. Enter a name for the new approval process.
2. Optionally, enter a description to distinguish this approval process from others.
3. Click Next. If you are editing an existing approval process and do not want to make further changes, click Save to store

your changes.

Specify filter criteria

If only certain types of records should enter this approval process, you must enter filter criteria. For example, if only employees
from headquarters should use this approval process to submit expense reports, then you would enter the following filter criteria:
"Current User: Office Location equals Headquarters."

1. Enter filter criteria that records must match in order to be included in this approval process. Leave the filter blank if you
want all records submitted to be included in the approval process. For information on using filter criteria, see "Entering
Filter Criteria" in the Salesforce online help.

Note:  Select a current user field if you want the filter based on the user submitting an approval request.

2. Click Next. If you are editing an existing approval process and do not want to make further changes, click Save to store
your changes.

Specify approver field and record editability

When you define approval steps, you can assign approval requests to different users. One option is to use a custom user field
to automatically route these requests. To see some examples of specifying a custom user field as an approver field, see "Useful
Approval Processes" in the Salesforce online help.

When a record is in the approval process, it will always be locked--only an administrator will be able to edit it. However, you
may choose to also allow the currently-assigned approver to edit the record.

1. From the Next Automated Approver Determined By picklist, select a custom user field if you want Salesforce to
automatically assign approval requests to an approver based on the value in the custom user field. For example, you may
want approval requests automatically routed to a user's manager as specified in a custom Direct Manager user field.

• To specify a single user to approve all approval requests, leave this field blank. You can select a single user as the approver
when creating an approval step.
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Caution:  Leaving the Next Automated Approver Determined By field blank prevents you from
automatically assigning approval requests to an approver in any step you create for this approval process.

• To create a new custom hierarchy field that stores the direct manager for each user, click Create New Field from
this option. For more information, see "Creating Custom Fields" in the Salesforce online help.

Note:  Make sure the assigned approver has access to read the records for the approval requests. For example, a
user who does not have read access to an Expenses custom object will not be able to view expense approval requests.

2. Select Administrators ONLY... if you want only users with the "Modify All Data" permission to be able to edit records
that are pending approval. Select Administrators OR... if you want the assigned approver to be able to edit the records
too. When a record is submitted for approval, it is automatically locked to prevent other users from editing it during the
approval process.

3. Click Next. If you are editing an existing approval process and do not want to make further changes, click Save to store
your changes.

Select email notification template

If you select an email template with which to notify approvers that an approval request has been assigned to them, that template
will be used for all steps for the approval process. For more information on creating email templates, see "Managing Email
Templates" in the Salesforce online help.

1. Optionally, choose an email template to use when notifying approvers that an approval request is assigned to them.
2. Click Next. If you are editing an existing approval process and do not want to make further changes, click Save to store

your changes.

Configure approval request page layout

The approval page is where an approver will approve or reject a request.

1. Select the fields you want to display on the approval request page and click Add.
2. Sort the fields by selecting them and clicking Up or Down.
3. Select Display approval history information... to include the Approval History related list that lists such fields

as Date, Assigned To, Actual Approver, and Comments. To modify the fields displayed on the Approval History
related list, see "Customizing Related Lists" in the Salesforce online help.

4. Select Add Approval History Related List... to update all the page layouts for this object to include a related
list that allows users to submit approval requests and track them.

5. Choose a security setting:

Allow approvers to access the approval page only from within the Salesforce application

Requires users to log in to Salesforce before approving or rejecting an approval request.

Allow approvers to access the approval page only from within the Salesforce application,

or externally from a wireless-enabled mobile device

Users can approve requests from the email notification they receive via a wireless device. Note that
this prevents the approver from selecting a Salesforce user as the next approver.

6. Click Next. If you are editing an existing approval process and do not want to make further changes, click Save to store
your changes.
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Specify initial submitters

Specify which users are allowed to submit records for approval. For example, choose Owner if expense reports can only be
submitted by record owners.

1. Select a Submitter Type, enter a search term, and click Find.
2. Select from the list of available submitters and click Add.
3. Click Save.

Activate the approval process

Activate the process after you have created at least one approval step for the approval process. See "Creating Approval Steps"
in the Salesforce online help.

To activate a process:

1. Click Setup ➤ Customize ➤ Workflow & Approvals ➤ Approval Processes.
2. Click Activate next to the process.

Creating Approval Steps

User Permissions Needed

"Customize Application"To create approval steps:

Approval steps assign approval requests to various users and define the chain of approval for a particular approval process.
Each approval step specifies the attributes a record must have to advance to that approval step, the user who can approve
requests for those records, and whether to allow the delegate of the approver to approve the requests. The first approval step
in a process also specifies the action to take if a record does not advance to that step. Subsequent steps in the process also allow
you to specify what happens if an approver rejects the request.

The actions you associate with an approval step can be reused in workflow rules. To create approval steps:

1. Click Setup ➤ Customize ➤ Workflow & Approvals ➤ Approval Processes, and select the name of the approval process.
2. Click New Approval Step from the Approval Steps related list. If this button is not available, the approval process is active

and you cannot add more steps.
3. Enter a name and description for this step.
4. Enter a step number that determines the order of this step in relation to the other steps in this approval process.
5. Click Next.
6. Optionally, specify filter criteria to determine the attributes a record must have before Salesforce executes the actions for

this step.

To specify filter criteria, select Filter records based on the criteria below and use the instructions for
"Entering Filter Criteria" in the Salesforce online help.

7. If you specified filter criteria and this is the first step in your approval process, choose what should happen to records that
do not meet the criteria. Options are:

Approve...

Automatically approves the request and performs all final approval actions.

Reject...

Automatically rejects the request and performs all final rejection actions.
8. Click Next.

139

   
Apex Approval Process Automation



9. Select the assigned approver for approval requests created by this step. The assigned approver is the user or members of a
queue responsible for approving records that enter this step. The options are:

• Let the submitter choose... prompts the user to manually select the next approver.
• Automatically assign... assigns the approval request to the user in the user custom field displayed in this option.

The user custom field in this option is dependent on the user custom field selected for the process.
• Assign to... assigns all approval requests to the same user or queue selected in this option. For more information

on approval requests assigned to queues, see "Approval Process Considerations" in the Salesforce online help.

Note:  Make sure the assigned approver has access to read the records for the approval requests and is not a partner
user.. For example, a user who does not have read access to an Expenses custom object will not be able to view
expense approval requests.

10. Optionally, select The approver's delegate may also approve this request if the approver's delegated
approver can also approve these requests. A delegate is the user listed in the Delegated Approver field on the assigned
approver's user detail page.

Note:  A delegated approver cannot reassign an approval request; a delegated approver can only approve or reject
approval requests.

11. If this is not the first step in the approval process, specify what you want to happen when the approver rejects a request in
this step:

Perform all rejection actions...

Automatically rejects the request completely regardless of any previous steps that were approved.
Salesforce performs all rejection actions specified for this step and all final rejection actions.

Perform ONLY the rejection actions for this step...

Automatically rejects the request and returns the approval request to the previous approver. Salesforce
performs all rejection actions specified for this step.

Note:  If this is the first step in an approval process, the rejection behavior is determined by the Final Rejection
Actions for the approval process.

12. Click Save.
13. Specify any workflow actions you want to occur during this step:

Yes, I'd like to create a new approval action...
Select the type of action and click Go! to begin creating an action and associate it with this approval
step.

Yes, I'd like to create a new rejection action...
Select the type of action and click Go! to begin creating an action and associate it with this approval
step.

No, I'll do this later...
Select this option and click Go! to view the details of the approval process.

Approval actions execute when a record in this step of the approval process is approved. Rejection actions execute when a
record in this step is rejected. For instructions on adding actions, see "Selecting Approval Actions" in the Salesforce online
help and "Creating Approval Actions" in the Salesforce online help.

14. Optionally, add additional approval actions and rejection actions to the step. Click Show Actions next to a step to view
the Approval Actions and Rejection Actions related lists.

140

   
Apex Approval Process Automation



Initial Submission Actions

User Permissions Needed

"Customize Application"To create or edit initial submission actions:

Initial submission actions are the actions that occur when a user first submits a record for approval. For example, an initial
submission action can lock the record so that no users can edit it during the approval process. Initial submission actions can
also include any approval actions such as assigning a task, sending an email, or updating a field.

When a user submits a record for approval, Salesforce sends an approval request email to the approver as defined in the approval
step, and then executes a default initial submission action called "Record Lock." You can select up to 40 additional actions to
occur when a record is initially submitted for approval, 10 of each of the following types:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and
Due Date of the task.

Task

Uses an email template you specify to send an email to a designated recipient.Email

Changes the value of a selected field. You can specify a value or create a formula for the new
value.

Field Update

Sends a message to an endpoint you designate. You can also specify user name and the data
you want included in the message.

Outbound Message

To manage the initial submission actions for an approval process, click Setup ➤ Customize ➤ Workflow & Approvals ➤
Approval Processes and select the approval process.

The Initial Submission Actions related list shows all the actions that take place when a record is submitted for approval.

• Click Edit to change an action. Any changes you make to an action affect any other approval processes or workflow rules
that use it. This option is only available for some types of actions.

• Click Remove to remove the action from the approval process.This does not delete the action. This option is only available
for some types of actions.

• Click Add Existing to add another action to the list of actions. See "Selecting Approval Actions" in the Salesforce online
help.

• Click Add New and select the appropriate type to create a new action and associate it with the approval process. Next,
configure the action:

For workflow alerts:

1. Enter a description for this alert.
2. Choose an email template.
3. Select the type of recipient and choose from the list displayed. Select an entry in the list of Available

Recipients and click Add to add that entry to the list of Selected Recipients.
4. Enter up to 5 additional email addresses.
5. Click Save.

For field updates:

1. Enter a name and description for this field update.
2. Choose the object and the field you want to update.
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3. Specify the new field value. The available options depend on the type of field you are updating.
You can:

• Choose A specific value, and enter the value in the space provided.
• Choose A blank value (null) if you want Salesforce to remove any existing value and

leave the field blank. This option may not be available for several reasons such as the field is
required or a checkbox.

• For record owners, choose the user to whom the record should be assigned. For case, lead, and
custom object records, you can also choose a queue for this field. Optionally, select Notify
Assignee to send an email to the new record owner.

• For checkboxes, choose True to select the checkbox and False to deselect it.
• For picklists, select a specific value from the drop-down list, or select the value above or below

the current value based on the sorting specified in the picklist definition. If you sort values
alphabetically, the values above or below may be different for users in other languages.

• Choose Use a formula to set the new value to calculate the new value based on an
expression, merge fields, or other values.

a. To pass specific Salesforce data, choose the data type in the Select Field Type
drop-down list and choose one of the fields listed in the Insert Field drop-down list.

b. To insert an operator, choose the appropriate operator icon from the Insert Operator
drop-down list. Use the examples in "Operators and Functions" in the Salesforce online
help.

c. Optionally, insert a function from the Functions list. Functions are pre-built formulas
that you can customize with your input parameters. See "Operators and Functions" in the
Salesforce online help for a description of each operator and function.

4. Click Save.

For outbound messages:

1. Enter a name and description for this outbound message.
2. Enter an endpoint URL for the recipient of the message. Salesforce sends a SOAP message to

this endpoint.
3. Select the Salesforce user to use when sending the message.The chosen user controls data visibility

for the message that is sent to the endpoint.
4. Select Include Session ID if you want the Salesforce session ID included in the outbound

message. Include the session ID in your message if you intend to make API calls and you do not
want to include a username and password. Sending a username and password is less secure than
sending a session ID.

5. Select the fields you want included in the outbound message and click Add.

For workflow tasks:

1. Select an assignee. An assignee can be in the form of a user, role, record owner, record creator,
sales team role, or account team role depending on the type of record you chose.

Note:  If the assignee of a workflow task is set to the record owner and the owner of a lead
or case is a queue, the person who triggered the rule is assigned the task.

If a custom object has a master-detail relationship with a standard object, the owner of
the custom object record is automatically set to the owner of the master standard object
record. For example, if a custom object called "Expenses" has a master-detail relationship
with Accounts, the owner of each expense record is the owner of the account for the
expense.
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Likewise, if the assignee of a workflow task is a role and more than one user belongs to
that role, the person who triggered the rule becomes the task assignee. We recommend
that you do not assign workflow tasks to roles with multiple users. Assigning workflow
tasks to roles with one user allows you to easily change the user in that role without
modifying the workflow rule.

2. Enter a subject for the task.
3. Choose a due date, status, and priority. Due dates appear in the time zone of the assignee.
4. Check Notify Assignee to send an email notification when the task is assigned.
5. Enter any comments to add to the task.
6. Click Save.

Final Approval Actions

User Permissions Needed

"Customize Application"To create or edit final approval actions:

Final approval actions are the actions that occur when all approval requests for a record are approved. Final approval actions
can include any approval actions such as email alerts, field updates, tasks, or outbound messages. For example, a final approval
action can change the status to "Approved" and send a notification email.

When a record has been approved by all approvers, Salesforce executes all final approval actions. A default final approval action
called "Record Lock" is selected for you. You can modify it to automatically lock or unlock the record. You can select up to
40 additional actions to occur when a record is finally approved, 10 of each of the following types:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and
Due Date of the task.

Task

Uses an email template you specify to send an email to a designated recipient.Email

Changes the value of a selected field. You can specify a value or create a formula for the new
value.

Field Update

Sends a message to an endpoint you designate. You can also specify user name and the data
you want included in the message.

Outbound Message

To manage the final approval actions for an approval process, click Setup ➤ Customize ➤ Workflow & Approvals ➤
Approval Processes, and select the approval process.

The Final Approval Actions related list shows all the actions that take place when a record is finally approved.

• Click Edit to change an action. Any changes you make to an action affect any other approval processes or workflow rules
that use it. This option is only available for some types of actions.

• Click Remove to remove the action from the approval process.This does not delete the action. This option is only available
for some types of actions.

• Click Add Existing to add another action to the list of actions. See "Selecting Approval Actions" in the Salesforce online
help.

• Click Add New and select the appropriate type to create a new action and associate it with the approval process. Next,
configure the action:
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For workflow alerts:

1. Enter a description for this alert.
2. Choose an email template.
3. Select the type of recipient and choose from the list displayed. Select an entry in the list of Available

Recipients and click Add to add that entry to the list of Selected Recipients.
4. Enter up to 5 additional email addresses.
5. Click Save.

For field updates:

1. Enter a name and description for this field update.
2. Choose the object and the field you want to update.
3. Specify the new field value. The available options depend on the type of field you are updating.

You can:

• Choose A specific value, and enter the value in the space provided.
• Choose A blank value (null) if you want Salesforce to remove any existing value and

leave the field blank. This option may not be available for several reasons such as the field is
required or a checkbox.

• For record owners, choose the user to whom the record should be assigned. For case, lead, and
custom object records, you can also choose a queue for this field. Optionally, select Notify
Assignee to send an email to the new record owner.

• For checkboxes, choose True to select the checkbox and False to deselect it.
• For picklists, select a specific value from the drop-down list, or select the value above or below

the current value based on the sorting specified in the picklist definition. If you sort values
alphabetically, the values above or below may be different for users in other languages.

• Choose Use a formula to set the new value to calculate the new value based on an
expression, merge fields, or other values.

a. To pass specific Salesforce data, choose the data type in the Select Field Type
drop-down list and choose one of the fields listed in the Insert Field drop-down list.

b. To insert an operator, choose the appropriate operator icon from the Insert Operator
drop-down list. Use the examples in "Operators and Functions" in the Salesforce online
help.

c. Optionally, insert a function from the Functions list. Functions are pre-built formulas
that you can customize with your input parameters. See "Operators and Functions" in the
Salesforce online help for a description of each operator and function.

4. Click Save.

For outbound messages:

1. Enter a name and description for this outbound message.
2. Enter an endpoint URL for the recipient of the message. Salesforce sends a SOAP message to

this endpoint.
3. Select the Salesforce user to use when sending the message.The chosen user controls data visibility

for the message that is sent to the endpoint.
4. Select Include Session ID if you want the Salesforce session ID included in the outbound

message. Include the session ID in your message if you intend to make API calls and you do not
want to include a username and password. Sending a username and password is less secure than
sending a session ID.

5. Select the fields you want included in the outbound message and click Add.
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For workflow tasks:

1. Select an assignee. An assignee can be in the form of a user, role, record owner, record creator,
sales team role, or account team role depending on the type of record you chose.

Note:  If the assignee of a workflow task is set to the record owner and the owner of a lead
or case is a queue, the person who triggered the rule is assigned the task.

If a custom object has a master-detail relationship with a standard object, the owner of
the custom object record is automatically set to the owner of the master standard object
record. For example, if a custom object called "Expenses" has a master-detail relationship
with Accounts, the owner of each expense record is the owner of the account for the
expense.

Likewise, if the assignee of a workflow task is a role and more than one user belongs to
that role, the person who triggered the rule becomes the task assignee. We recommend
that you do not assign workflow tasks to roles with multiple users. Assigning workflow
tasks to roles with one user allows you to easily change the user in that role without
modifying the workflow rule.

2. Enter a subject for the task.
3. Choose a due date, status, and priority. Due dates appear in the time zone of the assignee.
4. Check Notify Assignee to send an email notification when the task is assigned.
5. Enter any comments to add to the task.
6. Click Save.

Final Rejection Actions

User Permissions Needed

"Customize Application"To create or edit final rejection actions:

Final rejection actions are the actions that occur when all approval requests for a record are rejected. Final rejection actions
can include any approval actions such as email alerts, field updates, tasks, or outbound messages. For example, a final rejection
action can change the status to "Rejected", send a notification email, and unlock the record so that users can edit it before
resubmitting.

When a record has been rejected by all approvers, Salesforce executes all final rejection actions. A default final rejection action
called "Record Lock" is selected for you. You can modify it to automatically lock or unlock a record. You can select up to 40
additional actions to occur when a record is rejected, 10 of each of the following types:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and
Due Date of the task.

Task

Uses an email template you specify to send an email to a designated recipient.Email

Changes the value of a selected field. You can specify a value or create a formula for the new
value.

Field Update

Sends a message to an endpoint you designate. You can also specify user name and the data
you want included in the message.

Outbound Message
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To manage the final rejection actions for an approval process, click Setup ➤ Customize ➤ Workflow & Approvals ➤
Approval Processes and select the approval process.

• The Final Rejection Actions related list shows all the actions that take place when a record is finally rejected.
• Click Edit to change an action. Any changes you make to an action affect any other approval processes or workflow rules

that use it. This option is only available for some types of actions.
• Click Remove to remove the action from the approval process.This does not delete the action. This option is only available

for some types of actions.
• Click Add Existing to add another action to the list of actions. See "Selecting Approval Actions" in the Salesforce online

help.
• Click Add New and select the appropriate type to create a new action and associate it with the approval process. Next,

configure the action:

For workflow alerts:

1. Enter a description for this alert.
2. Choose an email template.
3. Select the type of recipient and choose from the list displayed. Select an entry in the list of Available

Recipients and click Add to add that entry to the list of Selected Recipients.
4. Enter up to 5 additional email addresses.
5. Click Save.

For field updates:

1. Enter a name and description for this field update.
2. Choose the object and the field you want to update.
3. Specify the new field value. The available options depend on the type of field you are updating.

You can:

• Choose A specific value, and enter the value in the space provided.
• Choose A blank value (null) if you want Salesforce to remove any existing value and

leave the field blank. This option may not be available for several reasons such as the field is
required or a checkbox.

• For record owners, choose the user to whom the record should be assigned. For case, lead, and
custom object records, you can also choose a queue for this field. Optionally, select Notify
Assignee to send an email to the new record owner.

• For checkboxes, choose True to select the checkbox and False to deselect it.
• For picklists, select a specific value from the drop-down list, or select the value above or below

the current value based on the sorting specified in the picklist definition. If you sort values
alphabetically, the values above or below may be different for users in other languages.

• Choose Use a formula to set the new value to calculate the new value based on an
expression, merge fields, or other values.

a. To pass specific Salesforce data, choose the data type in the Select Field Type
drop-down list and choose one of the fields listed in the Insert Field drop-down list.

b. To insert an operator, choose the appropriate operator icon from the Insert Operator
drop-down list. Use the examples in "Operators and Functions" in the Salesforce online
help.

c. Optionally, insert a function from the Functions list. Functions are pre-built formulas
that you can customize with your input parameters. See "Operators and Functions" in the
Salesforce online help for a description of each operator and function.

4. Click Save.
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For outbound messages:

1. Enter a name and description for this outbound message.
2. Enter an endpoint URL for the recipient of the message. Salesforce sends a SOAP message to

this endpoint.
3. Select the Salesforce user to use when sending the message.The chosen user controls data visibility

for the message that is sent to the endpoint.
4. Select Include Session ID if you want the Salesforce session ID included in the outbound

message. Include the session ID in your message if you intend to make API calls and you do not
want to include a username and password. Sending a username and password is less secure than
sending a session ID.

5. Select the fields you want included in the outbound message and click Add.

For workflow tasks:

1. Select an assignee. An assignee can be in the form of a user, role, record owner, record creator,
sales team role, or account team role depending on the type of record you chose.

Note:  If the assignee of a workflow task is set to the record owner and the owner of a lead
or case is a queue, the person who triggered the rule is assigned the task.

If a custom object has a master-detail relationship with a standard object, the owner of
the custom object record is automatically set to the owner of the master standard object
record. For example, if a custom object called "Expenses" has a master-detail relationship
with Accounts, the owner of each expense record is the owner of the account for the
expense.

Likewise, if the assignee of a workflow task is a role and more than one user belongs to
that role, the person who triggered the rule becomes the task assignee. We recommend
that you do not assign workflow tasks to roles with multiple users. Assigning workflow
tasks to roles with one user allows you to easily change the user in that role without
modifying the workflow rule.

2. Enter a subject for the task.
3. Choose a due date, status, and priority. Due dates appear in the time zone of the assignee.
4. Check Notify Assignee to send an email notification when the task is assigned.
5. Enter any comments to add to the task.
6. Click Save.

Creating Approval Actions

User Permissions Needed

"Customize Application"To create approval actions:

Create approval actions if you want an approval step, initial submission, final approval, or final rejection to trigger some type
of action such as an email or field update. For example, you may have an expense approval process in Salesforce that you want
to send an outbound message to your Oracle accounting service to print expense checks when expense approval requests are
approved.

To create an approval action:

1. Click Setup ➤ Customize ➤ Workflow & Approvals ➤ Approval Processes.
2. Select the approval process you want associated with the action.
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3. Click Add New from the appropriate related list. When creating actions for an approval step, click Show Actions if they
are hidden.

4. Choose the type of action. The list of available actions differs depending on your settings and whether you have reached
the limit for any type of action:

• "Configure the alert" in the Salesforce online help.
• "Configure the field update" in the Salesforce online help.
• "Configure the outbound message" in the Salesforce online help.
• "Configure the task" in the Salesforce online help.

For workflow alerts:

a. Enter a description for this alert.
b. Choose an email template.
c. Select the type of recipient and choose from the list displayed. Select an entry in the list of Available

Recipients and click Add to add that entry to the list of Selected Recipients.
d. Enter up to 5 additional email addresses.
e. Click Save.

For field updates:

a. Enter a name and description for this field update.
b. Choose the object and the field you want to update.
c. Specify the new field value. The available options depend on the type of field you are updating.

You can:

• Choose A specific value, and enter the value in the space provided.
• Choose A blank value (null) if you want Salesforce to remove any existing value and

leave the field blank. This option may not be available for several reasons such as the field is
required or a checkbox.

• For record owners, choose the user to whom the record should be assigned. For case, lead, and
custom object records, you can also choose a queue for this field. Optionally, select Notify
Assignee to send an email to the new record owner.

• For checkboxes, choose True to select the checkbox and False to deselect it.
• For picklists, select a specific value from the drop-down list, or select the value above or below

the current value based on the sorting specified in the picklist definition. If you sort values
alphabetically, the values above or below may be different for users in other languages.

• Choose Use a formula to set the new value to calculate the new value based on an
expression, merge fields, or other values.

a. To pass specific Salesforce data, choose the data type in the Select Field Type
drop-down list and choose one of the fields listed in the Insert Field drop-down list.

b. To insert an operator, choose the appropriate operator icon from the Insert Operator
drop-down list. Use the examples in "Operators and Functions" in the Salesforce online
help.

c. Optionally, insert a function from the Functions list. Functions are pre-built formulas
that you can customize with your input parameters. See "Operators and Functions" in the
Salesforce online help for a description of each operator and function.

d. Click Save.

For outbound messages:

a. Enter a name and description for this outbound message.
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b. Enter an endpoint URL for the recipient of the message. Salesforce sends a SOAP message to
this endpoint.

c. Select the Salesforce user to use when sending the message.The chosen user controls data visibility
for the message that is sent to the endpoint.

d. Select Include Session ID if you want the Salesforce session ID included in the outbound
message. Include the session ID in your message if you intend to make API calls and you do not
want to include a username and password. Sending a username and password is less secure than
sending a session ID.

e. Select the fields you want included in the outbound message and click Add.

For workflow tasks:

a. Select an assignee. An assignee can be in the form of a user, role, record owner, record creator,
sales team role, or account team role depending on the type of record you chose.

Note:  If the assignee of a workflow task is set to the record owner and the owner of a lead
or case is a queue, the person who triggered the rule is assigned the task.

If a custom object has a master-detail relationship with a standard object, the owner of
the custom object record is automatically set to the owner of the master standard object
record. For example, if a custom object called "Expenses" has a master-detail relationship
with Accounts, the owner of each expense record is the owner of the account for the
expense.

Likewise, if the assignee of a workflow task is a role and more than one user belongs to
that role, the person who triggered the rule becomes the task assignee. We recommend
that you do not assign workflow tasks to roles with multiple users. Assigning workflow
tasks to roles with one user allows you to easily change the user in that role without
modifying the workflow rule.

b. Enter a subject for the task.
c. Choose a due date, status, and priority. Due dates appear in the time zone of the assignee.
d. Check Notify Assignee to send an email notification when the task is assigned.
e. Enter any comments to add to the task.
f. Click Save.

Note: The actions you create for approval processes can be reused in workflow rules.

Selecting Approval Actions

User Permissions Needed

"Customize Application"To select approval actions:

There are four types of approval actions:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and
Due Date of the task.

Task
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DescriptionType

Uses an email template you specify to send an email to a designated recipient.Email

Changes the value of a selected field. You can specify a value or create a formula for the new
value.

Field Update

Sends a message to an endpoint you designate. You can also specify user name and the data
you want included in the message.

Outbound Message

You can associate approval actions with approval steps, initial submission actions, final approval actions, and final rejection
actions. You can also reuse these actions for workflow rules. Before you begin, click Setup ➤ Customize ➤ Workflow &
Approvals ➤ Approval Processes and select the approval process you want associated with the actions.

To select an approval action:

1. Click Add Existing from the appropriate related list on the detail page of any approval process. If the Add Existing button
does not appear on an approval step, click Show Actions.

Alternatively, click Add New to create a new action and apply it to the selected approval process. For instructions on
creating actions, see "Creating Approval Actions" in the Salesforce online help.

2. Choose the type of action.
3. Select the action in the list of available actions and click Add to add the action to the list of selected actions.
4. Click Save.

Using the Approval Process Jump Start Wizard

User Permissions Needed

"Customize Application"To create approval processes:

The Approval Process Jump Start Wizard helps you create a simple one-step approval process in just a few clicks. However,
to make your process as functional and complete as possible, there are a few things you should do first:

1. If you would like to automate approval routing, you should first create a custom hierarchical relationship field, such as
Direct Manager on the user object.

2. Create an email template to notify an approver that they need to approve or reject a step in an approval process. Remember
to add approval merge fields so an approver can go to the approval page directly from the email. For more information,
see"Managing Email Templates" in the Salesforce online help.

3. Create an email template as confirmation to a record owner that a step of theirs in the approval process has been approved
or rejected.

4. Create the workflow actions you want to occur while a record is in the process of being approved. For more information,
see "Managing Workflow" in the Salesforce online help.

Design your approval process quickly using the jump start wizard. It automates the process of creating an approval process by
choosing some default options for you. For a list of the options the jump start wizard chooses automatically, see "Approval
Process Jump Start Default Selections" in the Salesforce online help.

To use the jump start wizard to create an approval process:

1. Click Setup ➤ Customize ➤ Workflow & Approvals ➤ Approval Processes.
2. Choose the object for the new approval process.
3. Click Create New Approval Process and choose Use Jump Start Wizard from the drop-down button.
4. Enter a name for the new approval process.
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5. Optionally, choose an email template to use when notifying approvers that an approval request is assigned to them.
6. Select Add Approval History Related List... to update all the page layouts for this object to include a related

list that allows users to submit approval requests and track them.
7. Enter filter criteria that records must match in order to be included in this approval process. Leave the filter blank if you

want all records submitted to be included in the approval process. For information on using filter criteria, see "Entering
Filter Criteria" in the Salesforce online help.

Note:  Select a current user field if you want the filter based on the user submitting an approval request.

8. Select the assigned approver for approval requests created by this step. The assigned approver is the user or members of a
queue responsible for approving records that enter this step. The options are:

• Let the submitter choose... prompts the user to manually select the next approver.
• Automatically assign... assigns the approval request to the user in the user custom field displayed in this option.

The user custom field in this option controls the user custom field available for each step in this process.

To create a new custom hierarchy field that stores the direct manager for each user, click Create New Field from
this option. For information on creating a custom field, see "Adding Fields" in the Salesforce online help.

• Assign to... assigns all approval requests to the same user or queue selected in this option. For more information
on approval requests assigned to queues, see "Approval Process Considerations" in the Salesforce online help.

Note:  Make sure the assigned approver has access to read the records for the approval requests. For example, a
user who does not have read access to an Expenses custom object will not be able to view expense approval requests.

9. Click Save. The Approval Process Detail page appears.
10. Select approval actions. For more information, see "Selecting Approval Actions" in the Salesforce online help.
11. When you are ready to use the approval process, activate it:

a. Click Setup ➤ Customize ➤ Workflow & Approvals ➤ Approval Processes.
b. Click Activate next to an inactive process to activate it.

Approval Process Jump Start Default Selections

The jump start wizard automates creating an approval process by automatically choosing some default options for you. When
you use the jump start wizard, your approval process will have the following attributes:

• Users must have the "Modify All Data" permission to edit records that are awaiting approval in the approval process.
• The approval request page layout displays the record name (or number), owner, date created, and approval history.
• The security settings prevent an approver from accessing the approval page externally from a wireless-enabled mobile

device.
• The owner of a record is the only person who can submit an approval request.
• Records are locked when submitted for approval.
• Records remain locked until approved or rejected.
• Rejected records are unlocked.
• There are no auto-approve or auto-reject actions.
• No email notification is sent upon approval or rejection.
• No field values are automatically updated during the approval process.
• An approver cannot automatically delegate another user to approve his or her approval requests.

151

   
Apex Approval Process Automation



Note:  After creating an approval process using the jump start wizard, you can change any of the above attributes by
clicking Edit from any approval process list page, and you can add additional steps from the approval process detail
page. However, you cannot edit the Record Lock action on the Initial Submission Actions list.

Managing Multiple Approval Requests

User Permissions Needed

"Modify All Data"To manage multiple approval requests:

To transfer multiple approval requests from one user to another or to remove multiple approval requests from the approval
process:

1. Before transferring an approval request, make sure the new assigned approver has access to read the records for the approval
requests. For example, a user that does not have read access to an Expenses custom object will not be able to view expense
approval requests.

2. Choose Setup ➤ Data Management ➤ Mass Transfer Approval Requests.
3. Enter the search conditions that the approval requests you are transferring must match. For example, you could search for

approval requests that were originally submitted by a particular user by specifying "Original Submitter equals jsmith." For
more information, see "Entering Filter Criteria" in the Salesforce online help.

4. Click Find to search for approval requests that match.
5. Choose an option:

• Mass remove records from an approval process unlocks the records and removes them from any approval
process so they no longer appear on the approver's list of pending approval requests.

• Mass transfer outstanding approval requests to a new user allows you to select a user and assign that
user as the approver for all approval requests selected.

6. Optionally, enter any comments to be stored with the approval requests. The comments you enter are displayed on the
Approval History related list if your administrator has customized it to include the Comments field.

7. Select the checkbox next to each approval request you want to transfer or remove from the approval process, depending
on the option you selected previously.

8. Click Transfer or Remove, depending on the option you selected previously.

Approval History

User Permissions Needed

Permissions vary depending on the approval process settingsTo use the Approval History related list:

The Approval History related list tracks a record through the approval process. If an approval process exists for an object, you
may see this related list on a record detail page. Depending on the approval process settings, use this related list for the following:

• To submit a record for approval, click Submit for Approval. Salesforce begins the approval process if any approval processes
apply to the record. This option is not available after the record has been submitted. Depending on the approval process,
you may be prompted to select the next approver.

• To take a record out of the approval process, click Remove from Approval Process. This is only available if the record is
in an approval process.

• To assign the approval request to another user, click Reassign next to an item.
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• To display the approval request detail page and approve or reject a pending approval request, click Approve / Reject next
to an item.

Note: You must have read access on a record to approve, reject, or reassign an approval request for it.

Depending on how your administrator customizes the Approval History related list, it can contain the following Status
values:

DefinitionStatus

The record has been submitted for a approval.Submitted

The record has been submitted for approval and is awaiting
approval or rejection.

Pending

The record has been approved.Approved

The record has been rejected.Rejected

The record has been submitted for approval but assigned to a
different approver.

Reassigned

Note:  Before you can submit a record for approval, it must meet the criteria for an active approval process. Contact
your administrator to find out about the attributes a record must have to be included in an active approval process for
your organization.

Items To Approve

User Permissions Needed

Permissions vary depending on the approval process settingsTo use the Items To Approve related list:

The Items To Approve related list tracks the open approval requests assigned to you. If your administrator has created an
approval process for your organization, you may see this related list on your home page. Depending on the approval process
settings, you can:

• Click an approval request to view more details about it.
• To assign the approval request to another user, click Reassign next to an item.
• To display the approval request detail page and approve or reject a pending approval request, click Approve / Reject next

to an item.

Note: You must have read access on a record to approve, reject, or reassign an approval request for it.

• Click Manage All to manage all of your assigned approval requests. Next, select approval requests by checking the appropriate
boxes. Optionally, check the box in the column header to select all currently displayed items.

• Click Reassign to assign the selected approval requests to another user, choose the user, enter any comments, and click
Save.

• Click Approve / Reject to display the approval request detail page and click Approve or Reject to approve or reject
all selected approval requests at once.
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Note: You must have read access on a record to approve, reject, or reassign an approval request for it.

Data Validation
Available in: Team, Professional, Enterprise, Unlimited, and Developer Editions

The data your users enter must be valid and accurate to support your business decisions. Validation rules give administrators
an easy way to build validation rules that ensure the validity of data before it is saved. Administrators can implement validation
rules with clicks, not code, reducing implementation time and costs. With validation rules in Winter '07, you can now:

• Prevent invalid data from being saved
• Define error messages to display when users enter invalid data
• Create sophisticated validation rules using formulas
• Prevent duplicate values
• Make fields conditionally required
• Enforce validation through Salesforce and the Apex API

Implementation Tips

• It is not necessary to begin your validation rule formula with an IF function. Any Boolean error condition expression works.
For example:

• Correct: CloseDate < TODAY()
• Incorrect: IF(CloseDate < TODAY(), TRUE, FALSE)

• Validation formulas cannot reference merge fields for formula, auto number, multi-select picklist, or compound address
fields likeMailing Address. However, merge fields for individual address fields, such as Billing City, can be used
in validation formulas.

• When one validation rule fails, Salesforce continues to check any additional validation rules on that field or any other field
on the page and displays all appropriate error messages at once.

• The detail page of a custom activity field does not list associated validation rules.
• Offline Edition and Outlook Edition do not run validation rules.
• Lead conversion ignores validation rules.
• Salesforce runs validation rules before creating records submitted via Web-to-Lead and Web-to-Case, and only creates

records that have valid values.
• The Salesforce Data Loader and the Apex API run validation rules.
• Salesforce runs validation rules on records before they are imported. Records that fail validation are not imported. Consider

deactivating the appropriate validation rules before running an import if they affect the records you are importing.
• Validation rules run before assignment rules, auto-response rules, escalation rules, and workflow rules. However, updates

to records based on workflow rules do not trigger validation rules. Therefore, workflow rules can invalidate previously valid
fields.

• When defining validation rules, you can set the error location to Top of Page or Field. If the error location is set to a
field that is later deleted or a field that is not visible on the page layout Salesforce automatically changes the error location
to Top of Page.

• An "Invalid Formula" error displays if your formula has a run-time error such as division by zero.
• When a validation rule contains the BEGINS or CONTAINS functions, it processes blank fields as valid. For example,

if you have a validation rule that tests to see if the serial number of an asset begins with "3," all assets that have a blank
serial number are considered valid.
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• Some merge fields display as radio buttons but function like picklist fields when referenced in a formula. Use the values
"Read," "Edit," and "None" when referencing the following merge fields in a formula:

• $UserRole.CaseAccessForAccountOwner
• $UserRole.OpportunityAccessForAccountOwner
• CaseAccessLevel (on Territory)
• OpportunityAccessLevel (on Territory)

Use the values "Read," "Edit," and "All" when referencing the following merge fields in a formula:

• AccountAccessLevel (on Territory)

• Text fields are never null even when they are blank. Avoid using text fields in "NULLVALUE" in the Salesforce online
help or "ISNULL" in the Salesforce online help functions. Instead, use the "LEN" in the Salesforce online help function
to determine if a text field is blank, such as IF( LEN( Field)=0 , "this is empty", "this is not empty").

Best Practices

• When creating validation rules, consider all the settings in your organization that can make a record fail validation such
as assignment rules, field updates, field-level security, or fields hidden on a page layout.

• Be careful not to create two contradicting validation rules for the same field; otherwise, users will not be able to save the
record.

• A poorly designed validation rule can prevent users from saving valid data. Make sure you thoroughly test a validation rule
before activating it. Users will never be able to save a record if your formula always returns a "True" value.

• Because validation rules run on the Self-Service portal, make sure your validation rules do not prevent Self-Service users
from creating cases.

• Write helpful error messages:

Always include the field label.
Users may not know what field is failing validation, especially if your error message is located at the
top of the page.

Give instructions.
An error message like "invalid entry" does not tell them what type of entry is valid. Use an error
message like "Close Date must be after today."

If appropriate, translate your error messages.
If users in your organization speak different languages, translate your error messages using the
translation workbench. See "Setting Up Translation Workbench" in the Salesforce online help.

Assign error numbers to validation rules and error messages.
This allows you to identify the source of the error.

• Consider what fields are visible and editable for users on their page layouts due to field-level security. Fields that are not
visible or editable for the user are still available in the formula for a validation rule and can cause a validation error. If the
error message is designed to display next to a hidden field, it will display at the top of the page.

For such fields, consider adding a default value to automatically populate the field with a valid value since users will not
be able to edit the field to correct any validation errors. See "Defining Default Field Values" in the Salesforce online help.

• Use the record type ID merge field in your formula to apply different validation for different record types. For information
about merge fields, see "About Merge Fields" in the Salesforce online help.

• If person accounts are enabled for your organization:

• To define a validation rule that applies only to person accounts, use the IsPersonAccount merge field.
• You must handle person account names and business account names separately in account validation rules. For business

accounts, use the Name merge field. For person accounts, use the FirstName and LastName merge fields.
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• Birthdate,Email, and other fields that are only supported for person accounts are available as merge fields in account
validation rules. When you use one of those merge fields, note that business account records will be processed as if
those fields have blank values.

• When using a validation rule to ensure that a number field contains a specific value, use the ISNULL function to include
fields that do not contain any value. For example, to validate that a custom field contains a value of '1', use the following
validation rule to display an error if the field is blank or any other number:

OR(ISNULL(field__c), field__c<>1)

Setting Up Validation Rules

About Validation Rules

Improve the quality of your data using validation rules. Validation rules verify that the data a user enters in a record meets the
standards you specify before the user can save the record. A validation rule can contain a formula or expression that evaluates
the data in one or more fields and returns a value of "True" or "False." Validation rules also include an error message to display
to the user when the rule returns a value of "True."

After you have defined validation rules:

1. The user chooses to create a new record or edit an existing record.
2. The user clicks Save.
3. Salesforce executes all validation rules.

• If all data is valid, Salesforce saves the record.
• If any data is invalid, Salesforce displays the associated error message without saving the record.

4. The user makes the necessary changes and clicks Save again.

You can specify the error message to display when a record fails validation and where to display it. For example, your error
message can be "The close date must occur after today's date." You can choose to display it near a field or at the top of the
page. Like all other Salesforce error messages, validation rule errors display in red text and are preceded by the word "Error."

Use validation rules for the following objects:

• Accounts
• Activities (tasks and events)
• Assets
• Campaigns
• Cases
• Contacts
• Contracts
• Custom objects
• Leads
• Opportunities
• Opportunity products
• Orders
• Products
• Solutions
• Users
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Defining Validation Rules

User Permissions Needed

"View Setup and Configuration"To view field validation rules:

"Customize Application"To define or change field validation rules:

Validation rules verify that the data a user enters in a record meets the standards you specify before the user can save the record.
A validation rule can contain a formula or expression that evaluates the data in one or more fields and returns a value of "True"
or "False." Validation rules also include an error message to display to the user when the rule returns a value of "True."

Before creating validation rules, review the "Validation Rule Considerations" in the Salesforce online help.

To create validation rules:

1. For standard objects, click Setup ➤ Customize, select the appropriate activity, tab, or users link, and click Validation
Rules.

For custom objects, click Setup ➤ Build ➤ Custom Objects and select the custom object.

2. Click New in the Validation Rules related list.
3. Enter the properties of your validation rule:

DescriptionField

Unique identifier of up to 80 characters with no spaces or
special characters.

Rule Name

Checkbox that indicates if the rule is enabled.Active

For internal purposes only. Use this field to enter a 255
character or less description that distinguishes the validation
rule from others.

Description

The expression used to validate the field. See "Building
Formulas" in the Salesforce online help and "Operators and
Functions" in the Salesforce online help.

Error Condition Formula

The message that displays to the user when a field fails the
validation rule.

If your organization uses the translation workbench, you can
translate the error message into the languages Salesforce

Error Message

supports. See "Setting Up Translation Workbench" in the
Salesforce online help.

Determines where on the page to display the error. To
display the error next to a field, choose Field and select the

Error Location

field. If the error location is a field, the validation rule is also
listed on the detail page of that field. If the error location is
set to a field that is later deleted or a field that is not visible
on the page layout Salesforce automatically changes the error
location to Top of Page.

4. Click Check Syntax to check your formula for errors.
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5. Click Save to finish or Save & New to create additional validation rules.

Note: The detail page of a custom activity field does not list associated validation rules. To edit the validation rule
for a custom activity field, select the validation rule by clicking Setup ➤ Customize ➤ Activities and choose Task
Validation Rules or Event Validation Rules.

Useful Validation Formulas

User Permissions Needed

"View Setup and Configuration"To view field validation rules:

"Customize Application"To define or change field validation rules:

Use the following samples for validation rules in Salesforce and AppExchange apps, including:

• "Account Validation Rules" in the Salesforce online help
• "Contact Validation Rules" in the Salesforce online help
• "Opportunity Management Validation Rules" in the Salesforce online help
• "Service & Support Validation Rules" in the Salesforce online help
• "User, Role, and Profile Validation Rules" in the Salesforce online help
• "Account Address Validation Rules" in the Salesforce online help
• "Date Validation Rules" in the Salesforce online help
• "Number Validation Rules" in the Salesforce online help
• "Other Validation Rules" in the Salesforce online help
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Account Address Validation Rules

Billing Zip Code

Validates that the account Billing Zip/Postal Code is in 99999 or 99999-9999
format if Billing Country is USA or blank. It checks each digit separately to verify
if it is a number.

Description:

OR(
  AND(  
      OR(BillingCountry = "USA", LEN(BillingCountry) = 0),
      LEN(BillingPostalCode) <>5, LEN(BillingPostalCode) <> 10),

  NOT(CONTAINS("0123456789", LEFT( BillingPostalCode, 1))), 
  NOT(CONTAINS("0123456789",  MID( BillingPostalCode , 2, 1))),

  NOT(CONTAINS("0123456789",  MID( BillingPostalCode , 3, 1))),

  NOT(CONTAINS("0123456789",  MID( BillingPostalCode , 4, 1))),

  NOT(CONTAINS("0123456789",  MID( BillingPostalCode , 5, 1))),

  AND(
   LEN(BillingPostalCode) = 10,
   OR(
      MID( BillingPostalCode , 6, 1) <> "-",
      NOT(CONTAINS("0123456789",  MID( BillingPostalCode , 7, 
1))),
      NOT(CONTAINS("0123456789",  MID( BillingPostalCode , 8, 
1))),
      NOT(CONTAINS("0123456789",  MID( BillingPostalCode , 9, 
1))),
      NOT(CONTAINS("0123456789",  MID( BillingPostalCode , 10,
 1))))
   )
)

Formula:

Zip code must be in 99999 or 99999-9999 format.Error Message:

Billing Zip/Postal CodeError Location:
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Shipping Zip Code

Validates that the account Shipping Zip/Postal Code is in 99999 or 99999-9999
format if Shipping Country is USA or blank.

Description:

OR(
  AND(  
      OR(ShippingCountry = "USA", LEN(ShippingCountry) = 0),
      LEN(ShippingPostalCode) <>5, LEN(ShippingPostalCode) <> 
10),
  NOT(CONTAINS("0123456789", LEFT( ShippingPostalCode, 1))), 
  NOT(CONTAINS("0123456789",  MID( ShippingPostalCode , 2, 1))),

  NOT(CONTAINS("0123456789",  MID( ShippingPostalCode , 3, 1))),

  NOT(CONTAINS("0123456789",  MID( ShippingPostalCode , 4, 1))),

  NOT(CONTAINS("0123456789",  MID( ShippingPostalCode , 5, 1))),

  AND(
   LEN(ShippingPostalCode) = 10,
   OR(
      MID( ShippingPostalCode , 6, 1) <> "-",
      NOT(CONTAINS("0123456789",  MID( ShippingPostalCode , 7,
 1))),
      NOT(CONTAINS("0123456789",  MID( ShippingPostalCode , 8,
 1))),
      NOT(CONTAINS("0123456789",  MID( ShippingPostalCode , 9,
 1))),
      NOT(CONTAINS("0123456789",  MID( ShippingPostalCode , 10,
 1))))
   )
)

Formula:

Zip code must be in 99999 or 99999-9999 format.Error Message:

Shipping Zip/Postal CodeError Location:

Valid Billing State (US)

Validates that the account Billing State/Province is a valid two-character
abbreviation if Billing Country is US, USA, or blank.

Description:

AND (
OR(BillingCountry = "US", BillingCountry="USA", 
LEN(BillingCountry)=0),
OR(
LEN(BillingState) < 2,
NOT(
CONTAINS("AL:AK:AZ:AR:CA:CO:CT:DE:DC:FL:GA:HI:ID:" &
"IL:IN:IA:KS:KY:LA:ME:MD:MA:MI:MN:MS:MO:MT:NE:NV:NH:" &
"NJ:NM:NY:NC:ND:OH:OK:OR:PA:RI:SC:SD:TN:TX:UT:VT:VA:" &
"WA:WV:WI:WY", BillingState)
)))

Formula:

A valid two-letter state code is required.Error Message:

Billing State/ProvinceError Location:
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Valid Billing Province (Canada)

Validates that the account Billing State/Province is a valid two-character abbreviation if
Billing Country is CA or CAN.

Description:

AND (
   OR(BillingCountry = "CA", BillingCountry="CAN"),
   OR(
   LEN(BillingState) < 2,
   NOT(
      CONTAINS("AB:BC:MB:NB:NL:NT:NS:NU:ON:PC:QC:SK:YT", BillingState)
)))

Formula:

A valid two-letter province code is required.Error Message:

Billing State/ProvinceError Location:

Valid Shipping State

Validates that the account Shipping State/Province is a valid two-character abbreviation if
Shipping Country is US, USA, or blank.

Description:

AND ( 
OR(ShippingCountry = "US", ShippingCountry="USA", LEN(ShippingCountry)=0),

OR( 
LEN(ShippingState) < 2, 
NOT( 
CONTAINS("AL:AK:AZ:AR:CA:CO:CT:DE:DC:FL:GA:HI:ID:" & 
"IL:IN:IA:KS:KY:LA:ME:MD:MA:MI:MN:MS:MO:MT:NE:NV:NH:" & 
"NJ:NM:NY:NC:ND:OH:OK:OR:PA:RI:SC:SD:TN:TX:UT:VT:VA:" & 
"WA:WV:WI:WY", ShippingState) 
)))

Formula:

A valid two-letter state abbreviation is required.Error Message:

Shipping State/ProvinceError Location:

Valid Shipping Province (Canada)

Validates that the account Shipping State/Province is a valid two-character abbreviation, if
Billing Country is CA or CAN.

Description:

AND ( 
OR(ShippingCountry = "CA", ShippingCountry="CAN"), 
OR( 
LEN(ShippingState) < 2, 
NOT( 
CONTAINS("AB:BC:MB:NB:NL:NT:NS:NU:ON:PC:QC:SK:YT", ShippingState) 
)))

Formula:

A valid two-letter province abbreviation is required.Error Message:

Shipping State/ProvinceError Location:
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Valid Billing Country

Validates that the account Billing Country is a valid ISO 3166 three-letter code.Description:

OR( 
LEN(BillingCountry) = 1, 
LEN(BillingCountry) = 2, 
NOT( 
CONTAINS( 
"AFG:ALB:DZA:ASM:AND:AGO:AIA:ATA:ATG:ARG:ARM:ABW:" & 
"AUS:AUT:AZE:BHS:BHR:BGD:BRB:BLR:BEL:BLZ:BEN:BMU:BTN:BOL:" & 
"BIH:BWA:BVT:BRA:IOT:BRN:BGR:BFA:BDI:KHM:CMR:CAN:CPV:CYM:" & 
"CAF:TCD:CHL:CHN:CXR:CCK:COL:COM:COG:COD:COK:CRI:CIV:HRV:" & 
"CUB:CYP:CZE:DNK:DJI:DMA:DOM:ECU:EGY:SLV:GNQ:ERI:EST:ETH:FLK:" & 
"FRO:FJI:FIN:FRA:GUF:PYF:ATF:GAB:GMB:GEO:DEU:GHA:GIB:GRC:GRL:" & 
"GRD:GLP:GUM:GTM:GIN:GNB:GUY:HTI:HMD:VAT:HND:HKG:HUN:ISL:" & 
"IND:IDN:IRN:IRQ:IRL:ISR:ITA:JAM:JPN:JOR:KAZ:KEN:KIR:PRK:KOR:KWT:" & 
"KGZ:LAO:LVA:LBN:LSO:LBR:LBY:LIE:LTU:LUX:MAC:MKD:MDG:MWI:MYS:" & 
"MDV:MLI:MLT:MHL:MTQ:MRT:MUS:MYT:MEX:FSM:MDA:MCO:MNG:MSR:MAR:" & 
"MOZ:MMR:NAM:NRU:NPL:NLD:ANT:NCL:NZL:NIC:NER:NGA:NIU:NFK:MNP:" & 
"NOR:OMN:PAK:PLW:PSE:PAN:PNG:PRY:PER:PHL:PCN:POL:PRT:PRI:QAT:" & 
"REU:ROU:RUS:RWA:SHN:KNA:LCA:SPM:VCT:WSM:SMR:STP:SAU:SEN:SCG:" & 
"SYC:SLE:SGP:SVK:SVN:SLB:SOM:ZAF:SGS:ESP:LKA:SDN:SUR:SJM:SWZ:" & 
"SWE:CHE:SYR:TWN:TJK:TZA:THA:TLS:TGO:TKL:TON:TTO:TUN:TUR:TKM:" & 
"TCA:TUV:UGA:UKR:ARE:GBR:USA:UMI:URY:UZB:VUT:VEN:VNM:VGB:VIR:" & 
"WLF:ESH:YEM:ZMB:ZWE:", 
BillingCountry )))

Formula:

A valid three-letter country code is required.Error Message:

Billing CountryError Location:

Account Validation Rules

Account Number Length

Validates that the Account Number is exactly seven digits (if it is not blank). The
number seven is simply illustrative. You can change this to any number you like.

Description:

AND( 
   LEN(AccountNumber) > 0,
   LEN(AccountNumber) <> 7
)

Formula:

Account Number must be seven digits.Error Message:

Account NumberError Location:
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Annual Revenue Range

Validates that the account Annual Revenue is not negative and does not exceed $100
billion. This limit is designed to catch typos.

Description:

OR( 
   AnnualRevenue < 0,
   AnnualRevenue > 100000000000
)

Formula:

Annual Revenue cannot exceed 100 billion.Error Message:

Annual RevenueError Location:

Number Validation Rules

Time Cards Must Total 40 Hours

Ensures that users cannot save a time card record with more than 40 hours in a work
week. This example requires five custom fields on your custom object, one for each day
of work.

Description:

Monday_Hours__c  +  
Tuesday_Hours__c  +  
Wednesday_Hours__c  +  
Thursday_Hours__c  +  
Friday_Hours__c  > 40

Formula:

Your total hours cannot exceed 40.Error Message:

Top of PageError Location:

Number Cannot Be Negative

Validates that a custom field called Hours Worked is not a negative number.Description:

Hours_Worked__c < 0Formula:

Hours Worked cannot be less than zero.Error Message:

Hours WorkedError Location:
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Number Must Be Even

Validates that a custom field called Ark Passengers is a non-negative even number.Description:

OR(
   Ark_Passengers__c < 0,
   MOD( Ark_Passengers__c, 2) <> 0
)

Formula:

Ark Passengers must be a positive even number.Error Message:

Ark PassengersError Location:

Number Must Be Odd

Validates that a custom field called Socks Found is a non-negative odd number.Description:

OR(
   Socks_Found__c < 0,
   MOD( Socks_Found__c, 2) = 0
)

Formula:

Socks Found must be an odd number.Error Message:

Socks FoundError Location:

Number Must Be a Multiple of Five

Validates that a custom field called Multiple of 5 is a multiple of five.Description:

MOD( Multiple_of_5__c, 5) <> 0Formula:

Number must be a multiple of five.Error Message:

Multiple of 5Error Location:

Number Must Be an Integer

Validates that a custom field called My Integer is an integer.Description:

FLOOR( My_Integer__c) <> My_Integer__cFormula:

This field must be an integer.Error Message:

My IntegerError Location:
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Number Must Be Between -50 and 50

Validates that a custom field called Volume is between -50 and 50.Description:

ABS( Volume__c) > 50Formula:

Volume must be between -50 and 50.Error Message:

VolumeError Location:

Number Range Validation

Validates that the range between two custom fields, Salary Min and Salary Max, is
no greater than $20,000.

Description:

(Salary_Max__c - Salary_Min__c) > 20000Formula:

Salary range must be within $20,000. Adjust the Salary Max or Salary Min values.Error Message:

Salary MaxError Location:

Percentage Must Be Between Zero and 100

Validates that a custom field called Mix Pct is between 0 and 100%. Note that percent
fields are expressed divided by 100 in formulas (100% is expressed as 1; 50% is expressed
as 0.5).

Description:

OR( 
   Mix_Pct__c > 1.0,
   Mix_Pct__c < 0.0
)

Formula:

Mix Pct must be between 0 and 100%.Error Message:

Mix PctError Location:
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Contact Validation Rules

Mailing Address Fields Are Required

Validates that the contact Mailing Street, Mailing City, and Mailing Country
are provided.

Description:

OR(
   LEN( MailingStreet ) = 0,
   LEN( MailingCity ) = 0,
   LEN( MailingCountry ) = 0
)

Formula:

Mailing Street, City, and Country are required.Error Message:

Top of PageError Location:

Mailing Street Is Required

Validates that the contact Mailing Street is provided.Description:

LEN( MailingStreet ) = 0Formula:

Mailing Street is required.Error Message:

Mailing StreetError Location:
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Mailing Zip Code

Validates that the contact Mailing Zip/Postal Code is in 99999 or 99999-9999
format if Mailing Country is USA or blank.

Description:

OR(
  AND(  
      OR(MailingCountry = "USA", LEN(MailingCountry) = 0),
      LEN(MailingPostalCode) <>5, LEN(MailingPostalCode) <> 10),

  NOT(CONTAINS("0123456789", LEFT( MailingPostalCode, 1))), 
  NOT(CONTAINS("0123456789",  MID( MailingPostalCode , 2, 1))),

  NOT(CONTAINS("0123456789",  MID( MailingPostalCode , 3, 1))),

  NOT(CONTAINS("0123456789",  MID( MailingPostalCode , 4, 1))),

  NOT(CONTAINS("0123456789",  MID( MailingPostalCode , 5, 1))),

  AND(
   LEN(MailingPostalCode) = 10,
   OR(
      MID( MailingPostalCode , 6, 1) <> "-",
      NOT(CONTAINS("0123456789",  MID( MailingPostalCode , 7, 
1))),
      NOT(CONTAINS("0123456789",  MID( MailingPostalCode , 8, 
1))),
      NOT(CONTAINS("0123456789",  MID( MailingPostalCode , 9, 
1))),
      NOT(CONTAINS("0123456789",  MID( MailingPostalCode , 10,
 1))))
   )
)

Formula:

Zip code must be in 99999 or 99999-9999 format.Error Message:

Mailing Zip/Postal CodeError Location:

Phone Number Has International Format

Validates that the Phone number begins with a plus sign (+) for country code. Note that
this validation rule conflicts with the ten-digit rule.

Description:

LEFT(Phone, 1) <> "+"Formula:

Phone number must begin with + (country code).Error Message:

PhoneError Location:
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US Phone Number Has Ten Digits

Validates that the Phone number is in (999) 999-9999 format. This works by using the
SUBSTITUTE function to strip off all the formatting characters like parentheses, dashes,
and slashes and confirming the length of the number is ten digits.

Description:

AND(
   MailingCountry = "USA",
   LEN(
   SUBSTITUTE(SUBSTITUTE(SUBSTITUTE(SUBSTITUTE( SUBSTITUTE( 
SUBSTITUTE( Phone , "(", ""), ")", ""), "-","")," 
",""),".",""),"/","")) <> 10
)

Formula:

US phone numbers should be in this format: (999) 999-9999.Error Message:

PhoneError Location:

Date Validation Rules

Date Must Be a Weekday

Validates that the value of a custom date field is a weekday (not Saturday or Sunday) .Description:

CASE( MOD( My_Date__c - DATE(1900, 1, 7), 7), 
0, 0, 
6, 0, 
1 ) = 0

Formula:

Date must be a weekday.Error Message:

My DateError Location:

Date Must Be a Weekend Day

Validates that the value of a custom date field is a Saturday or SundayDescription:

CASE( MOD( My_Date__c - DATE(1900, 1, 7), 7), 
0, 1, 
6, 1, 
0 ) = 0

Formula:

Date must be a weekend day.Error Message:

My DateError Location:
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Date Must Be in the Current Month

Validates that a custom date field contains a date within the current month and year.Description:

OR ( 
YEAR( My_Date__c ) <> YEAR ( TODAY() ), 
MONTH( My_Date__c ) <> MONTH ( TODAY() ) 
)

Formula:

Date must be in the current month.Error Message:

My DateError Location:

Date Must Be in the Current Year

Validates that a custom date field contains a date within the current year.Description:

YEAR( My_Date__c ) <> YEAR ( TODAY() )Formula:

Date must be in the current year.Error Message:

My DateError Location:

Date Must Be the Last Day of the Month

Validates whether a custom field called My Date is the last day of the month. To do
this, it determines the date of the first day of the next month and then subtracts 1 day.
It includes special case logic for December.

Description:

DAY(My_Date__c) <> 
IF(Month(My_Date__c)=12, 31, 
DAY(DATE(YEAR(My_Date__c),MONTH(My_Date__c)+1,1) - 1))

Formula:

Date must be the last day of the month.Error Message:

My DateError Location:

Date Must Be Within One Year of Today

Validates whether a custom field called Follow-Up Date is within one year of today’s
date. This example assumes a 365 day year. (It does not handle leap years.)

Description:

Followup_Date__c - TODAY() > 365Formula:

Follow-Up Date must be within one year of today.Error Message:

Follow-Up DateError Location:
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Day of Month Cannot Be Greater Than 15

Validates that a custom field called Begin Date contains a date in the first 15 days of
the specified month.

Description:

DAY( Begin_Date__c ) > 15Formula:

Begin Date cannot be after the 15th day of month.Error Message:

Begin DateError Location:

End Date Cannot Be Before Begin Date

Validates that a custom field called End Date does not come before another custom
field called Begin Date.

Description:

Begin_Date__c > End_Date__cFormula:

End Date cannot be before Begin Date.Error Message:

Begin DateError Location:

Expiration Date Cannot Be Before Close Date

Validates that a custom field called Expiration Date does not come before Close
Date.

Description:

Expiration_Date__c < CloseDateFormula:

Expiration Date cannot be before Close Date.Error Message:

Expiration DateError Location:

Opportunity Management Validation Rules

Conditionally-Required Field Based on Opportunity Stage

Validates that a custom field called Delivery Date is provided if an opportunity has
advanced to the Closed Won or Negotiation/Review stage.

Description:

AND ( 
  OR ( 
     ISPICKVAL( StageName, "Closed Won"), 
     ISPICKVAL( StageName, "Negotiation/Review")),
ISNULL( Delivery_Date__c )
)

Formula:

Delivery Date is required for this stage.Error Message:

Delivery DateError Location:
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Close Date Cannot Be Prior to Current Month

Validates that the Close Date of an opportunity is not within a month prior to the
current month. Note the use of ISNEW and ISCHANGED in this formula to ensure
the condition is only checked when the opportunity is being created or the Close Date
field is modified subsequently.

Description:

AND(
  OR (
     ISNEW(), 
     ISCHANGED( CloseDate )), 
  CloseDate < DATE( YEAR(TODAY()), MONTH(TODAY()), 1) )

Formula:

Close Date cannot be prior to current month.Error Message:

Close DateError Location:

Close Date Must Be a Future Date

Ensures that users do not change the Close Date of an opportunity to a day in the past.Description:

CloseDate < TODAY()Formula:

Close Date cannot be a day in the past.Error Message:

Close DateError Location:

Discounts on Opportunities

Validates that a custom discount percent field is between 0 and 40%.Description:

OR(Discount_Rate__c < 0, Discount_Rate__c > 0.40)Formula:

The Discount Rate must not exceed 40%.Error Message:

Discount RateError Location:
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High-Value Opportunity Must Be Approved Before Closed

Opportunities with amounts greater than $50,000 require that a custom checkbox field
called Approved is checked in order to change the stage to Closed Won or Closed Lost.
To automate this, set field-level security on the Approved checkbox so that it can only
be checked via a custom approval process. (Enterprise Edition or Unlimited Edition)

Description:

AND( 
   OR( 
      ISPICKVAL(StageName ,"Closed Won"),
      ISPICKVAL( StageName ,"Closed Lost")) , 
(Amount > 50000), 
NOT(ISPICKVAL( Approval_Status__c ,"Approved") ) )

Formula:

All high-value opportunities must be approved for closure. Click the Request Close
button.

Error Message:

Top of PageError Location:

Opportunity Amount Cannot Exceed $10 Million

Validates that opportunity Amount is positive and no more than $10 million. This limit
is designed to catch typos.

Description:

OR( 
   Amount < 0,
   Amount > 10000000
)

Formula:

Amount cannot exceed $10 million.Error Message:

AmountError Location:

Opportunity Check for Products

Validates that an opportunity has at least one opportunity product before users can save a change
to an opportunity.

Description:

NOT(OR(ISNEW(),HasOpportunityLineItem))Formula:

You must add products to this opportunity before saving.Error Message:

Top of PageError Location:
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Opportunity Must Have Products if Beyond "Needs Analysis" Stage

Validates that an opportunity has opportunity products before the Stage can move
beyond Needs Analysis.

Description:

AND ( 
  CASE( StageName,
     "Value Proposition", 1,
     "Id. Decision Makers", 1,
     "Perception Analysis", 1,
     "Proposal/Price Quote", 1,
     "Negotiation/Review", 1,
     "Closed Won", 1,
     0) = 1,
  NOT(HasOpportunityLineItem)
)

Formula:

Opportunity products are required to advance beyond the Needs Analysis stage.Error Message:

Top of PageError Location:

Opportunity Name Format

Validates that an opportunity contains a hyphen as a way of enforcing an “[Account] –
[Amount]” opportunity naming convention.

Description:

FIND( " - ", Name ) = 0Formula:

Opportunity Name should use "[Account] - [Amount]" format.Error Message:

Opportunity NameError Location:

Prevent Sales Reps from Moving Opportunity Stage Backwards

Prevent sales reps from changing opportunity Stage “backwards” to specific values, once
they have accepted the opportunity via a custom approval process. The approval process
sets the custom Accepted Flag checkbox to True.

Description:

AND(
   Accepted_Flag__c,
   OR ( ISPICKVAL( StageName, "Stage 1"), ISPICKVAL( StageName,
 "Stage 2"))
)

Formula:

Invalid stage for accepted opportunity.Error Message:

StageError Location:
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Probability Must Be 100% for Won Opportunities

Validates that the probability of a won opportunity is properly set to 100%.This is useful
for data cleanliness and reporting purposes.

Description:

AND ( 
     ISPICKVAL( StageName, "Closed Won"), 
     Probability <> 1)

Formula:

Probability must be 100% for won opportunities.Error Message:

ProbabilityError Location:

Probability Must Be Zero for Lost Opportunities

Validates that the probability of a lost opportunity is properly set to zero. This is useful
for data cleanliness and reporting purposes.

Description:

AND ( 
     ISPICKVAL( StageName, "Closed Lost"), 
     Probability <> 0)

Formula:

Probability must be 0% for lost opportunities.Error Message:

ProbabilityError Location:

Project Start Date

Validates that a field is conditionally required based on the values of other fields. Use this
validation formula to ensure that users include a Project Start Date for an opportunity
that is closed/won.

Description:

AND(ISPICKVAL( StageName , "Closed Won"),
  ISNULL(Project_Start_Date__c ))

Formula:

Project start date is required for won opportunities.Error Message:

Project Start DateError Location:
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Service & Support Validation Rules

Conditionally Require Description When Case Reason is "Other"

Validates that a custom field called Other Reason contains a value if a case has a Case
Reason of “Other.”

Description:

AND(
  ISPICKVAL( Reason, "Other" ),
   Other_Reason__c = "" 
)

Formula:

Description of Other Reason is required.Error Message:

Other ReasonError Location:

Prevent Open Cases from Being Reset to New

If a case is already open, prevents the Status from being changed back to “New.”Description:

AND(
  ISCHANGED( Status ),
  NOT(ISPICKVAL(PRIORVALUE( Status ), "New")),
  ISPICKVAL( Status, "New")
)

Formula:

Open case Status cannot be reset to New.Error Message:

StatusError Location:

Restrict Status of Re-Opened Cases

Validates that the case Status is "Re-opened" when a closed case is opened again.Description:

AND(
  ISCHANGED( Status ),
  OR( 
     ISPICKVAL(PRIORVALUE( Status ), "Closed"), 
     ISPICKVAL(PRIORVALUE( Status ), "Closed in SSP")),
  NOT( ISPICKVAL( Status, "Re-Opened"))
)

Formula:

Closed case can only be changed to “Re-opened.”Error Message:

StatusError Location:
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User, Role, and Profile Validation Rules

Discount Percent Does Not Exceed Role-Based Limit

Validates that a custom field on opportunities called Discount Percent does not
exceed a maximum value that varies depending on the user’s role. The default maximum
is 15%.

Description:

Discount_Percent__c  >
   CASE( $UserRole.Name,
      "CEO", 0.95,
      "SVP, Sales & Marketing", 0.8,
      "VP, International Sales", 0.5,
      "VP, North American Sales", 0.5,
      "Director, International Sales", 0.3,
      "Director, Channel Sales", 0.2,
      0.15)

Formula:

Discount (%) exceeds limit allowed for your role.Error Message:

Discount PercentError Location:

Expense Amount Does Not Exceed User's Max Allowed Expense

Validates a custom field called Expense Amount against a custom user field called Max
Allowed Expense.

Description:

Expense_Amount__c > $User.Max_Allowed_Expense__cFormula:

Amount cannot exceed your maximum allowed expense.Error Message:

Expense AmountError Location:

Only Record Owner Can Change Field

Ensures that only the record owner can make changes to a custom field called Personal
Goal.

Description:

AND(
   ISCHANGED( Personal_Goal__c ),
   Owner <> $User.Id 
)

Formula:

Only record owner can change Personal Goal.Error Message:

Personal GoalError Location:
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Only Record Owner or Administrator Can Change Field

Ensures that only the record owner or users who have a custom profile of “Custom:
System Admin” can make changes to a custom field called Personal Goal.

Description:

AND(
   ISCHANGED( Personal_Goal__c ),
   Owner <> $User.Id,
    $Profile.Name <> "Custom: System Admin"
)

Formula:

Only record owner or administrator can change Personal Goal.Error Message:

Personal GoalError Location:

Opportunity Close Date Can Only Be Back-Dated by Administrator

Validates that the Close Date of an opportunity does not fall prior to the current
month, except for users who have a custom profile called “Custom: System Admin.”

Description:

AND(
  OR (
     ISNEW(), 
     ISCHANGED( CloseDate )), 
  CloseDate < DATE( YEAR(TODAY()), MONTH(TODAY()), 1),
   $Profile.Name <> "Custom: System Admin"
)

Formula:

Close Date cannot be prior to current month.Error Message:

Close DateError Location:

Other Validation Rules

Allow Number to Be Increased but Not Decreased

Allows a custom field called Commit Amount to be increased but not decreased after
initial creation. This rule uses the PRIORVALUE() function to compare the updated
value of the field to its value prior to update.

Description:

PRIORVALUE(Commit_Amount__c) > Commit_Amount__cFormula:

Commit Amount cannot be decreased.Error Message:

Commit AmountError Location:
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Force Users to Check "I Accept Terms" to Enter Certain Values

Uses a checkbox labeled “I accept terms” to force the user to select a checkbox in order
to enter a value called Number of Days that exceeds their Paid Time Off (PTO) balance
available.

Description:

AND(
    NOT( I_accept_terms__c  ),
    Number_of_Days__c > $User.PTO_Balance__c
)

Formula:

Request will cause a negative PTO balance. You must accept Negative PTO Balance
terms.

Error Message:

I accept termsError Location:

Prohibit Changes to a Field After It Has Been Saved

Prevents users from changing a custom field called Guaranteed Rate after it has been
saved initially.

Description:

AND( 
   NOT( ISNEW() ),
   ISCHANGED( Guaranteed_Rate__c )
)

Formula:

Guaranteed Rate cannot be changed.Error Message:

Guaranteed RateError Location:

Social Security Number Format

Validates that a custom text field called SSN is formatted in 999-99-9999 number format
(if it is not blank).

Description:

NOT(
OR(LEN(SSN__c) = 0,
AND(
  LEN( SSN__c ) = 11,
  CONTAINS("0123456789", LEFT( SSN__c, 1)), 
  CONTAINS("0123456789",  MID( SSN__c, 2, 1)),
  CONTAINS("0123456789",  MID( SSN__c, 3, 1)),
  MID( SSN__c, 4, 1) = "-",
  CONTAINS("0123456789",  MID( SSN__c, 5, 1)),
  CONTAINS("0123456789",  MID( SSN__c, 6, 1)),
  MID( SSN__c, 7, 1) = "-",
  CONTAINS("0123456789",  MID( SSN__c, 8, 1)),
  CONTAINS("0123456789",  MID( SSN__c, 9, 1)),
  CONTAINS("0123456789",  MID( SSN__c, 10, 1)),
  CONTAINS("0123456789",  MID( SSN__c, 11, 1))
)))

Formula:

SSN must be in this format: 999-99-9999.Error Message:

SSNError Location:
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Valid Currency

Validates selected currency against an explicit subset of active currencies in your
organization using the Currency picklist. Use this example if you only allow some of
the active currencies in your organization to be applied to certain types of records.

Description:

CASE(CurrencyIsoCode,
  "USD", 1,
  "EUR", 1,
  "GBP", 1,
  "JPY", 1,
   0) = 0

Formula:

Currency must be USD, EUR, GBP, or JPY.Error Message:

CurrencyError Location:

Website Extension

Validates a custom field called Web Site to ensure its last four characters are in an
explicit set of valid website extensions.

Description:

AND(
   RIGHT( Web_Site__c, 4) <> ".COM",
   RIGHT( Web_Site__c, 4) <> ".com",
   RIGHT( Web_Site__c, 4) <> ".ORG",
   RIGHT( Web_Site__c, 4) <> ".org",
   RIGHT( Web_Site__c, 4) <> ".NET",
   RIGHT( Web_Site__c, 4) <> ".net",
   RIGHT( Web_Site__c, 6) <> ".CO.UK",
   RIGHT( Web_Site__c, 6) <> ".co.uk"
)

Formula:

Web Site must have an extension of .com, .org, .net, or .co.uk.Error Message:

Web SiteError Location:

Packaging and Upgrading
Available in: Team, Professional, Enterprise, Unlimited, and Developer Editions

AppExchange packaging enhancements and upgrading capabilities give developers access to the most robust development
platform in the industry. Now, Apex developers can share apps rapidly, offer upgrades, and track their customer's licenses and
installed versions.

Key capabilities of AppExchange packaging and upgrading:

• Upgradeable packages, referred to as "managed packages" in Salesforce
• Namespaces that uniquely identify a developer's components
• License management app
• Packageable extensions
• Additional packageable components
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Implementation Tips

• You must use a Developer Edition organization to create and work with a managed package.
• A Developer Edition organization can contain a single managed package and many unmanaged packages.
• Before converting an unmanaged package to managed, enable your organization to create managed packages. Follow the

instructions in "Enabling Managed Packages for Your Organization" in the Salesforce online help.
• All packages are unmanaged unless otherwise indicated by one of the following managed icons:

• Managed - Beta
• Managed - Released
• Managed - Installed

• You can offer beta versions of a managed package to a small sampling of your users if you are still developing the components
within the package but want to allow beta testers to install it and provide feedback. For more information on how beta
versions of managed packages behave, see "Using Beta Versions of Managed Packages" in the Salesforce online help.

• Installers of managed packages are not able to downgrade to earlier versions.
• When you release a managed package, meaning it is uploaded without the Beta checkbox selected, the properties of its

components change to prevent developers and installers from making harmful changes. For a list of each component type
and these properties, see "Properties of Managed Components" in the Salesforce online help. If you do not want to offer
upgrades to your package, consider keeping it unmanaged.

• Some components in a released managed package are always editable. For a list of these attributes, see "Properties of
Managed Components" in the Salesforce online help.

Best Practices

• You can use the same license management organization to manage many different managed packages in different Developer
Edition organizations. A license management organization is any Enterprise, Unlimited, or Developer Edition organization
that has installed the free License Management App from the AppExchange.

• Convert your unmanaged package to a managed package if you plan on developing new versions of your app, intend to
manage licenses, or want to ensure your installers never have namespace conflicts.

• Create your package before changing your developer settings.
• If you requested a unique four-character ID from salesforce.com prior to Winter '07, you still need to register a namespace

prefix. Existing components that include your unique four-character ID will have the namespace prefix automatically
appended to their API name. For example, if you previously used the API name abcd.Expense__c to access the Expense
object from the API and you register the same prefix using the new process, use abcd__abcd.Expense__c to access this
object from the API going forward.

• If you own more than one managed package in different Developer Edition organizations, choose a namespace prefix that
identifies both your name and the name of the package. For example, mbenioffApp1, mbenioffApp2, and mbenioffApp3
would be good namespace prefixes for all the apps that Marc Benioff owns.

• If you are planning to use the same License Management App for more than one managed package, make sure you name
the packages and versions uniquely so that you can tell which installs are for which package.

• Choose a namespace prefix that is short.

Setting Up AppExchange Upgrades

About Managed Packages

Managed packages are AppExchange packages that can be upgraded in the installer's organization.They differ from unmanaged
packages in that some components are locked, ensuring a smoother upgrade process. "Unmanaged Packages" in the Salesforce
online help do not include locked components.
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Managed packages differ from unmanaged packages in many other ways. Before creating managed packages, here are a few
things to consider:

• You must use a Developer Edition organization to create and work with a managed package.
• A Developer Edition organization can contain a single managed package and many unmanaged packages.
• Before converting an unmanaged package to managed, enable your organization to create managed packages. Follow the

instructions in "Enabling Managed Packages for Your Organization" in the Salesforce online help.
• All packages are unmanaged unless otherwise indicated by one of the following managed icons:

• Managed - Beta
• Managed - Released
• Managed - Installed

• You can offer beta versions of a managed package to a small sampling of your users if you are still developing the components
within the package but want to allow beta testers to install it and provide feedback. For more information on how beta
versions of managed packages behave, see "Using Beta Versions of Managed Packages" in the Salesforce online help.

• Installers of managed packages are not able to downgrade to earlier versions.
• When you release a managed package, meaning it is uploaded without the Beta checkbox selected, the properties of its

components change to prevent developers and installers from making harmful changes. For a list of each component type
and these properties, see "Properties of Managed Components" in the Salesforce online help. If you do not want to offer
upgrades to your package, consider keeping it unmanaged.

• Some components in a released managed package are always editable. For a list of these attributes, see "Properties of
Managed Components" in the Salesforce online help.

Tip: The Managed - Released or Managed - Installed icon on any detail or edit page indicates that the item is
included in a managed package and may not be editable. Click Display More Information to view which attributes
you can edit. For a list of packageable items and their editable attributes, see "Properties of Managed Components"
in the Salesforce online help.

Enabling Managed Packages for Your Organization

User Permissions Needed

"Customize Application"To enable managed packages:

"Create AppExchange Packages"To create packages:

"Upload AppExchange Packages"To upload packages:

Creating a managed package is just as easy as creating an unmanaged package, but it requires a few customizations in your
organization first. The only requirement for enabling your Salesforce organization to create managed packages is that you are
using a Developer Edition organization.

To enable your organization for managed packages:

• Review the information about managed packages before determining if this is the right type of package for your app.
• Install the License Management App from www.appexchange.com. Search for "License Management App" to locate it.

The License Management App tracks information about each user who installs your app. It allows you to track what users
have which version, giving you a means of distributing information about upgrades.

The License Management App can be installed in any Salesforce organization except a Personal, Team, or Professional
Edition organization and does not need to be the same Salesforce organization that you use to create or upload the package,
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although it can be. You can also use the same License Management App to manage an unlimited number of your managed
packages in different Developer Edition organizations.

• Configure your developer settings. Your developer settings specify your namespace prefix, the Salesforce organization
where you install the License Management App, and the unmanaged package you want to convert into a managed package.

Planning the Release of Managed Packages

Releasing an AppExchange app is similar to releasing any other program in software development. You may want to roll it
out in iterations to ensure each component functions as planned. You may even have beta testers who have offered to install
an early version of your app and provide feedback.

Once you release an app by publishing it on the AppExchange directory, anyone can install it. So, plan your release carefully.
Review the states defined below to familiarize yourself with the release process. Salesforce automatically applies the appropriate
state to your package and components depending on the upload settings you choose and where it is in the release process.

DescriptionState

The package has not been converted into a managed package
or the component has not been added to a managed package.

Unmanaged

Note that a component that is "Managed - Beta" can become
"Unmanaged" if it is removed from a managed package. All
packages are unmanaged unless otherwise indicated by one of
the managed icons below.

The package or component was created in the current
Salesforce organization and is managed, but it is not released
because of one of these reasons:

Managed - Beta

• It has not been uploaded.
• It has been uploaded with Beta selected. This option

prevents it from being published, publicly available on the
AppExchange.The developer can still edit any component
but the installer may not be able to depending on the
"Properties of Managed Components" in the Salesforce
online help.

The package or component was created in the current
Salesforce organization and is managed. It is also uploaded

Managed - Released

with Beta not selected, indicating that it can be published on
the AppExchange and publicly available. Note that once you
have moved a package to this state, some properties of the
components are no longer editable for both the developer and
installer. For a list of these properties in Managed - Released
packages, see "Properties of Managed Components" in the
Salesforce online help.

The package or component was installed from another
Salesforce organization but is managed.

Managed - Installed

Using Beta Versions of Managed Packages

A beta package is an early version of a managed package that is uploaded to the AppExchange with a Beta checkbox selected.
The purpose of a beta package is for the developer to share it with a sampling of the intended audience to test it, gather
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feedback, and enhance it before releasing it to a wider audience. Before installing a beta version of a managed package, review
the following notes:

• Beta versions of managed packages are indicated in the developer's organization by the following icon: Managed - Beta
• Beta versions of managed packages are indicated by the same icon as managed released packages in the installer's organization:

Managed - Installed
• Users can install beta packages in Salesforce Sandbox or Developer Edition organizations only.
• The properties of managed components apply to installers of beta versions of a managed package. However, these restrictions

do not apply to developers. Because developers beta test packages to get feedback, uncover critical feature gaps, and fix
bugs, the components of a beta managed package are still editable in the developer's organization until the developer
uploads the package without the Beta checkbox selected.

• When a developer uploads a managed package without selecting the Beta checkbox, that package is no longer beta and
can be registered and published on the AppExchange.

• Beta versions of managed packages are not upgradeable. Because developers can still edit the components of a beta package,
the post-beta version may not be compatible with the copy a user has installed. We recommend attempting to upgrade
from a beta version of a managed package first. If that fails, uninstall the beta package and install the managed released
version.

Properties of Managed Components

The components in a managed package behave differently than those in an unmanaged package at different points in the
release process. For example, an installer cannot change certain properties of managed components in any package that is in
a Managed - Installed state, regardless of whether it is beta. Likewise, the developer cannot change certain properties of
managed components in any package that is in a Managed - Released state. However, Managed - Beta components have the
same properties as unmanaged components in the developer's organization. Developers should determine when the right time
is to make a beta package Managed - Released because doing so restricts the properties of each component within it. To
understand each state of a managed package, see "Planning the Release of Managed Packages" in the Salesforce online help.
Components in a managed packaged have one of the following properties:

• Editable but not upgradeable.

This means that components are editable in both the developer's and installer's organization. Editable components are not
upgradeable. Salesforce remembers which editable components an installer has deleted so that it does not reinstall unwanted
components. For example, the installer can delete a document that was included in a managed package and upgrades to
that package that still include the document will not get installed again. Any changes the installer makes are also not
overwritten during upgrades. Likewise, the publisher can make changes to documents and even delete them but that does
not affect the installed users. Each installer can have different versions of these items because new installers get the
component with the latest attributes but previous installers do not get their version of the component updated.

• Restricted in the installer's and publisher's organization.

A restricted component may have some attributes that are editable in the installer's organization but other attributes that
are editable in the publisher's organization.

• Locked in both the developer's and installer's organization; this ensures that the components can be upgraded smoothly.

Developers can always add additional components to a managed package regardless of its state with a few exceptions:

• Once a managed package is Managed - Released, the developer can make changes to the profile settings but installers
will not get these changes when upgrading. We recommend contacting installers to ask them to make important profile
changes manually when they upgrade.

• Developers can add universally required custom fields to managed packages as long as they have default values.
• Developers cannot add auto number fields to Managed - Released packages.

Before releasing a managed package, review the properties of each managed released component in the installer's and publisher's
organizations.
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Property in Developer's OrganizationProperty in Installer's OrganizationComponent Type

Can change the Label or
Description.

Can change the Logo, the order of tabs,
which tabs are displayed, and the profiles
that can view the app. Can also designate

Custom apps

whether to overwrite users' custom app
customizations.

Can change Content Source,
Behavior,Label,Description,URL,
Link Encoding, and s-control.

Can change window open properties.Custom buttons

Can change Content Source,
Behavior,Label,Description,URL,

Can change window open properties.Custom links

Link Encoding, s-control, and
Display Type.

Can change the Label, Description,
auto-number Display Format,

Can change picklist sorting and values.Custom fields and relationships (on
custom objects)

Related List Label, default value,
and formula.

Can change the Label, Description,
auto-number Display Format,

Can change Restricted Admin
Field.

Custom fields (on standard objects)

Related List Label, default value,
and formula.

Can change the Label, Description,
Deployment Status, and Record
Name.

Can only delete when the package is 
Managed - Beta.

Can change sharing settings,
Deployment Status and Track
Field History.

Custom objects

Editable but not upgradeable.Editable but not upgradeable.Custom reports

Can change Label, Description,
Encoding, HTML Body, Filename,
and Content.

Can only delete the s-control or change
the source when the package is 
Managed - Beta.

LockedCustom s-controls

Can change Label, Description,
Encoding, and Splash Page Custom
Link.

Can change Tab Style and icon.Custom tabs

Editable but not upgradeable.Editable but not upgradeable.Dashboards

Editable but not upgradeable.Editable but not upgradeable.Documents

LockedLockedEmail templates (including letterheads)

Editable but not upgradeable.Editable but not upgradeable.Email template attachments
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Property in Developer's OrganizationProperty in Installer's OrganizationComponent Type

Locked

Can only delete or change Public
Folder Access when the package is

Managed - Beta.

Can change Public Folder Access
and sharing settings.

Folders

Can change Description, Name,
whether it is active, and any attribute

LockedLetterheads

available when you click Edit
Letterhead.

Editable but not upgradeable.Editable but not upgradeable.Page layouts (on custom objects)

Editable but not upgradeable.Editable but not upgradeable.Profiles

Editable but not upgradeable.Editable but not upgradeable.List views (only public list views on
custom objects)

Editable but not upgradeable.Editable but not upgradeable.Record types (on custom objects)

Editable but not upgradeable.Editable but not upgradeable.Related list layouts

Editable but not upgradeable.Editable but not upgradeable.Search layouts

Can change Description, formula,
Error Message, and Error
Location.

Can only delete or change the name
when the package is Managed - Beta.

Can change Active flag.Validation Rules (on custom objects)

Can change Tab Type (URL or
s-control), Label, Description, URL,

Can change Tab Style and icon.Web Tabs

s-control,Encoding,Has Sidebar,
Height, and Splash Page Custom
Link.

Enabling Managed Packages for Your Organization

User Permissions Needed

"Customize Application"To enable managed packages:

"Create AppExchange Packages"To create packages:

"Upload AppExchange Packages"To upload packages:

Creating a managed package is just as easy as creating an unmanaged package, but it requires a few customizations in your
organization first. The only requirement for enabling your Salesforce organization to create managed packages is that you are
using a Developer Edition organization.

To enable your organization for managed packages:

• Review the information about managed packages before determining if this is the right type of package for your app.
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• Install the License Management App from www.appexchange.com. Search for "License Management App" to locate it.
The License Management App tracks information about each user who installs your app. It allows you to track what users
have which version, giving you a means of distributing information about upgrades.

The License Management App can be installed in any Salesforce organization except a Personal, Team, or Professional
Edition organization and does not need to be the same Salesforce organization that you use to create or upload the package,
although it can be. You can also use the same License Management App to manage an unlimited number of your managed
packages in different Developer Edition organizations.

• Configure your developer settings. Your developer settings specify your namespace prefix, the Salesforce organization
where you install the License Management App, and the unmanaged package you want to convert into a managed package.

Configuring Your Developer Settings

User Permissions Needed

"Customize Application"To configure developer settings:

"Create AppExchange Packages"To create packages:

"Upload AppExchange Packages"To upload packages:

The developer settings in a Developer Edition organization allow you to create a single managed package and upload that
package to the AppExchange directory so other users can install and upgrade the package in their organization. After configuring
your developer settings the first time, you can no longer modify them.

Note:  Regardless of the developer settings, you can always create an unlimited number of unmanaged packages.

Before configuring your developer settings, review the requirements and steps in "Enabling Managed Packages for Your
Organization" in the Salesforce online help.

To configure your developer settings:

1. Click Setup ➤ Exchange ➤ Shared Apps.
2. Click Edit.

Note: This button does not appear if you have already configured your developer settings.

3. Review the selections necessary to configure developer settings, and click Continue.
4. Register a namespace prefix.
5. Choose the package you want to convert to a managed package. If you do not yet have a package to convert, leave this

selection blank and update it later.
6. Specify a license management organization. If you have not yet installed the License Management App, select Do this

later.
7. Click Review My Selections.
8. Click Save. Salesforce automatically prepends your namespace prefix, followed by two underscores ("__"), to all unique

component names in your Salesforce organization. A unique component is one that requires a name that no other component
has within Salesforce, such as custom objects, custom fields, custom links, s-controls, and validation rules.
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Registering a Namespace Prefix

User Permissions Needed

"Customize Application"To configure developer settings:

"Create AppExchange Packages"To create packages:

"Upload AppExchange Packages"To upload packages:

A namespace prefix is a one to 15-character alphanumeric identifier that distinguishes your package and its contents from
packages of other developers on the AppExchange. Your namespace prefix must be globally unique across all Salesforce
organizations. It keeps your managed package under your control exclusively.

Salesforce automatically prepends your namespace prefix, followed by two underscores ("__"), to all unique component names
in your Salesforce organization. A unique component is one that requires a name that no other component has within Salesforce,
such as custom objects, custom fields, custom links, s-controls, and validation rules. For example, if your namespace prefix is
abc and your managed package contains a custom object with the API name, Expense__c, use the API name abc__Expense__c
to access this object using the API.

Caution: S-controls that are stored in the s-control library or the Documents tab that do not use the Apex API will
still function properly after you register a namespace prefix. However, s-controls stored outside of your organization
or s-controls that use the Apex API to call Salesforce may require some fine tuning.

Your namespace prefix must:

• Begin with a letter
• Contain one to 15 alphanumeric characters. We recommend a shorter length for convenience.
• Not contain two consecutive underscores

To register a namespace prefix:

1. From the developer settings configuration page, enter a requested namespace prefix in the space provided.
2. Click Check Availability to determine if it is already in use.
3. Repeat if the namespace prefix you entered is not available.
4. Complete the remaining developer settings as needed.

Note:  If you requested a unique four-character ID from salesforce.com prior to Winter '07, you still need to register
a namespace prefix. Existing components that include your unique four-character ID will have the namespace prefix
automatically appended to their API name. For example, if you previously used the API name abcd.Expense__c to
access the Expense object from the API and you register the same prefix using the new process, use
abcd__abcd.Expense__c to access this object from the API going forward.

Specifying a License Management Organization

User Permissions Needed

"Customize Application"To configure developer settings:

"Create AppExchange Packages"To create packages:

"Upload AppExchange Packages"To upload packages:
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A license management organization is a Salesforce organization that you use to track all Salesforce subscribers who install your
managed package. The license management organization receives notification (in the form of a lead record) when a subscriber
installs or uninstalls your package and tracks each package upload on the AppExchange directory.

Your license management organization can be any Salesforce Enterprise, Unlimited, or Developer Edition organization that
has installed the free License Management App from the AppExchange directory.

Note:  Ensure that there is sufficient free space for the LMA app and multiple license records in the organization that
you will use as the LMO. We recommend that you install the LMA in an Enterprise edition or Unlimited edition
organization to avoid storage limit errors. If you choose to use a Developer edition organization as your LMO, we
recommend using it only for the LMO and not for developing apps.

Caution:  Once you specify a license management organization, you are not able to change it.

From the developer settings configuration page, specify a license management organization from one of the following options:

• Make this Salesforce organization my license management organization.

Choose this option to make the Salesforce organization you are currently using the one that contains the License Management
App and the one you use to store information about the Salesforce users who have installed your managed package. If you
have not yet installed the License Management App, click the Get It Now! link to do so now.

• Make a different Salesforce organization my license management organization.

Choose this option to make another Salesforce organization the one you use to install the License Management App and
store information about the Salesforce users who have installed your managed package.Your license management organization
can be any Salesforce organization, except a Personal, Team, or Professional Edition organization. Choosing this option
requires the Salesforce username and password to the organization you select. To use a single Salesforce organization to
manage multiple managed packages published from different Developer Edition organizations, select this option and enter
the username and password for that Salesforce organization.

• Make a third-party Salesforce organization my license management organization.

Choose this option to make another Salesforce organization install the License Management App and store information
about the Salesforce users who have installed your package. Your license management organization can be any Salesforce
organization, except a Personal, Team, or Professional Edition organization. This option allows you to enter the email
address, not the Salesforce username, of a representative for a third party who can accept a license management request.
Salesforce sends a license management request in email prompting this person to accept or reject the request.

• Do this later.

Choose this option to skip this step and choose a license management organization at another time.

Note: The License Management App automatically adds a new user, License Manager, to any Salesforce organization
that installs your managed package. This is a free user license and allows the License Management App to track which
version is installed.

Publishing Upgrades to Managed Packages

User Permissions Needed

"Customize Application"To configure developer settings:

"Create AppExchange Packages"To create packages:

"Upload AppExchange Packages"To upload packages:
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As a publisher, first ensure that your app is upgradeable by converting it to a managed package. Any changes you make to the
components in a managed package are automatically included in subsequent uploads of that package.

To publish upgrades to a managed package:

1. Select the package from the list of packages available at Setup ➤ Exchange ➤ Shared Apps.
2. View the list of package items. Changes you have made to the items in this package are automatically included. If the

changes reference additional items, those items are automatically included as well. To add new items, click Add to add
them to the package manually.

3. Click Upload to AppExchange and upload it as usual.
4. When you receive an email with the link to the upload on the AppExchange directory, notify your installed users that the

new version is ready. Use the list of installed users from the License Management App to distribute this information. The
License Management App automatically stores the version number that your installers have in their organizations.

Publishing Extensions to Managed Packages

User Permissions Needed

"Create AppExchange Packages"To create packages:

"Upload AppExchange Packages"To upload packages:

The community of developers, users, and visionaries building and publishing apps on the AppExchange directory is part of
what makes Apex such a rich development platform. Use this community to build extensions to other apps and encourage
them to build extensions to your apps.

An extension is any package, component, or set of components that adds to the functionality of a managed package. An
extension requires that the base managed package is installed for it to work. For example, if you have built a recruiting app,
an extension to this app might include a component for performing background checks on candidates.

To publish extensions to a managed package:

1. Install the base package in the Salesforce organization that you plan to use to upload the extension.
2. Build your extension components.
3. Create a new package and add your extension components. Salesforce automatically includes some related components.

See "What is automatically included in a package?" in the Salesforce online help for more information.
4. Upload the new package that contains the extension components.
5. Proceed with the publishing process as usual:

• "Create a test drive" in the Salesforce online help

Note:  If you are creating a test drive for an extension, Salesforce simply creates a test drive environment. After
that, log in to the test drive environment and install both the base package and extension for your uploaded
package.

• "Register the extension" in the Salesforce online help
• Go to www.appexchange.com for information on how to publish your app

Apex Mobile
Available in: Unlimited and Developer Editions
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Available for an additional cost in: Professional and Enterprise Editions

The Winter ‘07 Apex Mobile release introduces Apex Mobile on Windows Mobile 5 selected devices. It also includes many
new features and performance enhancements on the RIM BlackBerry and Palm Treo platforms.

For more detailed descriptions and screenshots, download the updated user guides from the Apex Mobile Administration
Console or direct your users to their Self-Management Console.

About Apex Mobile

Apex Mobile on Windows Mobile 5

Winter ’07 introduces the first release of Apex Mobile on the Windows Mobile 5 platform. The following features are now
available:

• SFA Support - accounts, contacts, leads, opportunities, tasks, and events
• Custom objects and custom fields support
• Authentication workflow (Activation, Login, Verification, Change Password)
• Two-column view on all list screens with clickable column headers
• Record types and page layouts support
• Simple and advanced remote search capability
• Local find per object on the list screen
• New user interface
• Collapsible sections
• Lead conversion
• Directing users for support
• Auto-pin discovery
• Transport Connection Status clickable icon
• PIM Integration: place calls and send emails directly from a record in Apex Mobile. Built-in workflow gives you the option

to log the activity.
• Password masking
• Dependent, multi-select, and combo picklists

Device Certifications

• Cingular (HTC) 8125
• Verizon/Vodafone Treo 700w
• Sprint Treo 700wx
• TIM I-mate JasJar
• Vodafone I-mate JasJar
• Wind I-mate JasJar
• 3 I-mate JasJar
• T-Mobile I-mate JasJar
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Application Enhancements

Calendar User Interface

With Winter ‘07, Apex Mobile adds a new user interface to the Event tab. Salesforce events can now be viewed on Apex
Mobile in day, week, month, or list view, allowing customers to easily navigate to the most relevant events.

• Click the ‘7’ icon (or access via trackwheel) to read events in the week view. Click any date in that given week to view the
events scheduled for that day.

• On the week or month view, a bold date indicates that one or more events are scheduled.
• Custom views into the local data can still be applied in conjunction with the day, week, month, or list view.

Change Record Ownership

Users can now change ownership of a record using the mobile device. From the view screen of the record, click the trackwheel
and select Change Owner.

Note:  Permissions are inherited directly from Salesforce; if you have permission to reassign a record to another user
in the online user interface, you can via Apex Mobile as well.

Implementation Tips for Administrators

When reassigning a record to another user, the user list from which you select is compiled from the local list of users stored
on the device. This list is built dynamically when the profile is run and queries automatically retrieve owners of all records in
the mobile profile.

Thus, if a profile is set up to only retrieve records owned by that person, the user list may be empty. In this case, it is
recommended that the administrator mobilize the User object, and write a query that retrieves the user records that the user
(or group of users) assigned to this profile will most likely need to access.

Alternatively, the user could run a search for ‘Users’ and retrieve those user records to store locally.

General Enhancements for the RIM BlackBerry Platform

New Device Certifications

• United States – Cingular 7130c
• United States – SprintPCS 7130e
• United States – Cingular/AT&T 8700c
• United States – T-Mobile 8700g
• UK – Vodafone 8700v

Deployment Enhancements

Deployment enhancements have been made to the BlackBerry platform to help ease the download and installation process of
Apex Mobile. Details include:

• Auto-configuration of transport parameters
• Checking on device for storage allocation
• Detection of OS via installer
• Performing an auto start after a required reboot of the device
• Clearer messaging when a mobile profile is broken
• Better handling when a device radio is turned off
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Battery Life Enhancements

Many enhancements have been made to the battery life on the RIM BlackBerry devices. Through multiple energy saving
measures and timers, drainage rates have dropped dramatically and battery efficiency has escalated, greatly improving the Apex
Mobile user experience on the RIM platform.

General Enhancements for the Palm Treo Platform

New Device Certifications

• United States – Verizon 700p
• United States – Sprint PCS 700p

Combo Picklist Default Values

The Palm Treo Apex Mobile application now supports combo picklists and their default values. Any combo picklist field types
created in Salesforce are now supported in a create, read, update, or delete request via Apex Mobile.

Apex Mobile Administration Console

The mobile administration console has many new features and points of integration in this release. New features such as
Mobile Trials extend the ability to showcase the Apex Mobile application to prospects without support or sales interaction.
New integration initiatives such as single sign-on will greatly improve the mobile administrator's experience and lessen the
burden of administrating users in two places.

Mobile Trials

Salesforce users can now sign up for a trial of Apex Mobile. Upon completing the registration process, users will receive an
email with instructions for installing the Apex Mobile client on their device. During the activation process, a default profile
is used to retrieve key information from the user’s organization including tasks, events, accounts, contacts, opportunities, leads
and other objects. The default profile can be customized to retrieve any custom object to which the user has access.

Integrated Mobile Administration Console

Mobile Administrators can now manage all aspects of their mobile deployments from within their Salesforce organization.
Specifically, Mobile Administrators can install a private AppExchange package to manage mobile users, mobile profiles, and
devices. Administrators may access the console via single sign-on without having to authenticate.

Device Info Auto Discovery

Users can now be configured on the console without being associated to a device. The end-user process has not changed at
all; the user receives a welcome installation email from which they will download and install the Apex Mobile software. Once
the user enters his or her Salesforce credentials to activate the account, the installer detects the device PIN, manufacturer,
model, OS, and transport, and auto-creates the device record in the console.

AJAX Toolkit
The Winter ’07 release introduces the Apex AJAX Toolkit 8.0. The AJAX Toolkit allows developers to easily create dynamic
Web pages and s-controls that harness the full power of the Apex API 8.0 (Apex API 8.0 on page 193).

• Full-Featured API Support: The AJAX Toolkit includes complete support for the Apex API version 8.0. The AJAX
Toolkit also binds Salesforce components to JavaScript objects and provides complete schema support, including custom
objects and custom fields.
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• User Interface Integration: Leverage the AJAX Toolkit in your s-control or dynamic Web page. With integrated session
management, the toolkit automatically establishes a session—there’s no need for merge fields or separate login calls.

• High Performance: The AJAX Toolkit is tuned for high performance and scalability from the ground up.

Apex API 8.0
The Apex API is the key to how salesforce.com enables The Business Web. Just like consumer Web services like Google,
Amazon.com, and eBay, salesforce.com opens its services to the public to allow you to customize and integrate Salesforce for
your business and to enable an ecosystem of developers and software providers to build applications to meet the needs of the
salesforce.com community.

Winter ’07 introduces Apex API 8.0, salesforce.com’s most ambitious API release to date. Apex API 8.0 incorporates your
most frequently requested enhancements to create an API that is more powerful and efficient than ever before.

SOQL Relationships
With Winter ’07, you can retrieve a record and all its related records in a single query. For example, you
can retrieve all the data on a detail page including related list records with a single API call. You can also
filter queries based on the data in the parent record.

SOQL/SOSL Enhancements
Powerful new methods include:

• ORDER BY and LIMIT to control order and size of returned results.
• count() to return result size without retrieving any data.
• toLabel()  to retrieve translated values from the translation workbench.
• convertCurrrency() to filter/retrieve currency values using conversion rates.

Merge API
A single merge() call merges accounts, contacts, and leads. You can query and retrieve deleted and
archived objects with queryAll() and rescue items from recycle bin using undelete().

Upsert with Relationships
In the previous version of the API,upsert() could create or update a record using an ID from an external
master, streamlining data replication into Salesforce. In API 8.0, upsert() establishes relationships to
other records using external system IDs, allowing you to replicate data without knowing any Salesforce
IDs.

Metadata Enhancement
Enhanced describeLayout() allows the efficient retrieval of page layouts for large organizations.

New Platform Features and Objects Exposed
The new process() and processSubmit() methods enable programmatic processing of workflow
approvals. EmailTemplates, CampaignMemberStatus, and other new Winter ’07 objects are exposed in
the API. The SOAP header EmailHeader allows system email to be triggered via API calls. Also, you
can enable customer self service login via the API using the SOAP header LoginScopeHeader.

Outbound Messages
Polling the API is a thing of the past. You can reliably integrate in real time to any endpoint exposed on
the Internet by sending outbound messages based on workflow triggers:

• The outbound messaging functionality is based on familiar and easy-to-understand Salesforce concepts
like workflow.

• You can monitor the outbound message queue and the outbound message status.
• All outbound messages contain the necessary information to easily call back into the API for a complete

integration round-trip.
• Salesforce tries to resend outbound messages for up to 24 hours if an endpoint is temporarily unavailable.
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Data Loader Enhancements
Winter '07 includes a new version of the AppExchange Data Loader. The AppExchange Data Loader is a client application
that allows you to load data in bulk into or out of any Salesforce object. In Winter '07, version 8.0 offers a new operation,
upsert, as well as an entirely new command-line batch mode interface. All other existing functionality remains unchanged.

Implementation Tips

• Before installing or upgrading the client, confirm that your environment meets the system requirements:

• Windows 2000, Windows XP, Linux, or another operating system that supports Java™.

Windows users can run the AppExchange Data Loader wizards, while non-Windows users can run the application
from the command line.

• 90 MB free disk space.
• 256 MB available memory.
• Java JRE 1.5 or later.

• If you are using the command-line batch mode interface in version 7.0 or earlier, see Upgrading Your Batch Mode Interface
on page 197 before installing the new version.

About AppExchange Data Loader 8.0

What is the AppExchange Data Loader?

The AppExchange Data Loader is a client application for the bulk import or export of data. Use it to insert, update, delete,
or extract Salesforce records.

The AppExchange Data Loader can move data into or out of any type of record. When importing data, it reads, extracts, and
loads data from comma separated values (CSV) files. When exporting data, it outputs CSV files.

The AppExchange Data Loader offers the following key features:

• An easy-to-use wizard interface
• An alternate command line interface
• A batch mode interface with database connectivity
• Support for large files with up to millions of rows
• Drag-and-drop field mapping
• Support for all objects, including custom objects
• Detailed success and error log files in CSV format
• A built-in CSV file viewer
• Platform independence, by virtue of being written in Java®

To get started, see the following topics:

• "Installing the AppExchange Data Loader" in the Salesforce online help
• "When to Use the AppExchange Data Loader" in the Salesforce online help

For usage instructions, see the following topics:

• "Configuring the AppExchange Data Loader" in the Salesforce online help
• "Inserting, Updating, or Deleting Data" in the Salesforce online help
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• "Exporting Data" in the Salesforce online help
• "Using the Command Line Interface" in the Salesforce online help
• "Running in Batch Mode" in the Salesforce online help

Inserting, Updating, or Deleting Data

User Permissions Needed

"Create" on the recordTo insert records:

"Edit" on the recordTo update records:

"Create" or "edit" on the recordTo upsert records:

"Delete" on the recordTo delete records:

The insert, update, upsert, and delete wizards allow you to add new records, modify existing records, or delete existing records.
Note that "upsert" is a combination of inserting and updating - if a record in your file matches an existing record, the existing
record will be updated with the values in your file. If no match is found, then the record is created as new.

1. Start the AppExchange Data Loader by choosing Start ➤ Programs ➤ salesforce.com ➤ AppExchange Data Loader
8.0 ➤ AppExchange Data Loader.

2. Click Insert, Update, Upsert, or Delete. These commands can also be found in the File menu.
3. Enter your Salesforce username and password. Click Log in to log in. After your login completes successfully, click Next.

(Until you log out or close the program, you will not be asked to log in again.)
4. Choose an object. If your object name does not display in the default list, check Show all objects to see a complete

list of the objects that you can access. The objects will be listed by localized label name, with developer name noted in
parentheses. For object descriptions, see the Apex Web Services Developer’s Guide.

5. Click Browse... to select your CSV file.
6. Click Next. After the object and CSV file are initialized, click OK.
7. If you are performing an upsert:

a. Your CSV file must contain a column of ID values for matching against existing records. The column may be either
an external ID (a custom field with the "External ID" attribute), or Id (the Salesforce record ID). From the drop-down
list, select which field to use for matching. If the object has no external ID fields, Id will automatically be used. For
more information on external IDs, see "Custom Field Attributes" in the Salesforce online help. Click Next to continue.

b. If your file includes the external IDs of an object that has a relationship to your chosen object, enable that external ID
for record matching by selecting its name from the drop-down list. If you make no selection here, you can use the
related object's Id field for matching by mapping it in the next step. Click Next to continue.

8. Define how the columns in your CSV file map to Salesforce fields. Click Choose an Existing Map to select an existing
field mapping, or click Create or Edit a Map to create a new map or modify an existing map. See "Defining Field Mappings"
in the Salesforce online help for details.

9. Click Next.
10. For every operation, the AppExchange Data Loader generates two unique CSV log files; one filename starts with "success,"

while the other starts with "error." Click Browse... to specify a directory for these files.
11. Click Finish to perform the operation, and then click Yes to confirm.
12. As the operation proceeds, a progress information window reports the status of the data movement.
13. After the operation completes, a confirmation window will summarize your results. Click View Successes to view your

success file, click View Errors to open your errors file, or click OK to close. See "Reviewing Output Files" in the Salesforce
online help for more information.
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Tip:  If you are updating or deleting large amounts of data, review "Performing Mass Updates" in the Salesforce online
help and "Performing Mass Deletes" in the Salesforce online help for tips and best practices.

Importing Attachments with the AppExchange Data Loader

You can use the AppExchange Data Loader to import attachments to Salesforce.

1. If you are migrating attachments from a source Salesforce organization to a target Salesforce organization, begin by
requesting a weekly data export for the source organization. On the Schedule Export page, make sure to select the Include
Attachments... checkbox, which causes the file Attachment.csv to be included in your export. You can use that file
in the next step. For more information on the weekly export service, see "Exporting Backup Data" in the Salesforce online
help.

2. Confirm that the CSV file you intend to use for attachment importing contains the following columns (each column
represents a Salesforce field):

• ParentId - the Salesforce ID of the parent record.
• Name - the name of the attachment file, such as myattachment.jpg.
• IsPrivate - "0" if the attachment is not private; "1" if it is private.
• OwnerId - the Salesforce ID of the record owner.
• Body - the Salesforce ID of the attachment.

3. Edit the values in the Body column so they contain the full filename of the attachments as they exist on your computer.
For example, if an attachment with the ID "123456789" is located on your computer at C:\Export, then set the value as
C:\Export\123456789. For reference, see this sample CSV file.

4. Proceed with an insert or upsert operation; see "Inserting, Updating, or Deleting Data" in the Salesforce online help. At
the Select data objects step, make sure to select the Show all Salesforce objects checkbox, and the
Attachment object name in the list.

Note:  If your CSV file includes a column of pure attachment ID values, you can use a Microsoft Excel formula field
to prepend the directory path in front of the ID value.

Running in Batch Mode

On the Windows 2000 and Windows XP platforms, you can run the AppExchange Data Loader in batch mode from the
command line. See the following topics:

• "Understanding Installed Directories and Files" in the Salesforce online help
• "Spring Framework Overview" in the Salesforce online help
• "Running Individual Batch Processes" in the Salesforce online help
• "Configuring Batch Processes" in the Salesforce online help
• "Configuring Database Access" in the Salesforce online help
• "SQL Configuration" in the Salesforce online help
• "Mapping Columns" in the Salesforce online help
• "Command Line Operations" in the Salesforce online help
• "Data Access Objects" in the Salesforce online help
• "Encrypting From the Command Line" in the Salesforce online help

Note:  If you have used the batch mode from the command line with a version earlier than 8.0, see "Upgrading Your
Batch Mode Interface" in the Salesforce online help.

196

   
Apex Data Loader Enhancements

http://blogs.salesforce.com/blogs/files/attachments_to_import.csv


Upgrading Your Batch Mode Interface

The batch mode interface in versions 8.0 and later of the AppExchange Data Loader are not backwards-compatible with
earlier versions. If you are using a version earlier than 8.0 to run batch processes, your options are as follows:

Maintain the old version for batch use
Do not uninstall your old version of the AppExchange Data Loader. Continue to use that version for
batch processes. You will not be able to take advantage of newer features such as database connectivity,
but your integrations will continue to work. Optionally, install the new version alongside the old version
and dedicate the old version solely to batch processes.

Generate a new config.properties file from the new GUI
If you originally generated your config.properties file from the graphical user interface, use the new
version to set the same properties and generate a new file. Use this new file with the new batch mode
interface. For more information, see "Running in Batch Mode" in the Salesforce online help.

Manually update your config.properties file
If your old config.properties file was created manually, then you need to manually update it for the
new version. For more information, see "Understanding Installed Directories and Files" in the Salesforce
online help.

Understanding Installed Directories and Files

In versions 8.0 and later, installing the AppExchange Data Loader creates several directories under the installation directory.
The following directories are involved in running the program from the command line:

bin directory
Contains the batch files encrypt.bat for encrypting passwords and process.bat for running batch
processes.
These batch files can only be executed on a Windows platform. However, the commands they contain
will be similar for other platforms. For information on running the AppExchange Data Loader from the
command line on any platform, see "Using the Command Line Interface" in the Salesforce online help.

conf directory
The default configuration directory. Contains the configuration files config.properties,
Loader.class, and log-conf.xml.
The config.properties file that is generated when you modify the Settings dialog in the graphical
user interface is located at C:\Documents and Settings\<your Windows username>\Application
Data\salesforce.com\AppExchange Data Loader 8.0. You can copy this file to the conf installation
directory to use it for batch processes.

samples directory
Contains three subdirectories of sample files for reference.

File Path Convention

The file paths provided in these topics start one level below the installation directory. For example, \bin means C:\Program
Files \salesforce.com\AppExchange Data Loader 8.0\bin, provided you accepted the default installation directory.
If you installed the program to a different location, please substitute that directory path as appropriate.

Spring Framework Overview

The AppExchange Data Loader configuration files are based on the Spring Framework, which is an open source full-stack
Java/J2EE application framework.
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The Spring Framework allows you to use XML files to configure beans. Each bean represents an instance of an object; the
parameters correspond to each object's setter methods. A typical bean has the following attributes:

id

Uniquely identifies the bean to XmlBeanFactory, which is the class that gets objects from an XML
configuration file.

class

Specifies the implementation class for the bean instance.

For more information on the Spring Framework, see the official documentation and the support forums.

Running Individual Batch Processes

To start an individual batch process use\bin\process.bat, which requires the following parameters:

A configuration directory
The default is \conf.

To use an alternate directory, create a new directory and add the following files to it:

• If your process is not interactive, copy process-conf.xml from \samples\conf.
• If your process requires database connectivity, copy database-conf.xml from \samples\conf.
• Copy config.properties from \conf.

A process name
The name of the ProcessRunner bean from \samples\conf\process-conf.xml.

Process Example

process ./conf accountMasterProcess

Note: You can configure external process launchers such as the Microsoft Windows XP Scheduled Task Wizard or
a UNIX cron job to run processes on a schedule.

Configuring Batch Processes

Use \samples\conf\process-conf.xml to configure your AppExchange Data Loader processes, which are represented
by ProcessRunner beans. A process should have ProcessRunner as the class attribute and the following properties set in
the configuration file:

name

Sets the ProcessRunner name, which is also used as the nongeneric thread name and for configuration
backing files (see below).

configOverrideMap

A property of type map where each entry represents a configuration setting: the key is the setting name;
the value is the setting value.

The configuration backing file stores configuration parameter values from the last run and is used to load default configuration
parameters.The settings in configOverrideMap take precedence over those in the configuration backing file.The configuration
backing file is managed programmatically and does not require any manual edits.

For the names and descriptions of available process configuration parameters, see Data Loader Process Configuration Parameters.
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Configuring Database Access

When running the AppExchange Data Loader in batch mode from the command line, use
\samples\conf\database-conf.xml to configure database access objects.

DatabaseConfig Bean

The top-level database configuration object is the DatabaseConfig bean, which has the following properties:

sqlConfig

The SQL configuration bean for the data access object that interacts with a database.

dataSource

The bean that acts as database driver and authenticator. It must refer to an implementation of
javax.sql.DataSource such as org.apache.commons.dbcp.BasicDataSource.

DatabaseConfig Example

<bean id="AccountInsert"
    class="com.salesforce.lexiloader.dao.database.DatabaseConfig"
    singleton="true">
    <property name="sqlConfig" ref="accountInsertSql"/>
</bean>

DataSource

The DataSource bean sets the physical information needed for database connections. It typically has the following properties,
at minimum:

driverClassName

The fully qualified name of the implementation of a JDBC driver.

url

The string for physically connecting to the database.

username

The username for logging in to the database.

password

The password for logging in to the database.

Depending on your implementation, additional information may be required. For example, use
org.apache.commons.dbcp.BasicDataSource when database connections are pooled.

DataSource Example

<bean id="oracleRepDataSource"
    class="org.apache.commons.dbcp.BasicDataSource"
    destroy-method="close">
    <property name="driverClassName" value="oracle.jdbc.driver.OracleDriver"/>
    <property name="url" 
value="jdbc:oracle:thin:@myserver.internal.salesforce.com:1521:TEST"/>
    <property name="username" value="test"/>
    <property name="password" value="test"/>
</bean>
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SQL Configuration

When running the AppExchange Data Loader in batch mode from the command line, sqlConfig contains configuration
parameters for accessing specific data in the database. As shown in the code samples below, queries and inserts are different
but very similar. The bean must be of type com.salesforce.lexiloader.dao.database.SqlConfig and have the
following properties:

sqlString

The SQL code to be used by the data access object.

The SQL can contain replacement parameters that make the string dependent on configuration or
operation variables. Replacement parameters must be delimited on both sides by "@" characters. For
example, @process.lastRunDate@.

sqlParams

A property of type map that contains descriptions of the replacement parameters specified in sqlString.
Each entry represents one replacement parameter: the key is the replacement parameter's name, the value
is the fully qualified Java type to be used when the parameter is set on the SQL statement. Note that
"java.sql" types are sometimes required, such as java.sql.Date instead of java.util.Date. For more
information, see the official JDBC API documentation.

columnNames

Used when queries (SELECT statements) return a JDBC ResultSet. Contains column names for the
data outputted by executing the SQL. The column names are used to access and return the output to the
caller of the DataReader interface.

SQL Query Bean Example

<bean id="accountMasterSql"
    class="com.salesforce.lexiloader.dao.database.SqlConfig"
    singleton="true">
    <property name="sqlString"/>
        <value>
            SELECT distinct
                '012x00000000Ij7' recordTypeId,
                accounts.account_number,
                org.organization_name,
                concat (concat(parties.address1, ' '), parties.address2) billing_address,
                locs.city,
                locs.postal_code,
                locs.state,
                locs.country,
                parties.sic_code
            from
                ar.hz_cust_accounts accounts,
                ar.hz_organization_profiles org,
                ar.hz_parties parties,
                ar.hz_party_sites party_sites,
                ar.hz_locations locs
            where
                accounts.PARTY_ID = org.PARTY_ID
                and parties.PARTY_ID = accounts.PARTY_ID
                and party_sites.PARTY_ID = accounts.PARTY_ID
                and locs.LOCATION_ID = party_sites.LOCATION_ID
                and (locs.last_update_date > @process.lastRunDate@ OR 
accounts.last_update_date > @process.lastRunDate@
        </value>
    </property>
    <property name="columNames">
        <list>
            <value>recordTypeId</value>
            <value>account_number</value>
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            <value>organization_name</value>
            <value>billing_address</value>
            <value>city</value>
            <value>postal_code</value>
            <value>state</value>
            <value>country</value>
            <value>sic_code</value>
        </list>
....</property>
    <property name="sqlParams">
        <map>
            <entry key="process.lastRunDate" value="java.sql.Date"/>
        </map>
    </property>
</bean>

SQL Insert Bean Example

<bean id="partiesInsertSql"
    class="com.salesforce.lexiloader.dao.database.SqlConfig"
    singleton="true">
    <property name="sqlString"/>
        <value>
            INSERT INTO REP.INT_PARTIES (
            BILLING_ADDRESS, SIC_CODE)
            VALUES (@billing_address@, @sic_code@)
        </value>
    </property>
    <property name="sqlParams"/>
        <map>
            <entry key="billing_address" value="java.lang.String"/>
            <entry key="sic_code" value="java.lang.String"/>
        </map>
    </property>
</bean>

Mapping Columns

When running the AppExchange Data Loader in batch mode from the command line, you must create a properties file that
maps values between Salesforce and data access objects.

1. Create a new file.
2. Observe the following syntax:

• On each line, pair a data source with its destination.
• Put the data source on the left, an equals sign (=) as a separator, and the destination on the right.
• Data sources can be either column names or constants. Surround constants with double quotation marks, as in

"sampleconstant". Values without quotation marks are treated as column names.
• Destinations must be column names.
• You may map constants by surrounding them with double quotation marks, as in "United States"=BillingCountry.

3. In your configuration file, use the parameter process.mappingFile to specify the name of your mapping file.

Column Mapping Example for Data Insert

The Salesforce fields are on the right.

SLA__C=SLA__c
BILLINGCITY=BillingCity
SYSTEMMODSTAMP=
OWNERID=OwnerId
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CUSTOMERPRIORITY__C=CustomerPriority__c
ANNUALREVENUE=AnnualRevenue
DESCRIPTION=Description
BILLINGSTREET=BillingStreet
SHIPPINGSTATE=ShippingState

Column Mapping Example for Data Export

The Salesforce fields are on the left.

Id=account_number
Name=name
Phone=phone

Command Line Operations

When running the AppExchange Data Loader in batch mode from the command line, several operations are supported. An
operation represents the flow of data between Salesforce and an external data source such as a CSV file or a database. See the
following list of operation names and descriptions.

Extract

Uses a Salesforce Object Query Language (SOQL) string to export a set of records from Salesforce, then
writes the exported data to a data source. For more information about SOQL, visit the Apex Developer
Network.

Insert

Loads data from a data source into Salesforce as new records.

Update

Loads data from a data source into Salesforce, where existing records with matching ID fields will be
updated.

Upsert

Loads data from a data source into Salesforce, where existing records with a matching custom external
ID field will be updated; records without matches will be inserted as new records.

Delete

Loads data from a data source into Salesforce, where existing records with matching ID fields will be
deleted.

Data Access Objects

When running the AppExchange Data Loader in batch mode from the command line, several data access objects are supported.
A data access object allows access to an external data source outside of Salesforce. They can implement a read interface
(DataReader), a write interface (DataWriter), or both. See the following list of object names and descriptions.

csvRead
Allows the reading of a comma or tab-delimited file. There should be a header at the top of the file that
describes each column.

csvWrite
Allows writing to a comma or tab-delimited file. A header will be outputted at the top of the file based
on the column list provided by the caller.

databaseRead
Allows the reading of a database. Use database-conf.xml to configure database access. For more
information, see "Configuring Database Access" in the Salesforce online help.
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databaseWrite
Allows writing to a database. Use database-conf.xml to configure database access. For more
information, see "Configuring Database Access" in the Salesforce online help.

Encrypting From the Command Line

When running the AppExchange Data Loader in batch mode from the command line, you must encrypt the following
configuration parameters:

• sfdc.password

• sfdc.proxyPassword

Use the utility described below to perform encryption.

Using the Encryption Utility

The AppExchange Data Loader offers an encryption utility to secure passwords specified in configuration files. To use the
encryption utility:

1. Run \bin\encrypt.bat.
2. At the command line, follow the prompts provided to execute the following actions:

Generate a key
Key text is generated onscreen from the text you provide. Carefully copy the key text to a key file,
omitting any leading or trailing spaces. The key file can then be used for encryption and decryption.

Encrypt text
Generates an encrypted version of a password or other text. Optionally, you can provide a key file for
the encryption. In the configuration file, make sure that the encrypted text is copied precisely and the
key file is mentioned.

Verify encrypted text
Given encrypted and decrypted versions of a password, verifies whether the encrypted password
provided matches its decrypted version. A success or failure message will be printed to the command
line.

Additional Apex Enhancements

AppExchange Apps Enhancements

• The publisher of an AppExchange app may have included a link to an external website with information about configuring
your app. If so, the AppExchange Downloads page displays a Configure option next to the app when you click Setup ➤

Exchange ➤ Installed Apps. Click Configure to view the publisher's suggested configurations for the app.
• You can now package the following components:

• Custom fields on standard objects
• Record types on custom objects
• Validation rules on custom objects
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Custom Object Enhancements

Custom Tab Icons
If the document used for the icon in a custom tab is later deleted from the Documents tab, Salesforce

replaces it with a default multicolor block icon ( ).

Recursive "Self " Relationships
You can now create a custom object relationship between an object and itself, but it must be a lookup
relationship and a single record cannot be linked to itself.

Simplified Custom Object Creation
The multi-step wizard for creating or modifying custom objects has been simplified to a single Custom
Object Definition page:

1. Click Setup ➤ Build ➤ Custom Objects.
2. Click New Custom Object, or click Edit to modify an existing custom object.

Tracking Field History for Custom Objects

You can now select fields to track on the History related list of custom objects. Any time a user modifies
any of the fields whose history is set to be tracked, a new entry is added to the History related list. All
entries include the date, time, nature of the change, and who made the change. History data does not
count against your organization’s storage limit.

To track field history for custom objects:

1. Click Setup ➤ Build ➤ Custom Objects and click Edit next to the name of the custom object whose
history you want to track.

2. Select the Track Field History checkbox.
3. Click Save.
4. Select the name of the custom object.
5. Click Set History Tracking in the Custom Fields & Relationships section.

When you choose the fields you want to track, Salesforce begins tracking history from that date and
time forward. Changes made before that date and time are not included in the history.

6. Choose the fields you want tracked in the History related list of the record detail page.
7. Click Save.

When you start history tracking for custom objects, be sure to customize custom object page layouts
to include the History related list. For more information, see "Customizing Page Layouts" in the
Salesforce online help.

Email Templates

• Custom and HTML email templates have a text-only version for recipients who are unable to read HTML emails. The
text-only version is now automatically updated whenever you modify the HTML portion of the template, provided you
have left the text-only version blank.

• In email templates, you can add substitute text to any merge field. Substitute text displays in a sent email if the merge
record does not contain data for that field. To add substitute text, place a comma after the field name and enter the text
before the closing bracket, for example: Dear {!Contact.FirstName, Sir or Madam}. When you save the template,
the merge field will appear in the email template with the following syntax: Dear {!NullValue(Contact.FirstName,
"Sir or Madam")}. The syntax change in the saved template is new with Winter '07, and all existing templates will
automatically reflect this change.
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Field Enhancements

Hierarchical Relationship Fields on Users
A new type of custom field is available on users to manage hierarchical relationships between users. Choose
the Hierarchical Relationship type when creating a custom user field if you want it to be a lookup
for another user that prevents cyclical references. This is useful when creating a field to store a user's
manager because managers cannot directly or indirectly report to themselves.

Increased Limits for Controlling Picklists
The maximum number of values allowed in a controlling picklist field has been increased to 300.

Uniqueness and Case-Sensitivity Constraints on Fields
A new custom field attribute ensures the value of the field is never duplicated. Additionally, when the
custom field type is Text, the unique attribute designates if Salesforce detects duplicates based on case.
Select Treat "ABC" and "abc" as different values if you want to use case-sensitive behavior,
or select Treat "ABC" and "abc" as duplicate values if you want to use case-insensitive behavior.

Universally Required Fields
Up until now, you have been able to make a field required on a page layout or through field-level security.
Now, you can make a field required universally, giving you a higher level of data quality. A universally
required field is a custom field that must have a value whenever a record is saved within Salesforce, the
Apex API, or automated processes such as Web-to-Lead and Web-to-Case. You can make the following
types of custom fields universally required:

• Date
• Date/Time
• Email
• Master-Detail Relationship
• Number
• Percent
• Phone
• Text
• Text Area
• URL

To make a custom field universally required, select the Required checkbox when defining the custom
field.

Merge Fields
The following standard fields are now available for use as merge fields in formulas and s-controls:

Merge Field NameField LabelObject

WhoIdNameEvent

WhatIdRelated ToEvent

UiSkinUser Interface ThemeOrganization

CreatedByIdCreated By IDProfile

CreatedDateCreated DateProfile

DescriptionDescriptionProfile

IsSsoEnabledIs Single Sign On EnabledProfile

LicenseTypeLicense TypeProfile
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Merge Field NameField LabelObject

NameNameProfile

IdProfile IDProfile

TypeProfile TypeProfile

NameRecord Type NameRecord Type

WhoIdNameTask

WhatIdRelated ToTask

All standard user fields.User

CaseAccessForAccountOwnerCase Access Level For Account
Owner

User Role

RollupDescriptionDescriptionUser Role

NameNameUser Role

OpportunityAccessForAccountOwnerOpportunity Access Level For
Account Owner

User Role

IdRole IDUser Role

Formula Enhancements

Many new formula functions are available for you to use wherever formulas are available. Some functions are designed to apply
to a specific feature, such as s-controls.

Note: You no longer need to surround merge fields in formulas with the {! and } characters. However, your existing
formulas do not need updating.The formula builder automatically removes these characters when they are not needed.

Use the following new functions wherever formulas are available:

BR

Inserts a line break in a string of textDescription:

BR()Use:

FirstName & " " & " " & LastName & BR() & 
MailingStreet & BR() & 

Example:

MailingCity & " " & MailingState & " " & 
MailingPostalCode

This displays a formatted mailing address for a contact
including spaces and line breaks where appropriate.

Tips: • Do not remove the parentheses after the function name.
• Keep the parentheses empty. They do not need to contain

a value.
• Remember to surround the BR() with concatenation

operators: &.
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DATEVALUE

Returns a date value for a date/time or text expression.Description:

DATEVALUE(expression) and replace expression with
a date/time or text value, merge field, or expression.

Use:

DATEVALUE(ClosedDate) creates a date field based on the
value of the Date/Time Closed field.

DATEVALUE("2005-11-15") returns November 15, 2005
as a date value.

Example:

Tips: • If the field referenced in the function is not a valid text or
date/time field, the formula field displays #ERROR!

• When entering a date as a literal value, surround the date
with quotes and use the following format:
YYYY-MM-DD, that is, a four-digit year, two-digit
month, and two-digit day.

• If the expression does not match valid date ranges, such
as the MM is not between 01 and 12, the formula field
displays #ERROR!

FIND

Returns the position of a string within a string of text
represented as a number.

Description:

FIND(search_text, text[, start_num]) and replace
search_text with the string you want to find, replace text

Use:

with the field or expression you want to search, and replace
start_num with the number of the character from which to
start searching from left to right.

FIND(" ", Street) returns the character position of the
first space in the Street field. You can use this number to

Example:

find out the length of the street address as a means of
separating a street address from street name in an address field.

SUBSTITUTE(Email, LEFT(Email, FIND("@",

Email)), "www.") finds the location of the @ sign in a
person's email address to determine the length of text to
replace with a "www." as a means of deriving their website
address.

Tips: • Be sure to remove the brackets, [ and ], from your formula
before validating it.

• If the field referenced in your text parameter is blank,
the formula field displays 0.

• Your search_text parameter is case sensitive.
• Your text parameter cannot contain any wildcard

characters.
• If your search does not return any results, a 0 displays in

the field.
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• The start_num parameter is optional. If you do not enter
a start_num value, the formula uses the value one, or the
first character in the string.

• If your start_num is not greater than zero, a 0 displays
in the field.

• If your start_num is greater than the length of the text,
a 0 displays in the field.

• When entering your start_num parameter, remember
that some fields like theWebsite field are unique because
a "http://" is automatically appended to the beginning of
the text you enter.

• Note that the first character in a string is designated as
one rather than zero.

MAX

Returns the highest number from a list of numbers.Description:

MAX(number, number,...) and replace number with the
fields or expressions from which you want to retrieve the
highest number.

Use:

Book Royalties

MAX(0.10 * Pages__c , (Retail_Price__c * 
0.07)* Total_Sold__c )

Example:

This example determines which amount to pay in royalties for
a book. It displays the greater of two amounts: $0.07 for each
book sold or $0.10 per page. It assumes you have custom
number fields for Pages and Total Sold and a custom
currency field for Retail Price.

Commissions

MAX( $User.Commission_Percent__c * Price , 
Price * Account_Discount__c , 100)

This example determines what commission to log for an asset
based on which is greater: the user's commission percentage
of the price, the price times the discount percent stored for
the account or 100 dollars. This example assumes you have
two custom percent fields on users and assets.

MIN

Returns the lowest number from a list of numbers.Description:

MIN(number, number,...) and replace number with the
fields or expressions from which you want to retrieve the lowest
number.

Use:
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401K Matching

MIN(250, Contribution__c /2)

Example:

This example determines which amount to provide in
employee 401K matching based on a matching program of
half of the employee's contribution or $250, whichever is less.
It assumes you have custom currency field for Contribution.

Bonus

MIN( Gross__c *  Bonus_Percent__c , 
Performance__c / Number_of_Employees__c )

This example determines an employee's bonus amount based
on the smallest of two amounts: the employee's gross times
bonus percent or an equally divided amount of the company's
performance amount among all employees. It assumes you
have custom number field for Number of Employees, a
custom percent field for Bonus Percent, and currency
custom fields for the employee's Gross and company's
Performance.

SUBSTITUTE

Substitutes new text for old text in a text string.Description:

SUBSTITUTE(text, old_text, new_text) and replace
text with the field or value for which you want to substitute

Use:

values, old_text with the text you want replaced, and
new_text with the text you want to replace the old_text.

SUBSTITUTE(Name, "Coupon", "Discount") returns
the name of an opportunity that contains the term "Coupon"

Example:

with the opportunity name plus "Discount" wherever the term
"Coupon" existed.

SUBSTITUTE(Email, LEFT(Email, FIND("@",

Email)), "www.") finds the location of the @ sign in a
person's email address to determine the length of text to
replace with a "www." as a means of deriving their website
address.

Tips: • Each term provided in quotes is case sensitive.
• If the old_text appears more than once, each occurrence

is replaced with the new_text value provided even when
that results in duplicates.

Use the following new advanced functions for custom buttons, links, and s-controls:
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GETRECORDIDS

Returns an array of strings in the form of record IDs for the
selected records in a list, such as a list view or related list.

Description:

{!GETRECORDIDS(object_type)} and replace
object_type with a reference to the custom or standard
object for the records you want to retrieve.

Use:

{!REQUIRESCRIPT("/soap/ajax/8.0/connection.js")}Custom Button Example:

var records = 
{!GETRECORDIDS($ObjectType.Case)}; 
var newRecords = []; 

if (records[0] == null) 
{ 
alert("Please select at least one row") 
} 
else 
{ 
for (var n in records) { 
var c = new sforce.SObject("Case"); 
c.id = records[n]; 
c.Status = "New"; 
newRecords.push(c); 
} 

result = 
sforce.connection.update(newRecords); 

window.location.reload(); 
}

In this example, all selected case records are updated with a
Status of "New." To set this up in your organization, create
a custom list button for cases with the following attributes:

• Display Type is "List Button"
• Behavior is "Execute JavaScript"
• Content Source is "OnClick Java Script"

Paste the sample code above into the content of your custom
button. Finally, add the list button to the a page layout that
contains the Cases related list, such as accounts or
opportunities. Users can select any number of cases in the
related list and click the list button to change the status of
those cases at once. Notice the check for records[0] ==
null, which displays a message to users when they do not
select at least one record in the list.

Tips:
• Use global variables to access special merge fields for

s-controls, custom buttons, and links.
• Activities are special types of objects. Use

{!GETRECORDIDS($ObjectType.Task)} when creating
a task list button. Use
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{!GETRECORDIDS($ObjectType.Event)} when creating
an event list button.

• This function is only available in custom buttons, links,
and s-controls.

INCLUDE

Returns content from an s-control snippet. Use this function
to reuse common code in many s-controls.

Description:

{!INCLUDE(source, [inputs])} and replace source
with the s-control snippet you want to reference. Replace
inputs with any information you need to pass to the snippet.

Use:

Including Header Snippet

<html>
<body>

S-Control Example:

{! INCLUDE($SControl.Header_Snippet, 
[title = "My Title", theme = "modern"])}
</body>
</html>

This example references a snippet that provides a header for
a page that you created to display in a web tab. It displays the
page title "My Title." Use the $SControl global variable to
reference a custom s-control.

Including Input Parameters

Use the following two examples to see how you can create a
reusable snippet and include it in an s-control.

<h2 class=”{!$Request.titleTheme}.title”>
{!$Request.titleText}</h2>

This snippet requires two input parameters: titleTheme and
titleText. It is a reusable HTML tag that presents a page
title and theme based on input parameters. Next, create an
s-control that includes this snippet:

<html>
<head>
</head>
<body>
{! INCLUDE($SControl.Title_Snippet, 
[titleTheme = "modern", titleText = "My 
Sample Title"]) }

... Insert your page specific content here 

...

</body>
</html>
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This s-control uses the snippet titled Title_Snippet to display
the title of the page "My Sample Title" and modern theme.
Replace Insert your page specific content here
with your own HTML content and use the s-control as the
source of a web tab to create your own pages in Salesforce.

Tips:
• Because this function references an s-control snippet and

does not copy it, it always runs the latest content of the
s-control snippet. Remember when making a change to
your s-control snippet that it affects all INCLUDE
functions that refer to it.

• Use the $Request global variable to access any information
inside the snippet.

• This function is only available in custom buttons, links,
and s-controls.

LINKTO

Returns a relative URL in the form of a link (href and anchor
tags) for a custom s-control or Salesforce page.

Description:

{!LINKTO(label, target, id, [inputs], [no

override]} and replace label with the text for the link,
Use:

target with the URL, and id with a reference to the record.
Inputs are optional and can include any additional parameters
you want to add to the link. The no override argument is
also optional and defaults to "false." It applies to targets for
standard Salesforce pages such as $Action.Account.New.
Replace no override with "true" when you want to display
a standard Salesforce page regardless of whether you have
defined an override for it elsewhere.

New Account S-Control

<html>
<body>

S-Control Example:

{!LINKTO("Create a New Account", 
$Action.Account.New,
   $ObjectType.Account)}
</body>
</html>

This example allows users to click a link to create a new
account. It is useful in account list views or web tabs where
you want users to create an account directly from that page.
Use the $Action global variable to access the new account page
in Salesforce.

New Email Window S-Control

<html>
<body>
{!LINKTO("Email link", 
  "mailto:support@yourcompany.com?
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subject=Please%20Help")};
</body>
</html>

This example launches a new email window addressed to
support@yourcompany.com with the subject "Please Help"
whenever a user clicks "Mail link."

Link to Another S-Control

<html>
<body>
{!LINKTO("Check for duplicates", 
  $Scontrol.dedup_account, Account.Id)}
</body>
</html>

Use this example to generate a page containing a hyperlink
labeled "Check for duplicates." When users click this link,
Salesforce runs your custom s-control. This example assumes
you have already created a custom s-control to find duplicate
accounts and merge their information.

Tips:
• Avoid using this function in an inline s-control if you want

it to open in a new window.
• Enclose multiple inputs in brackets to indicate they are

together:

{!LINKTO("View Case",  $Action.Case.View
 ,  Case.Id , [parm1="A", parm2="B"])}

• Set inputs to null if you do not have any to pass yet you
want to set the no override argument:

{!LINKTO("View Case",  $Action.Case.View
 ,  Case.Id , null, true)}

• This function is only available in custom buttons, links,
and s-controls.

REQUIRESCRIPT

Returns a script tag with source for a URL you specify. Use
this function when referencing the ApexAJAX Toolkit or
other JavaScript toolkits.

Description:

{!REQUIRESCRIPT(url)} and replace url with the link for
the script that is required.

For the AJAX Toolkit:

{!requireScript("/soap/ajax/8.0/connection.js")}

Use:
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Returns:

<script 
src="/soap/ajax/8.0/connection.js"></script>

For Dojo:

{!requireScript("/js/dojo/0.3.1/dojo.js")}

Returns:

<script 
src="/js/dojo/0.3.1/dojo.js"></script>

{!REQUIRESCRIPT("/soap/ajax/8.0/connection.js")}
var c = new sforce.SObject("Case");

Custom Button Example:

c.id = "{!Case.Id}";
c.Status = "New";
result = sforce.connection.update([c]);
window.location.reload();

This example sets the Status of a case to "New" whenever a
user clicks a custom button from the case detail page.To build
this custom button, define a custom button that has the
Behavior set to "Execute JavaScript" and Display Type
set to "Detail Page Button," paste the content above, and add
it to your case page layouts.

Tips:
• Use global variables to access special merge fields for

s-controls.
• Use this function when creating s-controls for custom

buttons or links where you have set the Behavior to
"Execute JavaScript" because the script tag should be
outside the OnClick code.

• This function is only available in custom buttons, links,
and s-controls.

URLFOR

Returns a relative URL for an action or s-control.Description:

{!URLFOR(target, id, [inputs], [no override])}

and replace target with the URL, id with a reference to the
Use:

record, and inputs with any optional parameters. The no
override argument is also optional and defaults to "false."
It applies to targets for standard Salesforce pages such as
$Action.Account.New. Replace no override with "true"
when you want to display a standard Salesforce page regardless
of whether you have defined an override for it elsewhere.
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<html>
<head>

S-Control Example:

<script src="/soap/ajax/8.0/connection.js">
</script>
<script>
function init()
{
var queryResult = 
sforce.connection.query("Select count() from
 CaseSolution Where CaseId = '{!Case.Id}'");
var size = queryResult.size;
if (size > 0) {
//go to the standard case close page without
 invoking the override
window.parent.location.href = 
"{!URLFOR($Action.Case.CloseCase, Case.Id, 
[retURL=URLFOR($Action.Case.View, Case.Id)],
 true)}"
}
else
{
alert("Case must contain at least one 
solution before it can be closed.");
//go to the standard case detail page
this.parent.location.href = 
"{!URLFOR($Action.Case.View, Case.Id)}";
}
}
</script>
</head>
<body onload="init()">
<p>&nbsp;</p>
</body>
</html>

In this example, the s-control displays a message to users when
they click Close Case on a case with no associated solutions.
If the case is associated with at least one solution, the close
case page displays as usual.To implement this example, create
an s-control with the content above. Then, override the close
case option using the s-control.

This example shows how you can validate data using a standard
button override. Use validation rules to validate data on a
record and an s-control like the one in this example to validate
associated data. This example does not apply to records
updated using the API.

This example uses the URLFOR function to build Salesforce
URLs rather than hard-coding them, which is more scalable.
It also sets the no override argument to "true," telling
Salesforce to ignore the override and call a standard close case
action within an override.

Tips:
• Use global variables to access special merge fields for

s-controls.
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• Enclose multiple inputs in brackets to indicate they are
together:

{!URLFOR($Action.Case.View,  Case.Id, 
[parm1="A", parm2="B"])}

• Set inputs to null if you do not have any to pass yet you
want to set the no override argument:

{!URLFOR($Action.Case.View,  Case.Id, 
null, true)}

• When you override a standard action, that action is no
longer available in Salesforce. For example, if you override
the new account action, that affects the New button on all
pages such as the account detail page, account related lists
on other detail pages, and the Create New drop down list
in the sidebar. To override a standard action yet still access
it, use the no override argument in your s-control to
reference that action.

• This function is only available in custom buttons, links,
and s-controls.

Import Queue

The Import Queue is now available by clicking Setup ➤ Monitoring ➤ View the Import Queue.

Licenses Related List on Company Information Page

You can now view information about your organization's licenses on the Company Information page.

To view a list of available licenses by type, click Setup ➤ Company Profile ➤ Company Information. This page lists the
following for each type of user license:

• Total Licenses indicates the number of licenses for which your organization is billed and that are available to you.
• Active Licenses is the number that you have assigned to users.
• Licenses Remaining is the number of unused licenses.

New Languages: Finnish and Thai

Salesforce now includes support for Finnish and Thai in the application, increasing the supported languages to fourteen:

• Brazilian Portuguese
• Simplified Chinese
• Traditional Chinese
• English
• Dutch
• Finnish
• French
• German
• Italian
• Japanese
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• Korean
• Spanish
• Swedish
• Thai

Users can change their personal language setting by clicking Setup ➤ My Personal Information ➤ Personal Information
➤ Edit.

Page Layout Enhancements

• When editing page layouts, you may want to save changes and continue editing. Use the new Quick Save option on page
layouts to do just that.

• All of the editing properties for an item on the page layout, including fields, related lists, and s-controls, are now consolidated
into a single button. Click Edit Properties to edit the attributes of any type of item on the page layout.

• To edit the properties of any item on a page layout, double-click the item. For example, double-click a related list to change
the fields, sorting of fields, standard buttons, custom buttons, and more.

• The Printable View button is now a link to make more room for your custom buttons.
• You can now add the Account Name field to the Close Case Layout.

Search Enhancements

Search result rankings have been optimized, using a dynamic score, to produce more relevant results. A dynamic score combines
information retrieval algorithms with data-specific heuristics.

Security Enhancements

With Winter '07, you can increase your organization's online security with two new features that block HTML file uploads,
which could potentially contain malicious JavaScript or other code:

• Users are now prohibited from uploading solution attachments with the following file extensions: htm, html, htt, htx,
mhtm, mhtml, shtm, shtml, acgi. This security enhancement is enabled by default for all organizations and cannot be
disabled.

• A new security setting, Disallow HTML documents and attachments, blocks users from uploading any file to the
Documents tab or attaching it to a record if it has one of the following file extensions: htm, html, htt, htx, mhtm, mhtml,
shtm, shtml, acgi.

This setting is disabled by default. To enable this setting, click Setup ➤ Security Controls ➤ HTML Documents and
Attachments Settings.

Note: HTML attachments are not permitted on solutions, regardless of whether this security setting is enabled.
In addition, this setting does not affect attachments on email templates; HTML attachments on email templates
are always permitted.

After this setting is enabled, previously-uploaded HTML documents and attachments are unaffected. However,
when users attempt to view an HTML attachment or document, their browser first prompts them to open the file
in the browser, save it to their computer, or cancel the action.

Setup Audit Trail

Setting up Email-to-Case is now tracked on the setup audit trail. Users who have the "View Setup and Configuration"
permission can view your organization's setup audit trail by clicking Setup ➤ Security Controls ➤ View Setup Audit Trail.

Supported Browsers

With Winter '07, Salesforce supports the following browsers:
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• Microsoft® Internet Explorer version 6.0 or later (recommended)
• Mozilla Firefox version 1.5 or later

Regardless of which browser you use, JavaScript must be enabled.

User Interface Customization Enhancements

Collapsible Sidebar
The collapsible sidebar gives users the ability to show or hide the sidebar on every Salesforce page that
normally includes the sidebar. When you select the Enable Collapsible Sidebar setting under
Setup ➤ Customize ➤ User Interface, the collapsible sidebar becomes available to all users in your
organization, but each user can choose his or her own preference for displaying the sidebar. Users can
leave the sidebar visible at all times, or they can collapse the sidebar and only show it when needed by
clicking the edge of the collapsed sidebar.

Tip:  If your organization uses divisions, we recommend that you keep the sidebar pinned and
visible at all times so you always have access to the Divisions drop-down list.

Related List Hover Links
Related list hover links now display at the top of record detail pages for all users. Users can mouse-over
a related list hover link to display the corresponding related list in an interactive overlay that allows users
to quickly view and manage the related list items. Users can also click a related list hover link to jump
down to the content of the related list without having to scroll down the page.
Related list hover links are enabled for all organizations with Winter '07. Users with the "Customize
Application" permission can disable them if necessary.
To enable or disable related list hover links:

1. Click Setup ➤ Customize ➤ User Interface.
2. Select the Enable Related List Hover Links checkbox.

You can deselect the checkbox at any time to turn off related list hover links.

3. Click Save.

Optional Display of Custom Home Page Components
Now you can opt to show your custom sidebar components on all pages in Salesforce. This is helpful if
you have custom home page layouts that include components in the sidebar. Selecting this option makes
the sidebar components available on all pages in Salesforce.

New Printable View Link
On all record detail pages, the Printable View button has been changed to a link with the same name.
The Printable View link is now located at the top right of the record detail page near the context-sensitive
Help for this Page link.

User Object Enhancements

Delegated Approver Field
A new standard field is available on users. Use the Delegated Approver field to indicate which user
can approve or reject approval requests assigned to that user.

Hierarchical Relationships
A new type of custom field is available on users to manage hierarchical relationships between users. Choose
the Hierarchical Relationship type when creating a custom user field if you want it to be a lookup
for another user that prevents cyclical references. This is useful when creating a field to store a user's
manager because managers cannot directly or indirectly report to themselves.
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Restricted Custom Fields
When you create a custom field on users, a new Restricted Field checkbox displays which you can
select to only allow users with the "Manage Users" permission to edit the field. This checkbox is not
available on custom formula fields.

User Fields in List Views
You can now add the following user fields to user list views, user lookup fields, user search layouts, and
user reports:

• Allow Forecasting

• City

• Created By Alias

• Created By

• Created Date

• End of Day

• Last Modified By Alias

• Last Modified By

• Last Modified Date

• Password Expiration Date

• Start of Day

• State/Province

• Street

• Time Zone

• Zip/Postal Code

• Mobile

• Profile
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